
This file includes the context-sensitive help for the Animation menu including:
· command descriptions (F1)
· dialog box controls What’s this? Topics

Note
· Some dialog box controls are used by more than one dialog box in the Animation menu; the descriptions of 

these shared controls includes a line that state that fact.
· 2 controls in this file are also used by the Apply Script To Frames dialog box which is documented in 

D_ROLLUPS.RTF because it opens from the Recorder Roll-Up.



Animation Menu commands



Plays the current animation. Once the animation is started, it continues to play until it is stopped using the Stop 
Animation command.



Stops animation play and freezes the last active frame in the Image Window.



Rewinds the animation to the first frame and freezes it in the Image Window.



Rewinds the animation one frame and displays it in the Image Window. 



Advances the animation to the last frame and freezes it in the Image Window.



Advances the animation one frame and displays it in the Image Window. 



Opens the Go To Frame dialog box where you select a particular animation frame. Enter the frame you want in 
the box and click OK. The selected frame is immediately displayed in the Image Window.



Opens the Insert Frames dialog box where you insert one or more frames into a animation. You can insert a copy 
of the current frame appearing in the animation window, or or a paper colored frame. Choose the frame insertion
point and number of frames to be inserted by using the dialog box options.



Opens the Insert Animation From Disk dialog box where you can add a previously-saved file into the body of the 
current animation. This file may be a single .BMP image or an entire animation file. After you select the file and 
click Open, the Insert File dialog box appears where you choose the frame location at which the file is to be 
inserted. 

Note
· If the current animation and the inserted file are different sizes, the inserted file always conforms to the image 

dimensions of the current animation. 



Opens the Delete Frames dialog box where you delete one or more frames from a animation using the From 
Frame and To Frame boxes.



Opens the Move Frames dialog box where you re-order frames in a animation. You can move single or multiple 
frames to any point in the sequence of the animation. 



Creates a animation file using the active image. The active image is automatically assigned the .AVI file 
extension and becomes the first and only frame of the new animation file. Use the other commands in the 
Animation menu to add new frames to the new animation.



Go To Frame dialog box



Type the number of the animation frame you want to display in the Image Window.



Insert Frames dialog box



Type the number of the frame before or after which you want to insert new frames. The frame you choose is not 
overwritten.



Type the number of frames to be inserted.



Enable to insert the new frame(s), or move existing frame(s), immediately before the frame whose number you 
specify in the Frame box.
This control appears in both the Insert Frames and Move Frames dialog boxes.



Enable to insert the new frame(s), or move existing frame(s), immediately after the frame whose number you 
specify in the Frame box.
This control appears in both the Insert Frames and Move Frames dialog boxes.



Enable if you want all the frames you are inserting in this operation to be copies the frame that is visible in the 
Image Window.



Enable to make the new frames you are inserting only display the current paper color. 



Delete Frames/Move Frames dialog box



Type the number of the first frame to be affected by the operation. This number box is inclusive. The frame 
corresponding to the number appearing in the box will be deleted, moved, or affected by the script you play.
· Note

The Delete Frame(s), Move Frame(s), and Apply Script to Frame(s) dialog boxes share this control.



Type the number of the last frame to be affected by the operation. This number box is inclusive. The frame 
corresponding to the number appearing in the number box will be deleted, moved, or affected by the script you 
choose.
· Note

The Delete Frame(s), Move Frame(s), and Apply Script to Frame(s) dialog boxes share this control. 



Type the number of the frame before or after which you want to place the range of frames you are moving. The 
frame you choose here is not overwritten by the frames you move. It remains intact.





EDIT MENU



Undoes the last change made to the image. Corel WEB.PhotoPaint remembers the previous action and displays 
the name of the action after the prefix Undo; e.g., Undo Map To Object. If you make a mistake or do not like the 
effect created by the last action, the Undo command reverses it.



Reapplies the last change you undid. If you have not previously undone an action, this command is grayed out.



Reapplies the most recent operation. The command name includes the name of the last operation performed. If 
the last operation cannot be repeated, the command name is grayed out.



Lists each step taken while editing an image and lets you return to a previous stage in its development. Each 
step is listed in the order in which it occurred, from the first action taken to the last. To revert to a particular 
point in the development of the image, click a command in the list and click Undo. The image reverts to that 
point in its development. 



Allows you to redo a sequence of operations you reversed using the Undo List command. The sequence of 
operations you choose in the Redo List dialog box are performed in the same order in which they were performed
originally. 



Marks the current point in your image's development so you can return to it later if you make a mistake. To 
return to the checkpoint, use the Restore To Checkpoint command.



Reverses all changes made to the image since the last checkpoint. You must set a checkpoint using the 
Checkpoint command before you can use the Restore To Checkpoint command.



Cuts an object, masked selection, or floating selection from the image and copies it to the Clipboard. 



Copies an object, masked selection, or floating selection from the image and copies it to the Clipboard. If there is
no defined area, the entire image is copied.



 Pastes the contents of the clipboard into your image as an object that floats above the image; you can move 
and edit the pasted area like you would any object.



Pastes the contents of the clipboard into your image and makes the pasted item a floating selection, which is 
enclosed by a mask marquee. You can move this marquee, and the pixels it contains, anywhere in the Image 
Window without affecting the underlying image.



 Pastes the contents of the clipboard into the selection boundary displayed in the image; You can reposition the 
item anywhere within the selection boundary. If the item you paste is smaller than the selection you are pasting 
it into, it is enclosed by a second marquee.



Creates a new image using the contents from the clipboard. You can also use the New From Clipboard command 
(found in the File menu) to complete this task. If you paste from Corel WEB.PhotoPaint, the document is pasted 
at your current display resolution; if you paste from CorelDRAW, the document is pasted at 72 dpi. You can 
change the resolution afterwards using the Resample command (found in the Image menu).



Removes everything from the image or defined area, leaving only the paper color.



Opens the Edit Fill and Transparency dialog box, which lets you fill a masked selection or the entire image using 
any of the fill color, pattern, and transparency options. 



Saves or copies the selected area to an existing file or new file. Specify the name, location, and file format of the 
file.



Selects a file to paste into the active image. Specify the filename, location, and file format. The file is pasted into
the active image as an object and is enclosed by an object marquee. 



Clears the Clipboard of all information. The Clipboard is a temporary storage area used to store information and 
transfer information between documents and applications. 



Returns the paint, paper, and fill colors to the defaults: black for the paint and fill colors, and white for the paper 
color.



UNDO LIST



Displays the number of commands in the list.



Enable to display only the name of each command taken in the course of the image’s development. When 
disabled, the command is accompanied with a corresponding numerical representation of the action.



Displays each action taken in the course of the image’s development. The actions are listed in sequential order 
from the first action taken to the last. To revert to a particular point in the development of the image, click on a 
command in the list and click Undo. The image reverts to that point in its development.



Opens the Save Recording dialog box where you save the current Quick Script file (QSC) to a specified drive and 
folder.



Edit Fill & Transparency dialog box



Fill Color tab



Use to sample a fill color from the image. Click the Eyedropper tool and click the color on your image.



Click to select the current paint color as the fill.



Click to select the current paper color as the fill.



Click to select the current fill displayed in the Preview window on the right. 



Click to select a uniform fill, which applies a solid color over the area you are filling. If you want to change the 
color of the uniform fill, click Edit and select or mix a new color in the Uniform Fill dialog box.



Click to select a fountain fill, which progresses from one color to another following a concentric square, conical, 
linear, rectangular, or radial pattern. Click Edit to open the Fountain Fill dialog box, which contains all the 
controls you need to customize, create, save, or delete fountain fills.



Click to select a bitmap fill, which is a fill created from any bitmap image. The images that work best are those 
that are patterned and can tile to create a contiguous pattern, like river stones, coins, or bricks. Click Edit to 
open the Bitmap Fill dialog box, which contains the controls you need to import, select, and customize bitmap 
fills. 



Click to select a texture fill, which is a mathematically (algorithmically) generated image with customizable 
attributes. Unlike the tiling bitmap fills, textures fill a designated area with a single image. The many preset 
textures include water, minerals, clouds, and dozens of other presets. Click Edit to open the Texture Fill dialog 
box, which contains the controls you need to create, select, and customize texture fills.



Displays the selected paint mode. Paint modes determine the way the colors in the fill are applied to the colors 
that already exist in your image. 



Click to open the dialog box that pertains to the type of fill you have selected. For example, if you have selected 
a texture fill, but don't want to use the fill that appears in the Preview window above, click Edit and modify the fill
in the Texture Fill dialog box. 



Displays the selected fill.



Transparency tab



Lists the available gradient patterns. A grayscale depiction of the pattern appears in the Preview window to the 
right. Opaque areas show as black, completely transparent areas show as white, while the values that fall 
between are represented by their equivalent grayscale values. Click and drag in the Preview window above to 
interactively edit the pattern's center, start, and end points.



Allows you to set a starting transparency value for your fill. A value of zero is completely opaque, while a value 
of 100 is completely transparent.



Allows you to set an ending transparency value for your fill. A value of zero is completely opaque, while a value 
of 100 is completely transparent.



Displays a grayscale depiction of the selected transparency. Opaque areas show as black, completely 
transparent areas show as white, while the values that fall between are represented by their equivalent 
grayscale values.



Stuff common to both tabs



Displays what your image will look like if you apply the selected fill and transparency options. Click and drag to 
interactively edit the transparency path of the fill.



Click to reset the transparency levels, adjustment handles, and paint mode to their default settings.



Closes the dialog box and applies the selected fill and transparency options to your image.



Closes the dialog box without applying the selected fill and transparency options to your image.



Bitmap Fill dialog box (other fill dialogs are 
CDRDLG)



Displays the selected fill. Click the arrow to view a list of available bitmap fills.



Opens the Import dialog box, which allows you to import a bitmap file to use as a fill.



Deletes the current fill from the bitmap list.



Displays controls that allow you to edit the fill's tiling properties.



Use these controls to change the size of the fill's tiles.



Enable this option to use the fill's default tile size. If you want to define the tile size yourself, disable this option 
and type in values in the Width and Height boxes.



Displays the width of each tile. To adjust the width, type in a new value or use the scroll arrows to adjust the 
current value. 



Displays the measurement units used to define tile width. To change the units, click the arrow and select a 
different one from the list box.



Displays the height of each tile. To adjust the height, type in a new value or use the scroll arrows to adjust the 
current value. 



Displays the measurement units used to define tile height. To change the units, click the arrow and select a 
different one from the list box.



These controls allow you to offset the first tile (and all that follow) relative to the top left corner of the area you 
are filling. This is useful if you want a part of the pattern to fall in a specific spot. 



Sets the horizontal offset of the tile relative to the top left corner of the area you wish to fill. Type in a value or 
use the scroll arrows to adjust the existing value. Set it to zero if you want the first tile flush with the left side of 
the area.



Sets the vertical offset of the tile relative to the top left corner of the area you wish to fill. Type in a value or use 
the scroll arrows to adjust the existing value. Set it to zero if you want the first tile flush with the top of the area.



These controls allow you to shift columns or rows of tiles, so that the fill's pattern appears staggered rather than 
continuous.



Enable to shift alternating rows of tiles by the amount you specify in the box below. 



Enable to shift alternating columns of tiles by the amount you specify in the box below.



Specifies how far alternating columns or rows will be shifted. To adjust the amount, type in a new value or use 
the scroll arrows to adjust the existing value.



Enable to fill the area with a single, large tile. 



Enable to keep the height and width of the tiles identical.





Context sensitive help for Effects menu



Repeats the last effect filter applied to the current image, and retains the same settings (the filter's dialog box 
won't reopen). If you haven't used a filter since you opened Corel WEB.PhotoPaint, this command is grayed out. 



Opens the Edge Detect dialog box, which finds the edges of elements in your image, then converts them to lines 
on a background of a single color.



Opens the Pixelate dialog box, which allows you to break up your image into square, rectangular, or concentric 
arc cells. 



Opens the Puzzle dialog box, which allows you to break down your image into puzzle-like pieces or blocks that 
resemble a jigsaw puzzle. 



Opens the Ripple dialog box, which allows you to create vertical or horizontal rippled waves throughout your 
image.



Opens the Shear dialog box, which allows you to distort an image along a path that you define using a shear 
curve.



Opens the Swirl dialog box, which allows you to create a swirling vortex of distortion on your image. You can 
select the direction and angle of the distortion. 



Opens the Tile dialog box, which allows you to reproduce your image as a series of tiles on a grid. 



Opens the Wet Paint dialog box, which allows you to create the illusion that your image is a painting that is still 
wet and dripping. 



Opens the Wind dialog box, which allows you to smear your image in a specific direction to create the effect of 
wind blowing across your image. 



Opens the Whirlpool dialog box, which allows you to apply a pattern of fluid streamlines over your image. 



Opens the 3D Rotate dialog box, which allows you to rotate your image as if it were one side of a three-
dimensional box.



Opens the Emboss dialog box, which allows you to transform your image into a relief.



Opens the Map To Object dialog box, which allows you to wrap your image around a sphere or cylinder. 



Opens the Mesh Warp dialog box, which allows you to distort your image by manipulating the panels of a grid.



Opens the Page Curl dialog box, which allows you to create the impression that a corner of your image has rolled
in on itself. 



Opens the Perspective dialog box, which allows you to create the sense of three-dimensional depth, as if your 
image were on a flat plane receding into the distance.



Opens the Pinch/Punch dialog box, which allows you to warp your image by either "pinching" your image away 
from you or "punching" it toward you.



Opens the Zig Zag dialog box, which allows you to distort an image by bending the image lines that run from the
center of the image to its edge.



Opens the Blur Control dialog box, which gives you access to five blur filters at the same time. 



Opens the Noise Control dialog box, which gives you access to nine noise filters at the same time.



Opens the Sharpen Control dialog box, which gives you access to five sharpen filters at the same time.



Opens the Vignette dialog box, which allows you to frame your image in a variety of ways.



Opens the Gaussian Blur dialog box, which allows you to produce a hazy effect. The image is blurred according to
a gaussian distribution. 



Opens the Motion Blur dialog box, which allows you to create the illusion of motion in your image.



Opens the Halftone dialog box, which allows you to give your image the appearance of a color halftone.



Opens the Psychedelic dialog box, which allows you to change the colors in your image into bright, psychedelic 
colors.



Opens the Solarize dialog box, which allows you to transform colors . The effect depends on the relative amount 
of each color component.



Opens the Add Noise dialog box, which allows you to add random pixels with different types of distribution.



Opens the Dust and Scratch dialog box, which allows you to reduce image noise. Use this filter with a mask 
selection to repair dust and scratch damage.



Opens the Remove Noise dialog box, which allows you to soften your image and reduce the speckled effect that 
can occur during the scanning or video-capturing process.



Opens the Lens Flare dialog box, which allows you to produce rings of light on your image that simulate the flare 
that appears on a photograph when the camera is aimed toward a direct bright light.



Opens the Lighting Effects dialog box, which allows you to add light sources to your image.



Opens the Sharpen dialog box, which allows you to accentuate the edges in your image by finding the edges and
increasing the contrast between adjacent pixels. 



Controls common to all effects dialogs



Click to toggle between viewing the Original and Result windows side-by-side and viewing a single, larger Result 
window.



Use the Hand tool to drag areas of an image into view when your image is larger than the Image Window. 



Use the Zoom tool to magnify areas of your picture. Click to zoom in to the next preset level, right-click to zoom 
out to the next preset level.



Click to reset all controls in the dialog box to their default settings. 



Displays how your image looks before you apply the effect. 



Displays how your image would look if you applied the effect using the current settings. Click Preview to update 
the Result window, or click the lock button to have the Result window update continuously. 



Click Preview to view how your image would look if you applied the effect using the current settings. 



Click to have the Result window automatically update to reflect any changes you make to settings in the dialog 
box. 



Click to have the Result window automatically update to reflect any changes you make to settings in the dialog 
box. 



Click to open the Effects menu, from which you can access any of the effect filters. 



Save Preset dialog box (common)



Type a name for the new preset.



2D effect flyout menu



Edge Detect dialog box



Move the slider to set the intensity of the effect.



Click to apply a white fill to all areas of your image that are not part of the outlined image.



Click to apply a black fill to all areas of your image that are not part of the outlined image.



Click to apply the current paint color to all areas of your image that are not part of the outlined image.



Pixelate dialog box



Move the slider to adjust the width of the blocks. In circular mode, width is the arc-width of each block (in 
degrees). 



Move the slider to adjust the height of the blocks. In circular mode, height is the difference in radius between the
block's inner and outer curves.



Move the slider to adjust the opacity of the effect. 



Click to break up your image into rectangular blocks. 



Click to break up your image into concentric arcs.



Click to break up your image into square blocks.



Puzzle dialog box



Move the slider to adjust the width of the puzzle blocks. 



Move the slider to adjust the height of the puzzle blocks. 



Move the slider to adjust the amount of shifting that occurs.



Click to fill in empty areas with black.



Click to fill in empty areas with white. 



Click to fill in empty areas with the paint color. 



Click to fill in empty areas with the original image. 



Click to fill in empty areas with a negative of the original image. 



Enable this check box to force the height and width of the blocks to be the same. 



Ripple dialog



Move the slider to adjust the distance between each wave cycle. Larger values create greater distances between
each wave and result in a smaller number of waves.



Move the slider to adjust the amount of displacement the wave creates. The greater the number, the greater the
wave displacement.



Move the slider to adjust the direction of the ripple effect. 



Enable this check box to apply distortion to the ripple. 



Click to apply a horizontal ripple effect (automatically sets the Directional Angle value to 90 degrees). 



Click to apply a vertical ripple effect (automatically sets the Directional Angle value to 0 degrees). 



Click to use a custom direction for the ripple effect. Move the Direction Angle slider to set the direction.



Shear filter



Click to stretch the edges of the image to fill empty areas.



Click to fill empty areas with the paint color. 



Click to use the opposite edge of the image to fill empty areas. 



Displays the current Shear map. Drag to reshape the response curve. 



Displays the selected editing style. To use a different editing style, click the down arrow and choose a style from 
the list.



Click to load saved shear maps. 



Click to open the Save Shear Map Files dialog box, which allows you to save shear maps in the Shearmap 
directory as .SHR files. 



Click to display the response curve from left to right. 



Click to display the response curve from top to bottom. 



Move the slider to adjust the degree to which your image conforms to the curve. Set the value at 100 per cent to
have the image conform completely to the curve. 



Click to smooth the response curve when you are using Freehand editing style. Each time you click, the response
curve is smoothed slightly more. 



Type a description of the Shear map you are saving in the File Name box.



Swirl dialog



Click to swirl your image in a clockwise direction. 



Click to swirl your image in a counterclockwise direction. 



Move the slider to adjust the number of whole rotations that occur.



Move the slider to adjust the number of partial rotations. For example, if you set the Whole Rotations value to 1, 
and the Additional Degrees value to 90, your image will be rotated 450 degrees, or 1.25 times.



Tile dialog



Move the slider to adjust the number of times the image appears along the horizontal axis. 



Move the slider to adjust the number of times the image appears along the vertical axis. 



Enable this check box to force an identical number of horizontal and vertical tiles. When this option is enabled, 
moving one slider also moves the other.



Wet Paint dialog box



Move the slider to adjust the size of the paint drip. 



Move the slider to adjust the range of colors that drip. Negative values cause the dark colors to drip; positive 
values cause the light colors to drip. 



Wind dialog box



Move the slider to adjust the opacity of the effect. 



Move the slider to set the intensity of the effect.



Displays the angle from which the wind approaches the image. To change the wind's direction, click a location on
the edge of the dial, or type an angle into the box.



Displays the angle from which the wind approaches the image. To change the wind's direction, type an angle in 
the box, or click a location on the edge of the dial. 



Whirlpool dialog box



Move the slider to adjust the spacing between swirls.



Move the slider to adjust the smear length.



Move the slider to adjust the amount of twisting in each swirl.



Move the slider to adjust the amount of detail in the streaks.



Enable this check box to allow the filter to warp your image. Disable it to maintain the shapes of the elements in 
your image.



Displays the currently used Whirlpool style. To use another, click the down arrow and choose one from the list.



Click to save the currently used style.



Click to delete the currently used Whirlpool style.



3D effects flyout menu



3D Rotate dialog box



Displays a three-dimensional box that you manipulate to change the perspective of your image. The shaded 
plane of the box represents the image. Move the vertical and horizontal sliders to rotate and position the three-
dimensional model.



Move the slider to rotate the image vertically. 



Move the slider to rotate the image horizontally. 



Enable this check box if you want to ensure that all parts of your image remain within the Image Window. 



Emboss dialog box



Move the slider to adjust the depth of the ridges and crevices in the relief. 



Move the slider to adjust the amount of background color the relief will contain.



Click to create a relief using the original image colors. 



Click to create a relief using gray as the embossing color. This produces an overall gray image with moderate, 
embossed highlights.



Click to create a relief using black as the embossing color. This produces an overall black image with high-
contrast, embossed highlights.



Click to create a relief using the paper color as the embossing color.



Move the slider to determine the angle at which the light hits the relief to create the embossing effect. You can 
also adjust the angle by typing the number of degrees in the box to the left.



Displays the current angle at which the light is hitting the relief. Type a new value or adjust the existing value 
using the scroll arrows.



Map to Object dialog box



Move the slider to adjust the direction and amount of wrapping. Negative percentage values wrap the image 
toward the back (convex); positive percentage values wrap the image toward the front (concave).



Click to have your image appear to wrap around a sphere.



Click to have your image appear to wrap around a horizontal cylinder. 



Click to have your image appear to wrap around a vertical cylinder.



Mesh Warp dialog box



Move the slider to adjust the number of gridlines. The more gridlines there are, the more control you have while 
you manipulate your image.



Displays your image with the grid over it. Drag the nodes that intersect gridlines to distort your image. 



Displays the current Mesh Warp style. If you have previously saved Mesh Warp styles, they appear in this list. To 
use a different style, click the down arrow and choose a new style from the list. 



Click to open the Save Meshwarp Files dialog box. 



Click to delete the current Mesh Warp style. 



Page Curl dialog box



Click to have the page curl begin along the top or bottom edge of your image. You can set the location of the curl
by clicking one of the buttons on the left. 



Click to have the page curl begin along the left or right edge of your image. You can set the location of the curl 
by clicking one of the buttons on the left. 



Click to make the curl completely opaque. 



Click to change the transparency of the curl.



Click if you want the page curl on the top right corner of the image. 



Click if you want the page curl on the top left corner of the image. 



Click if you want the page curl on the bottom right corner of the image. 



Click if you want the page curl on the bottom left corner of the image. 



Move the slider to adjust the width of the page curl. Increase the value to extend the page curl along the 
horizontal edge of the image.



Move the slider to adjust the height of the page curl. Increase the value to extend the page curl along the 
vertical edge of the image.



Displays the current curl color. To choose another color, click the down arrow, and click a color from the color 
picker. 



Displays the current background color. To choose another color, click the down arrow, and click a color from the 
color picker. 



Perspective dialog box



Click to enable the Perspective editing mode, which allows you to move two nodes at the same time in opposite 
directions, providing the illusion of distance and perspective.



Click to enable the Shear editing mode, which allows you to skew the image by moving two nodes 
simultaneously. 



Displays a two-dimensional model of your image that has nodes in each corner. Drag the nodes to manipulate 
the perspective of the image.



Enable this check box to ensure that all parts of your image remain visible in the Image Window. 



Displays your image. To preview the current Perspective settings, click Preview or the Auto-Preview button.



Pinch/Punch dialog box



Move the slider to adjust the pinch or punch effect. Positive values apply a pinch effect, whereas negative values
apply a punch effect. 



Zig Zag dialog box



Move the slider to adjust the number of distortion waves. 



Move the slider to set the intensity of the distortion.



Move the slider to the right to make the distortion waves phase out toward the edges of your image. Move the 
slider to the left to make the waves extend toward the edges. 



Click to use distortion waves that resemble pond ripples.



Click to use distortion waves that extend outward from a central point and phase out toward the edges of your 
image. This creates an effect that looks like the surface of a pond after you've thrown in a small stone.



Click to use distortion waves that extend from the center of your image. This creates an effect that looks like the 
surface of a pond after you've thrown in a large stone. You can control whether the waves phase out toward the 
edges of the image by moving the Damping slider.



Artistic effects flyout menu



Vignette dialog box



Move the slider to adjust the fade rate between the image and the frame. 



Move the slider to adjust the size of the frame. 



Click to use black as the frame color. 



Click to use the paint color as the frame color. 



Click to use white as the frame color. 



Click to use an oval fame. 



Click to use a circular frame. 



Click to create a rectangular frame. 



Click to create a square frame. 



Blur effects flyout menu



Gaussian Blur dialog box



Move the slider to set the intensity of the effect. 



Motion Blur dialog box



Move the slider to determine the intensity of the effect. 



Click the edge of the dial to set the direction of blurring.



Type an angle value in the box to set the direction of blurring.



Click to have the blurring ignore the pixels that fall outside the image.



Click to have the blurring start with the paper color. 



Click to have the blurring start with the colors at the edge of the image.



Color transform flyout menu



Halftone dialog box



Move the slider to adjust the range of the effect. 



Move the slider to set the angle of the cyan color screen. The angle of the screen determines how the color 
mixes with the other screens. You can adjust the screen angles to produce a wider range of colors.



Move the slider to set the angle of the magenta color screen. The angle of the screen determines how the color 
mixes with the other screens. You can adjust the screen angles to produce a wider range of colors.



Move the slider to set the angle of the yellow color screen. The angle of the screen determines how the color 
mixes with the other screens. You can adjust the screen angles to produce a wider range of colors.



Move the slider to set the angle of the black color screen. The angle of the screen determines how the color 
mixes with the other screens. You can adjust the screen angles to produce a wider range of colors.



Psychedelic dialog box



Move the slider to set the intensity of the effect. 



Solarize dialog box



Move the slider to set the intensity of the effect. 



Noise effects flyout menu



Add Noise dialog box



Move the slider to set the intensity of the effect. 



Move the slider to set the density of the noise (random pixels) you are adding. 



Enable this check box to apply randomly colored noise to the image.



Click to apply noise along a Gaussian distribution curve. Most of the colors that are added using this setting will 
resemble the original colors.



Click to apply noise using the Spike method. This produces a thin, light-colored grain.



Click to apply noise using the Uniform method. This results in an overall granular appearance. 



Dust and Scratch dialog box



Move the slider to determine how large a change in value must occur to any pixel before the effect is applied.



Move the slider to set the range of the effect. Move the slider to the right to increase the number of pixels that 
are successively selected and evaluated when you apply the effect.



Remove Noise dialog box



Move the slider to set the brightness level at which pixels are considered noise. 



Enable this check box to have Corel WEB.PhotoPaint automatically calculate the noise reduction level that is 
required to improve image quality.



Render effects flyout menu



Lens Flare dialog box



Click to create a lens flare effect that mimics focal lengths between 50 mm (standard lens, normal perspective) 
and 300 mm (telephoto/zoom lenses, magnified perspective). 



Click to create a lens flare effect that mimics a moderate wide-angle lens.



Click to create a lens flare effect that mimics a moderate telephoto/zoom lens. 



Move the slider to determine the intensity of the light. The effect of the brightness setting varies with different 
lens types. 



Displays how your image would look if you applied the effect with the current settings. Click in the Preview 
window to move the flash to that location.



Displays the color of the flash. To change the color, click the down arrow and click a color on the color picker. To 
choose from a larger selection of colors, click Others, which opens the Select Color dialog box.



Lighting Effects dialog box



Move the slider to set the intensity of the light. Positive values add light; negative values subtract light. 



Click to add a light source.



Click to delete the selected light source from the Preview window. To select a light source, click it in the Preview 
window.



Click to view the light source(s) in the Preview window. 



Lists all available preset lighting styles. Match different preset light styles with preset light types to find the 
lighting effect you need. To use another light style, click the down arrow and choose a style from the list. 



Click to open the Add/Modify Light dialog box, which allows you to save your settings as a preset lighting style. 



Click to open the Remove Light Type dialog box, which allows you to delete the current lighting style from the 
Styles list box. 



Lists all available light types. Match different preset light types with preset light styles to find the lighting effect 
you need. To use another light type, click the down arrow and choose a type from the list.



Displays the color of the light(s). To change the color, click the down arrow and click a color on the color picker. 
To choose from a larger selection of colors, click Others, which opens the Select Color dialog box. 



Move the slider to adjust the brightness of the light(s).



Move the slider to adjust the elevation of the light(s). This affects the scope of the light.



Move the slider to adjust light aperture settings. A low aperture setting produces a narrow, more intense point of 
light (like a flashlight). A higher aperture setting produces a wide, diffused ray of light that illuminates a much 
larger area (like a ceiling lamp). The range is from 1 to 180 degrees. 



Move the slider to adjust the amount of fading at the edge of the light shaft. A lower value provides a softer 
transition between lit and unlit areas.



Move the slider to adjust the amount of white the light sources contain. 



Type the horizontal coordinate for the position of the light source. You can also move the light source by dragging
it in the Preview window. 



Type the vertical corrdinate for the position of the light source. You can also move the light source by clicking and
dragging it in the Preview window. 



Move the slider to change the direction in which the light is shining. You can also change the direction by clicking
and dragging the light source in the Preview window. 



Move the slider to control the length of the light source. A longer light source results in more diffused light. You 
can also adjust the length of the light source by clicking and dragging the smaller of its two circles. 



Displays the channel in which you are creating a texture. To work in another channel, click the down arrow and 
choose a channel from the list. If you don't want to use a texture, choose None.



Move the slider to adjust the amount of texture on the surface of your image. A higher value results in more 
raised surfaces for the light to bounce off of. 



Move the slider to adjust the contrast of the texture. A setting of 0 uses all 256 grayscale values, whereas a 
setting of 100 uses just the values 0 and 255 (black and white).



Add/Modify Light db



Type a name for the new light type. Click OK to add it to the Light Style list in the Lighting Effects dialog box. 



Sharpen effects flyout menu



Sharpen dialog box



Move the slider to determine the amount of edge sharpening. 



Move the slider to determine how great a change in value must occur to any pixel before the effect is applied. 



Fancy Effects flyout menu



Alchemy dialog box



Displays the selected preset style. Each style is a unique combination of different settings, which you can use as 
is or customize using the controls in the dialog box. To use another style, click the down arrow and choose a style
from the list. 



Click to open the Save As dialog box, which allows you to save a customized style and add it to the Style list box.



Saves the current style. If you haven't previously saved the style, the Save As dialog box opens, which allows 
you to assign a name to the style.



Click to delete the current custom style from the Style list box. You can't delete the preset styles that come with 
Corel WEB.PhotoPaint.



Displays how your image would look if you applied the effect. 



Brush tab (alchemy db)



Displays six different brush types. Click the brush type you want to use.



Displays the current brush shape.



Click to open the Load Brush dialog box, which allows you to load a brush type. Corel WEB.PhotoPaint comes with
many preset brushes, and you can load any grayscale .BMP file as a brush. The grayscale .BMP works like a 
mask: white sections are affected by change, black sections are protected from change, and gray areas are 
affected in varying degrees according to their brightness values. 



Click to set the seed value randomly. The Alchemy filter uses the seed value as the basis for its calculations for 
applying brushstrokes. Use the Randomize button when you are mostly satisfied with the effect but would like to 
change the application of the brushstrokes. For example, if the brushstrokes are smearing a face, randomizing 
the seed value will place the brushstrokes at different locations and correct the problem.



Displays the current seed value, which the Alchemy filter uses as the basis for its calculations for applying 
brushstrokes. Click the Randomize button to set the seed value randomly. 



Move the slider to control the amount of horizontal variation in the brushstrokes. 



Move the slider to control the amount of vertical variation in the brushstrokes. 



Move the slider to control the density of the brushstrokes. 



Click to apply the brushstrokes without a specific or repeating pattern. 



Click to apply the brushstrokes so that they overlap brushstrokes that are below and to the right. Most of the top 
and left sides of the brushstrokes won't be visible. 



Click to apply the brushstrokes so that the brightest portion of the stroke is always visible. 



Click to return all controls in this dialog box to their default settings.



Color tab (alchemy db)



Click to base each brushstroke on the color of the pixel that falls in the center of the brushstroke. 



Click to base all brushstrokes on the color displayed below.



Displays the current brush color. To use a different color, click the down arrow and click a color on the color 
picker. Click Others to open the Select Color dialog box. 



Click to apply the brushstrokes to your image.



Click to apply the brushstrokes to a solid colored background. 



Displays the current background color. To use a different color, click the down arrow and click a color on the color
picker. Click Others to open the Select Color dialog box. 



Move the slider to control the amount of hue variation each brushstroke contains. 



Move the slider to control the amount of saturation variation each brushstroke contains. 



Move the slider to control the amount of brightness variation each brushstroke contains. 



Size tab (alchemy db)



The function of this slider changes depending on the pattern you have chosen in the Vary Brush Size list box. 
· Size: Move the slider to adjust the size of the brushstrokes. 
· Center: Move the slider to adjust the size of the brushstrokes toward the center of the radial pattern.
· Top: Move the slider to adjust the size of the brushstrokes along the top of the vertical plane.
· Left: Move the slider to adjust the size of the brushstrokes along the left side of the horizontal plane.
· Warm: Move the slider to adjust the size of the warm brushstrokes.
· Unsaturated: Move the slider to adjust the size of the unsaturated brushstrokes.
· Dark: Move the slider to adjust the size of the dark brushstrokes.



The function of this slider changes depending on the pattern you have chosen in the Vary Brush Size list box. 
· Edge: Move the slider to adjust the size of the brushstrokes around the edges of the radial pattern.
· Bottom: Move the slider to adjust the size of the brushstrokes along the bottom of the vertical plane.
· Right: Move the slider to adjust the size of the brushstrokes along the right side of the horizontal plane. 
· Cool: Move the slider to adjust the size of the cool brushstrokes. 
· Saturated: Move the slider to adjust the size of the saturated brushstrokes. 
· Bright: Move the slider to adjust the size of the dark brushstrokes. 



Move the slider to adjust the amount of variation in the size of the brushstrokes. 



Opens the Center dialog box, which allows you to select a center point if you have chosen By Radial Distance as 
the Vary Brush Size setting. The center point determines the point at which the brushstrokes change in size. 
Click the location you want to use as the center point.



Displays the current pattern that is being used to vary the size of the brushstrokes. To use another pattern, click 
the down arrow and choose a pattern from the list. The Adjust sliders change to reflect the pattern you choose.



Angle tab (alchemy db)



The function of this slider changes depending on the pattern you have chosen in the Vary Brush Angle list box. 
· Angle: Move the slider to adjust the angle of the brushstrokes. 
· Center: Move the slider to adjust the angle of the brushstrokes toward the center of the radial pattern.
· Top: Move the slider to adjust the angle of the brushstrokes along the top of the vertical plane.
· Left: Move the slider to adjust the angle of the brushstrokes along the left side of the horizontal plane.
· Warm: Move the slider to adjust the angle of the warm brushstrokes.
· Unsaturated: Move the slider to adjust the angle of the unsaturated brushstrokes.
· Dark: Move the slider to adjust the angle of the dark brushstrokes.



The function of this slider changes depending on the pattern you have chosen in the Vary Brush Angle list box. 
· Edge: Move the slider to adjust the angle of the brushstrokes around the edges of the radial pattern.
· Bottom: Move the slider to adjust the angle of the brushstrokes along the bottom of the vertical plane.
· Right: Move the slider to adjust the angle of the brushstrokes along the right side of the horizontal plane. 
· Cool: Move the slider to adjust the angle of the cool brushstrokes. 
· Saturated: Move the slider to adjust the angle of the saturated brushstrokes. 
· Bright: Move the slider to adjust the angle of the dark brushstrokes. 



Move the slider to adjust the amount of variation in the angle of the brushstrokes. 



Displays the current pattern that is being used to vary the angle of the brushstrokes. To use another pattern, 
click the down arrow and choose a pattern from the list. The Adjust sliders change to reflect the pattern you 
choose.



Opens the Center dialog box, which allows you to select a center point if you have chosen By Radial Distance as 
the Vary Brush Angle setting. Click the location you want to use as the center point.



Transparency tab (alchemy db)



The function of this slider changes depending on the pattern you have chosen in the Vary Brush Transparency list
box. 
· Angle: Move the slider to adjust the transparency of the brushstrokes. 
· Center: Move the slider to adjust the transparency of the brushstrokes toward the center of the radial pattern.
· Top: Move the slider to adjust the transparency of the brushstrokes along the top of the vertical plane.
· Left: Move the slider to adjust the transparency of the brushstrokes along the left side of the horizontal plane.
· Warm: Move the slider to adjust the transparency of the warm brushstrokes.
· Unsaturated: Move the slider to adjust the transparency of the unsaturated brushstrokes.
· Dark: Move the slider to adjust the transparency of the dark brushstrokes.



The function of this slider changes depending on the pattern you have chosen in the Vary Brush Transparency list
box. 
· Edge: Move the slider to adjust the transparency of the brushstrokes around the edges of the radial pattern.
· Bottom: Move the slider to adjust the transparency of the brushstrokes along the bottom of the vertical plane.
· Right: Move the slider to adjust the transparency of the brushstrokes along the right side of the horizontal 

plane. 
· Cool: Move the slider to adjust the transparency of the cool brushstrokes. 
· Saturated: Move the slider to adjust the transparency of the saturated brushstrokes. 
· Bright: Move the slider to adjust the transparency of the dark brushstrokes. 



Move the slider to adjust the amount of variation in the transparency of the brushstrokes. 



Displays the current pattern that is being used to vary the transparency of the brushstrokes. To use another 
pattern, click the down arrow and choose a pattern from the list. The Adjust sliders change to reflect the pattern 
you choose.



Opens the Center dialog box, which allows you to select a center point if you have chosen By Radial Distance as 
the Vary Brush Transparency setting. The center point determines the point at which the brushstrokes change in 
size. Click the location you want to use as the center point.



Center dialog box (accessed from Alchemy db)



Displays the location of the center point. To move the center point, click the location you want to use as the 
center point. 



Indicates the distance in pixels of the center point from the left edge of your image.



Indicates the distance in pixels of the center point from the top edge of your image.



Terrazzo dialog box



Displays the source image and the area that is used to create the kaleidoscopic pattern. To use a different area 
of the image, drag the enclosed area to its new location. To resize the enclosed area, drag the node on its corner.



Displays how your image would look if you applied the Terrazzo effect using the current settings. 



Click to open the Symmetry dialog box, which contains all the patterns you can use to create a kaleidoscopic 
pattern from your image. 



Displays how the base tile would look if you applied the current settings. 



Displays the filename of the image you are using to create the kaleidoscopic pattern. To use another image, click
the down arrow and choose New Image. You can then load any image to use as the source image. 



Displays the current merge mode, which determines the way the effect is combined with the pixels that already 
exist in your image. To use another merge mode, click the down arrow and choose a mode from the list.



Move the slider to adjust the fade rate between tiles. At a setting of 0, the boundaries between tiles are stark. At 
a setting of 100, the tiles fade into each other. 



Enable this check box to view the feather boundary in the Original window. The feather boundary indicates the 
area over which one tile fades into the next. 



Move the slider to adjust the opacity of the effect. 



Enable this check box if you want the Result window to reflect changes as you make them. Disable to update the
Result window each time you release the mouse button. 



Click to open the Save Tile dialog box, which allows you to save the tile for use as a pattern or canvas.



Symmetry dialog box (accessed from Terrazzo)



Displays the different symmetry patterns you can use as the basis of your kaleidoscopic pattern. Click one to 
select it. 





FILE MENU CONTEXT-SENSITIVE HELP (PHOTO-PAINT)



Opens the Create a New Image dialog box, where you can select the initial settings for your new image. 



Opens the Open An Image dialog box, where you can select an existing file to open or import. 



Opens the Partial Area dialog box, which allows you to select a section of your image to open. Work on your 
image in sections if your image is particularly large, or has a high resolution. This reduces the amount of data 
your system has to process at a time. 



Closes the active image. If you have more than one image open, you must close each image separately. 



Saves the active image. If you have never saved the image before, the Save As dialog box opens.



Opens the Save As dialog box, which lets you specify the name, location, and file format of the image. Use this 
command to save an image for the first time, or to change the name, location or file format of an existing image.



Lets you save an open section of an image as a new image. 



Reverts to the last saved version of the image. Use this command when you want to undo all the changes you 
have made since you last saved the image.



Opens the Select Source dialog box, which allows you to choose a TWAIN image input source. The sources that 
appear depend on the scanner driver(s) you have installed on your system. 



Lets you access and control external input devices, such as scanners or video capture boards, from within Corel 
WEB.PhotoPaint.



Opens an image and simultaneously applies color correction to it. The color correction method is based on the 
scanner you selected while setting up device profiles in the Color Manager. See the Color Manager online help for
more details on calibrating your system and selecting the right color correction method.



Launches CorelSCAN which is an application that guides you through the process of creating quality scanned 
images. The image you scan or acquire from an existing file using CorelSCAN will be acquired and displayed in 
the Corel application from which you launched CorelSCAN. You can also use CorelSCAN as a standalone 
application.



 Launches any plug-in export filters you have added.



Allows you to send images to other users through Microsoft Exchange.



Allows you to open the four most recently opened files without having to access the Open dialog box.



Closes PHOTO-PAINT. If you have made changes to any open images since the last time you saved, you are 
prompted to save. 



Closes PHOTO-PAINT. If you have made changes to any open images since the last time you saved, you are 
prompted to save. 



Publishes your image to WEB.DESIGNER, if you launched WEB.PhotoPaint from within WEB.DESIGNER. 



Create A New Image dialog box



Displays the color mode of your new image. Click the down arrow to display a list of available color modes. The 
number of bits a color mode uses dictates both the system resources it requires, as well as the number of colors 
or shades it is capable of producing.
· Choose Black and White (1-bit) to create line art and black-and-white images. 
· Choose Grayscale (8-bit) to create grayscale or duotone images.
· Choose Paletted (8-bit) to create non-photographic images (256 colors), or when creating images for the World

Wide Web. 
· Choose RGB Color (24-bit) to create professional-quality photographic color images. 



Displays the numeric values of the paper color. The components depend on the color mode you are using. For 
example, RGB colors are broken down into their red, green and blue components. 



Displays the paper color. To select a different paper color, click the down arrow, and click a color from the color 
picker. If the color you want is not displayed, click Others to open the Select Color dialog box.



Displays the image's width.



Displays the image's height.



Displays the image's width. To change the width, type in a new value or use the scroll arrows to adjust the 
existing value. 



Displays the image's height. To change the height, type in a new value or use the scroll arrows to adjust the 
existing value. 



Displays the available measurement units. The image width and height values correspond to the measurement 
units that you select. 



Displays five preset image sizes as well as an option for creating your own custom image size. 



Click to change the page orientation to portrait.



Click to change the page orientation to landscape.



An image’s resolution determines how much detail the image contains, and is measured by the number of pixels,
or dots, it contains per inch (dpi). A high resolution allows for more detail and smoother color transitions than a 
low resolution, but also results in a much larger file size. Setting the resolution is a balancing act between 
achieving the level of detail you need, while keeping the file size down to a level that your system can handle. 
Generally, you should use 96 dpi if you are creating Web graphics, and twice the line screen of the printer for 
images you are going to print. 



Displays the horizontal resolution of the image. To change the resolution, type in new values or adjust the 
existing values using the scroll arrows. 



Displays the vertical resolution of the image. To change the resolution, type in new values or adjust the existing 
values using the scroll arrows. 



Displays the horizontal resolution of the image in dots per inch (dpi).



Displays the vertical resolution of the image in dots per inch (dpi).



Enable if you want to keep the horizontal and vertical resolution values of the image identical. Disable if you 
want to type in different, independent values.



Enable to create the new file in portions. The Partial Area dialog box opens to let you choose which area of the 
image to open initially. 



Displays the size of the image.



Displays the memory required to create the image.



Displays the system memory currently available. 



Enable to create a movie. When this option is enabled, you can type in the number of frames you want in the 
movie. 



Type in the number of frames you want to include in the movie, from 1 to 1000. This option becomes available 
once you enable the Create A Movie check box. 



PARTIAL AREA DIALOG BOX



Displays the currently selected grid. Click the down arrow to display a list of available preset grids. 
· 2 x 2

Two rows, two columns.
· 3 x 3

Three rows, three columns.
· 4 x 4

Four rows, four columns.
· 8 x 8

Eight rows, eight columns.
· Custom

Choose Custom to define your own grid. Click and drag the nodes to resize the panels, or move a panel by 
clicking and dragging it.



Lets you edit the current grid. You can create a custom grid by choosing Custom Grid in the Grid Size box, or by 
enabling the Edit Grid check box. Click and drag the nodes to resize the panels, or move a panel by clicking and 
dragging it.



Displays the image that you want to load divided into the panels of a grid. The flashing area is the area that is 
currently selected to open. Click to select a different area. 



Displays the filename and extension.



Displays the size of the selected portion of the image in bytes.



PARTIAL LOAD MOVIE DIALOG BOX



Resets the range of frames to include all frames.



Moves to the first frame of the movie.



Moves back one frame at a time.



Click and drag to cycle through the frames of the movie.



Moves forward one frame at a time.



Moves to the last frame of the movie. 



Type in the number of the first frame you want to open. 



Type in the number of the last frame you want to open.



Click to play the movie in the Preview window. 



Enable to play only the selected range of frames in the Preview window.



Displays the selected frame of the movie.



Indicates which frame of the movie is displayed in the Preview window.



Stops the movie from playing in the Preview window.



EPS Export dialog box



Enable to save a thumbnail representation of the image. This thumbnail is used to show you a preview of the 
image in various dialog boxes when you are opening the image in Corel WEB.PhotoPaint or in another 
application.



Choose the file format to use for the thumbnail of the image you are saving along with the image. The thumbnail
can be .TIF or .WMF file. When you choose .TIF, you can also choose the thumbnail’s color depth.



Choose a color depth option. This is only available when you select .TIF as the file format for the thumbnail 
representation of your image. The option you choose sets the number of colors that can be used to create the 
thumbnail. Keep in mind that the more colors you use, the larger the .EPS file will be.



Choose the resolution for the thumbnail representation of your image you are creating as you save the image to 
the .EPS format.



When enabled, only the section of the current image that is enclosed by either a path or a mask marquee 
displays or prints when you use the .EPS file in another application. The sections of the image that are outside 
the path or mask marquee are not deleted but simply hidden when you use the file in the other application. To 
see the entire image again, open the .EPS file in Corel WEB.PhotoPaint. To actually crop the image file to only 
save the section enclosed by the path or the mask marquee, enable the Crop Image To Path/Mask When Saving 
option at the bottom of this dialog box.



When enabled, saves the contents of the mask marquee on the image in the .EPS file. The program converts the 
mask to a path before saving, so the process may take some time, depending on how complicated the mask is. 
The sections of the image that are outside the mask marquee are still in the image but will not be visible, nor will
they print, when you use the .EPS file in another application. You can still see those sections if you open the 
image in Corel WEB.PhotoPaint. To delete the sections that are outside the mask marquee, enable the Crop 
Image To Path/Mask When Saving option at the bottom of this dialog box.



When enabled, saves the contents of either the active path or one of the paths listed in the box below. If the 
path is not closed, the program automatically closes it before saving the contents. The sections of the image that
are outside the path are still in the image but will not be visible, nor will they print, when you use the .EPS file in 
another application. You can still see those sections if you open the image in Corel WEB.PhotoPaint. To delete the
sections that are outside the path, enable the Crop Image To Path/Mask When Saving option at the bottom of this
dialog box.



Provides a list of paths to clip the image to. Any path you saved previously using the Path node Edit Tool Settings
Roll-Up or Property Bar appears in this list, as well as the active path called the Workpath.



Crop Image To Path/Mask When Saving
Enable to permanently remove the sections of the image that are outside the mask marquee or path. When you 
do so, those sections are not saved in the .EPS file.



OPEN AN IMAGE DIALOG BOX (CDRFLT)



CROP IMAGE DIALOG BOX (CDRFLT)



RESAMPLE IMAGE DIALOG BOX (CDRFLT)



SAVE AN IMAGE TO DISK DIALOG BOX (CDRFLT)



SELECT SOURCE DIALOG BOX (TWAIN)



ACQUIRE DIALOG BOX (TWAIN)



ACQUIRE FROM FILE DIALOG BOX (TWAIN)



CHOOSE PROFILE DIALOG BOX (MS Exchange)



PRINT DIALOG BOX (CDRGFX)



Save Map File dialog box



Type a filename for the .HTM file if you are creating a client-side or client/server-side image map, or for the .MAP 
file if you are creating a server-side image map.



Choose a map file type from the list. 
Client-side image maps do not depend on a server to process the map information, but the browser used by 
people wanting to see your Web page must support map display which is not always the case. 
Server-side image maps do not depend on any browser to process the map information, but the server must be 
able to recognize the code in the map file. NCSA and CERN use different codes, so you do need to know whether 
the server you are using runs CERN or NCSA. Contact your server administrator to find this information.
Client/Server-side map files offer the best of both worlds and create the files needed for both the client and 
server sides.



Enable the check box and type a name for the map that will include the mapping coordinates. When creating a 
client-side image map, the mapping coordinates are stored directly in the HTML page. When creating a server-
side image map, they are stored in a .MAP file. For client/server-side image maps, they are stored in both an 
HTML page and in a .MAP file. 
The name you type here will be used by the .MAP file if you are creating a client/server image map. The .MAP file
for server-side image maps will be the same as the .HTM filename you typed in the File Name box at the top of 
this dialog box.



Type the Universal Resource Locator (URL) address of the World Wide Web page that should be accessed when 
any part of the image that has not been defined as a clickable area is clicked.



Enable to include image information in the .HTM file. You choose the information you want to include in the 
bottom section of this dialog box. The information is used for maintenance purposes and is not visible on your 
Web page; it is embedded in the HTML code.



Type the name of the author of the file. This information is saved in the .HTM and .MAP files when you enable the
Include File Header check box.



Type a description of the image file. This information is saved in the .HTM and .MAP files when you enable the 
Include File Header check box.



When creating a server-side or client/server-side image map, type the server information in this box. Server 
information includes the location of the Common Gateway Interface (.CGI) on the server, i.e., the program that 
responds to the image map, and its name, the directory where your map file is stored and its file name. Contact 
your server provider to find this information. 



Enable to include the name and type of the image file used to create map file.



Enable to include the date that the image map was created in the .HTM file’s code.



Enable to include the image map type in the .HTM file’s code.





 HELP MENU



Displays the Corel WEB.PhotoPaint Help Contents. From anywhere in the online Help, clicking the Contents 
button returns you to the contents screen.



Changes the mouse pointer to a question mark. You can click any command or screen area to display the related 
context-sensitive Help.



Interactively guides you through each step of various tasks that can be performed in Corel applications; choose 
the task to complete from the Tutors list.



Displays a dialog box with information about the version of Corel WEB.PhotoPaint that you are running. The 
System Information button displays the System Information dialog box, which has information about your 
system, display, network, printer, Corel EXEs and DLLs, and system DLLs. 



Opens the Technical Support online Help that provides details about product support for Corel applications, 
including support services, import and export filters information, error messages, and troubleshooting tips.



If you have an Internet Browser installed and set up on your system, click this command to access Corel 
Corporation’s World Wide Web site.





Context-sensitive help for Image menu



Opens the Adjust flyout, which contains a number of filters that allow you to adjust the colors and tonal range of 
your image.



Opens the Brightness-Contrast-Intensity dialog box, which allows you to lighten or darken your image, and to 
adjust the distinction between light and dark areas. 



Opens the Color Balance dialog box, which allows you to adjust the mixture of colors in your image. For example,
in an RGB image, you can increase or decrease the amount of red, green, or blue tones. 



Opens the Gamma dialog box, which allows you to adjust the midtones in your image without affecting the 
shadows or highlights. 



Opens the Gamma dialog box, which allows you to adjust the midtones in your image without affecting the 
shadows or highlights. 



The Hue/Saturation/Lightness command allows you to adjust the hue, saturation, and lightness values of the 
colors in your image. 



Opens the Replace Colors dialog box, which allows you to select specific colors from your image and replace 
them.



Reduces the saturation of each color in your image to 0, which converts each color to its grayscale equivalent. 
This allows you to make your image appear as grayscale without converting its color mode. 



Opens the Color Hue Control dialog box, which allows you to adjust manually the levels of red, green, blue, cyan, 
magenta, and yellow in your image.



Opens the Transform flyout, which offers a number of ways of correcting and transforming the colors in your 
image. 



Opens the Deinterlace dialog box, which allows you to smooth video images by removing the odd or even scan 
lines and filling them in with detail taken from the rest of the image.



Inverts the colors in your image. Use this command to turn an image into a negative. 



Opens the Posterize dialog box, which allows you to reduce the number of tonal values and to map all existing 
colors to the closest match. This process simplifies the image by removing tonal gradations and creating larger 
areas of flat color.



Opens the Threshold dialog box, which allows you to set a specific brightness value as a threshold. All pixels that
fall below this threshold will become black; all pixels above the threshold won’t be affected. You can set an 
image-wide threshold, or you can set a threshold in a specific color channel. 



Opens the Resample dialog box, which allows you to modify the size or resolution of your image.



Opens the Paper Size dialog box, which allows you to adjust the color and size of the paper (background) behind 
your image. This allows you to alter the printed dimensions of your image without changing its resolution. 



Opens the Duplicate Image dialog box, which allows you to duplicate the active image. The duplicate image 
opens in its own window.



Flips the image horizontally.



Flips the image vertically.



Rotates the image 90° clockwise.



Rotates the image 90° counter-clockwise.



Rotates the image 180°.



Opens the Custom Rotate dialog box, which allows you to select the angle and direction of rotation.



Opens the Convert to BW dialog box, which allows you to convert your image to a 1-bit black-and-white image 
using any of four conversion methods: Line Art, Ordered, Error Diffusion, or Halftone. 



Converts the image to an 8-bit grayscale image. 



Opens the Duotone dialog box, which allows you to convert a grayscale image into a monotone (one ink), 
duotone (two ink), tritone (three ink), or quadtone (four ink) image. 



Opens the Convert To Paletted Image dialog box, which allows you to convert your image to 8-bit paletted color. 



Converts the image to 24-bit RGB color. 



Opens the Color Table dialog box, which displays each color of a 16 or 256 color image. Use this dialog box to 
add, edit, and save individual colors or blocks of colors.



Opens the Crop flyout, from which you can select a method of cropping your image.



Crops the image around the mask marquee. 



Opens the Crop Border Color dialog box, which allows you to crop the border color from an image according to 
color tolerance levels you set. 



Positions skewed or imperfectly positioned images squarely onscreen. 



Enable to preserve the background when you work with objects and masks. Disable this option when you want to
remove the object or selection from your image.



Opens the Image Info dialog box, which shows you the image’s size, resolution, file format, type of compression, 
color mode, and whether it has been changed since you opened it.



Brightness-Contrast-Intensity dialog box (Adjust 
flyout menu)



Move the slider or type a value in the box to adjust the brightness values of the pixels in your image. This control
shifts all pixel values up or down the tonal range, lightening or darkening all colors equally. 



Move the slider or type a value in the box to adjust the contrast in your image. Adjusting the contrast increases 
or decreases the difference between the lightest and darkest pixels in your image. 



Move the slider or type a value in the box to adjust the intensity of your image. Increasing the intensity brightens
the lighter areas of your image without washing out the dark areas. Contrast and intensity usually go hand-in-
hand, because an increase in contrast sometimes washes out detail in shadows and highlights, and an increase 
in intensity can bring it back.



Color Balance dialog box (Adjust flyout menu)



Move the slider to shift the balance of cyan and red in your image. 



Move the slider to shift the balance of magenta and green in your image.



Move the slider to shift the balance of yellow and blue in your image. 



Enable this check box if you want the changes applied to the darkest pixels in your image. 



Enable this check box if you want the changes applied to the midtones in your image. 



Enable this check box if you want the changes applied to the lightest pixels in the image. 



Enable to maintain the brightness values of your image. If you leave this check box unchecked, the overall 
lightness or darkness of your image may be affected by color correction.



Gamma dialog box (Adjust flyout menu)



Move the slider or type a value in the box to set the gamma curve value. Adjusting the gamma curve value 
allows you to pick up detail in a low contrast image without significantly affecting the shadows or highlights. This
adjustment does affect all the values in your image, but because it is curve-based, the changes are weighted 
toward the midtones.



Hue/Saturation/Lightness dialog box (Adjust 
flyout menu)



Move the slider or type a value to shift the hues along the color wheel. Hue is the most basic of color 
components in that it is what makes red red, blue blue, etc. Compare the Original Color and New Color 
spectrums to see how the changes will affect your image's colors.



Move the slider or type a value in the box to shift the saturation of all colors in your image. Saturation refers to 
the purity of your colors. Fully saturated colors contain no black, whereas fully desaturated colors appear as their
grayscale equivalents. Compare the Original Color and New Color spectrums to see how the changes will affect 
the colors in your image.



Move the slider or type a value to shift the lightness of all colors in your image. Lightness refers to the amount of
black or white your colors contain. Compare the Original Color and New Color spectrums to see how the changes 
will affect the colors in your image.



Displays the original colors in your image. Compare with the New Color spectrum to see how the changes will 
affect the colors in your image. 



Displays the adjusted color spectrum. Compare with the Original Color spectrum to see how the changes will 
affect the colors in your image. 



Replace Colors dialog box (Adjust flyout menu)



Displays the areas of your image that are affected by the color replacement. White areas are fully affected, gray 
areas are partially affected, and black areas are unaffected. To adjust the tolerance, move the Range slider.



Displays the color you want to replace in the image. Use the Eyedropper tool to sample a specific color from the 
image, or click the down arrow and click a color on the color picker. For a larger selection of colors, click Others 
and choose a color from the Color dialog box.



Displays the color you want to use as a replacement. Click the down arrow and click a color on the color picker. 
For a larger selection of colors, click Others and choose a color from the Color dialog box. Move the Hue, 
Saturation, and Lightness sliders to fine-tune this color. 



Move the slider to control the hue of the replacement color. Hue is the main attribute in a color that distinguishes
it from other colors. Blue, green, and yellow, for example, are all hues. 



Move the slider to shift the saturation of all colors in your image. Saturation refers to the purity of your colors. 
Fully saturated colors contain no black, whereas fully desaturated colors appear as their grayscale equivalents. 
Compare the Original Color and New Color spectrums to see how the changes will affect your image's colors.



Move the slider to control the lightness of the replacement color. Lightness refers to the amount of black or white
in a color.



Move the slider to increase or decrease the range of colors that is replaced in your image. 



Posterize dialog box (Transform flyout menu)



Move the control the intensity of the posterization. Posterization simplifies the gradations of color in your image. 



Threshold dialog box (Transform flyout menu)



Displays the current low-level value. To adjust the value, type a value in the box, or drag the pointer that is 
below the histogram.



A histogram that plots the brightness value of every pixel in your image. Values range from 0 to 255, and the 
histogram indicates how many pixels are at each brightness level. The pointers beneath indicate the low-level, 
threshold, and high level values.



Displays the current threshold value. To adjust the value, type a value in the box, or drag the pointer that is 
below the histogram.



Displays the current high-level value. To adjust the value, type a value in the box, or drag the pointer that is 
below the histogram.



Move the pointers to adjust the low-level, high-level, and threshold values. 



Click to have all the values that fall below the threshold map either to black (the default) or to the low-level 
value you set.



Click to have all the values that fall above the threshold map either to white (the default) or to the high-level 
value you set. 



Click to convert your image to black and white. The values that fall below the threshold level map to the low 
level value, and the values that fall above the threshold level map to the high level value. If you do not set low 
and high levels, the defaults are 0 (black) and 255 (white).



Displays the channel in which you are working. Click the down arrow to select a different channel. You can edit 
each channel separately, or you can edit them simultaneously in the composite channel. 



Displays the current clipping percentage; that is, the percentage of the most extreme brightness values Corel 
WEB.PhotoPaint will ignore when identifying the lightest and darkest values in the histogram. To change the 
percentage, type a value or adjust the current value using the scroll arrows. This option is only available if you 
have disabled the Automatic check box.



Enable this check box to have Corel WEB.PhotoPaint automatically clip the outlying brightness values in your 
image; that is, to ignore a percentage of the most extreme brightness values when identifying the lightest and 
darkest pixels in the histogram. Disable this check box if you want to set the clipping percentage yourself. 



Resample dialog box



Displays the width of your image using the unit of measurement selected in the units box. You can adjust the 
width using either of two methods: you can either type a value in the box or use the scroll arrows to adjust the 
current value, or you can type a value in the Percentage box. No matter which method you use, the change is 
reflected in both boxes.



Displays the height of your image using the unit of measurement selected in the units box. You can adjust the 
height using either of two methods: you can either type a value in the box or use the scroll arrows to adjust the 
current value, or you can type a value in the Percentage box. No matter which method you use, the change is 
reflected in both boxes.



Displays the image's current width.



Displays the image's current height.



Displays the new width of your image as a percentage of the original image width. To adjust the width, type a 
value in the box or adjust the existing value using the scroll arrows. 



Displays the new height of your image as a percentage of the original image height. To adjust the width, type a 
value in the box or adjust the existing value using the scroll arrows.



Displays the unit of measurement used to calculate image height and width.



Displays the unit of measurement used to calculate image size. Click the down arrow to display a list of the 
available units. 



Displays the unit of measurement used to calculate image size. Click the down arrow to display a list of the 
available units. 



Displays the horizontal resolution of the image in pixels, or dots per inch (dpi). To change the resolution, type a 
value in the box, or use the scroll arrows to adjust the existing value. Ensure the Maintain Aspect Ratio control is 
enabled if you want to force the horizontal and vertical resolutions to be identical.



Displays the vertical resolution of the image in pixels, or dots per inch (dpi). To change the resolution, type a 
value in the box, or use the scroll arrows to adjust the existing value. Ensure the Maintain Aspect Ratio control is 
enabled if you want to force the horizontal and vertical resolutions to be identical.



Displays the original horizontal resolution of the image in pixels, or dots per inch (dpi).



Displays the original vertical resolution of the image in pixels, or dots per inch (dpi).



Displays the unit of measurement used to determine the image's horizontal resolution. 



Displays the unit of measurement used to determine the image's vertical resolution.



Click an option to determine the process used to resample the image. When you increase the resolution of an 
image, Corel WEB.PhotoPaint must add pixels that weren't originally in the image. If you select the Anti-Alias 
option, Corel WEB.PhotoPaint averages the adjacent pixels and creates new pixels based on these average 
values. This takes longer, but provides better results than Stretch/Truncate, which simply duplicates neighboring 
pixels to fill in the gaps. 



Enable this control to maintain current image proportions, both in dimension and resolution. When you type a 
value in one box, the value in the other box will adjust automatically.



Maintains the original file size of the image; that is, the amount of space it takes up on your hard drive. Changing
the resolution without changing the image dimensions will affect the image size. 



Displays the original file size of the image in bytes.



Displays the size (in bytes) the file will be after resampling.



Click to reset all values in this dialog box to the default settings. 



Paper Size dialog box



Displays the width of the paper using the unit of measurement selected in the units box. To adjust the paper 
width, type a value in the box or use the scroll arrows to adjust the existing value.



Displays the height of the paper using the unit of measurement selected in the units box. To adjust the paper 
height, type a value in the box or use the scroll arrows to adjust the existing value.



Displays the unit of measurement used to calculate paper height and width. Click the down arrow to display a list
of the available units. 



Displays the unit of measurement used to calculate image height and width.



Enable this control to maintain the current proportions. When you type a value in one box, the value in the other 
box adjusts automatically.



Displays the current position of the image on the paper. You can change the position of the image in two ways: 
you can either drag it in the Preview window or you can click the down arrow and select a preset placement from
the list.



Displays the current position of the image on the paper. You can change the position of the image in two ways: 
you can either drag it in the Preview window or you can click the down arrow and select a preset placement from
the list.



Displays the original paper width using the unit of measurement selected in the units box.



Displays the original paper height using the unit of measurement selected in the units box.



Duplicate Image dialog box



Displays the name and location of the original file. This is the file that will be duplicated.



Type a filename and path for the duplicate image in the As box, or click OK to accept the default filename.



Enable to merge all objects with the background in the duplicate image. Disable to duplicate the image without 
merging all objects.



Custom Rotate dialog box (Rotate flyout menu)



Displays the angle of rotation. To adjust the rotation angle, type a value in the box, or use the scroll arrows to 
adjust the existing value. 



Click to rotate the image clockwise. 



Click to rotate the image counter-clockwise.



Enable this control to rotate the image without changing its size. Otherwise, the image is resized so that all of 
the image is visible in the Image Window.



Enable this control to prevent jagged edges from appearing around the edges of your image after it is rotated.



Convert To flyout menu



Convert to black and white db



Click to convert the image to black and white line art. 



Displays the selected threshold value. All color values in your image that fall below the threshold will map to 
black, and all values that fall above the threshold will map to white. To adjust the threshold, type a value in the 
box, or adjust the existing value using the scroll arrows. 



Click to produce a black and white image using dots of various sizes. On printers that cannot print dots of 
different sizes, the halftone is produced by printing different numbers of dots in a given area. 



Click to produce an image using just black and white values, but using Ordered dithering to create the illusion of 
varying shades of gray. This option is less expensive in terms of system requirements than the Error Diffusion 
method of dithering. 



Click to produce an image using just black and white values, but using the Error Diffusion method of dithering to 
produce the illusion of varying shades of gray. This method is more expensive in terms of system requirements 
than the Ordered method of dithering.



Displays the selected halftone screen. The halftone is produced by printing different numbers of dots in a given 
area. The halftone screen determines the shape of that given area. 



Controls the line frequency of the halftone screen. 



Controls the screen angle of the halftone screen. 



Displays the selected unit of measurement that is used to calculate the line frequency. Click the down arrow to 
choose a different unit of measurement. 



Duotone dialog



Displays the current image. Enable the Preview check box to preview the image with duotone inks applied to it. 



Enable this check box to preview the image with duotone inks applied. 



The functionality of the Load button depends on which tab of the Duotone dialog box is selected. On the General 
tab, the Load button opens the Load Duotone File dialog box, where you can access duotone (.CPD) files. On the 
Inks tab, the Load button opens the Load Ink File dialog box, where you can access ink (.CIK) files.



The functionality of the Save button depends on which tab of the Duotone dialog box is selected. On the General 
tab, the Save button opens the Save Duotone File dialog box, where you can save the current set of ink curves. 
On the Inks, tab, the Save button opens the Save Ink File dialog box, where you can save the selected ink file.



Displays the dynamic ink curves. The horizontal plane displays the 256 possible shades of gray in a grayscale 
image (0 is black; 255 is white). The vertical plane represents the intensity of an ink (from 1 to 100 per cent) that
is applied to the corresponding grayscale values.



Displays how each ink is applied along the grayscale model. This allows you to visually review the percentage of 
color that is added to each grayscale pixel.



Displays the selected ink mode. Click the down arrow to choose from all available ink modes. 
· A monotone is a grayscale image that is printed with a single ink. The single ink produces all the shadows, 

midtones, and highlights in the image. A monotone is like a conventional grayscale image.
· A duotone is a grayscale image that is printed with two inks, usually a black ink and a colored ink. The black 

ink is applied to shadow areas and the colored ink is applied to midtones and highlight areas. This adds a 
colored tint to the grayscale image.

· A tritone is a grayscale image that is printed with three inks, usually a black ink and two colored inks. 
· A quadtone is a grayscale image that is printed with four inks, usually a black ink and three colored inks.



Displays the selected ink colors. To choose a different color, double-click the ink's name to open the Color dialog 
box. 



Displays how much ink is applied to each point on the ink curve. Position indicates the grayscale value of each 
point, whereas value indicates the percentage of ink that is applied to the pixels at each point. 



Displays how much ink is applied to each point on the ink curve. Position indicates the grayscale value of each 
point, whereas value indicates the percentage of ink that is applied to the pixels at each point. 



Displays the ink colors used in a monotone, duotone, tritone, or quadtone image.



Displays the selected overprint ink colors and how they will appear when printed to a composite printer. To 
choose or create a new color, double-click a color in the list, which opens the Select Color dialog box.



Opens the Select Color dialog box, which allows you to choose or create a new color. You can also access the 
Select Color dialog box by double-clicking a color in the Overprints Inks list.



Resets the selected item in the Overprints Inks list to the settings that were present when you first opened the 
tab.



Displays all variations of the current ink colors.



Enable this check box to view overprint areas onscreen. 



Click to reset the selected ink curve to its default settings. 



Resets all items in the overprints list to the settings that were present when you first opened the tab. 



Convert to paletted image dialog box



Click to disable screen dithering. Dithering enhances the appearance of images that contain more colors than 
your monitor is capable of displaying; however, if your monitor is capable of displaying more than 256 colors, 
there is no need for dithering. 



Click to enable the Error Diffusion method of dithering. Dithering enhances the appearance of images that 
contain more colors than your monitor is capable of displaying. Error Diffusion is more expensive in terms of 
system requirements than the Ordered method.



Click to enable the Ordered method of screen dithering. Dithering enhances the appearance of images that 
contain more colors than your monitor is capable of displaying. Ordered dithering is faster than Error Diffusion, 
and is less expensive in terms of system requirements.



Click to use the uniform Color Palette, which provides a complete 256 color spectrum (equal quantities of red, 
green, and blue), regardless of whether they are used in the image. 



Click to use an optimized Color Palette, which contains colors that are based on the colors of all visible objects 
and the background. This option produces the best color, but is slower than the Uniform color option.



Click to open the Color Table dialog box, which allows you to use the Netscape Navigator  Colors palette, the 
Microsoft® Internet Explorer Colors palette, or to choose and create colors for your own customized palette.



Click to sample the image and use the first 256 colors to create a palette.



Click to use an adaptive palette, which contains colors that are based on the colors of all visible objects and the 
background. 



Displays the number of colors you want to include in an Adaptive or Optimized palette. Additional colors will not 
be added if you select more colors than are used in the image. Black and white images are the exception: a 
palette with 256 shades of grays is created when the image is converted.



Color Table dialog box



Displays the index number and the value of each color model component for the selected color.



Opens the Open Palette dialog box, which allows you to select and load a previously saved palette. 



Opens the Save Palette As dialog box, which allows you to save a custom palette. The custom palette is saved as
a .CPL (Custom palette) file.



Reverts to the Color Palette's default settings.



Displays the selected palette. Click the down arrow to choose from a list of all available palettes.



Displays the Color Palette selected from the Table list box.



Opens the Select Color dialog box, which allows you to choose or create a new color to add to the Color Table. 
This new color replaces the color that is selected in the Color Table. 



Opens the Duotone dialog box.



Deletes the selected color from the Color Table.



Opens the Select Color dialog box, which allows you to choose or create a color to add to the current palette. 



Crop Border Color dialog box (Crop flyout menu)



Click to crop a paper-colored border from your image.



Displays the current paper color.



Displays the current paint color.



Displays the selected "other" color; that is, a color that is neither the paint nor paper color. There are two ways 
of selecting a different "other" color. You can click the down arrow and click a color on the color picker, or you 
can click the Eyedropper tool and then click the color on your image. 



Use to sample a color from your image. Click the Eyedropper tool, and click the color you want to use in your 
image.



Click to crop a paint-colored border from your image.



Click to crop a colored border from your image that is neither the paint nor paper color. You can click a color on 
the color picker, or click the Eyedropper tool and then click the color on your image.



The Crop Border Color dialog box crops an image based on similarities between adjacent pixels. You can 
determine the color tolerance in two ways: 
· Normal: Determines the cropping area based on the color similarity between adjacent pixels. Move the slider 

to determine the sensitivity of the color tolerance. If you increase the tolerance, more colors will be cropped. If
you reduce it, fewer or no additional colors will be cropped. 

· HSB: Determines the cropping area based on the similarity of hue, saturation, and brightness levels between 
adjacent pixels. Move the sliders to determine the sensitivity of the color tolerance. If you increase the 
tolerance, more colors will be cropped. If you reduce the tolerance, fewer or no additional colors will be 
cropped.



Image Info dialog box 



Displays the name and file extension of the active image.



Displays the width of the active image using the units of measurement you selected in the General Options 
dialog box (Tools, Options, General). The width is also displayed in pixels.



Displays the height of the active image using the units of measurement you selected in the General Options 
dialog box (Tools, Options, General). The height is also displayed in pixels.



Displays the horizontal resolution of the image in pixels, or dots per inch (dpi).



Displays the vertical resolution of the image in pixels, or dots per inch (dpi).



Displays the color mode of the active image. 



Displays the amount of space the file takes up on your hard drive.



Displays the system resources required while the file is open.



Displays the file format of the image. 



Displays the file's compression type.



Indicates whether the image contains objects, and also how many objects it contains.



Indicates whether you have made changes to the image since you opened it. 



Indicates the number of frames the movie contains, as well as how many frames are currently loaded. 





Mask Menu commands



Creates a mask selection that has the exact shape and size of the selected object. If Preserve Image (Image 
menu) is enabled, the new mask is superimposed on the object and the two marquees appear simultaneously. If 
Preserve Image is not enabled, the mask replaces the object; the object is merged into the background when the
mask is created. The color of the marquee changes to reflect this transformation. 



Opens the Load A Mask From Disk dialog box that lets you load a previously saved mask or any importable 
image. Corel WEB.PhotoPaint converts the imported image to a grayscale image that will be used as a mask over
the image. Any bitmap image, except movie files, can be used as a mask.



 Places a mask marquee around the entire image area just inside the window frame. The entire image is selected
and is editable. Even if the image is only partially visible because it has been zoomed in, the entire image is still 
selected. The resulting selection can be edited with any tool in the Paint On Mask mode.



 Removes the current mask from the image window. If the mask was not saved in a channel or to disk, it is gone 
permanently.



Makes the area that is protected by the current mask editable, and makes the currently editable area, called the 
selection, become protected. If the current mask’s transparency has been edited to protect some pixels more 
than others, using Invert makes the less protected areas more protected, and the more protected areas more 
editable. This changes the areas of the image that can be altered with tools and effects.



The Normal mask mode lets you create a single mask selection shape in the image window. Only one mask is 
visible on screen at a time; creating a mask in this mode removes all other existing masks from the image.



The Additive Mask mode lets you add areas to the existing mask selection on the active image. This creates 
complex, composite masks. The dimensions and shape of the added areas are defined by the mask tool you 
select after enabling this command.



The Subtractive command lets you remove areas from an existing mask selection. The removed areas become 
part of the protected area. The dimensions and shape of the areas subtracted are defined by the mask tool you 
select after enabling this command.



Use this mask mode to create a selection which consists of several areas you define by using various mask tools,
but excludes the overlapping sections of those areas, i.e., the overlapping areas are protected from changes 
made to the image. If there are no overlapping sections, all the areas you define are included in a single 
selection and can be edited using the various mask tools.



The Float command creates a temporary layer that floats above the background; this layer contains the current 
mask selection and the image pixels enclosed by its marquee. You can move the selection and its contents 
without affecting the underlying image.    When the selection is at the appropriate location, click this command 
again, now called Defloat, to remove the temporary layer; the pixels enclosed by the marquee are merged with 
the image replacing the background pixels. The mask marquee is still visible and can be moved using the Mask 
Transform tool. Note that while in Float mode, some Mask menu commands, such as Feather, will cause the mask
to defloat.



Lets you select or protect portions of an image based on the pixel colors. You can proceed by defining colors to 
be protected by the mask or to be unprotected by it. Use the Eyedropper tool in the dialog box to choose the 
colors in the image itself. For each color you choose, you set a tolerance range by assigning a tolerance value 
between 1 and 100. All pixels that are within the defined color range are either protected or unprotected, 
depending on the choice you made. This command lets you create complex, intricate masks that would 
otherwise be extremely difficult to define using any one of the standard mask tools. 



Opens the Feather dialog box that lets you set mask feathering options. Feathering is the blending of the edge of
a mask selection with an underlying object or background. The transition between one and the other becomes 
more gradual. Feathering partially selects pixels along the selection’s edge and assigns them decreasing 
grayscale values as they get closer to the protected area. Editing changes applied to a feathered selection will 
fade gradually toward the rest of the image. 



Expands a mask selection to include areas of the image with similar pixel colors. The selection continues to 
expand until all of the adjacent pixels that have colors that meet the selection criteria are included. The criteria 
for including pixels is set using the Magic Wand Tool Settings Roll-Up Tolerance slider. You also enable or disable 
Anti-aliasing in the Magic Wand’s Tool settings Roll-Up or Property Bar.



Opens the Border dialog box that lets you create a border-shaped mask selection. This border selection is based 
on the shape of an existing mask selection displayed on the image. The dialog box lets you specify the width of 
the border in pixels and the harshness of the edges of the selection.    Use the Mask Overlay command in the 
Mask menu to see the effect of using different edges settings. 



Removes protected areas that are completely surrounded by a mask selection. Those areas, called holes, are 
often created by tools such as the Magic Wand and Lasso mask tools. When working with a Photo CD image, for 
example, these tools can often create a complex selection that encloses areas of the image that were not 
selected. This is due to the color or HSB tolerance that was set before the mask was applied.



Opens the Smooth dialog box that lets you smooth over or round off the sharp angles of a mask marquee. This 
results in a smoother, more fluid marquee shape. The degree to which the sharp angles are reduced is set in the 
Radius number box.



Opens the Expand dialog box that lets you increase the size of a mask selection. In the box, type the number of 
pixels to add along the perimeter of the marquee. The edges of the mask selection move a distance equal to the 
chosen number of pixels to increase the size of the mask.



Opens the Reduce dialog box that lets you decrease the size of a mask selection. In the box, type the number of 
pixels to remove along the perimeter of the marquee. The edges of the mask selection move a distance equal to 
the chosen number of pixels to reduce the size of the mask.



Lets you add a brush or effect stroke along the edge of a mask selection. It first opens the Choose Stroke Position
dialog box in which you choose the position of the stroke relative to the mask border. It then opens the Stroke 
Mask dialog box in which you choose a tool and attributes for that tool. There are several brushes and effects 
tools from which to choose. The tool you choose uses the current paint color and the settings currently selected 
in the Tool Settings Roll-Up. You can, however, click the Edit button to change the brush attributes without having
to exit the Stroke Mask dialog box. To add a stroke to a mask, simply choose a tool and click OK.



Superimposes a red-tinted semi-transparent sheet over the entire image to provide an accurate illustration of the
characteristics of the current mask; the image areas that are protected are covered with the red overlay while 
the editable areas are not. If you applied varying degrees of transparency to the mask prior to using this 
command, some areas tinted by the overlay will be lighter than others, indicating that the level of protection 
provided by the mask is lower than in other places.
This command is especially valuable when you are working with masks that have gradual transitional edges in 
which the single-lined mask marquee does not indicate the actual selected area. This is often the case with color 
masks, and any mask to which you have applied a feather or stroke effect.
You choose the color of the Mask Overlay color in the Display tab in the Options dialog box accessed from the 
Tools menu.



Toggles the mask marquee on and off. If enabled, the marquee is visible. If disabled, the marquee is invisible.



Color Mask dialog box



Choose Sampled Colors to create the mask using the colors you choose in the image with the Eyedropper tool. 
Other options are used to quickly add a specific color to the list below, to avoid having to select it in the image 
itself. For example, the Reds option adds a red to the color list, the Shadows option adds black to the list. Once 
you have sampled a color, or selected from this list of presets, you can edit it using the Options button in this 
dialog box and set the tolerance value in the mode of your choice.



Lists all colors selected in the image with the Eyedropper tool, the specific colors chosen in the list box above, 
and the tolerance setting assigned to each one. The checkbox located on the left-hand side of each color is used 
to include or exclude a selected color when creating the mask; add the checkmark to include the color, remove it
to exclude the color. This allows you to experiment with your color selections without having to reset all the 
colors each time.



Drag to smooth out the edges of the mask selection resulting from your color and tolerance choices. Color-
sensitive masks can produce selections that have many sharp angles and bends in their outlining areas; a higher
Smoothing factor gets rid of those sharp bends in direction.



Choose how you want the color mask displayed in the Preview area above. The options are: Overlay, Grayscale, 
White matte, and Black matte. The pixels that are protected by the mask will be represented with the option you 
choose. The overlay color is set in the Options dialog box (Tools menu).



Use the Eyedropper tool to click colors to add to the list. You can click the colors in the Preview area or in the 
image itself. Once you have clicked a color, it is included in the list on the right-hand side of this dialog box. You 
can change the tolerance setting if necessary.



Click to clear the color list; do this to start the mask creation from scratch.



Click to see a menu of commands to use when creating or editing a color-sensitive mask:
· Open Color Mask: loads a mask saved to disk previously. Use this to edit an existing color-sensitive mask.
· Save Color Mask: saves the current color-sensitive mask to disk for future use.
· Mask to Channel: saves the current color-sensitive mask in a mask channel which is automatically saved 

with the image when using Corel WEB.PhotoPaint’s .CPT file format.
· Modify Colors: makes all colors selected in the list on the right editable and protects all other colors in the 

image.
· Protect Colors: protects all colors selected in the list and makes all other colors in the image editable.
· Mode: choose the mode needed when setting tolerance values for each selected color. When you choose HSB,

you set a tolerance value for all components of the mode, i.e. Hue, Saturation, and Brightness.
· Edit Color: opens the Select Color dialog box which allows you to edit the color highlighted in the list on the 

right.



Displays a preview of the mask. Colors that are protected or modified are shown. Choose the mask overlay color 
in the Options dialog box.



Enable to make the preview area update automatically after every selection or adjustment you make in the 
dialog box.



Mask Border dialog



Determines the number of pixels between the original mask marquee and the position of the second mask 
marquee required to create a border-shaped mask selection.



Displays a list box where you can choose a soft or hard border edge. A soft edge produces a more gradual blend 
with the background image than a hard edge.



Mask Expand/Reduce dialog



Type the number of pixels that you want to add with the Expand command or remove with the Reduce 
command. The pixels are added or removed along the perimeter of the mask selection. The selection will be 
larger or smaller but will retain its shape.



Mask Feather dialog



Type the number of pixels to use along the perimeter of the mask selection in the feathering transition. 
Feathering replaces opaque pixels with semi-transparent ones. A large number produces a wide feathering 
transitional area, which makes the feathering effect more gradual. 



Controls the location of the feathered section of the mask. 
· Average: samples all the pixels in the defined width and assigns an average color value to each pixel.
· Inside: feathers toward the inside of the selection’s edge and appears to blend the background into the 

selection. 
· Outside: feathers toward the outside of the selection’s edge and blends the selection so that it appears to 

overlap the background area. 
· Middle: places the feathered section on the selection’s edge; there are as many feathered pixels inside the 

original hard edge as there are outside of it.



Choose the edge type for the feathered portion of the mask selection. Linear uses the sharp bends found in the 
selection when producing the feathered section, whereas Curved tends to round them off. Unavailable when you 
select Average for the location of the feathered section



Save Mask As Channel dialog



Type a mask channel name or accept the default filename (Alpha 1, Alpha 2, etc.). The channel name you choose
will appear in the Channels Roll-Up.



Mask Smooth dialog



Determines the intensity of    mask selection smoothing. Smoothing tones down differences in adjacent pixels 
along the edges of the mask.



Stroke Mask dialog



Click this button to change the attributes of the tool you have selected to apply a stroke along the mask 
marquee. A dialog box specific to the tool you have selected will appear allowing you to set nib attributes, color 
tolerance, choose an image list among others, depending on the tool chosen.



Displays the paint tools you can use to stroke the boundary of the current selection. Each tool features two or 
more brush types within its specific category. Click the down arrow next to the list box to select a type. The 
current size and shape of the selected tool is used but can be changed by clicking the Edit button. The current 
paint color is used.



Lets you choose a specific paintbrush type. Each paintbrush selected from the iconic display (above) features 
two or more types within its specific category. The current size and shape of the selected tool is used and 
displayed in the preview area. Click the Edit button to change those attributes. The current paint color is used.



Displays the effect tools you can use to stroke the boundary of the current selection. Each effect tool features 
two or more types within its specific category. Click the down arrow next to the list box to select a type. The 
current size and shape of the selected tool is used but can be changed by clicking the Edit button. 



Lets you choose a specific effect tool type. Each effect tool selected from the iconic display (above) features two 
or more types within its specific category. The current size and shape of the selected tool is used, and is 
displayed in the preview area. Click the Edit button to change the attributes.



Click to apply copies of an image, or of tiles of an image, along the selection’s edge. Click the Edit button to 
choose the image, the order of the tiles, spacing, transparency, and other attributes.



Erases the pixels along the edge of the selection. They are replaced by the current paper color. Click the Edit 
button to choose the size, shape, transparency, and other attributes of the eraser tool.



Replaces the current paint color with the paper color in the pixels along the edge of the selection. Click the Edit 
button to choose the shape, size, transparency, tolerance, and other attributes for the Color Replacer.



Eraser Tool and Color Replacer Tool dialog boxes
Use the controls in this dialog box to edit the attributes of the tool you have chosen to use to stroke the mask 
marquee  the Eraser or Color Replacer tool. The attributes relate to the tool’s nib, i.e., its shape, size, 
transparency, soft edge, flatten and rotate characteristics. When you choose the Color Replacer tool, the dialog 
box also displays color tolerance controls. For information about individual controls, right-click the control and 
choose What’s this?.



Image Sprayer Tool dialog box
Use the controls in this dialog box to edit the attributes of the Image Sprayer tool you have chosen to use to 
stroke the mask marquee. The controls of this dialog box allow you to choose the image list to use, set the 
transparency, distribution and other characteristics. For information about individual controls, right-click the 
control and choose What’s this?.



Click this button to load an image list you wish to spray along the mask marquee.



Choose Stroke Position dialog box
This dialog box is used to choose the location of the brush or effect stroke you will apply to the edge of a mask 
selection. You can choose to have the stroke centered on the selection edge, or place it just inside or outside of 
the edge. When you make your selection and click OK, the Stroke Mask dialog box appears.



Centers the stroke on the selection’s edge.



Places the stroke just inside the selection’s edge.



Places the stroke just outside the selection’s edge.



The following topics are for the Load Texture and Reset Texture buttons found on the Texture/Color 
tab when you choose a paint or effect tool in the Stroke Mask dlg and click the Edit button to 
change the attributes of the tool.



Click to load a different texture for the selected tool.



Click to reset the tool to the default texture.





This file includes the context-sensitive help topics for the
Object menu including:
· menu command descriptions (F1)
· dialog box controls What’s This topics except the Threshold 

dialog box’s single control which is documented in 
D_MASKMENU.RTF because it shares the same help ID as the 
Mask Threshold control.

Note
· All dialog box overviews have been aliased to overview topics 

in the Working with Objects Chapter (see PHOTOPNT.ALI).



Object Menu commands



Creates an object using the shape and contents of the current mask selection. The selection is transformed into 
an object. The color of the marquee changes to reflect this transformation. 
Enabling the Preserve Image command (Image menu) before you create the object, makes the object from a 
copy of the pixels that are included inside the marquee. Disabling Preserve Image creates the object by cutting 
the pixels; therefore, when the object is moved, the area that was below it shows only the paper color.



This command is available when working in Layer mode. It creates a new object that consists of a transparent 
layer over the entire image. You can then use most of the tools in the toolbox to add elements to the new object 
such as shapes, paintbrush strokes, and sprayed images. After you’ve added object elements, you can use the 
Undo, Clone, and Effects tools to edit the object. All elements that are added or edited float above the underlying
image on the transparent layer; they do not affect the image itself. The new object’s thumbnail, displayed at the 
top of the Objects Roll-Up (View menu), is updated as you edit the object.



Allows you to precisely align multiple objects. All objects to be aligned must be selected by using the Object 
Picker tool while holding down SHIFT. You can align objects to each other, to the center of the image, or to a grid.
Object can be aligned horizontally or vertically in any one of a number of combinations.



Creates a copy of the selected object that is placed behind the original object and offset according to the 
distances you specify in the dialog box. You can choose the color and opacity for the shadow object and apply 
feathering. The shadow object is represented in the Objects Roll-Up (View menu) by a thumbnail and the word 
"shadow" in the object’s name.



The Order commands allow you to control the stacking order of each object in your image, i.e., which object will 
be on top of or below other objects.
To Front moves the selected object(s) to the front of the screen. If the front object has a fill, Corel WEB.PhotoPaint
"knocks out" the area underneath the front object wherever it overlaps other objects in your drawing so that it 
does not print.



The Order commands allow you to control the stacking order of each object in your image, i.e., which object will 
be on top of or below other objects.
To Back moves the selected object(s) to the back of the screen. Areas of the object that are overlapped by other 
objects with fills are "knocked out" so that they will not print.



The Order commands allow you to control the stacking order of each object in your image, i.e., which object will 
be on top of or below other objects.
Forward One moves the selected object(s) forward one position.



The Order commands allow you to control the stacking order of each object in your image, i.e., which object will 
be on top of or below other objects.
Back One moves the selected object(s) back one position.



The Order commands let you control the stacking order of each object in your image above the base image; or,    
which object will be on top or below other objects.
Reverse Order reverses the stacking order of the selected objects.



Groups all selected objects so that they can be selected and transformed as a single object. When an object in a 
group is selected, a single highlighting box appears around the entire group. You can also collect groups into 
larger groups with other objects and/or groups. When you use the Objects Roll-Up, the thumbnails associated 
with each object in the group are linked by a thick black line.
Grouped objects can be transformed (e.g., sized, scaled, rotated, or skewed) as a group in any object-editing 
mode. They can also be edited as a group using the Paint, Effect, and Clone tools when you work in Multi mode. 
In Single and Layer mode, only one object in the group can be edited with these tools; the object that can be 
edited is the object that has the pencil icon next to its name in the Objects Roll-Up.



Breaks the selected group into its component objects. 



Combines selected objects so that they become a single object. Although the component objects can be 
physically separated from one another, they remain linked.



Combines the selected object(s) with the background image. After an object is combined it becomes a 
permanent element in the background image.
You can choose how the colors of the objects merge with the colors of the image background by selecting a 
merge mode. All merge modes are listed at the bottom of the Objects Roll-Up (View menu). When the objects are
selected, you can preview the result of the mode by choosing its name from the list. The operation is applied 
permanently only when you click the Combine, Objects With Background command.



Combines all objects that are visible on the screen with the background image, even objects that are not 
selected. After the objects are combined they become permanent elements in the background image. 
You can choose how the colors of the objects merge with the colors of the image background by selecting a 
merge mode. All merge modes are listed at the bottom of the Objects Roll-Up (View menu). When the objects are
selected, you can preview the result of a mode by choosing its name from the list. The operation is applied 
permanently only when you click the Combine, All Objects With Background command.



Creates a duplicate of the selected object(s). The duplicate object is superimposed over the original and 
becomes the active object in the Image Window. There is no limit to the number of duplicates that can be made.



Deletes the selected object(s) from the Image Window. To undelete an object that has been mistakenly deleted, 
click Edit, Undo immediately.



Lets you change the shape of an object by using a mask as a clipping tool. Use a mask tool to define the area of 
an object you want to keep, then choose this command. The area outside the mask selection is deleted.
If you no longer need the mask, click Mask, Remove. Only the object marquee remains visible in the image.



Feathers the edge of the selected object. Feathering is a gradual increase in the transparency of the pixels that 
are located along the edge of an object. Feathering makes the transition between the object and the surrounding
image more gradual and less obvious. You decide how wide the feathered section of the object will be and the 
type of edges to use.



Flips the selected object(s) horizontally.



Flips the selected object(s) vertically.



Rotates the selected object(s) 90° clockwise.



Rotates the selected object(s) 90° counterclockwise.



Rotates the selected object(s) 180°.



Displays the controls used to rotate objects in both the Tool Settings Roll-Up and the Property Bar. Rotation and 
Skew handles appear around the object. Drag a corner handle to determine the degree of rotation. Double-click 
inside the object to apply the rotation. Drag the small circle to change the center of rotation.



 Places distortion handles at each corner of the object’s highlighting box. Drag an arrow to determine the amount
of distortion. Double-click inside the object to apply the distortion.



Use to apply perspective to the selected object(s). This gives the illusion of depth, like the object is placed in 
three-dimensional space. When you select this command, circular handles appear at each corner of the object’s 
highlighting box. Drag one of the handles to make one side of the object larger, so that it looks closer than the 
rest of the object, or smaller, so that it looks further away. Double-click inside the object to apply the 
perspective.



 Use the Tool Settings Roll-Up's object Size and Scale tabs, or the Property Bar to stretch object(s). Selection 
handles appear around the object(s). Drag a middle selection handle to control the amount of stretching. Double-
click inside the object to apply the transformation.



Use the Tool Settings Roll-Up's object Skew tab, or the Property Bar to control the degree of object skewing. 
Rotation and Skew handles appear around the object(s). Drag a middle handle to control the degree of skewing. 
Double-click inside the object to apply the skewing.



Use when you are creating an image map for a World Wide Web page. Assigns a link to a URL (Universal 
Resource Locator) from an object. The dialog box lists all objects on the image so that you can assign links to 
several objects in a single operation.



Selects all objects in the active image. Places handles along the border of the highlighting box that encloses all 
of the objects to let you manipulate the entire range simultaneously.



Lets you turn the display of the object marquee on and off. If enabled, the marquees are visible.



Align dialog box



Enable one of the horizontal alignment options.
Left
Aligns the selected objects to the left side of the object that is at the top of the stacking order among all selected
objects. To see which object is at the top of the stack, look at the object order in the Objects Roll-Up.
Center
Aligns the selected objects to the center of the object that is at the top of the stacking order among all selected 
objects.
Right
Aligns the selected objects to the right side of the object that is at the top of the stacking order among all 
selected objects.



Enable on of the vertical alignment options.
Top
Aligns the selected objects to the top edge of the object that is at the top of the stacking order among all 
selected objects. To see which object is at the top of the stack, look at the object order in the Objects Roll-Up.
Center
Aligns the selected objects to the center of the object that is at the top of the stacking order among all selected 
objects.
Bottom
Aligns the selected objects to the bottom edge    of the object that is at the top of the stacking order among all 
selected objects.



Aligns the centers of selected objects to the center of the page. If you choose this option followed by a Horizontal
and/or Vertical option, the objects will be aligned accordingly with respect to the center of the page.



Aligns the selected objects to the nearest grid line(s). You must choose at least one of the Horizontal or Vertical 
alignment options.



Drop Shadow dialog box (Object menu)



Choose one of four options to position the shadow relative to the original object. The shadow is represented by 
the gray border. Placement options for the drop shadow are: top left, top right, bottom left, and bottom right of 
the object.



Type the horizontal distance you want between the edge of the original object and the outside edge of the 
shadow object. Uses the current units of measurement.



Type the vertical distance you want between the edge of the original object and the outside edge of the shadow 
object. Uses the current units of measurement.



Enable to make both offset values the same. When this option is enabled, the current vertical offset changes to 
match the horizontal offset.



Type the width, in pixels, of the shadow’s feathered edge. A feathered edge makes the shadow object blend 
gradually from its color to the colors of the image background. This makes the shadow object’s edges less 
noticeable. Type 0 if you want the sharpest edges possible for the shadow object.



Type a transparency value between 0 and 100 to set the shadow object’s opacity. Zero is completely transparent;
100 is completely opaque. The value typed here also modifies the opacity of any feathered pixels.



Choose the location of the feathered pixels relative to the shadow object. Inside places the feathered portion 
inside the shadow's edges, outside adds pixels just outside the shadow’s edges, and middle places 
approximately as many feathered pixels inside the edge as outside. Average samples all pixels in the defined 
width and assigns a color value to each one individually. This results in some pixels being inside and some being 
outside, and creates a more gradual transition in color between the shadow object and the background, much 
like a gradient.



Choose the edge type for the feathered portion of the shadow object. Linear uses the sharp bends found in the 
object when it produces the feathered section; whereas, Curved tends to round them off. This option is 
unavailable if you select Average for the location of the feathered section.



Click to make the shadow object black.



Click the make the shadow object white



Click to apply a custom color to the shadow object



Click to choose the color to apply to the shadow object. This is only available when you select the Use Custom 
Color option.



Click to automatically update the preview area after every selection or change made in this dialog box.



Click to update the preview area after you have made a selection or change in this dialog box. This has no effect 
if you’ve enabled the Always Update Preview option.



Defringe dialog box



Determines the width of the Defringe effect. The Defringe command gradually blends an object with the 
background by replacing the color of the pixels on the edges of the object with the color of adjacent pixels that 
do not contain any background color. A larger value creates a more gradual transition between the edges of the 
object and the background.



Object Feather dialog



Controls the number of pixels that are included in the feathered edge. A higher number produces a more gradual
feathering effect between the object and the background. 



Choose the type of gradient to use when feathering the object. Linear makes the gradient progress in even 
increments of added transparency from the beginning to the end of the feathered section. Curved makes the 
gradient follow a slanted S-shaped curve; this results in small transparency increments at the beginning of the 
feathered edge, larger ones in the middle, and small ones at the end. This makes the feathering look more 
concentrated.



Click to preview the effects of the current feathering settings on the object.



Displays the selected object. Click the Preview button to view the object with the feathering values you have 
entered in the Width and Edges number boxes. A number is visible in the top left of the object to indicate the 
current object magnification level.



The Hand tool is used to move a magnified image within the Preview window. Drag to see different parts of the 
image.



The Zoom tool is used to magnify specific areas of an image. Click to zoom in on the image. Right-click to zoom 
out.



Tag WWW URL dialog box



Click to select the object on which you want to define a clickable area. All objects in the image are listed using 
the same object names that appear in the Objects Roll-Up.



Type the Universal Resource Locator (URL) you wish to link to when the object is clicked.



Type the alternative text for the clickable area you are defining. This text will appear when a user accesses your 
page on the World Wide Web but uses a browser that does not support graphics or that cannot display your 
image(s).



Choose the shape of the clickable area on the object. The clickable area can be a polygon that closely follows the
object’s shape, a rectangle that matches the object’s highlighting box, an oval shape that fits within the object’s 
highlighting box, or a circle that has a radius equal to the object’s longest dimension from its center to its edges.



Displays the coordinates, in pixels, of the clickable area relative to the top left corner of the image. The first set 
of coordinates defines the area’s top and left edge. The second set of coordinates defines the area’s bottom and 
right edge.



Displays the height and width of the clickable area in pixels.



Click to clear the Universal Resource Locator (URL) address and comments for the selected clickable area.





This .RTF contains all the context-sensitive help for all 
the Roll-Ups in Corel WEB.PhotoPaint



Object Picker tool - TSR
· The Mask Transform tool shared the same controls and help Ids as the Object Picker tool; each of the following 

topics have been written with this in mind.



Object Picker: Position



Type the horizontal coordinate to define the on-screen location of the mask marquee or the selected object. The 
left side of the highlighting box of the mask marquee or object will be located at this coordinate. Click View, 
Rulers to see the rulers in the Image Window.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Type the vertical coordinate to define the on-screen location of the mask marquee or the selected object 
onscreen. The top of the highlighting box of the mask marquee or object will be located at this coordinate. Click 
View, Rulers to see the rulers in the Image Window.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Moves the mask marquee or the selected object relative to its current location. The marquee or object moves the
distance you specify in the Horizontal and Vertical boxes.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Object Picker: Size



Type the horizontal dimension for the widest section of the mask marquee or the selected object. 
· This control is available for both the Object Picker tool and the Mask Transform tool.



Type the vertical dimension for the longest section of the mask marquee or the selected object.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Enable this option to maintain the height-to-width ratio of the mask marquee or selected object. If you change 
one dimension the other one is updated automatically.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Object Picker: Scale



Type the horizontal scaling factor for the mask marquee or selected object as a percentage of its current 
horizontal dimension.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Type the vertical scaling factor for the mask marquee or selected object as a percentage of its current vertical 
dimension.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Click this button to flip the mask marquee or selected object horizontally. The transformed marquee or object has
the same dimensions it had before the transformation.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Click this button to flip the mask marquee or selected object vertically. The transformed marquee or object has 
the same dimensions it had before the transformation.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Enable this option to maintain the height-to-width ratio of the mask marquee or selected object when it is scaled 
or flipped.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Object Picker: Rotate/Angle



Type the angle of rotation you want to apply to the current mask marquee or selected object. Type a value 
between 1 and 360 degrees.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Type the horizontal coordinate of the point around which you want the mask marquee or selected object to 
rotate. This location is set relative to the rulers unless you enable the Relative Center option.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Type the vertical coordinate of the point around which you want the mask marquee or selected object to rotate. 
This location is set relative to the rulers unless you enable the Relative Center option.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Enable to place the center of rotation at the coordinates you specify in the Center Of Rotation boxes, relative to 
the current position of the center of rotation instead of relative to the rulers.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Object Picker: Skew



Type the horizontal skew value, in degrees, for the mask marquee or selected object. Positive values move the 
top of the marquee or object to the left. Negative values move it to the right.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Type the vertical skew value, in degrees, for the mask marquee of selected object. Positive values move the right
side of the marquee or object up. Negative values move it down.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Common to all Object Picker and Mask Transform tool tabs



Click to see a preview of the transformation of the mask marquee or the selected object in the Image Window. 
This is a preview only. You can either press ESC, or double-click outside the object or marquee in the Image 
Window to cancel the transformation and return to the original state. Click Apply in the Tool Settings Roll-Up, 
press ENTER, or double-click inside the object to apply the transformation permanently.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Applies the transformation to the mask marquee or to the selected object.
· This control is available for both the Object Picker tool and the Mask Transform tool.



Creates a copy of the original object, applies the selected transformations to the copy, and leaves the original 
intact. Only available when you are transforming objects.



Transparency tool and Transparency Brush tool TSR - 
commons control:



Enable to add the your chosen transparency value to the existing transparency value of the pixels in the object. 
Disable this option to replace the existing transparency values of the pixels in the object with the values you 
have chosen for this tool.



Object Transparency tool - TSR



Displays the type of transparency pattern that is currently selected. The pattern is either a gradient whose 
grayscale progression is used to fade the selected object(s) into the image background, or a fill type such as 
Texture or Bitmap whose grayscale values are used to change the transparency of pixels in the object.



Choose the type of transparency pattern to use when fading an object into the image background or editing the 
transparency of an object.



Type the transparency value, between 0 and 100, for the start point of the object’s transparency blend with the 
rest of the image. Zero is opaque; 100 is completely transparent. If you are using the Property Bar, you can also 
move the slider to set the transparency.



Type the transparency value, between 0 and 100, for the end point of the object’s transparency blend with the 
rest of the image. Zero is opaque; 100 is completely transparent. If you are using the Property Bar, you can also 
move the slider to set the transparency.



Click to update the image after each mouse move without having to release the mouse button.



This button is only available when you choose the Bitmap or Texture option in the Type box. It opens dialog boxes
that are used to change the attributes of the bitmap or texture you use to edit an object’s transparency.



Applies the selected options to the object. Click this button after you have edited the current transparency blend 
by dragging the start or end point.



Object Transparency Brush - TSR
· all controls in TSR except two are all nib controls covered in the Nibs Roll-Up topics



Adjust the slider to choose the maximum opacity level you want to apply to pixels that are repeatedly brushed 
with the Transparency Brush tool.



Path Node Edit Tool Settings Roll-Up



Lists all the paths you have saved and provides quick access to them; click a path to load it into the current 
image. If you’ve just created a path in the Image Window and have not saved it, the path is given the default 
name "WorkPath" which is also listed. If you choose to load a saved path, a message box will appear to allow you
to save the changes you have made to the current path. 



Adds a node halfway between the selected node and the next node in the direction the path was created. You 
can also select several nodes and then click the Add button to add one node on each of the segments associated
with the selected nodes. Add nodes if you cannot shape a curve the way you want by moving the existing nodes 
and control points.



Deletes the selected node(s). Use to remove surplus nodes from an excessively complex path and to smooth 
unwanted bumps along a curve. If you delete several nodes that are close to one another you change the shape 
of the path.



Connects two end nodes, one at the beginning and the other at end of the same path. Use to close an open path 
or to connect two physically separated path segments. The two nodes become one. 



Splits the selected node into two nodes. The nodes remain one on top of the other until you move one of them. 
Use to break a path segment. 



Deletes any nodes that can be deleted without significantly changing the shape of the curve. Use to simplify a 
path that has been edited substantially or that has been created from a mask. You can adjust the sensitivity of 
Auto-Reduce by typing a new value in the Reduce Tolerance box below. A high value may result in a significant 
change to the path shape.



Sets the sensitivity of the Automatic Node Reduction feature. Type a value from 1 to 10. A high value removes 
more nodes than a low value and may cause more significant changes in the shape of the path.



Click to make segments that are located between two selected nodes behave like rubber bands when you move 
the nodes. The path segments stretch or shrink according to the direction and distance you move their nodes.



Changes the selected curve node(s) to line node(s) in order to create line segment(s).



Changes the selected line node(s) to curve node(s) in order to create curved segments. The segment shape may 
not change after this operation. However, when you select one of its nodes, control points appear to allow you to
curve the segment.



Changes the selected node to a smooth node. This constrains the angle between the two control points to 180 
degrees, but allows you to independently vary the distance between the node and each of its control point. Use 
when you want to create a smooth transition between line segments.



Changes the selected node to a symmetrical node. This constrains the angle between the two control points to 
180 degrees and keeps both control points at an equal distance from the node. Use when you want to create the 
same curvature on both sides of the node. 



Changes the selected node to a cusp node. This allows you to independently edit the control points on either 
side of the node. Use when you want to add a sharp bend to a path.



Click to edit the nodes and segments of a path. You can select segments, nodes, and control points, move them 
to shape the path, convert the segments to lines or curves, add and delete existing nodes, and change the node 
type.



Allows you to create new paths and to add segments to the current path by clicking where you want to create a 
node that will be automatically linked to the end node of the path.



Click to remove the path currently displayed in the Image Window. If the path you are clearing has been saved to
disk, a message appears and asks if you also want to delete the saved path.



Deletes the existing path so that you can create a new one. A message will appear to ask if you want to save the
current path or the changes you have made since the path was last saved.



Allows you to save the existing path to disk so that you can use it in the future in any image. Paths are given 
a .PTH file extension.



Allows you to open a path that has been saved to disk.



Allows you to create a mask selection that has the shape of the current path. A dialog box will appear to allow 
you to use Anti-aliasing when you create the mask. This avoids jagged edges in the outline of the mask 
selection. Both the mask selection and the path will appear on-screen.



Allows you to create a path that has the shape of the current mask marquee. A dialog box will appear with 
threshold and tightness controls to allow you to choose how closely the path will resemble the mask marquee 
and how much of the marquee’s sharp bends will be present in the resulting path.



Allows you to apply a brush stroke along the current mask marquee. You choose the position of the stroke 
relative to the marquee (or selection boundary), the tool to use (Paint, Effect, Color Replacer, or Eraser), and the 
attributes of the tool. The current paint color is used.



Allows you to apply a brushstroke along the current path. You choose the tool to use (Paint, Effect, Color 
Replacer, or Eraser) and the attributes of the tool. The current paint color is used.



Both the Path to Mask and the Mask to Path dialog boxes have same ID (Emailed Dana 
asking one of them be changed on Oct 7; waiting for outcome)



Path to Mask dialog box
This dialog box is used to make the edges of the mask selection boundary look smooth. The Anti-alias option 
partially selects pixels that are located next to curved and diagonal edges in the resulting mask marquee; this 
removes jagged edges.



Mask to Path dialog box
This dialog box provides two controls that affect how closely the new path will resemble the shape of the current 
mask selection. 
The Tightness control influences the number of nodes the new path will have, which in turn determines how 
closely it will match the shape of the mask selection.
The Threshold control is used to determine the angle that is required between sections of the selection’s 
boundary for a node to be placed at the intersection of the sections. A low value tends to produce more cusps, 
and therefore, more nodes on the resulting path.



Type a tightness value from 1 to 10 to determine how close the shape of the path will be to the shape of the 
mask marquee. The higher the value, the more the new path resembles the marquee; it has more nodes than a 
path with a lower tightness value.



Type a threshold value from 1 to 10 to determine the size of the angle required between segments of a mask 
marquee for a node to be created at the intersection of the segments. A low value produces more cusps, 
therefore more nodes on the resulting path than using a high value.



Repeat Stroke tool - Tool Settings Roll-Up



Repeat Stroke tool - Tab 1



Shows a preview of the brush stroke selected in the list box below. The brush stroke's dimensions are written 
below the preview areas. If you type a scaliing factor and an angle for the brush stroke using the Roll-Up's 
controls, the preview is updated.



Lists brush strokes that have been previously saved. Click to select a brush stroke. Click the image to repeat the 
stroke.



Click to open a flyout menu which includes commands to let you add the last brush stroke created in an image to
the list of saved brush strokes, load a saved path as a stroke, and delete the brush stroke currently displayed in 
the list box on the left.



Type a scaling factor to apply to the selected brush stroke. Values below 100 shrink the stroke height and width 
proportionally; values above 100 increase stroke height and width. The starting point of the stroke does not 
move when the stroke is scaled.



Type the maximum variation in the size of the stroke that is acceptable when you apply several repetitions of the
stroke in a single click or when you plan on to click several times. If you leave the stroke scale at 100%, choose a
variation of 20%, and choose several repetitions, the repeated strokes will be between 80% and 120% of the 
original size (100% plus or minus 20%). Using the same example, if you set the repeat number to 1, each 
successive click of the tool in the image will also result in a stroke that is between 80% and 120% of the original.



Type the number of strokes you want to create each time you click in the Image Window, or each time you click 
and drag to define an area in the image. On the angle tab of this Roll-Up, set the angle variation to have each 
repetition of the stroke at a different angle. If the angle variation is zero, all repetitions of the stroke are 
performed over the same area in the image. This makes a non opaque stroke progressively darker.



Repeat Stroke tool - Tab 2



Type a rotation angle for the selected brushstroke. The preview area is updated. The starting point of the stroke 
is the center of rotation, or the pivot around which the brushstroke is rotated.



Type the maximum variation in the angle you want between each stroke created in the image. This changes the 
angle of individual strokes if you have set several repetitions per click, or, if you have set a single repetition, 
when you click several times in the Image Window.



Type an increment for the angle to add to each repetition of a stroke from the previous stroke. This distributes 
the repetitions of a stroke evenly to create a fan-like result.



Click to make each repetition of a saved brush stroke that is applied to a path be on a tangent to the path. For 
this to work, you must have a path in the Image Window and, once you have selected a brush stroke and its 
attributes, click the Stroke Current Path button in the Repeat Stroke tool's Property Bar or Tool Settings Roll-Up.



Repeat Stroke tool - Tab 3



Enable to use the colors in the image to create the brush strokes rather than the color you used when you saved 
the brush stroke. This works as if you were applying brushstrokes to a painting that was still wet.



Enable to use the current paint color when you create the strokes instead of the color you used when you saved 
the brush stroke.



Set the variation in the hue of the stroke color you want to see between each repetition of a stroke.



Set the variation in the color purity of the stroke you want to see between each repetition of a stroke.



Set the variation in the brightness of the stroke color you want to see between each repetition of a stroke.



Common to all tabs of Repeat Stroke tool Roll-Up



Applies the selected stroke and options to the current path in the image. Paths are created with the Path Node 

Edit tool .



Click to change the attributes of the brush that was originally used to create the selected stroke. Attributes 
include brush size, nib angle, transparency level among others.



Fill TSR



Click to choose a fountain fill, which progresses from one color to another following a concentric square, conical, 
linear, rectangular, or radial pattern. Click Edit to open the Fountain Fill dialog box, which contains all the 
controls you need to customize, create, save, or delete fountain fills.



Click to choose a bitmap fill, which is a fill created from any bitmap image. The images that work best are those 
that are patterned and can tile to create a contiguous pattern, like river stones, coins, or bricks. Click Edit to 
open the Bitmap Fill dialog box, which contains the controls you need to import, select, and customize bitmap 
fills. 



Click to choose a uniform fill, which applies a solid color over the area you are filling. If you want to change the 
color of the uniform fill, click Edit and select or mix a new color in the Uniform Fill dialog box.



Click to choose a texture fill, which is a mathematically (algorithmically) generated image with customizable 
attributes. Unlike the tiling bitmap fills, textures fill a designated area with a single image. The many preset 
textures include water, minerals, clouds, and dozens of other presets. Click Edit to open the Texture Fill dialog 
box, which contains the controls you need to create, choose, and customize texture fills.



Click to suppress the fill. 



Click to open the dialog box that pertains to the type of fill you have chosen. For example, if you have selected a 
texture fill, but don't want to use the fill that appears in the Preview window above, click Edit and modify the fill 
in the Texture Fill dialog box. 



Displays the chosen fill. 



The Color Tolerance controls determine the range of effect for color sensitive tools such as the Magic Wand Mask,
Lasso Mask, and Fill tools. The higher the value, the more colors will be included in the operation.
· Normal: Determines the color tolerance based on the similarity of brightness values between adjacent pixels. 
· HSB: Determines the color tolerance based on the similarity of hue, saturation, and brightness levels between 

adjacent pixels. 



Gradient Fill TSR



Displays the current gradient pattern graphically.



Displays the current gradient pattern. To change the pattern, click the down arrow and choose one from the list.



Displays the current paint mode. Paint modes determine the way the fill colors are applied to the colors that 
already exist in your image.



Displays the current gradient style. You can choose gradients that move from one color to another, or from a 
color to a transparency. To change the style, click the down arrow and choose one from the list box.



Displays the transparency level of the fill. A higher value results in a more transparent fill. To change the value, 
enter a new value, or adjust the existing one using the scroll arrows. 



Click to apply the fill.



Zoom TSR



Enable this check box to zoom out by right-clicking when the zoom tool is selected. 



CROP tool - Tool Settings Roll-Up



Type the vertical coordinate you want for the top of the cropped area. The units are those specified in the VUnits 
box below. It is easier if you use the same units as are used on the rulers. Choose View, Show Rulers to display 
the rulers in the Image Window. The value you type equals the distance between the top edge of the crop 
marquee and the top edge of the original image. 



Type the horizontal coordinate you want for the left edge of the cropped area. The units are those specified in the
HUnits box below. It is easier if you use the same units as are used on the rulers. Choose View, Show Rulers to 
display the rulers in the Image Window. The value you type equals the distance between the left edge of the crop
marquee and the left edge of the original image.



Lists the available units of measurement. The Top edge and Height values use the vertical units that are 
selected. The Left edge and Width values use the horizontal units that are selected.



Type the height of the crop marquee. The value you type uses the measurement units chosen in the VUnits box. 
As soon as you type a value for either the width or height of the cropped area, one side of the crop marquee 
appears in the Image Window and starts at the coordinates specified in the Top Edge and Left Edge boxes. When 
both the width and height values are typed, the entire crop marquee is displayed in the Image Window to allow 
you to size it if necessary before cropping the image.



Type the width of the crop marquee. The value you type uses the measurement units chosen in the HUnits box. 
As soon as you type a value for either the width or height of the cropped area, one side of the crop marquee 
appears in the Image Window and starts at the coordinates specified in the Top Edge and Left Edge boxes. When 
both the width and height values are typed, the entire crop marquee is displayed in the Image Window to allow 
you to size it if necessary before cropping the image.



Mask tools - Tool Settings Roll-Up
· common nib controls are under heading "Nib controls"



CIRCLE/RECT MASK WHAT’S THIS?



Type the number of pixels you want to use along the edge of the mask selection to apply feathering. Feathered 
pixels gradually become more opaque as you get closer to the protected area of the mask. Therefore, changes 
applied to the selection blend gradually toward the rest of the image.



A list box that lets you choose either a rectangle and circle mask style. There are four styles to choose from: 
Normal and Fixed, which are common to both the Rectangle and Circle mask tools; Single Row and Single 
Column, which are exclusive to the Rectangle Mask tool.
· Normal

Choose this to define a mask selection manually in the Image Window by using the standard click and drag 
functionality.

· Fixed Size
Choose this to precisely set the dimensions of the mask selection. Enter a value in both the Width and    Height
boxes. When you use the Circle Mask tool, the dimensions you type are used for the diameter of the circular 
selection or for the widest and longest sections of an elliptical selection.

· Row(s)
Choose this to create a mask selection that runs horizontally (left to right) from one edge of the image to the 
other and has a height equal to the number of pixels you type in the Height box.

· Column(s)
Choose this to create a mask selection that runs vertically (top to bottom) from the top edge of the image to 
the bottom and has a width equal to the number of pixels you type in the Width box. 



Type the width, in pixels, of a fixed-size mask selection. Type a value or use the scroll arrows to change the 
value.



Type the height, in pixels, of a fixed-size mask selection. Type a value or use the scroll arrows to change the 
value.



 Lasso Tool/Magic Wand Tool



The tolerance What’s this topic is in the Fill TSR section of this file because it is also applicable to 
the Fill tool. The Anti-alias topic is in the D_BRUSHTOOLS.RTF.



Mask Transform tool
· all TSR controls for the Mask Transform tool have the same Ids as the Object Picker tool TSR. The topics in the 

Object Picker tool section of this file are valid for both tools.



Shape Tools - Tool Settings Roll-Up
· the common fill topics included in the Shape Tools Settings Roll-Up are in the Fill TSR section of this rtf file. 



Displays a thumbnail of the current shape tool. As you change the Roll-Up controls, the tool changes in the 
Preview window. 



The function of this control varies with the type of tool selected.
· Shape tools (Rectangle, Ellipse, Polygon)

Controls the size of the border, or outline, in pixels. A value of 0 produces a shape without a border.
· Line tool

Controls the width of the line in pixels. The minimum line width is 1.

Note
· When you view your image at a zoom level below 100%, some outlines of shapes that are 1 or 2 pixels wide 

may not be apparent. This is only a display issue; the segments are indeed present in the image and you will 
see them if you increase the magnification level.



Controls the roundness of the corners of the rectangle. The Preview window displays the effect of changing this 
control.



Enable this option to automatically convert all new shapes you draw (rectangles, ellipses, polygons, and lines) to 
objects that float above the image. Objects can be easily moved, sized, or transformed.



Following topic is required in the Polygon and Line Tool 
Settings Roll-Up ONLY.



Controls the type of joint that is placed between segments that created using the Line tool, and between the 
segments of shapes that you draw with the Polygon tool when you use a Width value other than zero. Choices 
are Butt, Filled, Round, and Point. 
· Butt: the segments are joined normally; if their outline is wide, a gap appears between two joined segments.
· Filled: the gap caused by the overlap of the segments is filled.
· Round: the corners are rounded.
· Point: the corners are pointed.



Text tool - Tool Settings Roll-Up



Lists all the available fonts on your system. Select a font by clicking on the font name.



Displays and lets you change the size of the currently chosen font. Choose a font size that is displayed in the 
Size list box or type a numeric value for the size you want.



Type the percentage of the current font size you want to use for inter-character spacing.



Type the percentage of the current font size you want to use for inter-line spacing.



Click to enable or disable bold character formatting.



Click to enable or disable italic character formatting.



Click to enable or disable underline character formatting.



Click to place the text immediately to the right of the location you clicked when you created the text.



Click to center text on the location you clicked when you created the text.



Click to place the text immediately to the left of the location you clicked when you created the text.



Displays a sample of the currently selected font with the applied font settings (e.g., bold, italics, size).



Enable this option to make the text you create in the Image Window convert automatically to a text-shaped 
mask selection.



IDs for the Property Bar for Text tool are aliased to the 
topics above except the following which is a stacked 
control that combines two of the above controls.



Inter-character spacing (Top)
Type the percentage of the current font size you want to use for inter-character spacing.
Inter-line spacing (Bottom)
Type the percentage of the current font size you want to use for inter-line spacing.



Objects Roll-Up (View menu, Roll-Ups command)



Objects Roll-Up
The Objects Roll-Up lists all objects in the current image, and provides a thumbnail representation of each object.
The purpose of the Objects Roll-Up is to facilitate object management and editing. It also provides access to 
three object-editing modes.
In the objects list, you can select objects, change their position in the stacking order, and assign descriptive 
names to each object. You can make the objects list longer if there are too many objects in the active image for 
all of their thumbnails to appear in the Roll-Up.
Controls in the Roll-Up allow you to hide objects from view, lock them to protect them from change, change their 
overall opacity, and choose the editable object when working in Single or Layer mode.
For your convenience, several menu commands that are related to objects are also provided as buttons in the 
Roll-Up. These commands include the Create Object From Mask, Create Mask From Object, Delete, and Combine 
Objects With Background. 
The Objects Roll-Up is also where you choose the merge mode you want to use when you combine an object with
the image background. The merge mode determines how the color of the object mixes with the color of the 
background.



Object Roll-Up What’s This?



Click to work in the default Multi object editing mode. In Multi mode, what you see is what you can edit using 
Corel WEB.PhotoPaint’s tools and commands. You can use the Objects Roll-Up’s padlock icons to protect objects 
or the image background from editing changes.



Click to work in Single mode; this locks all objects except the one that is currently selected. A pencil icon appears
in the Roll-Up next to the name of the editable object. Only this object can be edited with Corel WEB.PhotoPaint’s
tools; the rest of the image is protected.



Click to work in Layer mode; this places the top-most object on a transparent layer that covers the entire image. 
Only this object can be edited; changes are applied to the new layer and do not affect the underlying image. The
pencil icon in the Roll-Up identifies the object that is currently editable in this mode.



Sets the overall opacity of the selected object. Move the slider to the right to increase opacity and to the left to 
decrease opacity. 



Click to unlock all objects in the current image. When you unlock the objects, the padlock icons to the right of the
objects are opened, indicating that each one can be accessed and manipulated independently.



Click to lock all objects that are not selected. You must be working in Multi mode for this button to work.



The Merge Mode box lets you choose the way in which the colors of the object and the colors of the background 
image are combined when the object is merged with the background. You can preview the result of using each 
merge mode directly in the Image Window. Highlight each merge mode sequentially and look at the selected 
object in the Image Window. When you find the mode you want to apply, select the Combine, Objects with 
Background command in the Objects menu.



Creates a mask selection that has the same shape as the selected object. The Preserve Image command located 
in the Image menu affects the result of using this button. If Preserve image is disabled, the object’s pixels are 
merged into the background and the object’s boundary is converted into a mask marquee. If Preserve Image is 
enabled, the object is kept and the mask selection is created on top of it. You can move either the object or the 
mask selection to see the other.



Creates an object that has the shape of the current mask selection. The Preserve Image command (Image menu)
affects the result of using this button. 
If Preserve Image is disabled, the mask selection is converted to an object. The object is created using the pixels 
that are included in the selection and is cut away from the background image. When the object is moved, a 
paper-colored impression of the original mask selection remains.
If Preserve Image is enabled, the mask selection is copied to create the object; the background image remains 
intact and visible when the object is moved.



Merges the selected object(s) with the background and uses the merge mode displayed in the Merge Mode box 
at the bottom of the Roll-Up. 
Combining is a permanent operation. Choose Edit, Undo immediately to undo the operation. Once combined, the
object becomes permanently embedded in the background image. 



The Delete Object button deletes the currently selected object(s) from the image. When you delete an object, 
the object is removed from both the image and the Objects Roll-Up list.



Creates a new empty layer that covers the entire image. You can create a new object on the new layer by using 
any of Corel WEB.PhotoPaint's tools. The object you create is on the layer and does not affect the underlying 
image.



Opens a flyout that includes commands for choosing the size of the thumbnails of the objects. The default size is 
small. Flyout commands also allow you to hide the thumbnails and to update them after you edit    objects.



Displays a thumbnail of each object and the background of the current image. The eye icon indicates whether 
the object is currently visible; when the icon is black, the object is visible, if the icon is gray, the object is hidden.
The padlock, which is displayed when you work in Multi mode, indicates whether the object is editable or 
protected. In Single or Layer mode, the padlocks are replaced with a single pencil icon that is used to identify 
and choose the object that is editable. Each object has a name that you can edit.



EYEDROPPER TSR



Controls the sample size of the eyedropper tool. The final color that the Eyedropper tool produces is the average 
color of the sample area. There are three preset sample sizes and a custom area option. 
· Point picks up the color of the single pixel located directly beneath the tip of the eyedropper.
· 3x3 averages the color of the 9 pixels located directly beneath the tip of the eyedropper.
· 5x5 averages the color of the 25 pixels located directly beneath the tip of the eyedropper.
· Custom lets you define the size of the sample area. Click and drag to enclose the sample area.



Enable to choose the fill color by right-clicking.



Nib controls (shared by all brush tools TSRs, 
property bar, and the Nibs Roll-Up)



Displays the width of the current nib, measured in pixels. To adjust this value, type a new number or adjust the 
current value using the scroll arrows. 



Click to display the Create From Mask flyout, which opens the Create a Custom Brush dialog box. This dialog box 
allows you to create a custom nib from the shape of a masked selection. 



Displays the current nib. This Preview window reflects any changes you make to the nib as you make them. If the
nib is too large to appear at its actual size, its size in pixels will display in the window.



Displays the current transparency level of the nib. To change the value, type a new value or adjust the existing 
value using the scroll arrows. You can type a value between 0 and 99: a value of 0 is opaque, while a value of 99 
is as close to totally transparent as you can get. 



Click to choose a round nib. 



Click to choose a square nib. 



Displays the flatness of the current nib. To change the value, type a new value or adjust the existing value using 
the scroll arrows. A nib with a flatness value of 0 is as tall as it is wide. If you want a nib that is half as high as it 
is wide, type a value of 50. You can type values between 0 and 99.



Displays the angle at which the current nib is rotated. To change the value, type a new value or use the scroll 
arrows to adjust the existing value. You can type values between 0 and 360, corresponding to the number of 
possible degrees of a rotation. 



Displays the current soft edge setting, which controls the transparency of the nib's edges. As you increase the 
value of this setting, the soft edge expands to eventually reach the center of the paint stroke. Low values affect 
only the rim of the brushstroke.



Create A Custom Brush dialog box



Type a nib size in pixels for the custom nib you are creating. If you want to be able to use this nib later, add it to 
the Nib list in the Nibs Roll-Up.



Save Brush dialog box



Type a name for your custom brush. The next time you select the current tool, your custom brush will appear as 
an option in the Type list box.



Nibs Roll-Up flyout menu commands



Click to open the nib flyout menu, which contains commands that let you add and delete nibs, as well as load, 
save, combine, and reset the nib palette. 



Displays the nibs in the palette that is loaded. Click to choose one. 



Adds the nib that you are currently using to the palette. If you are working with the default PNTNIB.NIB palette, 
you must re-save the palette using a different file name if you want the nib to be a permanent addition. 
Otherwise, the new nib will disappear when you use the Reset To Defaults command.



Deletes the selected nib from the palette. 



Opens the Nib Save As dialog box, which lets you save the current nib palette. This file will be saved with 
the .NIB file extension.



Opens the Nib Load dialog box, which lets you choose a new palette to load. Nib palettes have the .NIB file 
extension.



Opens the Nib Append dialog box, which lets you add another palette to the current one. To save this as a new 
palette, click Save As from the Nibs flyout menu. 



Click to load the default nib palette. 



Tab 1 of brush tools TSRs



Displays the current paint mode. Paint modes determine the way the paint is applied to the colors that already 
exist in your image. The default mode, Normal, simply replaces the existing colors with the paint color. For 
information on how each of the paint modes works, see the Painting, filling, and editing section of the online 
help. 



Displays the last four tools used. To view all available tools, click the down arrow (the arrow is grayed out on the 
Clone tool picker, because there are only four Clone tools). To select a tool, click its icon. You can achieve 
different effects with each tool by using different brush types (available in the Types box), or by customizing 
different brush settings. 



Click to open the brush flyout menu, which contains commands you can use to delete and reset brush types.



Displays the currently selected brush. To choose a different preset brush, choose a different one from the list 
box. Each tool (e.g., Airbrush, Spray Can) features a number of preset brushes. If you save a custom brush while 
using a tool, that brush will be added to the presets for that tool.



This setting controls the rate at which the effect or paint is applied to the image, ranging from 1 to 100. A higher 
value results in a more pronounced effect or heavier application of paint. To change the setting, type a new value
or adjust the existing one using the scroll arrows. 



Click to open the Save Brush dialog box, which allows you to assign a name to a customized brush. The custom 
brush will be added to the list of preset brushes for the tool you are using. 



Brush flyout menu commands



Deletes the selected brush. 



Resets the preset brush list for the current tool to its default settings. 



Resets the current brush to its default settings.



Resets all preset brushes to their default settings. 



Tab 2 of brush tools TSRs



Displays the current brush texture.



Click to open the texture flyout menu, which contains commands that let you load and reset textures.



Displays the amount of texture currently used in the brushstroke. To change this value, type a new value or 
adjust the existing values using the scroll arrows. A higher value will result in a more pronounced effect. 



Controls the smoothness of the brushstroke. To adjust this setting, type a new value or adjust the existing one 
using the scroll arrows. A higher value will result in a more pronounced effect. 



Displays the current bleed setting, which controls the application of color throughout the brushstroke in 
conjunction with the Sustain Color control. A brushstroke with a bleed value will, during the course of an 
extended brushstroke, run out of paint and simply smear the background colors (as though you were painting 
with a wet brush). With Sustain Color, traces of the paint color remain throughout the brushstroke.



Displays the current edge texture setting, which controls the amount of texture applied to the edges of your 
brushstroke. Edge texture is only apparent if the nib has a soft edge. To adjust this setting, type a new value or 
adjust the existing one using the scroll arrows. A higher value will result in a more pronounced effect. 



Displays the current Sustain Color setting, which controls the application of color throughout the brushstroke in 
conjunction with the bleed control. A brushstroke with a bleed value will, during the course of an extended 
brushstroke, run out of paint and simply smear the background colors (as though you were painting with a wet 
brush). With Sustain Color, traces of the paint color remain throughout the brushstroke.



Enable this control to produce smooth-looking curved or diagonal edges when you use this tool and prevent 
jagged edges from appearing.



Enable this control to make the effects of brushstrokes cumulative. Disable it if you want each brushstroke to 
"max out" after a certain point. For example, if you are applying a tint to an area and wish it to appear uniform, 
disable the cumulative option.



Tab 3 of brush tools TSRs



Controls the number of dabs in the brushstroke. Use this control in conjunction with the Spread and Spacing 
controls, which let you specify the layout of the dabs along the brushstroke.



Controls the spacing between dabs along the length of the stroke. To adjust this setting, type a new value or 
adjust the existing value using the scroll arrows. A value of zero will result in a solid line. A higher value will allow
you to distinguish between the dabs in the brushstroke.



Controls the distance between dabs along the width of the brushstroke. To adjust this setting, type a new value 
or adjust the existing value using the scroll arrows. A higher value will result in a more pronounced effect.



Controls the length of the brushstroke before it fades out. To adjust this setting, type a new value or adjust the 
existing value using the scroll arrows. A higher value will result in a more pronounced effect.



Controls the hue variation in the brushstroke. The higher the value, the more hues will be included in the 
brushstroke. To adjust this setting, move the slider or type a new value in the box.



Controls the saturation variation in the brushstroke. The higher the value, the more variance there will be in the 
saturation of the colors that are included in the brushstroke. To adjust this setting, move the slider or type a new 
value in the box.



Controls the lightness variation in the brushstroke. The higher the value, the more variance there will be in the 
lightness and darkness of the colors that are included in the brushstroke. To adjust this setting, move the slider 
or type a new value in the box.



Image List Attributes dialog box



Type values in the Images Per Row and Images Per Column boxes to define how the image list will be created 
from your document (you are essentially specifying a grid). Corel WEB.PhotoPaint will multiply these two values 
and type the result in the Number Of Images box. You can lower this value if you want to, but you cannot exceed 
it.



Type values in the Images Per Row and Images Per Column boxes to define how the image list will be created 
from your document (you are essentially specifying a grid). Corel WEB.PhotoPaint will multiply these two values 
and type the result in the Number Of Images box. You can lower this value if you want to, but you cannot exceed 
it.



Displays the total number of tiles the selected image is divided into based on the values you typed in the Images
Per Row and Images Per Column boxes. The tiles are numbered sequentially starting with the top left tile and 
ending with the bottom right tile. You can lower this value if you want to, but you cannot exceed it unless you 
adjust the values in the boxes above.



Displays the order in which the images will be sprayed in each brushstroke. To choose a different option, click the
down arrow and choose one from the list box. 



Use the From and To boxes to determine the range of images you want to use. Type the number of the first 
image you want to use in the From box, and the last image you want to use in the To box. The image range will 
encompass those images and all that fall between them. 



Use the From and To boxes to determine the range of images you want to use. Type the number of the first 
image you want to use in the From box, and the last image you want to use in the To box. The image range will 
encompass those images and all that fall between them. 



Undo tools TSR



Click to automatically replace the paint color with the paper color. The color tolerance settings determine the 
extent of the replacement. 



Topics on the Property Bar that couldn't be 
aliased



Displays the current paint mode. Paint modes determine the way the new colors combine with the colors that 
already exist in your image. 



Move the slider to adjust the nib size, or type a value into the box.



Displays the transparency value of the effect. To change the transparency, type a new value in the box, or use 
the scroll arrows to adjust the existing value. 



Click this tool and click your image to zoom in to the next preset level.



Click this tool and click your image to zoom out to the next preset level.



Displays the name of the currently loaded image list.



Click to open the Load Image List dialog box, which lets you select an image list to open. 



Click to return all controls to their default settings. 



Click to save the currently selected objects as an image list.



Click to open a menu that lets you save and delete brushes, as well as reset brush settings to their default 
values. 



Property Bar - Object Picker tool (stacked controls and 
others requiring different topics)



Mode buttons - Common to both the Object Picker tool 
and the Mask Transform tool



When enabled, displays controls for changing the location of the selected object or mask marquee depending on 
the tool that is active: Object Picker or Mask Transform tool.



When enabled, displays controls for rotating the selected object or mask marquee depending on the tool that is 
active: Object Picker or Mask Transform tool.



When enabled, displays controls for scaling and flipping the selected object or mask marquee depending on the 
tool that is active: Object Picker or Mask Transform tool.



When enabled, displays controls for changing the dimensions of the selected object or mask marquee depending
on the tool that is active: Object Picker or Mask Transform tool.



When enabled, displays controls for skewing the selected object or mask marquee depending on the tool that is 
active: Object Picker or Mask Transform tool.



When enabled, distortion handles appear along the selected object or current mask marquee in the Image 
Window depending on which tool is active: the Object Picker or Mask Transform tool. Drag the handles to distort 
the object or mask marquee.



When enabled, perspective handles appear along the selected object or current mask marquee in the Image 
Window depending on which tool is active: the Object Picker or Mask Transform tool. Drag the handles to apply 
perspective to the object or mask marquee.



Property Bar - Object Picker tool and Mask Transform 
tool - Position mode controls



These controls are available for both the Object Picker and the Mask Transform tools.
Horizontal box (Top)
Type the horizontal value needed when transforming the mask marquee or the selected object. 
Vertical box (Bottom)
Type the vertical value needed when transforming the mask marquee or the selected object. 
When working in The horizontal and vertical values correspond to
Position mode Ruler coordinates for the left and top of highlighting box.
Rotate mode Ruler coordinates for the location of the center of rotation.
Scale mode Percentage of current dimensions
Size mode Dimensions for the widest and longest sections.
Skew mode Skew factors in degrees.



Click to group or ungroup the selected objects. The name of the button toggles between Group and Ungroup.



Property Bar - Mask Transform tool - Rotate mode 
controls



Click to rotate the mask marquee 90 degrees in a counter-clockwise direction.



Click to rotate the mask marquee 90 degrees in a clockwise direction.



Property Bar - Repeat Stroke tool (Stacked controls)



Add Last Stroke (Top)
Click to add the last brushstroke created in the Image Window to the list of strokes that can be repeated using 
this tool. The list is displayed to the right of this control. Brushstrokes you add to the list are saved as paths with 
a .PTH extension.
Delete Stroke (Bottom)
Click to delete the stroke whose name is currently displayed in the Stroke List from the list. A dialog box will 
appear asking if you also want to delete the path file for that stroke that is on disk.



Scaling factor (Top)
Type a scaling factor to apply to the selected brushstroke. Values below 100 shrink the stroke height and width 
proportionally, values above 100 increase them. The starting point of the stroke does not move when the stroke 
is scaled.
Scale variation (Bottom)
Type the maximum variation acceptable for the size of the stroke when applying several repetitions of the stroke 
in a single click, or when you plan on clicking several times. If you leave the stroke scale at 100%, choose a 
variation of 20%, and choose several repetitions, the repeated strokes will be between 80% and 120% of the 
original size (100% plus or minus 20%). Using the same example, let’s suppose you set the repeat number to 1, 
each successive click of the tool in the image will also result in a stroke that is between 80% and 120% of the 
original.



Stroke rotation angle (Top)
Type a rotation angle for the selected brushstroke. The starting point of the stroke is the center of rotation, or the
pivot around which the brushstroke is rotated.
Angle variation (Bottom)
Type the maximum angle variation you want between each stroke created in the image. This makes the angle of 
individual strokes differ when you have set several repetitions per click, or, with a single repetition, when you 
click several times in the Image Window.



Repetition number (Top)
Type the number of strokes you want to create with each click in the Image Window, or each time you click and 
drag to define an area in the image. Set an angle variation to have each repetition of the stroke at a different 
angle. If the angle variation is zero, all repetitions of the stroke are performed over the same area in the image. 
This makes a non-opaque stroke progressively darker.
Accumulate angle increment (Bottom)
Type an angle increment to add to each repetition of a stroke to the angle of the previous stroke. This distributes 
the repetitions of a stroke evenly creating a fan-like result.



Use image colors (Top)
Enable to use the colors found in the image to create the brushstrokes instead of the color used when you saved 
the brushstroke. This works as if you were applying brushstrokes to a painting that is still wet.
Use current paint color (Bottom)
Enable to use the current paint color when creating the strokes instead of the color used when you saved the 
brushstroke.



 Property Bar - Shape tools (controls different from the 
TSR)



This control is found in the Property Bar for the Fill tool and all Shape tools . Click it to open the Select Fill dialog 
box, which lets you choose and edit fill types. When using a Shape tool, the selected fill is applied to the shapes 
you will be creating.



Click to toggle between the current fill type and no fill at all for the shapes you draw with the active tool. When 
this button is not pressed, the current fill, displayed in the Status Bar, will be used to fill the new shapes. You can
click the Fill button to edit the fill's attributes or to change the fill type.



Click to choose a different paint color. When you draw shapes using the active tool, the paint color is used for the
outline of the shape.



Property Bar - Crop tool



Vertical coordinate (Top)
Type the vertical ruler coordinate where you want the top of the cropped area to be located using the current 
units. Click View, Show Rulers to have the rulers display in the Image Window. The value you type here equals 
the distance between the top edge of the crop marquee and the top edge of the original image. 
Horizontal coordinate (Bottom)
Type the horizontal ruler coordinate where you want the left edge of the cropped area to be located, using the 
current units. Click View, Show Rulers to have the rulers displayed in the Image Window. The value you type here
equals the distance between the left edge of the crop marquee and the left edge of the original image.



Width (Top)
Type the width of the crop marquee using the current units of measurement.
Height (Bottom)
Type the height of the crop marquee using the current units of measurement.

Note
· As soon as you type the either the width or height of the cropped area, one side of the crop marquee appears 

in the Image Window starting at the coordinates you specified in the other boxes in the Property Bar. When 
both the width and height are typed, the entire crop marquee is displayed in the Image Window so you can 
size it if necessary before cropping the image.



Stacked Property Bar IDs



Use the From and To boxes to determine the range of images you want to use. Type in the number of the first 
image you want to use in the From box, and the last image you want to use in the To box. The image range will 
encompass those images and all that fall between them. 



Dabs (Top)
Displays the number of dabs in the brush stroke. To change it, type in a new value, or adjust the existing value 
using the scroll arrows. 
Spacing (Bottom)
Displays the spacing between dabs along the length of the stroke. To adjust this setting, type in a new value, or 
adjust the existing value using the scroll arrows. A value of zero will result in a solid line. A higher value will allow
you to distinguish between the dabs in the brush stroke.



Spread (Top)
Displays the distance between dabs along the width of the brush stroke. To adjust this setting, type in a new 
value, or adjust the existing value using the scroll arrows. A higher value will result in a more pronounced effect.
Fade Out (Bottom)
Displays the length of the brush stroke before it fades out. To adjust this setting, type in a new value, or adjust 
the existing value using the scroll arrows. A higher value will result in a more pronounced effect.



Rotate (Top)
Displays the angle at which the current nib is rotated. To change the value, type in a new value, or use the scroll 
arrows to adjust the existing value. You can type in values between 0 and 360, corresponding to the number of 
possible degrees of a rotation. 
Flatten (Bottom)
Displays the flatness of the current nib. To change the value, type in a new value or adjust the existing value 
using the scroll arrows. A nib with a flatness value of 0 is as tall as it is wide. If you want a nib that is half as high 
as it is wide, you would type in a value of 50. You can type in values between 0 and 99.



Click one of the buttons to determine the shape of the nib. Click the down arrow on the nib picker to choose from
a large selection of nib shapes and types.



Click one of the buttons to determine the shape of the nib. Click the down arrow on the nib picker to choose from
a large selection of nib shapes and types.



Click to select uniform fill as the fill type.



Click to select fountain fill as the fill type.



Click to select bitmap fill as the fill type.



Click to select texture fill as the fill type.



Size (Top)
Displays the width of the current nib, measured in pixels. To adjust this value, type in a new number or adjust the
current value using the scroll arrows. 
Flow/Amount (Bottom)
Controls the rate at which the effect or paint is applied to the image, ranging from 1 to 100. A higher value 
results in a more pronounced effect or heavier application of paint. To change the setting, type in a new value, or
adjust the existing one using the scroll arrows. 



Flow/Amount (Top)
Controls the rate at which the effect or paint is applied to the image, ranging from 1 to 100. A higher value 
results in a more pronounced effect or heavier application of paint. To change the setting, type in a new value, or
adjust the existing one using the scroll arrows. 
Soft Edge (Bottom)
Controls the transparency of the nib's edges. As you increase the value of this setting, the soft edge expands to 
eventually reach the center of the paint stroke. Low values affect only the rim of the brush stroke.



Size (Top)
Displays the width of the current nib, measured in pixels. To adjust this value, type in a new number or adjust the
current value using the scroll arrows. 
Flatten (Bottom)
Displays the flatness of the current nib. To change the value, type in a new value or adjust the existing value 
using the scroll arrows. A nib with a flatness value of 0 is as tall as it is wide. If you want a nib that is half as high 
as it is wide, you would type in a value of 50. You can type in values between 0 and 99.



Rotate (Top)
Displays the angle at which the current nib is rotated. To change the value, type in a new value, or use the scroll 
arrows to adjust the existing value. You can type in values between 0 and 360, corresponding to the number of 
possible degrees of a rotation.
Transparency (Bottom)
Displays the current transparency level of the nib. To change the value, type in a new value or adjust the existing
value using the scroll arrows. You can type in a value between 0 and 99: a value of 0 is opaque, while a value of 
99 is as close to totally transparent as you can get. 



Flatten (Top)
Displays the flatness of the current nib. To change the value, type in a new value or adjust the existing value 
using the scroll arrows. A nib with a flatness value of 0 is as tall as it is wide. If you want a nib that is half as high 
as it is wide, you would type in a value of 50. You can type in values between 0 and 99.
Soft Edge (Bottom)
Displays the current soft edge setting, which controls the transparency of the nib's edges. As you increase the 
value of this setting, the soft edge expands to eventually reach the center of the paint stroke. Low values affect 
only the rim of the brush stroke.



Transparency (Top)
Displays the current transparency level of the nib. To change the value, type in a new value or adjust the existing
value using the scroll arrows. You can type in a value between 0 and 99: a value of 0 is opaque, while a value of 
99 is as close to totally transparent as you can get. 
Soft Edge (Bottom)
Displays the current soft edge setting, which controls the transparency of the nib's edges. As you increase the 
value of this setting, the soft edge expands to eventually reach the center of the paint stroke. Low values affect 
only the rim of the brush stroke.



Opens the Create a Custom Brush dialog box, which allows you to create a custom nib from the shape of a 
masked selection. 



The following are toolbar buttons (Customize, Toolbars, 
Tool Properties) for Object Picker and Transparency 
tools, Mask tools, Repeat Stroke, Shape, Text, Crop 
tools)
These topics are for the controls that for some insane reason do not share an ID that already exists somewhere 
for Property Bar, Tools Settings Roll-Up or command ID.



Object Picker



Click to see the Property Bar controls that allow you to change the selected object's dimensions. You can also 
drag the handles found along the objet's highlighting box to change the object's width or height.



Click to see the Property Bar controls that allow you to precisely choose the location of the selected object. You 
can also click inside the object and drag it to a new location.



This control is common to both the Object Picker and Mask Transform tool. Click to apply the selected 
transformations to the selected object(s) or to the current mask marquee permanently.



Object Transparency Tool



Type the transparency value, between zero and 100, for the start and end points of the object’s transparency 
blend with the rest of the image. Zero is opaque, 100 is completely transparent. 
The top box is the start point's transparency, the bottom box is the end point's transparency.



Mask tools



When enabled, displays controls for skewing the current mask marquee in the Property Bar and in the Tool 
Settings Roll-Up.



When enabled, displays controls for changing the location of the current mask marquee in the Property Bar and 
in the Tool Settings Roll-Up.



When enabled, displays controls for changing the dimensions of the current mask marquee in the Property Bar 
and in the Tool Settings Roll-Up.



When enabled, displays controls for scaling and flipping the current mask marquee in the Property Bar and in the
Tool Settings Roll-Up.



Repeat Stroke tool



Click to load a saved path as a brushstroke.



Click to change the attributes of the brush used to create the selected stroke originally. Attributes include brush 
size, nib angle, transparency level among others.



Applies the selected stroke and options to the current path in the image. Paths are created with the Path Node 

Edit tool .



Shape tools



Width (Top)
The function of this control varies with the specific Shape tool that is active. For the Rectangle, Ellipse, and 
Polygon tools, it controls the size of the border, or outline, in pixels. A value of 0 produces a shape without a 
border. For the Line Tool, it controls the width of the line in pixels. The minimum line width is 1.
When viewing your image at a zoom level below 100%, some outlines of shapes that are 1 or 2 pixels wide may 
not be apparent. This is only a display issue; the segments are indeed present in the image and you will see 
them as you increase the magnification level.
Transparency (Bottom)
Displays the current transparency level of the nib. To change the value, type a new value or adjust the existing 
value using the scroll arrows. You can type a value between 0 and 99: a value of 0 is opaque, while a value of 99 
is as close to totally transparent as you can get.



Status Bar and other screen elements What's this? Help 
topics



Indicates whether you have caps lock on.



Displays the current date.



Displays the currently selected fill. 



Displays the total amount of free space on the swap disks you have defined for temporary file storage. Choose 
the swap disks using the Options command in the Tools menu.



Displays the coordinates of the current cursor position in the Image Window, in pixels, relative to the rulers. 
When the mouse is over a tool, this space shows a description of that tool.



Displays the current time.



Displays the icon associated with the active mask mode: Normal, Additive, Subtractive, or XOR mask mode. 
Choose the mask mode from the Toolbars or in the Mask menu.



Displays the current paint color. 



Shows the amount of RAM reserved for images you open and edit in Corel WEB.PhotoPaint. You choose the 
amount using the Options command in the Tools menu.



Displays an icon when a mask is present in the Image Window.



Indicates whether you have scroll lock on.



Displays the current paper color. 



Indicates whether you have a movie file open.



Indicates whether you have number lock on.



Displays the icon associated with the active Object Editing Mode: Multi, Single, or Layer. Choose an editing mode
from the Objects Roll-Up or the Toolbar.



Indicates whether you have a partial file loaded.



Other Screen elements



Use the rulers to determine the size and spacing, and position of objects, brush strokes and other elements in 
your image. To change the units displayed on one or both rulers, double-click the horizontal or vertical ruler, or 
click Tools, Grid And Ruler Setup. To change the units for both rulers for the all images, click Tools, Options, and 
choose the General tab.
To reposition the ruler origin, drag from the ruler intersection point onto the Image Window. As you drag, 
crosshairs appear. Release the mouse button when the crosshairs are where you want to place the origin.
To move a ruler, hold down SHIFT and drag it onto the Image Window. To move both rulers at the same time, hold
down SHIFT and drag the ruler intersection point.



Use the on-screen color palette to select a uniform color to use as the paint, paper, or fill color. Click a color to 
select it as the paint color. Right-click a color to make it the new fill color. Hold down CTRL and click a color to 
make it the new paper color. In all cases, the associated color swatch displayed in the Status Bar is updated 
accordingly. 
You can move the on-screen color palette by dragging it anywhere in the Corel WEB.PhotoPaint screen. When the
palette is floating, i.e., when it is not docked on the right side, or at the bottom of the screen, you can resize it by
placing the cursor near its edge until it becomes a two-way arrow. Drag to change the size of the palette.



TOOLBOX AND TOOLBAR BUTTONS



Selects, moves, and resizes objects. Clicking an object repeatedly with this tool displays handles for transforming
the object. SHIFT click to select multiple objects. Double-click the tool to open the Objects Roll-Up.



Defines rectangular mask selections. Hold down CTRL to create a square. Hold the SHIFT for the center of the 
selection to be where you first clicked in the image when creating it.



Defines elliptical mask selections. Hold down CTRL to create a perfect circle. Hold down SHIFT for the center of 
the selection to be where you first clicked in the image when creating it.



Defines irregularly-shaped or polygonal mask selections. Click and drag to draw the curved edges of the mask 
marquee. Click the start and end points to create a straight line section on the mask marquee. After the first 
click, press ESC to delete the first point and start again. To close the shape of the selection, move close to the 
first point created and double-click.



Defines irregularly-shaped mask selection that include all adjacent pixels that are the similar in color as the pixel 
you first clicked. Adjust the color tolerance in the Property Bar to set the range of colors that should be included 
in the selection. Use this tool when you want to apply an effect to an area that is highly irregular in shape but 
that includes many shades of the same color. You can invert the mask to protect the area and manipulate the 
rest of the image. The Magic Wand’s Property Bar controls for color tolerance and anti-aliasing are also used by 
the Grow and Similar commands in the Mask menu.



Defines mask selections that are irregular in shape and surrounded by pixels of similar colors. Click and drag to 
define the area in which the selection should be created. Double-click to create it. The resulting selection 
includes all pixels within the area you enclosed that do not fall within the color range of the point you first clicked
when defining the area. The mask marquee shrinks to exclude all pixels that fall within the current color range. 
The Color Range is defined using the Tolerance control in the Property Bar. Use this tool to edit part of an image 
that includes many different colors but that is surrounded, at least in part, by a uniform color.



Defines a mask selection by brushing an area as if you were painting. You set the size of the brush in the 
Property Bar and click and drag in the Image Window to create the selection. Release the mouse button only 
when the selection is complete. To use physically separate strokes of the brush to create the selection, enable 
the Additive mask mode.



Use to transform a mask marquee by moving the    handles that appear around it when this tool is selected. It 
allows you to size, scale, move, skew, rotate, distort and apply perspective to a mask marquee. The image pixels
enclosed by the mask marquee are not affected by such transformations unless the selection is floating.



Allows you to create and edit paths in your image. Paths can be used to create masks, apply a brush stroke of a 
specific shape, and create non-rectangular bitmaps for use in other applications. Paths can be saved to disk for 
future use.



Use to define a cropping area on an open image. Click and drag to create a rectangular bounding box. Move or 
resize it by clicking and dragging on the edges or corners. When you are satisfied with the cropping area, double-
click inside it to complete the operation. 



Selects colors from an open image. Use the left mouse button to select a paint color. Use the right mouse button 
to select a fill color. Hold down CTRL and click either mouse button to select a paper color. The Eyedropper tool is
also in the Color Mask dialog box, so you can select colors from your image when creating color-sensitive masks.



Use to magnify areas of your picture. Click to zoom in to the next preset level, right-click to zoom out to the next 
preset level, or click and drag around the area you wish to zoom in on.



Use to drag areas of an image into view when the image is larger than its window. 



Use this brush tool to replace whatever you paint over with the paper color. Hold down CTRL while clicking and 
dragging to constrain the tool to horizontal or vertical movements. Hold down SHIFT at the same time to change 
the direction of constraint.



Use this brush tool to restore areas to the way they looked before your last brush stroke. 



Replaces any paint you have just applied with the paper color. Hold down CTRL while clicking and dragging to 
constrain the tool to horizontal or vertical movements. Hold down SHIFT at the same time to change the 
direction of constraint. Double-click the tool to replace all the paint in your image with the paper color. 



Draws single or joined straight line segments using the paint color. The Render To Object option in the Property 
Bar creates new lines as objects that can be moved and transformed without affecting the underlying image.



Adds text to your image and allows you to edit existing text. Text is by default an object that floats above the 
image background. Use the Property Bar to change the font, style, size and effects. You can manipulate, edit, 
format and transform the text object while it is still an object. Once you’ve combined the text object with the 
background, you can no longer edit it as text. The Render Text To Mask options automatically makes new text 
you type become a mask selection.



Use to fill areas with any of four fill types. You can access the Uniform, Fountain, Bitmap, and Texture fill dialog 
boxes from the Property Bar or Tool Settings Roll-Up, which allow you to create and customize fills. 



Use to paint on an image using the paint color. The Property Bar and Tool Settings Roll-Up contain many preset 
paint tools, such as the Art Brush, Airbrush, Pencil, and Ball Point pen. Hold down CTRL while clicking and 
dragging to constrain the brush to horizontal or vertical movements. Hold down CTRL + SHIFT to change the 
direction of constraint.



Use to draw hollow or filled rectangles and rounded rectangles. Hold down CTRL while clicking and dragging to 
create a square. Hold down SHIFT to draw a rectangle from its center. The Render To Object option in the 
Property Bar creates new rectangles as objects that can be moved and transformed without affecting the 
underlying image.



Use to draw hollow or filled ellipses. Hold down CTRL while clicking and dragging to create a circle. Hold down 
SHIFT to draw an ellipse from its center. The Render To Object option in the Property Bar creates new ellipses as 
objects that can be moved and transformed without affecting the underlying image.



Use to draw hollow or filled polygons. Hold down CTRL while clicking and dragging to constrain the polygon’s 
sides to 45 degree angles. Hold down DELETE to remove the last segment you created. The Render To Object 
option in the Property Bar creates new polygons as objects that can be moved and transformed without affecting
the underlying image.



Use to duplicate part of an image and apply it to another part of the image or to another image altogether. The 
Property Bar and Tool Settings Roll-Up provide specialized clone tools that create a duplicate in the pointillist 
style (dots) and impressionist style (lines), as well as a Clone From Saved tool, which lets you restore parts of 
your image to the way they looked when you last saved. You can achieve different effects by customizing the 
brush you use to apply the effect. 



Allows you to perform local color and tonal corrections on your image. Click the arrow to the right of the tool 
picker on the Property Bar and in the Tool Settings Roll-Up to display the different Effect tools. 



Use to make the colors of an object fade gradually towards the image background color. The object fade is called
a transparency blend; it is a gradient fill that uses the object’s current color and transparency. Click and drag to 
determine the direction, the start and end points, of the object transparency. The object’s shape can be altered 
by the use of this tool.



Use to load up one or more images and spray them on your image. You can change the size, tiling, and order of 
the images, as well as create new image lists.



Brush areas on an object to make them more transparent.



What's this button on Standard toolbar



Click this button, and then click any item on the screen to view help on that item.



what's this for tools on Paint Tools toolbar



Click to paint with the Art Brush. 



Click to paint with the Air Brush. 



Click to paint with the Spray Can. 



Click to draw with the Pencil tool. 



Click to draw with the Ballpoint Pen tool. 



Click to draw with the Calligraphy Pen tool. 



Click to draw with the Felt Pen tool. 



Click to draw with the Marker tool. 



Click to draw with the Highlighter tool. 



Click to draw with the Chalk tool. 



Click to draw with the Crayon tool. 



Click to draw with the Charcoal tool. 



Click to draw with the Pastel tool. 



Click to paint with the Water Color brush. 



Click to paint with the Artistic brush.



what's this for tools on Clone Tools toolbar



Click to use the Clone tool, which lets you duplicate part of an image and apply it to another part of the image or
to another image altogether. You can achieve different effects by customizing the brush you use to apply the 
effect. Click to place the source point, and then click and drag over the destination point. 



Click to use the Impressionism Clone tool, which lets you duplicate part of an image and apply it to another part 
of the image using an Impressionist brush style. 



Click to use the Pointillism Clone tool, which lets you duplicate part of an image and apply it to another part of 
the image using a Pointillist brush style. 



Click to use the Clone From Saved tool, which lets you restore parts of your image to the way they were last time
you saved. 



what's this for tools on Effects Tools toolbar



Click to use the Smear tool, which allows you to smear colors in your image selectively by brushing over them. 
You can achieve different types of smearing by selecting different options in the Brush Type box (on the Property 
Bar and the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Click to use the Smudge tool, which allows you to decrease the definition between colors or hard edges in your 
image selectively by brushing over them. You can achieve different types of smudging by selecting different 
options in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), or by changing the size and 
shape of the brush you use to apply it.



Click to use the Brighten tool, which allows you to brighten or darken areas in your image selectively by brushing
over them. You can achieve different types of brightening by selecting different options in the Brush Type box (on
the Property Bar or the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Click to use the Contrast tool, which allows you to soften the definition between colors or hard edges in your 
image selectively by brushing over them. You can achieve different types of blending by selecting a different 
option in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), or by changing the size and shape
of the brush you use to apply it.



Click to use the Hue tool, which allows you to shift the hues in your image selectively by brushing over them. You
can achieve different types of effect by selecting different options in the Brush Type box (on the Property Bar or 
the Tool Settings Roll-Up), by changing the number of degrees the hues will shift around the color wheel in the 
Amount box, or by changing the size and shape of the brush you use to apply it.



Click to use the Hue Replacer tool, which allows you to replace the hues in your image selectively by brushing 
over them. This effect is based on the paint color. You can achieve different types of effect by selecting a 
different option in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), by changing the number 
of degrees the hues will shift from the paint color (around the color wheel), or by changing the size and shape of 
the brush you use to apply it.



Click to use the Sponge tool, which allows you to saturate or desaturate areas of your image selectively by 
brushing over them. You can achieve different types of effect by selecting a different option in the Brush Type 
box (on the Property Bar or the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to 
apply it.



Click to use the Tint tool, which allows you to tint areas of your image with the paint color by brushing over 
them. You can achieve different types of effect by selecting a different option in the Brush Type box (on the 
Property Bar or the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Click to use the Blend tool, which allows you to soften the definition between colors or hard edges in your image 
selectively by brushing over them. You can achieve different types of blending by selecting a different option in 
the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), or by changing the size and shape of the 
brush you use to apply it.



Click to use the Sharpen tool, which allows you to sharpen areas of your image selectively by brushing over 
them. You can achieve different types of sharpening by selecting a different option in the Brush Type box (on the 
Property Bar or the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Click to use the Undither tool, which allows you to create a smooth transition between adjacent pixels of different
colors or brightness levels. It works by adding intermediate pixels whose values are between those of the 
adjacent pixels. Use this tool to remove dust and scratches and to smooth jagged edges.



What’s this for the Animation toolbar
· All buttons share the same ID as the menu commands except for the slider described n the following topic



Drag the slider to display a different animation frame in the Image Window. The number of the frame appears in 
the box to the right of the slider.





This file includes the context-sensitive help for the Tools menu including:
· command descriptions (F1)
· dialog box controls What’s This? Topics

Except:
· Roll-Up groups command description????
· Grid and Ruler set up dialog box controls topics (see CDRUI)
· Guideline Setup dialog box controls topics (see CDRUI)

Note
· The dialog box overviews are aliased to Overviews of various chapters that deal with their respective uses. 

(see PHOTOPNT.ALI)



Tools Menu commands



Opens the Options dialog box, which lets you customize Corel WEB.PhotoPaint. There are six tab pages in the 
dialog box: General, Advanced, Memory, Display, Marquee, and Plug-In Filters. 
The options allow you to choose the color of object and mask marquees, the units of measurement to use in the 
Tool Settings Roll-Up for the Object Picker tool and the Mask Transform tool, the nudge distances, memory 
management options, automatic backup folder and time intervals, and much more.



This command is only available when you have installed a pressure-sensitive pen and tablet and its associated 
driver. The command opens the Pen Settings dialog box that lets you control the relationship between the 
pressure you apply to the tablet and the effect produced when using different paint tools. As you press down on 
a drawing tablet with a pen, causing the pressure to change, the paint effect also changes. For example, if you 
set the Size option to 10 percent, as you apply pressure to the tablet, the nib widens (just as a paintbrush would 
as you apply more pressure to the stroke) by a maximum of 10 percent. 
You can also assign a Corel WEB.PhotoPaint tool to the eraser of your pen.



Opens the Grid And Ruler Setup dialog box, which allows you to select measurement units. You can also set tick 
divisions and the origin point for the rulers, and grid attributes such as spacing.



Opens the Guidelines Setup dialog box, which allows you to set up, move, or delete Horizontal and Vertical 
guidelines.



Enables or disables the Snap To Grid option. When Snap To Grid is enabled, floating objects and mask selections 
are constrained to the grid points.



Enables or disables the Snap To Guideline option. When Snap To Guideline is enabled, floating objects and mask 
selections are constrained to the guidelines.



Options dialog box( General tab)



Choose to have one of three dialog boxes open automatically when you launch Corel WEB.PhotoPaint. By default,
the Welcome screen is displayed each time you launch the application. From the Welcome screen you can start a
new image or open an existing one among other options. If you use Corel WEB.PhotoPaint mostly for image 
editing, you can choose to have the Open An Image dialog box displayed immediately when you launch the 
application.



Choose the units of measurement for both the Horizontal and Vertical rulers in all images. The units you select 
are also used when applying object and mask transformations with the controls for the Object Picker and Mask 
Transform tools, and are used by the Image Info command found in the Image menu and the Crop tool.
You can also choose the units in the Grid and Ruler Setup dialog box. This dialog box allows you to set different 
units for the Horizontal and Vertical rulers; the units chosen are only applied to the active image’s rulers. The 
units you choose in the Options dialog box are used for the active image as well as all new images. 



Type the distance in pixels you want objects and mask marquees to move when you press an Arrow key on your 
keyboard.



Type a multiple of the nudge distance you want to use when moving objects and mask marquees by holding 
down    SHIFT and pressing an Arrow key on your keyboard.



Choose the appearance of the cursor when you use tools in the Image Window. The Object Picker and Text tools 
always keep their default shape.
Shape
Displays the current shape and size of the tool's nib (which varies with the tool selected). For example, if the 
Effect tool is selected, the cursor changes to reflect the current nib shape based on the settings you choose in 
that tool's Property Bar or Tool Settings Roll-Up.
Tool
Displays a representation of the selected tool. For example, if the Paint tool is selected, the cursor is a miniature 
paint brush.
Crosshair
Displays a cursor in the shape of a crosshair for positioning the tool on the image precisely.



Enable this option to make the cursor for all tools that use a brush appear in the shape and current size of the 
brush. This option overrides the Tool or Crosshair option chosen in the Cursor Type box for brush tools only. Brush
tools are the Paint, Effect, Clone, Image Sprayer , Object Transparency Brush, Mask Brush, Local Undo, Color 
Replacer, and Eraser tools. 



Enable this check box so that each time the cursor is over a tool or button, a label identifying the interface 
component is displayed.



Enable to make Image Windows conform to the size of the image when it is resampled, cropped, or in any way 
sized. This eliminates the border area that typically surrounds a resized image.



Determines the level of magnification when files are opened in the Corel WEB.PhotoPaint Image Window. The 
default is 100% which is recommended unless you have a slow graphics board.



Enable to perform multiple Windows operations at once. 



Enable to display a message advising you when you are opening an image that is Read Only. Read Only files 
cannot be saved because saving would overwrite the image. You can, however, make changes to a Read Only file
and use the Save As command to save it with a different name and/or in a different location. The original file still 
exists and is not modified.



Options dialog box (Display tab)



Choose the color of the guidelines you set up using the Guidelines Setup command. Click the color picker and 
choose a color. Click Others to see more colors or to create your own.



Controls the sensitivity of the Snap To Guidelines command. Type a distance in pixels. When the Snap To 
Guidelines command is enabled, if you move an object within the specified distance of a guideline, the object 
snaps to that guideline.



Choose the color of the grid you set up using the Grid And Ruler Setup command. Click the color picker and 
choose a color. Click Others to see more colors or to create your own.



Choose a style for the grid. The grid can consist of solid horizontal and vertical lines, dashed lines, or dots where 
gridlines intersect. You make the grid visible by choosing the Grid command in the View menu.



Choose the color of the mask overlay used to show a mask in the Image Window and in the Color Mask dialog 
box. Click the color picker and choose a color. Click Others to see more colors or to create your own.



Choose the colors used in the checkerboard pattern used to represent transparency. Click the color pickers and 
choose the two colors that make up the pattern. Click Others to see more colors or to create your own. The 
transparency pattern is seen in the Image Window when you hide the image background in the Objects Roll-Up.



Displays the colors you have selected in the checkerboard pattern. This pattern is used in the Image Window to 
represent transparency; transparency occurs when you hide the image background using the Objects Roll-Up 
controls.



Enable to use the standard Windows color palette when you are running Windows in 256 color mode.



Enable this check box to display color channels using their respective colors in both the Channels Roll-Up and in 
the Image Window. Disabling this option displays the color channels in grayscale.



Enable to make Corel WEB.PhotoPaint remember where you placed each dialog box and which page was 
displayed. The next time you access the dialog boxes, they are displayed where you last placed them instead of 
the default position which is in the center of the screen, and the dialog box page you last used is displayed.



Click to display a window used to calibrate on-screen rulers. Place a clear plastic ruler against the screen and 
adjust the horizontal and vertical pixel values until the measurements defined by the on-screen rulers match the 
plastic ruler. This ensures that distances on your screen match real-world distances.



Options dialog box (Marquee tab)



Choose the color of mask marquees. Click the color picker and choose a color. Click Others to see more colors or 
to create your own.



Choose the color of object marquees. Click the color picker and choose a color. Click Others to see more colors or
to create your own.



Choose the color of the marquee that will enclose data you paste into an existing mask selection. This marquee 
is visible only if the pasted data is smaller than the selection it is pasted into. Click Others to see more colors or 
to create your own.



Fine-tunes the position of all mask marquees. This allows you to place mask marquees closer or farther from the 
selection's boundary. This makes it easier to edit the outlining area of a selection because the marquee is not in 
the way. Choose a grayscale value between 1 and 255. Mask marquees will be located along the pixels that are 
located in the feathered section of the mask selection and that have that grayscale value.



Fine-tunes the position of object marquees on objects that have been feathered. Choose a value between 1 and 
255. A value of 255 places the marquee on the outermost pixels of the object that are opaque i.e. not modified 
by the feathering of the object. A value of 1 places the object marquee on the outermost pixels that have been 
modified by the feathering. 



Enable to make the object marquee appear on all objects that are visible in the Image Window.



Enable to make the object marquee appear only around objects that are editable in the Image Window. Objects 
that are visible but not editable, such as locked objects, will not have an object marquee when you enable this 
option.



Options dialog box (Memory tab)



Choose the drive and folder you want to use as the primary swap disk. The swap disks are used by Corel 
WEB.PhotoPaint to store temporary files not currently in use.



Choose the drive and folder you want to use as the secondary swap disk. The swap disks are used by Corel 
WEB.PhotoPaint to store temporary files not currently in use.



Displays the amount of available RAM on your system.



Type the maximum percentage of available memory you want to reserve for images you are creating or editing 
in Corel WEB.PhotoPaint. Once you have typed the percentage, the amount of memory it represents appears to 
the right of this box.



Click to let Corel WEB.PhotoPaint automatically choose the amount of RAM that will be reserved for the images 
you open and edit. 



Enable this check box to make the Undo command available. If you disable this check box, the Undo command is
grayed out, i.e., not available The Undo command is used to undo the last executed command. The Undo 
command is located in the Edit menu.



Enable this check box to make the Undo List command available. Enabling this option uses more of your 
system’s resources. The Undo List command, located in the Edit menu, allows you to undo a sequence of actions 
you just applied to the image. 



Type the number of actions you want the Undo command to be able to reverse. The Undo command reverses 
one action each time it is used. If you repeatedly use the Undo command, you can undo several of the last 
actions performed. The maximum number of Undo levels is 30. Keep in mind that the more levels you use, the 
more swap disk space Corel WEB.PhotoPaint requires to keep track of the state of the image as you edit it.



Options dialog box (Plug-in filters tab)



Displays a list of folders where Plug-In filters are located. You can insert a directory or delete an inserted folder 
using the Add and Remove buttons located to the right.



Opens the Select A Plug-In Folder dialog box that lets you select a Plug-In filter from the default directory. If you 
have placed filters in another drive or directory, you can also access them using this dialog box.



Deletes the folder highlighted in the Plug-In Folders list.



Enable to initialize all Plug-In filters when you launch Corel WEB.PhotoPaint. When disabled, Plug-In filters are not
initialized until you click the Effects menu in your next Corel WEB.PhotoPaint session. This process may take a 
few minutes. 



Enable to display a message advising you that the preview area in the filters dialog box may not be completely 
accurate when working with an image that has objects. Disable this option to stop the message from displaying.



Options dialog box (Advanced tab)



Enable to have the Save or Checkpoint command performed automatically on your image at a specific time 
interval.



Type the amount of time you want between each automatic save or checkpoint.



Enable to have the Auto-Save feature save your file as a checkpoint. A checkpoint temporarily saves your image 
at its current state but does not overwrite the file saved to disk. You can revert to the checkpoint version of your 
image by choosing the Restore To Checkpoint command in the Edit menu. When you enable this option, the 
Auto-Save feature updates the checkpoint version of the image at the time interval you specify in the box above.



Enable to have the Auto-Save feature save your file to disk and overwrite the saved version at the time interval 
you specify in the box above.



Enable to display a message to confirm whether you want the Auto-Save feature performed each time the set 
time interval has elapsed.



Enable to have a backup copy of your images created and updated automatically every time you save the 
image. The backup files are saved with the same file extension as the original file; therefore, they must be saved
in a different location than the original.



Displays the folder used to store the backup copies of your images. If you want to change the folder, enable the 
check box, click inside the text box, and type the complete path of the new folder you want to use to store 
backup copies of your images.



Click to Browse through all drives and folders when choosing the backup location.



Choose one of three scanner transfer modes. The transfer mode determines where the data created by the 
scanner is temporarily placed before it is transferred to Corel WEB.PhotoPaint. Some modes are faster than 
others but require more system resources.    It is recommended that you choose Memory mode for most jobs. If 
there are problems accessing the scan information, choose File or Buffered mode to see if either mode corrects 
the problem.



Enable this check box to display a message asking you to confirm that you want to apply changes performed on 
the image using tools. This message appears when you edit your image using tools such as the Text tool and the 
Gradient Fill tool. Disabling this option makes the changes permanent as soon as they are performed. They can 
only be reversed using the Undo or Undo List commands found in the Edit menu. 



Pen Settings dialog box



Lists all brush tool attributes you can customize when using a pressure-sensitive pen. Enable the check box 
associated with the attribute you want to customize, type a value for it, choose a paint tool, and use the pen in 
the Image Window to evaluate the result. The Pen Settings dialog box remains on screen as you test the 
attributes. For a description of each attribute, click the Help button in this dialog box.



Choose a Corel WEB.PhotoPaint tool that you want to activate automatically when you use your pressure-
sensitive pen’s eraser.    The eraser functionality of the pen is disabled by the selection you make here.



Choose saved pen settings from this list. Saved settings include the pen attributes you chose and the values you 
selected for those attributes



Click to save the current pen attributes and the values you assigned to each as settings. You can reuse saved 
settings at any time. This allows you to change the group of pen attributes you are using according to the task 
you want to accomplish.



Opens a flyout menu that lists three commands:
· Clear values: clears the values currently displayed in the dialog box.
· Delete Selected Setting: deletes the saved setting that is currently loaded in the dialog box. The name of the 

setting is displayed in the Settings list box.
· Delete All Custom Settings: deletes all settings you have saved.



Click this button to apply the values you selected for pen attributes to you pressure-sensitive pen. The Pen 
Settings dialog box remains open on-screen so that you can make adjustments to the values after you using the 
pen in the Image Window.



Closes the dialog box.



GRID AND RULER SETUP DIALOG BOX (CDRUI)



Grid and Ruler Setup dialog box



Ruler tab



Lets you choose which unit of measurement you want to use for the horizontal ruler.



Lets you choose which unit of measurement you want to use for the vertical ruler.



Enable this check box if you want to use the same units for the horizontal and vertical units.



Lets you move the ruler origin  the place where the horizontal and vertical rulers' 0 points meet 
 horizontally. For example, enter 1 inch if you want to move the origin 1 inch to the right. Negative numbers move

the origin to the left.



Lets you move the ruler origin  the place where the horizontal and vertical rulers' 0 points meet 
 vertically. For example, enter 1 inch if you want to move the origin 1 inch upward. Negative numbers move the 

origin downward.



If you're using inches as a ruler unit, use this list box to choose how many division marks ("ticks") you want 
between each inch mark on the ruler.



Enable this check box to display fractions on the rulers. If you leave this box disabled, the rulers display 
decimals.



Grid tab



Click this button if you want to set the distance between grid dots according to how many grid dots you want per
unit of horizontal and vertical distance. For example, if you want grid dots 0.1 inches apart, you would specify a 
frequency value of 10 dots per inch.



Use this box to specify how many grid dots you want for each unit of horizontal distance.



Use this box to specify how many grid dots you want for each unit of vertical distance.



Click this button if you want to set the distance between grid dots by typing the exact distance you want 
between each dot. For example, if you want grid dots 0.1 inches apart, you would specify a value of 0.1.



Use this box to specify how much horizontal distance you want between grid dots.



Use this box to specify how much vertical distance you want between grid dots.



Provides controls that let you set the amount of horizontal and vertical space you want between grid dots.



Enable this check box if you want to show the grid in the Drawing Window. Disable this check box to hide the 
grid.



Enable this check box if you want to have objects automatically line up with the grid as you move or draw them.



GUIDELINE SETUP DIALOG BOX (CDRUI)



Guidelines Setup dialog box



Horizontal tab



Displays a list of existing horizontal guidelines. If you want to edit a guideline, you need to select it here first.



Displays the selected guideline. When a guideline appears in this box, you can use the controls to the right to 
edit it. A value displayed here represents the guideline's position relative to the 0 point on the vertical ruler. If 
you want to add a guideline, type a value here and click Add.



Lets you choose the unit you want to use to set the position of the guideline displayed in the box to the left.



Adds a guideline at the position displayed in the box at the top-left corner of the dialog box. If no value appears 
in the box, this button is grayed out.



Moves the selected guideline to the position displayed in the box at the top-left corner of the dialog box. If no 
value appears in the box, this button is grayed out.



Removes the selected guideline.



Removes all horizontal guidelines from the active drawing.



Locks the selected guideline so that you can't move it by dragging it within the drawing window. Click this button
again to unlock the guideline.



Guidelines Setup dialog box - Vertical tab



Displays the selected guideline. When a guideline appears in this box, you can use the controls to the right to 
edit it. A value displayed here represents the guideline's position relative to the 0 point on the horizontal ruler. If 
you want to add a guideline, type a value here and click Add.



Displays a list of existing vertical guidelines. If you want to edit a guideline, you need to select it here first.



Lets you choose the unit you want to use to set the position of the guideline displayed in the box to the left.



Adds a guideline at the position displayed in the box at the top-left corner of the dialog box. If no value appears 
in the box, this button is grayed out.



Moves the selected guideline to the position displayed in the box at the top-left corner of the dialog box. If no 
value appears in the box, this button is grayed out.



Removes the selected guideline.



Removes all vertical guidelines from the active drawing.



Locks the selected guideline so that you can't move it by dragging it within the drawing window. Click this button
again to unlock the guideline.



Enable this check box to have guidelines appear in the Image Window. Disable this check box to hide all 
guidelines.



Enable this check box to have objects automatically line up with guidelines when you move or create the objects 
nearby.



Removes all Horizontal, Vertical, and Slanted guidelines from the active drawing.





Layout Page



Defines the left limit of the selection area. The limit is measured in the units selected in the Units list box.



Defines the top limit of the selection area. The limit is measured in the units selected in the Units list box.



Defines the width of the selection area relative to the Left parameter. The limit is measured in the units selected 
in the Units list box.



Defines the height of the selection area relative to the Top parameter. The limit is measured in the units selected 
in the Units list box.



Defines the units of measurement for the location parameters and preview window rulers.



Displays pre-defined crop sizes. Only valid sizes for the image are listed. Available sizes depend on the maximum
allowable scan size and on the orientation of the image. If you rotate an image, new crop sizes may appear.



Defines the number of colors that are reproduced in the final scan. The available options depend on the 
capabilities of the attached scanner. As you increase the amount of color, the time to complete the scan and the 
size of the file also increase.



Defines the halftone or dithering scheme used when scanning an image. Halftones allow a scanner to simulate 
shades of gray using varying densities of black dots. Dithering allows a scanner to create the effect of more 
colors by combining two adjacent color pixels to produce the effect of a third. Available options depend on the 
selected color depth as defined by the Depth parameter.



Defines the number of dots per inch (DPI) that the scanner reads from the image. A higher DPI setting creates a 
clearer scanned image; however, the file size of the image and the time to complete the scan also increase.



Rotates the image counterclockwise in 90-degree increments. This setting allows you to preview, scan and save 
the image in a different orientation. This setting affects both the final scan and the preview.



Reflects the image on its original vertical axis. If you rotate the image 90-degrees and then enable the Mirror 
option, the image is mirrored on its original vertical axis, which is now the horizontal axis.



Use this box to choose a custom resolution. Available resolutions vary among different scanner models. If the 
scanner doesn't provide any custom resolutions, this list box is disabled. 



Custom Page



Enables or disables the automatic document feeder (ADF). If the scanner isn't equipped with an ADF, this setting 
is disabled.



Enables a multiple scan mode that allows you to perform two or more consecutive scans using identical settings.
However, you must manually change the document on the scanner in between each scan.



Defines the page size that's being fed into the ADF for scanning. Only page sizes that are supported by the 
scanner are listed. If the scanner isn't equipped with an ADF, this setting is disabled.



Setting changes made in this section only affect the preview image. The settings for the final scan are still 
determined by the Layout settings.



Defines the number of colors that are displayed during the prescan. The valid options depend on the capabilities 
of the attached scanner. As you increase the amount of color, the time to complete the prescan also increases.



Defines the halftone or dithering scheme used when prescanning an image. Halftones allow a scanner to 
simulate shades of gray using varying densities of black dots. Dithering allows a scanner to create the effect of 
more colors than are defined in the graphic by specifying the colors of two adjacent pixels to provide the visual 
effect of a third color.



Defines the resolution of the image that's displayed in the Enhanced Preview window. The specified values 
indicate the scanned resolution in dots per inch (DPI). This box is enabled only if the Enhanced Preview window is
selected.



About Page



Displays information on system resources. Free Page File displays the amount of memory used to store swap 
files. Swap files are used to store information during processing. If this memory is too low, Corel TWAIN may not 
be able to process large images. Physical Memory displays the amount of physical RAM installed in your system. 
Memory Load displays the percentage of available memory currently in use.



Defines the location where Corel TWAIN stores its temporary files. By default this setting is identical to the 
TEMP= variable specified under DOS. You can change this to point to any other valid directory without affecting 
any other applications' temporary files.



Allows you to search for and select a directory to use for Corel TWAIN's Temp directory.



Displays version and copyright information for Corel TWAIN.



Enables or disables progress and error logging and specifies the type of logging to be performed. The information
provided by the log files isn't intended to provide information to you, but may help Corel Technical Support 
diagnose your problem. 



Disables progress and error logging. 



Saves error information to a file.



If you've selected To File and an error occurs, the error information is written to a text file in the selected path.



Allows you to search for, and select a file to use for error logging.



Clears the error log.



Corel TWAIN Dialog Box
The Corel TWAIN dialog box is divided into two parts: the main preview window and the tab pages. The main 
preview window displays a preview of the scanned image when you click Prescan. The tab pages provide a 
variety of settings to help you set up a scan. The tabs that are available depend on the features provided by your
scanner.
If you need to edit the image before scanning it into your application, enable the Enhanced Preview setting. The 
preview image will then appear in the Enhanced Preview window when you click the Prescan button.
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Indicates the manufacturer of the selected scanner.



Indicates the model of the scanner you've chosen from your scanning application.



Indicates the size of the file, in bytes, that's created by the scan, based on the parameter settings you choose on
the Layout page.



Indicates the total amount of RAM and virtual memory, in bytes, that's available to Corel TWAIN.



Indicates the amount of unused disk space, in bytes, on the selected drive.



Initiates the final scan of an image and places it in the graphics application.



Initiates a scan of an image and places it in a preview window.



Closes Corel TWAIN and returns to the currently running application.



Launches help.



Measures the width of the image. The units of measure are set on the Layout page. 



Measures the height of the image. The units of measure are set on the Layout page.



Automatic Document Feeder (ADF)
A mechanical device attached to the scanner that automatically pulls documents from a stack and places them, 
one at a time, on the scanner.



CONTEXT SENSITIVE HELP FOR VIEW MENU (PHOTO-PAINT)



Allows you to magnify or decrease the size of your on-screen image by selecting a zoom level from the flyout 
menu. Zooming in and out of your image allows you to view and work on your image from as close up or as far 
away as you require. 



Sets the zoom level so that one monitor pixel equals one image pixel. If your monitor’s resolution is 1024 x 768 
pixels and your image is 468 pixels wide, displaying it at 100 per cent means that the image will take up 468 of 
the 1024 available monitor pixels.



Displays the image at the size at which it will print. For this command to be accurate, you need to calibrate your 
rulers so that one inch onscreen actually equals an inch.



Adjusts your image to fit the active image Window.



Opens the Toolbars dialog box, which allows you to select the toolbars you want to display.



Displays or hides the Property Bar, which contains controls and options specific to the tool you are using.



Displays or hides the Status Bar, which displays by default across the bottom of your screen.



Opens the Channels Roll-Up, which contains controls and options for working with channels and masks. 



Opens the Color Roll-Up, which contains a model of the active color mode, a mixing area, and the numerical 
values for each of the color’s components. 



Opens the Nibs Roll-Up, which allows you to access preset brush nibs quickly without having to open the Tool 
Settings Roll-Up.



Opens the Objects Roll-Up, which contains controls and options to select, hide, display, lock, order, merge, and 
delete objects. It allows you to edit your objects in any of the three object editing modes, as well as to determine
the merge mode, which specifies how the colors of the object will combine with the background when you merge
it.



Opens the Command Recorder Roll-Up, which allows you to record sequences of commands, so that you can 
perform the commands on multiple images or frames, or use them in later sessions. 



Opens the Scrapbook, which provides drag and drop access to the folders that store the collections of objects 
and photographs that come with Corel WEB.PhotoPaint. You can also use the Scrapbook to browse your system 
and add shortcuts to the locations you access most often.



Opens the Tool Settings Roll-Up, which allows you to select and modify options and properties specific to the tool 
you are using. 



Hides the on-screen Color Palette. 



Displays paletted images' colors in the on-screen Color Palette.



Displays the current custom colors in the on-screen Color Palette.



Displays uniform colors in the on-screen Color Palette.



Displays Netscape Navigator  colors in the on-screen Color Palette. 



Displays Microsoft ® Internet Explorer colors in the on-screen Color Palette. 



Opens the Open Palette dialog box, which allows you to load a custom palette into the on-screen Color Palette.



Displays or hides the rulers.



Displays or hides the grid.



Displays or hides the guidelines.



Disables screen dithering, which is a method of enhancing the display of images on monitors that are capable of 
16-bit color or less. 



Enables the Error Diffusion method of screen dithering, which is a method of enhancing the display of monitors 
that are capable of 16-bit color or less. In error diffusion, the colors or grays are averaged using the accumulated
error over the whole image. This is the most accurate method of screen dithering, but is also the most expensive
in terms of file size and system requirements.



Enables the Ordered method of screen dithering, which is a method of enhancing the display of monitors that are
capable of 16-bit color or less. Ordered diffusion approximates pixel depth using a fixed dot pattern, much like 
the printed halftone. 



Hides the Title Bar and menus, leaving only the image and toolbars visible. To restore your screen, right-click (or 
press ALT + V) and disable the Maximize Work Area command. 



Hides the PHOTO-PAINT desktop and displays your image as large as possible. To restore your screen, press ESC. 



TOOLBARS DIALOG BOX (CDRUI)



Roll-ups - Color Roll-Up
· All the What's this topics for the Color Roll-Up and the Color Selection dialog box are in the Color Manager help

file. The Roll-Up overview calles for the PHOTO-PAINT help file; that is why it is placed in this RTF.



Color Roll-Up
Use the Color Roll-Up to select and edit colors. The Roll-Up is an alternative to using the various Color Selection 
dialog boxes. The advantage of using the Roll-Up is that it remains on-screen, therefore, it allows you to try the 
selected color in the Drawing Window or Image Window and make adjustments to the color quickly. 
The Color Roll-Up provides many different color selection methods, visual representations, and other controls to 
assist you when working with color. You can make different areas of the Roll-Up visible when you need to use 
them, or hide the areas to save space on your desktop.

Basic area of the Roll-Up
The color swatches and the selected color selection mode list box are always visible in the Roll-Up. The swatches
represent the current paper color and paint color. An out-of-gamut color swatch is displayed whenever the active 
color is not reproducible in the color space of the delivery system (usually a printer). 

Optional areas of the Roll-Up
There are several controls and visual representations  also called selectors 
 that you can display to select a new color.

· Color Components
Shows the numeric values for each component of the active color. The color components change depending on
the selected color model. You can use the color components to edit the active color numerically.

· Color Name
Shows the name of the active color (if a name has been defined for the color). You can also use this field to 
rename any color as loong as you are using a custom color palette.

· Color Model Visual Selector
When you work in a specific color model such as RGB, that model's graphical representation is displayed in the
bottom section of the Color Roll-Up. For each color model, there is one or two visual selectors that you use to 
define the color. As you drag the adjustment markers across the selector, the color component values change 
to define the new color. 
If you prefer to select colors using custom color palettes, these palettes are also displayed in this section of 
the Roll-Up. A set of swatches is shown to represent the colors available in the palette. 
The mode in which the image was created determines which color models and palettes are available.

· Mixing Area
The Mixing Area works like an artist’s palette. You can choose colors anywhere in the Color Roll-Up and use 
them in the Mixing Area to create custom colors. The new colors can be added to the custom palette or used 
on the image. You make the Mixing Area visible by clicking  and enable Show Mixing Area.

· Color Blender
The Color Blender is a color selection method which performs blends four colors to varying degrees and 
displays the resulting colors in a grid. You select the four colors to blend and the size of the grid. To see the 
Color Blender, select Color Blend from the Model list box located in the top section of the Roll-Up.

For more information
· For information about a specific control in this Roll-Up, right-click the control and choose What's This?.





Creates a duplicate view of the active image. The new Image Window is placed on top of the first Image Window. 
The two images are linked, and any changes that you make to one are applied to the other.



Layers CorelWeb.PHOTO-PAINT Image Windows so that the Title Bar of each Image Window is visible. To make an 
image active, click the Title Bar of its Image Window.



Arranges CorelWeb.PHOTO-PAINT Image Windows horizontally in equal sizes to fit your screen.



Arranges CorelWeb.PHOTO-PAINT Image Windows vertically in equal sizes to fit your screen.



Arranges minimized images across the bottom of the CorelWeb.PHOTO-PAINT desktop.



Closes the active window. If changes have been made to the image since you last saved it, you will be prompted 
to save the image.



Closes every open CorelWeb.PHOTO-PAINT window. If changes have been made to any of the images since you 
last saved them, you will be prompted to save the images.



Redraws all open images. System-intensive transformations can leave residue on the screen. Refreshing the 
Image Window will remove this residue. 





The Corel WEB.PhotoPaint desktop
The WEB.PhotoPaint desktop includes the work area, Image Windows, main Menu Bar, toolbars, Roll-Ups, and 
anything else that you choose to display while you work.

The work area
The work area is where all the action takes place. When you open an image, its window sits in the work area. 
When you open Roll-Ups, this is also where they sit, unless you drag them away. Like a real desktop, you can 
keep it neat to maximize space, or you can leave images, Roll-Ups and toolbars lying around for easy access.

Image Windows
When you open or create an image, it opens within its own window in the work area. You can move Image 
Windows around by dragging their Title Bars. You can open as many images as your system’s memory will 
permit, and display them in a variety of fashions (piled one on top of the other, cascaded, and tiled horizontally 
or vertically). If you have more than one image open, click anywhere in its window to make it active.

Toolbars and flyouts
Each button on a toolbar represents a command. Some are shortcuts to menu commands; others are commands 
that are available only as toolbar buttons. Since it is unlikely that you will ever need to use all the toolbars at 
once, you can choose which ones to display. 
Flyouts are toolbars that you access through other toolbars. A toolbar button with a small black arrow on the 
bottom right corner indicates a flyout. If you click the arrow, the flyout flies out (hence the name). You can drag a
flyout off its host toolbar by dragging any part of it that is not a button. This doesn’t actually remove it from the 
host toolbar, but it does display it as a separate toolbar, which can be useful if you use the buttons often. You 
can also display them as separate toolbars through the View menu.

Property Bar
The Property Bar contains the controls and options you need to work with whatever tool is currently selected. 

Roll-Ups
A Roll-Up is a dialog box that contains the same sorts of things as most dialog boxes  command buttons, 
boxes, boxes, etc. However, unlike most dialog boxes, you can keep Roll-Ups open while you continue to work. 
This is useful if you need to access the same ones frequently, or if you wish to experiment to get just the right 
effect. If you need to maximize your workspace but wish to keep the Roll-Up handy, roll it up by clicking the 
arrow in the Title Bar. This leaves just the Title Bar visible. Click the arrow again to unroll it.

On-screen alignment aids
Grids, rulers, and guidelines are alignment aids that help you to align or size things on your image with precision.
These tools are only visual , so you don’t have to worry about your image printing with a grid on top of it.

Status Bar
The Status Bar is the bar at the bottom of the Corel WEB.PhotoPaint screen that displays information relevant to 
whatever you are currently doing, whether you are performing an action, or working with masks, objects, or 
paths. 





  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Active window
Additive color model
Anti-aliasing

Bit depth
Bitmap fill
Bitmap
Black and white
Bleed
BMP
Brightness
Browser

Calibration
CDR
CERN
CGI
CGM
Check box
Client application
Client-side
Clipart
Clipboard
Color depth
Color Gamut



Color mask
Color mode
Color model
Color Palette
Color Table
Complex mask
Conical fill
Continuous tone
Contrast
Control point
Corel OCR-TRACE
Corel WEB.PhotoPaint
CorelAPP.INI
CorelFLT.INI
CPT
Crop
Cusp node
Custom Colors (palette)

Default settings
Defringe
Device driver
Disable
Dispacement map
Dither
Drive
Duotone

Embedded object
Emboss

Feathering
Fill color
Filter
Flat drop-off
Floating selection
Folder
Font
Fountain fill

Gaussian Blur
Gaussian drop-off 
Gaussian
GIF
Gradient
Grayscale image
Grayscale
Grid
Group



Highlighting box
HLS
HSB
Hue

Image colors (palette)
Image map
Intensity
Interlacing

Jaggies
JPEG (Joint Photographic Experts Group)

Line art
Linear fill
Linked object
Lossless
Lossy
Luminosity

Marquee
Mask modes
Mask overlay
Mask
Maximize
Menu Bar
Menu
Merge mode
Mesa drop-off
Microsoft® Internet Explorer Colors palette
Moire pattern
Monochrome

NCSA
Netscape Navigator  Colors palette

Nib
Nodes
Noise filters
Noise

Object editing modes
Object Linking and Embedding (OLE)
Object
On-screen Color Palette
Opacity

Opaque
Orientation
Out-of-gamut color
Out-of-gamut color
Overlay



Paint color
Paint mode
Paint program
Paletted color mode
Palette
Paper Color
Path segment
Path
PHOTOPNT.INI
Pixel
Point size
Point
Portrait
Preset brush type
Progressive
Protected area
Pure color

Radial fill
Radio button
Reduce tolerance, path
Resolution
RGB
Roll-Up
Ruler crosshairs
Rulers

Saturation
Scanner
Secondary mouse button
Segment
Selection
Server application
Server-side
Skew
Smooth node
Snap
Spreads
Square fill
Status Bar
Stretch
Swap disk
Swatch
Symmetrical node

Texture fill
Threshold, path
Threshold
Tightness, path



Tiling
Tint
Thumbnail
Toggle
Tolerance
Toolbar
Toolbox
Transformation
Transparent
True color
TRUMATCH Colors

Uniform color
Uniform Colors (palette)
URL

Vector graphics
Visual selector

Well
WIN.INI
Wizard
Workpath



 Active window
The window that contains the image on which you are currently working. 



 Additive color model
A color model, such as RGB, that is based on the behavior of colors of light; these models work by adding colors 
together to produce white.



 Anti-aliasing
Anti-aliasing is a method of smoothing the edges of shapes, objects, and mask selections. Anti-aliasing creates 
intermediate pixels that smooth the transition between colors and sharp edges.



 Aspect ratio
The aspect ratio of an image is the ratio between its width and height. For example, the aspect ratio of an image 
whose dimensions are 640 x 480 pixels is 4:3. You can change an image's aspect ratio by stretching or 
truncating (shortening) either its width or height.



 AVI
The filename extension (Audio Video Interleave) for a Windows video file. .AVI files include video and animation.



 Bit depth
The number of binary bits used to define the shade or color of each pixel in an image. For example, a black and 
white image has a pixel depth of 1 bit (1 or 0 in binary terms). The number of color values a given bit depth can 
produce is equal to two to the power of the bit depth.
Other common bit depths:

4-bit: 16 colors (e.g. standard VGA)
8-bit grayscale: 256 shades of gray 
8-bit color: 256 colors 
24-bit: 16 million colors 
32-bit: 4.3 billion colors

 Bitmap
An image composed of grids of pixels or dots. Scanners and painting programs, such as Corel WEB.PhotoPaint, 
generate this type of image. By contrast, CorelDRAW creates images using vector objects, which are shapes 
stored as mathematical equations. 



 Bitmap fill
A bitmap fill is created from any bitmap image. The images that work best are those that are patterned and can 
tile to create a contiguous pattern, like river stones, coins, or bricks. 



 Black and white
A 1-bit color mode with two possible colors: black or white. This mode is useful for line art and simple graphics.



 Bleed
One of the brush tool settings. The Bleed control works in conjunction with the Sustain Color control to determine
the way in which paint is applied throughout the brush stroke. A brush stroke with a bleed value will, during the 
course of a brush stroke, run out of paint and simply smear the background colors (as though you were painting 
with a wet brush).



 BMP
The filename extension for Windows bitmap files.



Brightness
In the HSB color model, the component that determines the amount of black in a color. 
See also Hue and Saturation.



Browser
Computer software that interprets HTML tags, displays Web pages, and runs Java programs. You use a browser to
view Web pages.



 Calibration
Adjusting a monitor or scanner to display and capture colors more accurately.



 CDR
The filename extension for CorelDRAW files.



 CERN
The birthplace of the World Wide Web. There are two Worldwide Web server systems: CERN and NCSA. Contact 
your server administrator to find out which system your server uses.



 CGI 
Common Gateway Interface is the command protocol between the server and a program. There is a CGI program
for image maps; if you are creating server-side image maps, you must have the image map CGI program on the 
server. Confirm with your server administrator that you can create server-side image maps.



 CGM
The filename extension for Computer Graphics Metafile, a vector-based graphic file format.



 Check box
A small square in a dialog box which you use to enable and disable options. An option is enabled when an X or a 
check mark appears in the check box, and is disabled when the check box is empty.



 Client application
A client application is an OLE (Object Linking and Embedding) compatible application that contains OLE objects 
(e.g., pictures, charts, text). that were created in other OLE applications. Not all OLE applications can be clients. 
If you are uncertain about whether an application is capable of performing as a client, check its documentation.



 Client-side image maps
Client-side image maps do not depend on the server to process the map information, but the user's browser 
must support image map display. It is always possible that your audience will not have a suitable browser to view
the map.



 Clipart
Ready-made images that can be brought into Corel applications and edited if required. Corel applications offer 
thousands of Clipart images in many different formats. You can purchase additional images, including some in 
bitmap format, from commercial suppliers.



 Clipboard
A temporary storage area that contains information you have cut or copied. You can paste the contents of the 
Clipboard into other programs (provided that program supports that type of information). Information remains on
the Clipboard until you replace it with the information from another cut or copy command. 



 Color depth
Color Depth determines the range of colors and tones that are available in an image, and is usually measured by
the number of colors displayed, e.g., 256 colors, or 16 million colors.
The color depth you select for your image will affect the file size, as well as the quality of the final product. Corel 
TWAIN allows you to choose from the following color depths: 16 million (24-bit), 256 colors(8-bit), 256 grays (8-
bit), and black and white(1-bit). The number of bits a color uses dictates both the horsepower it requires from 
your system as well as the number of colors or shades it is capable of producing. One bit can either be on or off, 
so 1-bit color is capable of producing just two pixel depths: 0 (off) results in a white pixel, and 1 (on) results in a 
black pixel. On the other end of the scale, 24-bit color has more than 16 million possible pixel depths (colors), 
and requires a great deal more memory. 



 Color Gamut
The range of colors that a mechanical device can either produce or perceive.



 Color mask
A mask applied to an image based on pixel color. The mask protects only the pixels that fall within the color 
range you specify, or protects all colors that do not fall within the defined color range. Color masks can be very 
complex in shape yet are easily created. They are an alternative selecting an area to edit by defining its shape. 
To create color masks, use the Magic Wand Mask tool, the Lasso Mask tool or the Color Mask command.



 Color mode
Refers to the color characteristics of an image, and determines how images are displayed in Corel applications.
· Black and White (1-bit)
· Grayscale (8-bit)
· Duotone (8-bit)
· Paletted (8-bit)
· RGB color (24-bit)



 Color model
A color model is a chart used to define a range of colors.



 Color palette
A range of colors used for the selection of individual colors. This term is used in two ways in Corel applications: it
refers both to the actual toolbar you use to make your selections and to color collections such as TRUMATCH or 
palettes you create yourself.



 Color Table
A tool in Corel WEB.PhotoPaint that is used to edit colors in a paletted image.



 Complex mask
A mask whose selection consists of several areas defined using various mask tools. All areas were added to the 
first selection created, using a mask mode that allows complex masks to be created such as Additive and XOR 
modes. A complex mask can also be made from the original mask’s selection, from which areas have been 
removed using the Subtractive mode.



 Conical fill
A type of fountain fill in which the color changes from the start color to the end color following a conical pattern. 



 Continuous tone
An image (usually photographic) represented by smooth graduated tones from black to white. Continuous tone 
images must be converted to dots and pixels for reproduction on mechanical devices.



 Contrast
The difference between the dark and light tones of an image. Higher contrast values indicate greater differences 
between dark and light with fewer gradations between them.



 Control point
Points extending from nodes along curves and line segments that are being edited with the Path Node Edit tool. 
Control points determine the angle at which the curve passes through the node. Control points appear when you 
select a node or segment with the Path Node tool. 



 CorelAPP.INI
A text file that contains configuration information for all installed Corel applications. This file is in the Corel\
CONFIG folder and can be edited by double-clicking on it in Windows Explorer. Changes you can make include 
increasing the Toolbox and color-palette size so that they appear larger on high-resolution monitors.



 CorelFLT.INI
A text file that contains information about the import and export filters used by all installed Corel applications. 
This file is in the Corel\CONFIG folder and can be edited by double-clicking it in Windows Explorer. Aside from 
adding pens and color definitions used by the HPGL filter, there's little reason to edit this file.



 Corel OCR-TRACE
A program supplied with CorelDRAW that traces bitmap images. The result is a vector graphic that you can 
import into CorelDRAW for editing.



 Corel WEB.PhotoPaint
Corel WEB.PhotoPaint is a powerful bitmap image editing and painting program that is ideal for retouching 
photographs, editing images and digital movie files, and creating original artwork. Corel WEB.PhotoPaint 
combines a vast array of special effects filters with impressive painting, masking, and object handling tools to 
allow you to produce effects ranging from the simple to the sublime.
Using Corel WEB.PhotoPaint, you can make subtle changes such as adjusting the lighting, sharpening the focus, 
or removing scratches; or you can make drastic changes such as removing people and things, swapping details 
between images, adding text and objects, adjusting color, colorizing black-and-white and grayscale images, 
splicing movies, and applying weird and wonderful combinations of special effects. Preview windows allow you to
see what the effect will look like before you commit, and Corel WEB.PhotoPaint’s undo capabilities allow you to 
change your mind.



 CPT
The filename extension for bitmap files created by Corel WEB.PhotoPaint.



 Crop
Cropping an image involves cutting away unwanted areas without affecting the resolution or dimensions of the 
information that remains.



 Cusp node

A node that allows you to move the two control points independently. Moving one control point does not affect 
the other one in any way. Use a cusp node when you want to add a sharp bend to a curve.



 Custom Colors (palette)
A palette composed of colors chosen by the user in the Color Roll-Up or Uniform Fill Dialog box.



 Default settings
Preset options built into a program.



 Defringe
A command that replaces the color of pixels along an object's edge with the color of pixels inside an object's 
boundary. 



 Device driver
A program through which a computer and devices such as a mouse or printer communicate. A mouse driver, for 
example, displays a pointer on the screen and translates clicks into actions.



 Disable
An option is disabled when there is no check mark beside it.



 Displacement map
An image used to determine the distortion pattern of a second image. Values from the displacement map are 
used to map negative and positive displacement of the original image.



 Dither
Randomization of pixels on devices or images using a limited Color Palette to simulate continuous tone 
progressions.
Screen dithering is a method of enhancing the display of monitors that are capable of 16-bit color or less. It 
works by averaging the depth of pixels in a given area to create additional colors or shades of gray (depending 
on whether you are working with color, grayscale or black-and-white images). Error diffusion provides the best 
results by spreading color approximations over several pixels. Ordered dithering is performed at a faster rate 
than error diffusion by approximating colors using fixed dot patterns.
Image Dithering is a method of enhancing the appearance of photographic images which use a limited Color 
Palette.



 Drive
A device in a computer that spins disks used to store information. Personal computers normally have a fixed-disk
drive labeled C or D (called a hard drive), and one or two floppy-disk drives labeled A and/or B. In addition, many 
computers have a CD-ROM drive.



 Duotone
An 8-bit color mode using 256 shades of up to four tones.



 Embedded object
Information from a file created in one program (the source program) that has been inserted into a file in another 
program (the destination program). For example, you can embed a graphic created in CorelDRAW into a 
Microsoft Word document.
See also Linked object and Object Linking and Embedding (OLE).



 Emboss
Emboss refers to a filter that causes areas to appear raised in relief. This is achieved by suppressing the color in 
the area and outlining it with a selected color.



 Feathering
The gradual blending of pixels between a mask selection or object and the surrounding background. Feathering 
produces a softer, more natural-looking edge. 



 Fill color 
The color used by the Fill tool to "paint" areas on images. The fill color also determines the color inside the 
rectangles, ellipses, and polygons you draw. You can choose the fill color in the Tool Settings Roll-Up for the Fill 
tool, in the on-screen Color Palette, or from the image itself by holding down SHIFT while-clicking a color with the
Eyedropper tool.



 Filter
The general name for a program that translates digital information from one form to another.
Import/Export filters convert files from one format to another. For example, in order to import a Corel DRAW 
image into Corel WEB.PhotoPaint, it must be converted from a vector file into bitmap form. By selecting a file 
format in the Export dialog box of DRAW, you are automatically activating the appropriate filter program which 
takes care of the translation.
Special Effects Filters process image information and alter it according to preset specifications in order to 
produce a special effect. For example, the Median filter in Corel WEB.PhotoPaint analyses all the pixels in an area
of your image and applies an average color across the area, creating a smooth, slightly blurry effect with less 
detail.



 Flat drop-off
A drop-off in either the Boss or Glass effect filters that is a straight diagonal line starting at the bevel area and 
ending on the image.



 Floating selection
A copy of the current mask selection. It is enclosed by a marquee and includes the image pixels. It floats on a 
plane above the image so that is can be moved without any consequence on the underlying image. You can 
paste clipboard data as a floating selection in an image.
As soon as you choose the Mask Brush or Mask Transform tool, it is defloated; the pixels are merged with the 
underlying image. The reason is that those tools are used to edit the shape of the mask itself, not the floating 
pixels included in its marquee. The content of the floating selection must therefore be dropped onto the 
underlying image before changes can be performed on the mask marquee. You can also defloat it by choosing 
the Defloat command in the Mask menu.



 Folder
Folders are used to store and organize your documents, programs, and other files. For example, you could create
a folder called LOGOS for storing logo designs. In previous versions of Windows, folders were called directories.



 Font
A set of characters in a given typeface and point size (see below). For example, 10 point Times Roman. Most 
fonts are available in families that include different weights or styles such as bold and italic.

10 pts 18 pts 36 pts



 Fountain fill
A fill progressing from one color to another, or through a series of colors, using a series of intermediate steps. 
Fountain fills are also called gradient or graduated fills. Corel WEB.PhotoPaint also offers a tool called the 
Gradient Fill tool, which allows you to select a transparency level as one of the end colors. 



 Gamut
A range of possibilities or capabilities, especially the range of colors that a mechanical device can either produce
or perceive.



 Gaussian
Refers to gaussian distribution, which applies an effect using bell-shaped (gaussian) distribution curves rather 
than straight lines.



 Gaussian Blur
Blurs the image according to a gaussian distribution, which spreads pixel information outward using bell-shaped 
curves.



 Gaussian drop-off
The drop-off has an "S" shape; it starts and ends with a round and gradual slope that becomes steep in the 
middle. It results in a smooth and less noticeable transition between the bevel and the rest of the image. 



 GIF
The filename extension for files in a bitmap format that is commonly used to store digitized color photographs. 
Corel applications can import files in this format.



 Gradient
An effect created by blending one color or transparency value into another through a series of intermediate 
steps.



 Grayscale
An 8-bit color mode that stores and displays images using 256 shades of gray from black to white. Each color is 
defined as a single value between 0 and 255, where 0 is darkest (black) and 255 is lightest (white). 



 Grayscale image
An image which uses the grayscale color model. Grayscale images  especially photographs
are commonly referred to as "black and white."



 Grid
A grid is just that  a grid that overlays your image so you can know exact coordinates as you work. You can 
adjust the amount of space between the horizontal and vertical lines in the Grid and Ruler Setup dialog box, and 
select a color and style for the grid in the Options dialog box. The Snap to Grid option (found under the Tools 
menu) constrains the cursor to the grid points.



 Group
A set of collected objects. Grouping enables a set of simple objects to behave and be edited as one.



 Highlighting box

The invisible rectangle, with eight handles, that encloses a selected object or mask selection. When you move or 
otherwise transform an object or selection, a dotted rectangle representing the highlighting box appears instead 
of the object or selection.



 HLS
Hue, lightness, and saturation are the components of the HLS color model, a variation on HSB and an alternative 
to RGB. Hue determines color (yellow, orange, red, etc.), lightness determines perceived intensity (lighter or 
darker color), and saturation determines color depth (from dull to intense). The circular visual selector defines 
the H value (0 to 360) and the S value (0 to 100); the vertical visual selector defines the L value (0 to 100).



 HSB
Hue, Saturation, and Brightness are the components of the HSB color model. This model is the closest 
approximation to how humans perceive color.
· Hue: a measure of the "color" of the colors in your image (e.g. green is a hue).
· Saturation: a measure of the depth of color in your image (the "richness" of a color).
· Brightness: an expression of the overall percentage of white in your image.



 HTML 
Hypertext Markup Language. The World Wide Web authoring standard. HTML is comprised of markup tags. You 
use the tags to tag text and integrated resources (such as images, sound, video, and animation) when creating a
Web page.
HTML has changed radically over the last few years. The number of HTML tags has grown, allowing Web authors 
to greatly enhance the design of pages.



 Hue
Hue is the main attribute in a color that distinguishes it from other colors. Blue, green, and red, for example, are 
all hues.
See also Saturation and Brightness.



 Image Colors (palette)
A palette composed of all the colors that appear in your image.



 Image Map
Image maps are graphics that have clickable areas which link the user to another Web page. The user clicks on 
the clickable area within the graphic, and is automatically linked to the designated page.



 Intensity
Intensity is a measure of the brightness of the lighter pixels in a bitmap image as it relates to darker mid-tones 
and dark pixels. Increasing intensity increases the vividness of whites while maintaining true darks.



 Interlacing
A method of having the image appear on-screen in entirety, but at a low, blocky resolution, as soon as the image
appears on-screen. As the image data loads, the image quality improves from unfocused to clear.



 Jaggies

A common term for jagged edges in a bitmap. Jaggies can be reduced with anti-aliasing.



 JPEG (Joint Photographic Experts Group)
An international standard for image compression that offers compression with almost no losses at ratios up to 20
to 1.



 Line art
In traditional graphic arts, an illustration containing only black and white.



 Linear fill
A fountain fill that progresses from one color to another following a linear pattern. 



 Linked object
In Object Linking and Embedding (OLE), information from one file (the source file) that has been inserted into 
another file (the destination file) while maintaining a link to the source file. Changes made to the information in 
the source file are automatically made to the information in the destination files.
See also Object Linking and Embedding (OLE) and Embedded object.



 Lossless
The process of compressing and decompressing does not distort the image. It is identical to the image that you 
originally created.



 Lossy
In the process of compressing the graphic, some of the image quality is lost. If you choose a high quality 
compression, very little of the image information is lost that is noticeable by the human eye. The lower the 
quality of compression, the poorer the image quality will be.



 Luminosity
A value corresponding to the brightness of a color.



 Marquee 
The dashed line that looks like marching ants, used by Corel WEB.PhotoPaint to represent the boundary of a 
mask selection or an object, in an image. By default, object marquees are blue and mask marquees are black.



 Mask 
A layer over the entire image that is used to define areas in the image that are protected from editing changes 
and those that are editable. The editable area(s) is called the selection. The mask marquee separates the 
selection from the protected areas. In regular masks, the selection is defined by creating a shape in the image. 
In a color-sensitive mask, the selection and protected area include pixels whose color is either in or out of the 
defined color tolerance range.



 Mask modes
States to which you set Corel WEB.PhotoPaint when creating or editing masks. There are four mask modes: 
Normal, Additive, Subtractive, and XOR. They are used to fine-tune an existing mask by adding or removing 
areas from its current selection in a variety of ways. The behavior of the mask tools is affected by the mode 
currently enabled. The resulting mask is called a complex mask. 



 Maximize
Maximizing your work area hides the title and Menu Bars, but allows you to continue editing your image (you can
still access all the menus using keystrokes). 



 Menu
A list of commands that appears when you choose a name in the Menu Bar. The Menu Bar appears below the 
Title Bar, which is across the top of the window.



 Menu Bar 
The bar near the top of the window that contains the names of the program's menus.



 Merge mode
The method by which the selected paint, object, or fill color combines with the colors in the image. Normally, 
when you apply color to a page or merge an object into the background, the applied color(s) simply replace the 
original colors in the image. Corel WEB.PhotoPaint's merge modes give you an alternative to just replacing 
colors. For instance, choosing the Add merge mode combines the paint and paper colors to produce a brighter 
resultant color. Corel WEB.PhotoPaint offers 16 to 21 merge modes, depending on the color depth of the image, 
for you to experiment with.



 Mesa drop-off
The drop-off is a curve that begins abruptly (almost a 90-degree angle) and ends with a rounded gradual slope.



Microsoft® Internet Explorer Colors palette
An 8-bit palette of 256 colors used by the web browser, Microsoft® Internet Explorer. By using only colors on this
palette, you ensure that your image colors will display clearly on systems using this browser.



 Moire pattern
Undesirable wave patterns in an image created by conflicting dot patterns. These occur when halftone screens of
two different frequencies are superimposed in the same image. For example, if you scan a halftone image, you 
will likely see moire patterns on your monitor screen because the original halftone screen will be different than 
the dpi frequency of the scanned image.



 Monochrome
An image containing a single color, usually black.



 NCSA
National Center for Supercomputing Applications. Developed a Web server system.
If you are creating an image map, it is not really important to know what NCSA is, but you do need to know 
whether the server you are using runs CERN or NCSA, as different codes are used in the map files. Contact your 
server administrator to find this information.



Netscape Navigator  Colors palette
An 8-bit palette of 256 colors used by the web browser, Netscape Navigator . By using only colors on this 
palette, you ensure that your image colors will display clearly on systems using this browser.



 Nib
In Corel WEB.PhotoPaint, the nib is the tip of the brush you use to apply effects with any of the brush tools. The 
Nibs Roll-Up contains preset nibs you can choose from to suit the style of brush you want. You can also customize
an existing nib in the Tool Settings Roll-Up for any of the brush tools. 



 Nodes
Square points located at the end of each line and curve segment that make up a path. There are three types of 
nodes: smooth, symmetrical and cusp. 



 Noise
In bitmap editing: refers to random pixels on the surface of a bitmap resembling static on a television screen.



 Noise Filters
Filters in Corel WEB.PhotoPaint used to add or remove noise from an image. 



 Object 
An object is an independent bitmap that is layered above the base image. Objects can be created by using the 
mask tools and then choosing the Create From Mask command (Object menu).



 Object editing modes
Corel WEB.PhotoPaint offers three different modes in which you can select, edit, delete and organize objects in 
your image. They are called Multi (default), Single, and Layer. You select the mode in the Objects Roll-Up (View 
menu). Extensive information is provided in the Working with Text and Objects section of the Corel 
WEB.PhotoPaint documentation.
· Multi mode makes it possible to edit several objects at once using a variety of brush and painting tools. It 

includes a lock feature that protects all locked objects from change. 
· Single mode automatically locks all objects in the image except one. You can change which object is editable 

in the Roll-Up. Only one object can be edited at a time.
· Layer mode places the editable object in the image on a transparent layer that covers the entire image; any 

change applied to the object in this mode only affects this transparent layer, not the underlying image.



Object Linking and Embedding (OLE)
A method of bringing data objects from one Windows application into another.
See also Linked object and Embedded object.



On-screen Color Palette
Along the bottom of the screen, you will find the Color Palette. This is used to apply outline and fill colors. 
To choose a fill color, select an object and click the Color Palette with the left mouse button. To choose an outline 
color, click it with the right mouse button. Clicking the X that appears at the left end of the palette removes the 
object's fill if you click with the left mouse button, or outline if you click with the right button.



 Opacity
Opacity refers to the ability to see through something. If an area is 100% opaque, you cannot see through it. 
Levels under 100% increase the ability to see through objects. The opposite of transparency.
See also Transparent.



 Opaque
The inability to see through an image or object. The opposite of transparent.



 Orientation
The direction in which objects are displayed on the page. For example, a page oriented so that the horizontal 
dimension is greater than the vertical dimension is said to have a landscape orientation.
See also Landscape and Portrait.



 Out-of-gamut color
A color that is beyond the capabilities (outside the gamut) of a given device.



 Overlay (mask)
A red-tinted transparent sheet superimposed over the entire image used to differentiate the areas of the image 
that are protected by the current mask from the editable ones (selection). 



 Paint Color
Paint Color is the color used by the Paint tool to apply color, and used by the Line and Shape Tools as an outline 
color. 



 Paint mode
Paint modes determine the way the paint is applied to the colors that already exist in your image. For example, 
the Normal paint mode simply replaces the base color with the paint color, whereas the Add mode creates a 
result color by adding the values of the paint and base colors.



 Paint program
A generic term referring to computer graphics programs that store digital images as bitmaps. Corel 
WEB.PhotoPaint is a paint program. Programs such as CorelDRAW, which store images as a series of lines and 
curves, are called draw programs.



 Palette
See Color Palette.



 Paletted color mode
An 8-bit color mode that stores and displays images using up to 256 colors. 
Converting a complex image to paletted color mode is useful for reducing file size, especially in preparation for 
Internet publishing. Paletted color mode also allows you to use the Color Table.



 Paper Color
Paper Color refers to the color of an image's background. 
Although normally white, the Paper Color in Corel WEB.PhotoPaint can be set to any color you wish. The Paper 
Color is set in the Create a New Image dialog box, but can also be changed by selecting a color from an image by
clicking the Eyedropper tool while holding down the CTRL key. Note that the color you specify as Paper Color will 
only affect new image files; it is not applied to the current image. 



 Path 
The line or series of lines you draw using the Path Node Edit tool. A path, both open and closed, can be 
converted into a mask marquee or highlighted with a border of color using the controls in the Tool Settings Roll-
Up for the Path Node Edit tool.



 PHOTOPNT.INI
A text file that contains configuration information about Corel WEB.PhotoPaint. This file is in the Corel\PHOTOPNT
folder and can be edited by double-clicking it in Windows Explorer. Changes you can make include the interval 
between backup file creation and the directory in which these backup files are stored.



 Pixel
Pixels, whose name is derived from the term Picture Element, are dots arranged on grids that combine to form an
image. Computer images are created as an array of such dots, each having a specific color. See also resolution 
and bit depth.



 Point
A unit of measure used primarily in typesetting for designating type sizes. There are approximately 72 
points(pts) to an inch and exactly 12 points to a pica.

10 pts    18 pts    36 pts
In CorelDRAW, a point is a Bezier vertex or control point.



 Point size
Typographic unit of measurement equal to 1/72 inch.

10 pts    18 pts    36 pts



 Portrait
A page oriented from left to right across its shortest dimension.



 PowerClip
A feature that allows you to place objects (called contents objects) inside other objects (called container objects).
If the contents object is larger than the container object, CorelDRAW automatically crops it. You see only the 
contents that fit inside the container.



 Preset brush type
A preset brush type is a combination of brush attributes such as size, shape, transparency, and texture. A 
number of preset brush types have been provided for each category of brush to produce different effects when 
using any of the brush tools. For example, the Pencil brush has two preset brush types: HB and 2B. The 
difference between the two preset types is that the 2B pencil brush type has a larger nib and more texture, 
producing a thicker, grainier stroke.



 Progressive
A method of having the image appear on-screen in entirety, but at a low, blocky resolution. As the image data 
loads, the image quality improves from unfocused to clear.



 Protected area
Section(s) of the image that is protected by the current mask. It is not affected by editing changes, such the 
application of paint or a special effect performed on the image. When looking at an image using the mask 
overlay, the protected area is represented by the overlay’s color, red by default. The transparent areas of the 
overlay correspond to the editable area(s) that make up the selection.



 Pure color
Any color that individual pixels on a computer screen can assume. On a monochrome screen, there are only two 
pure colors, black and white. Color screens typically display 16 or 256 pure colors. Newer video cards will display
32 or 64 thousand colors, and 24-bit cards display 16.7 million colors.
See also Dithered color.



 Radial fill
A fountain fill that creates a gradual transition from one color to another following a concentric circular pattern.



 Radio button
A round or diamond-shaped button in a dialog box that turns an option on or off. When two or more options are 
available, only one can be selected. They are also called option buttons.



 Reduce Tolerance (path)
Control found in the Tool Settings Roll-Up and in the Property Bar for the Path Node Edit tool. The value typed in 
this box must be between 1 and 10; it controls the extent of automatic reduction of nodes on a curve. The higher
the value, the more nodes are removed from the path or the section of the path you select. A high value may 
result in significant changes in the path’s shape after Auto-reduce has been used.



 Resolution
Resolution is an umbrella term that refers to the amount of detail and information an image file contains, as well 
as the level of detail an input, output or display device is capable of producing. When you work with bitmaps, 
resolution affects both the quality of your final output and the file size.
The resolution you choose for your image will usually move with your file – that is, whether you print a bitmap 
file to a 300 dpi laser printer or to a 1270 dpi imagesetter, it will always print at the resolution you set when you 
create the image.
If you want your final output to look like its onscreen counterpart, you have to understand the relationship 
between the resolution of your image and the resolution of your various devices before you begin to work. Once 
you do, you will be able to produce effective, consistent results.



 RGB
RGB, an additive set of colors based on the light primaries red green and blue, refers to a color mode, and to a 
color model.
The RGB color mode is a 24-bit method of processing images which uses 16 million colors to store and display 
images.
The RGB color model is a color model which defines colors using light primaries. Because of this, it is the model 
used for monitor display. 



 Roll-Up
A Roll-Up is a dialog box that contains the same sorts of things as most dialog boxes – command buttons, boxes, 
etc. However, unlike most dialog boxes, you can keep Roll-Ups open while you continue to work. If you need to 
maximize your workspace but wish to keep the Roll-Up open, roll it up by clicking the arrow in the Title Bar. This 
leaves just the Title Bar visible. Click the arrow again to unroll it.



 Ruler crosshairs

The point where two rulers meet. 



 Rulers
Rulers are exactly what you expect them to be  rulers that appear along the side and/or top of your work area 
to help you keep track of the actual size and location of parts of your image. You can set the unit of measure 
using the Grid and Ruler Setup dialog box.



 Saturation
Saturation is the purity of a color. The HSB color model uses Saturation as a component that determines the 
purity or intensity of a color. The more colors used to mix a color, the duller the color looks.
See also Hue and Brightness.



 Scanner
A device that converts images on a page or transparency into digital form. Corel applications can import scanned
images (also called bitmaps).



 Secondary mouse button
Normally the right mouse button. However, if you've swapped mouse buttons, the left mouse button becomes 
the secondary button.



 Segment (path)
Section of a path located between two consecutive nodes. A path is a series of segments



 Selection 
Section of the image that is not protected by the current mask thus available for editing. The selection is 
affected by the use of painting and editing tools, special effects, and image commands. When you apply the 
mask overlay, the selection is represented by the transparent areas of the overlay.



 Server application
A server application is an OLE (Object Linking and Embedding) compatible application that is used to create OLE 
objects (e.g., pictures, charts, text). These OLE objects can be placed in other OLE applications. Not all OLE 
applications can be servers. If you are uncertain about whether an application is capable of performing as a 
server, check its documentation.



 Server-side
Server-side image maps are not dependent on any browser to process the map information, but the server must 
be able to recognize the code in the map file. NCSA and CERN use different codes, so you do need to know 
whether the server you are using runs CERN or NCSA. Contact your server administrator to find this information.



 Skew
To change an object's shape by dragging one of the side handles that appear when you double-click it.



 Smooth node 

A type of node through which curves pass smoothly rather than at sharp angles. The node, and its two control 
points are always on a straight line. The control points can each be at a different distance from the node. Node 
types are selected from the Path Node Edit Tool Settings Roll-Up.



 Snap 
To force an object to move next to a grid line or guideline. You can turn Snap to Grid or Snap to Guideline on and 
off in the Tools menu.



 Spread
One of the brush tool settings. The Spread control determines the distance between the dabs of a brush stroke. 



 Square fill
A fountain fill that creates a gradual transition from one color to another following the pattern of concentric 
squares.



 Status Bar
An area at the bottom of most Corel application screens that shows information about the action in progress.



 Stretch
To resize an object horizontally or vertically by dragging the handles that appear around its highlighting box 
when you click it. 



 Swap disk
A swap disk is hard disk space used by software applications to store temporary files not currently in use. Corel 
WEB.PhotoPaint provides an option for selecting two swap disks. This artificially increases the amount of memory
available on your system. It also makes Corel WEB.PhotoPaint use the space in bigger increments than Windows, 
which is better for handling bitmap images.



 Swatch
A series of squares containing colors in the Color Palette.
A swatch book contains hundreds of samples for comparing and selecting colors.



 Symmetrical node

A symmetrical node is a node that constrains the angle between its two control points to 180 degrees. The two 
control points are both the same distance from the node. Use this node when you want the same curvature on 
both sides of the node. 
See also node.



 Texture fill
A texture fill is a mathematically generated pattern with customizable attributes. Unlike the tiling bitmap fills, 
textures fill a designated area with a single image. The many presets include water, minerals, clouds, and 
dozens of others.



 Threshold
In Corel WEB.PhotoPaint: refers to a level of tolerance for tonal variation in a bitmap image. 
For example, when converting your image to black and white, the threshold you set will determine how many 
tonal values will be converted to black and how many will become white.
Threshold settings are also used in color-sensitive masking and the application of some Effects filters.



 Threshold (path)
Control available when creating a path from a mask. Threshold values range from 1 to 10, and determine the 
size of the angle required between sections of a mask for a node to be created at the intersection of the 
sections. A low value produces more cusps, therefore more nodes on the resulting path than using a high value.



 Tightness (path)
Control available when creating a path from a mask marquee. Tightness values range from 1 to 10, and 
determine how close the shape of the path will be to the shape of the marquee. The higher the value, the more 
the new path resembles the marquee; it will have more nodes than a path with a lower tightness value.



 Tiling
The technique of repeating an image across a larger surface to cover it. Tiling is often used to create a patterned
background for World Wide Web pages.



 Tint
Or "color cast": refers to the application of a specific semi-transparent color over an image.



Thumbnail
A small bitmap image that lets you preview a file before opening or importing it, or a fill before you apply it. 



 Toggle
Any option that has mutually exclusive settings. For example, Show Rulers under the View menu toggles 
between showing and hiding the rulers. 



 Tolerance
Tolerance is an adjustment for controlling the color sensitivity of the Lasso Mask tool, Magic Wand Mask tool, Fill 
tool and Color Replacer tool. Tolerance is also used in the Color Mask dialog box to determine which pixels will be
selected or protected when creating the color mask. Tolerance values range from 0 to 100. A pixel is included if 
its grayscale value falls within the defined tolerance. Grayscale values are defined on a scale ranging from 0 to 
255. 

The first row in the illustration represents the scale of tolerance values. The second row shows the corresponding 
values in the grayscale scale. If you define a tolerance of 25, and click a pixel in the image that is 50% black, 50% 
black becomes the seed color, i.e. the color on which the color range is defined. All colors that are in the 50% black 
plus or minus 25 range, are included. In other words, all pixels that are 25% black (50 minus tolerance of 25) to 
75% black (50 plus tolerance of 25) are also selected (as illustrated above). 

In grayscale terms, a pixel that is 25% black has a grayscale value of 64 (25% of 255); 75% black is 192 (75% of 
255). This means that pixels that have grayscale values from 64 to 192 are included. 
You can choose a tolerance value in one of two modes:
· Normal 

Creates a selection, applies a fill, etc., based on the color similarity of adjacent pixels in the color mode of the 
image you are working with. The tolerance value you choose controls how discriminating the color selection 
will be.

· HSB
Creates a selection, applies a fill, etc., based on Hue, Saturation, and Brightness levels of adjacent pixels. The 
levels you set control how discriminating the HSB selection will be.



 Toolbar
A group of buttons that provides quick access to a series of related commands. In CorelDRAW, you can use any 
combination of the preset Toolbars, or create your own containing the buttons and button arrangements you find
most efficient.



 Toolbox
The toolbar that appears by default on the left side of the screen, which contains such tools as the Fill, Paint, 
Undo, Effects, and Clone tools. 



 Transformation
Changing an object by moving, stretching, scaling, or rotating it.



 Transparent
The ability to see through an object, image, or mask. The opposite of transparent is opaque. Setting lower levels 
of transparency causes higher levels of opacity and less visibility of the underlying objects/masks/image.



 True color
Some video cards are capable of displaying true, or 24-bit color. True color cards display 16.7 million colors as 
pure colors. On a monochrome screen, there are only two pure colors, black and white. Color screens typically 
display 8, 16, or 256 pure colors. See also Dithered color and Pure color.



 TRUMATCH Colors
A color-matching system for specifying process colors. The TRUMATCH® color system is based on the CMYK color
model and, therefore, colors do not add additional color separation plates. Colors are organized by hue (red to 
violet), saturation (deep to pastel), and brightness (adding or removing black). Colors can be displayed by name 
or swatch through the Color Options menu.



 Uniform fill
A solid color, black, white, or shade of gray used to fill objects or parts of an image. You can select uniform colors
from the Uniform Fill dialog box.



 Uniform Colors (palette)
An independent palette (not based on a color-matching system or your image) which provides 256 colors 
uniformly spread between red, green, and blue.



 URL 
Uniform Resource Locator. A URL is a "smart address"; the URL tells the Web server what kind of information to 
get and where to get it from, so that a new Web page at a new location is displayed.



 Vector graphics
Graphics created in programs such as CorelDRAW where shapes are represented as a series of lines and curves. 
Vector graphics are also referred to as object-based graphics or line art. This contrasts with bitmap graphics 
which are created pixel by pixel in paint programs and by scanners.



 Visual Selector
A graphic representation of a color model which includes an indicator for selecting colors.



Well
A series of squares containing colors in the Color Palette.
See also Swatch.



 WIN.INI
A file containing Windows settings and preferences for screen color, mouse double-click speed, fonts, etc. You 
can change the WIN.INI settings by editing this file with the Windows Notepad or other ASCII text editor.



 Wizard
An automated assistant that helps make each task simple and trouble free. The wizard asks you questions and 
then performs the appropriate actions based on your answers.



 Workpath
The path currently displayed in the Image Window which has not been saved to disk.





TOOLS



Object Picker tool

Selects, moves, and resizes objects. Double-click the object with this tool to rotate or skew it; triple-click to 
distort the object. SHIFT click to select multiple objects. Double-click the tool to open the Objects Roll-Up.



Object Transparency tool

Use to make the colors of an object fade gradually towards the image background color. The object fade is called
a transparency blend; it is a gradient fill that uses the object’s current color and transparency. Click and drag to 
determine the direction, the start and end points, of the object transparency. The object’s shape can be altered 
by the use of this tool. 



Object Transparency Brush tool

Brush areas on an object to make them more transparent.



Rectangle Mask tool

Defines rectangular mask selections. Hold down CTRL to create a square. Hold the SHIFT for the center of the 
selection to be where you first clicked in the image when creating it.



Circle Mask tool

Defines elliptical mask selections. Hold down CTRL to create a perfect circle. Hold down SHIFT for the center of 
the selection to be where you first clicked in the image when creating it.



Freehand Mask tool

Defines irregularly-shaped or polygonal mask selections. Click and drag to draw the curved edges of the mask 
marquee. Click the start and end points to create a straight line section on the mask marquee. After the first 
click, press ESC to delete the first point and start again. To close the shape of the selection, move close to the 
first point created and double-click.



Lasso Mask tool

Defines mask selections that are irregular in shape and surrounded by pixels of similar colors. Click and drag to 
define the area in which the selection should be created. Double-click to create it. The resulting selection 
includes all pixels within the area you enclosed that do not fall within the color range of the point you first clicked
when defining the area. The mask marquee shrinks to exclude all pixels that fall within the current color range. 
The Color Range is defined using the Tolerance control in the Property Bar. Use this tool to edit part of an image 
that includes many different colors but that is surrounded, at least in part, by a uniform color.



Magic Wand Mask tool

Defines irregularly-shaped mask selection that include all adjacent pixels that are the similar in color as the pixel 
you first clicked. Adjust the color tolerance in the Property Bar to set the range of colors that should be included 
in the selection. Use this tool when you want to apply an effect to an area that is highly irregular in shape but 
that includes many shades of the same color. You can invert the mask to protect the area and manipulate the 
rest of the image.



Mask Brush tool

Defines a mask selection by brushing an area as if you were painting. You set the size of the brush in the 
Property Bar and click and drag in the Image Window to create the selection. Release the mouse button only 
when the selection is complete. To use physically separate strokes of the brush to create the selection, enable 
the Additive mask mode.



Mask Transform tool

Use to transform a mask marquee by moving the    handles that appear around it when this tool is selected. It 
allows you to size, scale, move, skew, rotate, distort and apply perspective to a mask marquee. The image pixels
enclosed by the mask marquee are not affected by such transformations unless the selection is floating.



Path Node Edit tool

Allows you to create and edit paths in your image. Paths can be used to create masks, apply a brush stroke of a 
specific shape, and create non-rectangular bitmaps for use in other applications. Paths can be saved to disk for 
future use.



Repeat Stroke tool

Found on the Path Node Edit tool flyout (Toolbox) and the Node toolbar. Use to repeat any brush stroke you have 
previously saved (you can save strokes on the Property Bar or in the Tool Settings Roll-Up for this tool). Once 
saved, you can scale, change the angle, color, and other brush attributes for the stroke before applying it to an 
image or path.



Crop tool

Use to define a cropping area on an open image. Click and drag to create a rectangular bounding box. Move or 
resize it by clicking and dragging on the edges or corners. When you are satisfied with the cropping area, double-
click inside it to complete the operation. 



Zoom tool

Found on the Toolbox and Zoom toolbar. The Zoom tool magnifies areas of your picture. Click to zoom in to the 
next preset level, right-click to zoom out to the next preset level, or click and drag around the area you wish to 
zoom in on.



Hand tool

Found on the Zoom flyout (Toolbox) and the Zoom toolbar, as well as in dialog boxes that contain preview 
windows. Use to drag areas of an image into view when the image is larger than its window. 



Eyedropper tool

Selects colors from an open image. Use the left mouse button to select a paint color. Use the right mouse button 
to select a fill color. Hold down CTRL and click either mouse button to select a paper color. The Eyedropper tool is
also in the Color Mask dialog box, so you can select colors from your image when creating color-sensitive masks.



Local Undo tool

Found on the Undo Tool flyout (Toolbox) and the Undo Toolbar. Use this brush tool to restore areas to the way 
they looked before your last brush stroke. 



Eraser tool

Found on the Undo Tool flyout (Toolbox) and the Undo Toolbar. Use this brush tool to replace whatever you paint 
over with the paper color. Hold down CTRL while clicking and dragging to constrain the tool to horizontal or 
vertical movements. Hold down SHIFT at the same time to change the direction of constraint.



Color Replacer tool

Found on the Undo Tool flyout (Toolbox) and the Undo Toolbar. Replaces any paint you have just applied with the 
paper color. Hold down CTRL while clicking and dragging to constrain the tool to horizontal or vertical 
movements. Hold down SHIFT at the same time to change the direction of constraint. Double-click the tool to 
replace all the paint in your image with the paper color. 



Rectangle tool

Use to draw hollow or filled rectangles and rounded rectangles. Hold down CTRL while clicking and dragging to 
create a square. Hold down SHIFT to draw a rectangle from its center. The Render To Object option in the 
Property Bar creates new rectangles as objects that can be moved and transformed without affecting the 
underlying image.



Ellipse tool

Use to draw hollow or filled ellipses. Hold down CTRL while clicking and dragging to create a circle. Hold down 
SHIFT to draw an ellipse from its center. The Render To Object option in the Property Bar creates new ellipses as 
objects that can be moved and transformed without affecting the underlying image.



Polygon tool

Use to draw hollow or filled polygons. Hold down CTRL while clicking and dragging to constrain the polygon’s 
sides to 45 degree angles. Hold down DELETE to remove the last segment you created. The Render To Object 
option in the Property Bar creates new polygons as objects that can be moved and transformed without affecting
the underlying image.



Line tool

Draws single or joined straight line segments using the paint color. The Render To Object option in the Property 
Bar creates new lines as objects that can be moved and transformed without affecting the underlying image.



Text tool

Adds text to your image. Text is by default an object that floats above the image background. Use the Property 
Bar to change the font, style, size and effects. You can manipulate, edit, format and transform the text object 
while it is still an object. Once you’ve combined the text object with the background, you can no longer edit it as 
text. The Render Text To Mask options automatically makes new text you type become a mask selection.



Fill tool

Found on the Fill tool flyout (Toolbox) and the Fill toolbar. Use to fill areas with any of four fill types. You can 
access the Uniform, Fountain, Bitmap, and Texture fill dialog boxes from the Property Bar or Tool Settings Roll-Up,
which allow you to create and customize fills. 



Paint tool

Found on the Toolbox and the Paint toolbar. Use to paint on an image using the paint color. The Property Bar and 
Tool Settings Roll-Up contain many preset paint tools, such as the Art Brush, Airbrush, Pencil, and Ball Point pen. 
Hold down CTRL while clicking and dragging to constrain the brush to horizontal or vertical movements. Hold 
down CTRL + SHIFT to change the direction of constraint.



Effect tool

Found on the Toolbox and the Effect Tools toolbar. Allows you to perform local color and tonal corrections on your 
image. Click the arrow to the right of the tool picker on the Property Bar and in the Tool Settings Roll-Up to 
display the different Effect tools. 



Clone tool

Found on the Toolbox and the Clone Tools toolbar. Use to duplicate part of an image and apply it to another part 
of the image or to another image altogether. The Property Bar and Tool Settings Roll-Up provide specialized 
cloning brushes that create a duplicate in the pointillist style (dots) and impressionist style (lines). You can 
achieve different effects by customizing the brush you use to apply the effect. 



Navigator pop-up

Click this button, which appears on the bottom right of your Image Window when some areas of the image aren’t
visible, to launch the Navigator pop-up. Use the Navigator pop-up to move to different areas of your image.



Nibs Roll-Up button

 Found on the Property Bar when a brush tool is selected. Click to open the Nibs Roll-Up.



Brush tools
Brush tools are any of PHOTO-PAINT's tools that you apply with a brush and paint mode. The Paint, Clone, Effect, 
Undo, Mask Brush and Object Transparency tools are all brush tools. 



Smear tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
smear colors in your image selectively by brushing over them. You can achieve different types of smearing by 
selecting different options in the Brush Type box (on the Property Bar and the Tool Settings Roll-Up), or by 
changing the size and shape of the brush you use to apply it.



Smudge tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
decrease the definition between colors or hard edges in your image selectively by brushing over them. You can 
achieve different types of smudging by selecting different options in the Brush Type box (on the Property Bar or 
the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Brighten tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
brighten or darken areas in your image selectively by brushing over them. You can achieve different types of 
brightening by selecting different options in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up),
or by changing the size and shape of the brush you use to apply it.



Contrast tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
soften the definition between colors or hard edges in your image selectively by brushing over them. You can 
achieve different types of blending by selecting a different option in the Brush Type box (on the Property Bar or 
the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Hue tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
shift the hues in your image selectively by brushing over them. You can achieve different types of effect by 
selecting different options in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), by changing 
the number of degrees the hues will shift around the color wheel in the Amount box, or by changing the size and 
shape of the brush you use to apply it.



Hue Replacer tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
replace the hues in your image selectively by brushing over them. This effect is based on the paint color. You can
achieve different types of effect by selecting a different option in the Brush Type box (on the Property Bar or the 
Tool Settings Roll-Up), by changing the number of degrees the hues will shift from the paint color (around the 
color wheel), or by changing the size and shape of the brush you use to apply it.



Sponge tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
saturate or desaturate areas of your image selectively by brushing over them. You can achieve different types of 
effect by selecting a different option in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), or 
by changing the size and shape of the brush you use to apply it.



Tint tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
tint areas of your image with the paint color by brushing over them. You can achieve different types of effect by 
selecting a different option in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), or by 
changing the size and shape of the brush you use to apply it.



Blend tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
soften the definition between colors or hard edges in your image selectively by brushing over them. You can 
achieve different types of blending by selecting a different option in the Brush Type box (on the Property Bar or 
the Tool Settings Roll-Up), or by changing the size and shape of the brush you use to apply it.



Sharpen tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
sharpen areas of your image selectively by brushing over them. You can achieve different types of sharpening by
selecting a different option in the Brush Type box (on the Property Bar or the Tool Settings Roll-Up), or by 
changing the size and shape of the brush you use to apply it.



Undither tool

Found on the Effect Tools toolbar and the Effect tool picker (Property Bar and Tool Settings Roll-Up). Allows you to
create a smooth transition between adjacent pixels of different colors or brightness levels. It works by adding 
intermediate pixels whose values are between those of the adjacent pixels. Use this tool to remove dust and 
scratches and to smooth jagged edges.



Tabs and buttons in Tool Settings Roll-Up for Fill tool and
fill dialogs



Direct Color Path

Determines the fill's intermediate colors by traveling in a straight line across the color wheel between the To and 
From colors.



Clockwise Color Path

Determines the fill's intermediate colors by traveling clockwise around the color wheel between the To and From 
colors.



Counter-Clockwise Color Path

Determines the fill's intermediate colors by traveling counter-clockwise around the color wheel between the To 
and From colors.



Fountain Fill icon

Selects fountain fill as the current fill type. If you wish to modify the fill, click Edit.



Uniform Fill icon

Selects uniform fill as the current fill type. If you wish to modify the fill, click Edit.



Bitmap Fill icon

Selects full-color bitmap pattern as the current fill type. If you wish to modify the fill, click Edit.



Texture Fill icon

Selects texture fill as the current fill type. If you wish to modify the fill, click Edit.



No Fill icon

Click if you want no fill.



Unlock

Locks and unlocks the parameter.



Mid-Point Slider

Adjusts the midpoint of the color blend.



Color Wheel

Shows the color path that determines the fill's intermediate colors.



Preview Ribbon

Previews your custom gradient fill. You can add, remove, or edit color markers by clicking in the marker bar just 
above the preview ribbon.



Add Fill button

Saves the fill.



Delete Fill button

Deletes the fill.



Color Bar

Opens a flyout from which you can choose colors. Click More to open the Color dialog box.



Color Flyout

Opens a flyout from which you can choose colors. Click More to open the Color dialog box.



Tabs and buttons for Tools Settings Roll-Up 
for Object Picker tool and Mask Transform 
tool (same for both tools)



Position tab

 Found in the Tools Settings Roll-Up when the Object Picker or Mask Transform tool is selected. It is used to 
change the location of the selected object or mask in the Image Window.



Size tab

Found in the Tool Settings Roll-Up when the Object Picker or Mask Transform tool is selected. It is used to change 
the dimensions of the selected object or mask.



Rotate tab

Found in the Tool Settings Roll-Up when the Object Picker or Mask Transform tool is selected. It is used to rotate 
the selected object or mask around its center of rotation.



Scale tab

Found in the Tool Settings Roll-Up when the Object Picker or Mask Transform tool is selected. It is used to change 
the size of the selected object or mask by choosing a percentage of its original dimensions. Can also be used to 
mirror the selected object or mask.



Flip Horizontal

Found on the Scale page of both the Tool Settings Roll-Up and the Property Bar, for the Object Picker and Mask 
Transform tools. Mirrors the selected object or mask along its vertical axis.



Flip Vertical

Found on the Scale page of both the Tool Settings Roll-Up and the Property Bar, for the Object Picker and Mask 
Transform tools. Mirrors the selected object or mask along its horizontal axis.



Skew tab

Found in the Tool Settings Roll-Up when the Object Picker or Mask Transform tool is selected. It is used to slant
the selected object or mask.



Buttons for Property Bar for Object Picker 
tool and Mask Transform tool (same for both
tools)



Position mode

 Found in the drop-down mode list on the left-hand side of the Property Bar for the Object Picker and Mask 
Transform tools. It displays controls used to change the location of the selected object or mask.



Relative Position button

 Found in the Property Bar for the Object Picker tool when the Position mode is active. Click to move the selected 
object(s) or mask marquee by the specified horizontal and vertical distance relative to its current location.



Size mode

 Found in the drop-down mode list on the left-hand side of the Property Bar for the Object Picker and Mask 
Transform tools. It displays controls used to change the dimensions of the selected object or mask.



Rotate mode

 Found in the drop-down mode list on the left-hand side of the Property Bar for the Object Picker and Mask 
Transform tools. It displays controls used to rotate the selected object or mask around its center of rotation.



Relative Center button

 Found in the Rotate mode of the Property Bar when Object Picker or Mask Transform tool is selected. Click to 
move the center of rotation of the object or mask marquee relative to its current location, by the distance 
specified in the horizontal and vertical boxes. 



Scale mode

 Found in the drop-down mode list on the left-hand side of the Property Bar for the Object Picker and Mask 
Transform tools. It displays controls used to change the size of the selected object or mask by choosing a 
percentage of its original dimensions. Can also be used to mirror or flip, the selected object or mask.



Maintain Aspect button

 Found in the Scale and Size modes of the Property Bar when Object Picker or Mask Transform tool is selected. 
Click to keep the object or mask marquee’s current height to width ratio as is when changing its size.



Skew mode

 Found in the drop-down mode list on the left-hand side of the Property Bar for the Object Picker and Mask 
Transform tools. It displays controls used to slant the selected object or mask.



Mask mode buttons



Normal mode

 Mode used to create a mask comprised of a single selection and protected area. Can also be activated using 
the Mask menu; click Mask, Mode, Normal.



Additive mode

 Mode used to create a complex mask; allows you to add new areas to an existing selection. Can also be 
activated using the Mask menu; click Mask, Mode, Additive.



Subtractive mode

 Mode used to remove areas in an existing selection. Can also be activated using the Mask menu; click Mask, 
Mode, Subtractive.



XOR mode

 Mode used to add selections to an existing mask but exclude the overlapping areas between the original 
selection and the new ones. Can also be activated using the Mask menu; click Mask, Mode, XOR.



Buttons in the Regular Mask tools PBs



Feather width box

Found in the Property Bar for many tools, this control is used to set the width, in pixels, of the feathered edge of 
a mask selectionor object.



Anti-alias button

Found in the Property Bar for several mask tools, the Shape tools and the Object Picker tool, this button is used 
to apply anti-aliasing when creating a mask, a shape, or applying transformations to mask marquees and 
objects.



PB button for Text tool



Render To Mask button

Click to have text you type in the Image Window automatically rendered as a mask selection. This results in a 
text-shaped selection to which you can apply effects, image commands among others. 



PB button for object transparency tools



Use original transparency button

Enable to add the transparency value set for the tool to the current transparency of object pixels. Disable to 
replace the transparency value of object pixels by the transparency value set for the tool.



Buttons in the Path Node Edit TSR and PB 
(same in both) 



Node Edit button

Click to edit the shape of the path displayed in the Image Window. This button allows you to move path 
segments, nodes, and control points. It is also used to select nodes and segments you want to convert to a 
different type.



Add Nodes button

Used to create path segments. This button is automatically enabled when you first open the Tool Settings Roll-Up
for the Path Node Edit tool. If you’ve edited an existing path however, you need to click this button again to 
create new segments.



Delete Path button

Removes the path currently displayed in the Image Window and allows you to also delete the saved version of 
the path if one exists.



New Path button

Click to create a new path. This button clears any existing path from the Image Window. You will be asked if you 
want to save the existing paths before clearing them.



Save Path button

Click to save the current path to disk. A saved path has the .PTH file format and can be used in any image.



Open Path button

Opens paths that were previously saved to disk. Paths are saved with the .PTH file format. Saved paths can be 
used in any image.



Add button

Click to add a node at the selected location on the path. If you select a node, the new node is placed in the 
middle of the selected path segment.



Delete button

Click to delete selected nodes from the path. The path shape may be quite different when you delete nodes.



Join Selected button

Click to join the two end nodes selected. They will be merged into one node halfway between their current 
locations.



Break Selected button

Click to break up the path at the node selected. Two end nodes are created but remain superimposed. Click one 
and drag to move it to another location.



Auto-Reduce button

Click to remove superfluous nodes on a path. The path shape remains intact. Nodes are often rendered 
unnecessary after editing the path shape. Converting a mask to a path also tends to produce more nodes than 
are required. Using this feature makes the path smoother, easier to edit and smaller in size when you save it.



Reduce Tolerance box

Control found in the Property Bar for the Path Node Edit tool. The value typed in this box must be between 1 and 
10; it controls the extent of automatic reduction of nodes on a curve. The higher the value, the more nodes are 
removed from the path or the section of the path you select. A high value may result in significant changes in 
the path’s shape after Auto-reduce has been used.



To Line button

Converts the selected curve segment on a path to a line.



To Curve button

Converts the selected line segment on a path to a curve. The change may not be apparent on the segment. 
Select the segment’s nodes to see the control points that allow you to shape the curve.



Elastic Mode button

 Use when moving several nodes on a path. It makes the segments located between selected nodes behave like 
a rubber band; they stretch or shrink instead of remaining intact.



Cusp button

Converts the selected node(s) to cusp nodes which are used to make sharp changes in the direction of the path.



Symmetrical button

Converts the selected node(s) to symmetrical which produces a curve which has the same angle on either side of
the node.



Smooth button

Convert the selected node(s) to smooth in which the node and associated control points are on a straight line; 
this makes smooth changes in the direction of the curve.



Mask From Path button

Click to create a mask selection using the current path as its shape. Using the Mask Transform tool, you can 
move the mask and still see the path it was created from.



Path From Mask button

Click to create a path from the mask marquee displayed in the Image Window. The mask still exists after this 
operation is performed.



Stroke Path button

Click to apply a brush stroke or an effect along the path outline. A dialog box will appear for you to choose a tool 
and its attributes.



Buttons in the Objects Roll-Up



Lock icon

 Toggles between the locked and unlocked positions. Found in the Objects Roll-Up. Lock protects the 
associated object from editing changes made to the image; unlock makes the object editable.



Eye icon

Icon found in the Objects Roll-Up. Toggles the display of the associated object or channel on and off. 

Note
· An invisible object is automatically locked, i.e. protected from editing changes made to the image.



Buttons in the Recorder Roll-Up



Record button

 Press to begin recording the actions you apply to an image. Each command, keystroke and tool used is listed 
chronologically in the Recorder Roll-Up.



Stop button

 Ends or pauses the recording of actions in the Recorder Roll-Up.



Play button

 Plays the recording listed currently in the Recorder Roll-Up. The actions included in the command list are 
performed on the current image.



Step Forward button

 Plays the command listed in the Recorder that the Position Indicator (
) points to. The Indicator then moves to the next command in the list but does not play it. Use this button to play 

only one command in a script.



Rewind button

 Click to move the Position Indicator (
) to the first command in the script.



Fast Forward button

 Click to move the Position Indicator (
) to the last command in the script.



FOLLOWING ARE DESCRIPTIONS OF THE 3 CURSOR TYPES: NOT TOOLS I KNOW, BUT DID 
NOT KNOW WHERE ELSE TO PUT THEM.



Shape cursor
The Shape cursor represents all tools that have a nib (Paint, Effect, Clone, Mask Brush tools) as well as the Undo 
tools, by the current shape or size of the tool as specified in the Tool Settings Roll-Up. The Text tool is always 
represented by an I-beam, the Object Picker tool by an arrow.



Tool cursor
The Tool cursor represents all tools in the Image Window by a small version of the tool icon. This allows you to 
quickly see what tool is currently selected by simply looking at the cursor in the Image Window. Shape and Mask 
tools are displayed as a cross hair cursor with a small representation of the tool on the top right section of the 
cross hair. The Text tool is always represented by an I-beam, the Object Picker tool by an arrow.



Cross hair cursor
The Cross hair cursor represents all tools in the Image Window by a dashed cross. The intersection of the 
horizontal and vertical segments of the cursor is the starting point for each tool. When you are using a tool which
has a nib, such as the Paint, Effect, or Clone tool, the intersection corresponds to the center of the nib. The Text 
tool is always represented by an I-beam, the Object Picker tool by an arrow.



Always Update Preview button

 Click to have the preview area update after each selection, or change in selection, you make in the dialog box.



Tool pickers in TSRs and Property Bar



Clone tool picker

Displays the four cloning tools (from left to right: the Normal clone tool, Impressionist clone tool, Pointillism clone
tool, and Clone from Saved tool). To select a clone tool, click its icon. 



Tool Settings Roll-Up button

Click to open the Tool Settings Roll-Up for the selected tool.



Render as Object button

Click to create shapes as objects. This leaves them editable.



Effect tool picker

Click the arrow to open the Effect tool picker. To select an effect tool, click its icon. 



Nib picker

Click the arrow to open the Nib picker. To select a nib, click its icon.



Paint tool picker

Click the arrow to open the Paint tool picker. To select a paint tool, click its icon.



Buttons, icons, thingies, etc. in the Paint 
Color db



Color Model icon

Click to display a color model as your color selector. To select a different color model, click the  at the top right
of the dialog box and select one from the list.



Fixed Palette icon

Click to display a fixed palette as your color selector. Click the  at the top right of the dialog box to display 
more options for the current palette.



Color Blender icon

Click to display a color blender as your color selector. Click the  at the top right of the dialog box to display 
more options for the color blender.



Mixing Area icon

Click to display a mixing area as your color selector. Click the  at the top right of the dialog box to display more
options for the mixing area.



Tools in the Effects menu



The Set Center button

Click to determine the center of a radial effect.



The Direction Dial

Click and drag the arm of the dial to set the direction in which a special effect will be applied.



The Monkey Wrench Symmetry selector

One of the Symmetry tiling options in the Terrazzo filter.



The Light Source Settings selector

Click to indicate which light source in the Lighting Effects dialog box is being edited.



The Add and Remove Light Source buttons

 Click the Add Light Source button to add a light source to your image; click the Remove Light Source button to 
remove the active light source. 



The Reveal/Hide Light Source button

 Click to reveal or hide the light source in the preview window.





Lets you select, move, and resize objects using the mouse. After you select an object, you can use commands in 
the menus or the toolbar to change its appearance.



Removes the fill from the current object, leaving it transparent.



Removes the fill or outline color from the current object, leaving it transparent.



Magnifies or reduces your drawing. Click and drag in the Drawing Window to zoom in on an area; right-click to 
zoom out.



These two arrow buttons allow you flip through the pages of your document. They are located at the lower-right 
corner of the Preview box.





Trademarks and registered trademarks
The following list identifies all the trademark and registered trademark product, feature, and company names 
appearing the Corel WebMaster Suite Help files:
Corel® WebMaster Suite
Corel® WEB.DESIGNER
Corel® WEB.DATA
Corel® WEB.PhotoPaint

Corel® WEB.WORLD
Corel® WEB.GALLERY
Corel® WEB.DRAW
Corel® WEB.MOVE
Corel® WEB.SiteManager
Borland® dBASE®
Lotus® 123®
Microsoft® Access
Miscrosoft® Excel
Microsoft® FoxPro®
Microsoft® Internet Explorer
Microsoft® SQL Server

Microsoft® Windows® 95
Microsoft® Windows NT

Macromedia®
Netscape Navigator
Oracle®
PageDepot
Paradox®
Java  Programming Language
HotJava  Browser
Java  Powered applet
WebSite 1.1, a trademark of O'Reilly & Associates, Inc.

Java and other Java-based names and logos are trademarks of Sun Microsystems, Inc. and refer to Sun’s Java 
Technologies.





Working with color



Working with color
Corel WEB.PhotoPaint offers an impressive array of tools and techniques to give you full control over the colors 
that appear in your image, as well as the means to choose and edit new colors. Millions of colors are available at 
every stroke of your brush or click of your mouse. But as the range of available color options becomes broader, it
also becomes much more difficult to get colors just right. Greater capabilities also mean more variables, more 
potential pitfalls, and a greater need for tools to help you deal with the sometimes baffling world of full-color 
desktop color. 
This section will show you how to convert your image to a different color mode, select and create colors using 
the various available methods, edit or fine-tune colors using the Color Table, and perform color corrections using 
the filters Corel WEB.PhotoPaint provides for this purpose. 

Color modes, models, and color matching systems
Color modes refer to the color characteristics of an image. Color modes are described in terms of their color 
components (an RGB image is made up of red, green, and blue values) and their bit depth (e.g., the number of 
colors they are capable of producing). The more colors a color mode is capable of producing, the more disk 
space it requires from your system, and the more memory-intensive it is.
Color models are essentially colors that have been arranged into charts. You can use these charts to choose or 
identify colors for your image. Color models use mathematical representations of a color space to provide a 
standard against which we can measure color. 
A color palette is a collection of colors. Use the color palettes displayed in the Color Roll-Up, the Color dialog box,
and the onscreen Color Palette to pick colors for your image.
These are the three color palettes you are most likely to use:
· The Image Colors palette is a collection of all the colors that appear in your paletted image.
· The Uniform Colors palette is a collection of 256 colors evenly spread across the color spectrum.
· The Custom Colors palette is a palette composed of colors you select and arrange using the Color dialog box 

or the Color Roll-Up.

For more information see the following:
{button ,JI(`',`Converting your image to a different color mode')} Converting your image to a different color 
mode
{button ,JI(`',`Creating and selecting colors page 1 of 2')} Creating and selecting colors
{button ,JI(`',`Using custom color palettes')} Using custom color palettes
{button ,JI(`',`Working with the Color Table')} Working with the Color Table
{button ,JI(`',`Correcting or adjusting the colors in your image')} Correcting or adjusting the colors in your image
{button ,JI(`',`Preserving image color on the Internet')} Preserving image color on the Internet



Converting an image to a different color 
mode



Converting your image to a different color mode
You can use the commands in the Convert To flyout menu (click Image, Convert To) to convert the color mode of 
your image. Any conversion from one color mode to another involves some loss of information. This color loss 
won't be recovered by converting the image back to its original color mode.

 Note
· To use the Netscape Navigator  Colors palette or the Microsoft® Internet Explorer Colors palette, click 

Image, Convert To, Paletted (8-bit), choose the Custom option, and click OK. This opens the Color Table dialog 
box. Choose the custom palette you wish to use from the Table list box in the Color Table dialog box.

{button ,AL(`OVR Working with color;',0,"Defaultoverview",)} Related Topics



Converting a grayscale image to duotone
An image in the duotone color mode is a grayscale image enhanced with one to four additional colors. In the 
duotone color mode, an image is composed of 256 shades of one ink (monotone), two inks (duotone), three inks 
(tritone), or four inks (quadtone). 
When you open the duotone dialog box, tone curve grid appears in the image window. On the x axis, light values
(highlights) are toward the left; dark values (shadows) toward the right. The y axis moves from low color density 
toward the bottom to high color density toward the top. A null curve (straight diagonal line) on the grid indicates 
that the grayscale value of each pixel in the image is directly proportional to the percentage of the selected ink. 
In your artwork, this mode can be used to give a touch of color to grayscale images, or to create interesting 
special effects using different tone curve settings.

To convert a grayscale image to monotone, duotone, tritone or quadtone
1. Click Image, Convert To, Duotone.
2. In the Type list box, choose an option.
3. Enable the Preview check box to view the image in duotone mode. 
4. To edit ink colors, click the Inks tab. Then click a color swatch. The line on the tone curve becomes the color of 

the ink being edited. 
5. To choose a new color, double-click a color swatch that you want to change. 

The Color dialog box opens. Click a color from one of the models.

To adjust the duotone curve of an ink
1. On the Inks tab of the Duotone dialog box, click a color box. 
2. To adjust the percentage of color in the image's highlights and shadows, click and drag the nodes at either end

of the line. 
Drag the bottom node upward to increase the amount of color in the highlights; drag the top node downward 
to decrease the amount of color in the shadows.

3. Click on the line to create a node to adjust the percentage of color at any point along the curve. 
4. Position your pointer over the node you wish to edit. 

A hand icon appears when you are over the node. 
5. Click and drag the node to adjust the curve.

To specify how overprint colors display on screen
1. Enable the Use Overprints check box.
2. Double click the color you wish to edit from the box.

The Select Color dialog box opens.
3. Select a color from the Select Color dialog box and click OK. 

The color you’ve selected will appear on the portions of your image where the two inks overlap.
 Notes

· After conversion, you can edit your tone curves at any time by clicking Image, Convert To, Duotone again.
· You can only create duotone images from grayscale images. This option will be grayed out in all other color 

modes.

{button ,AL(`PRC Converting an image to a different color mode;',0,"Defaultoverview",)} Related 
Topics



Converting your image to paletted image mode
Paletted image mode is an 8-bit color mode that stores and displays images using up to 256 colors. Converting a
complex image to paletted color mode is useful for reducing file size, especially in preparation for Internet 
publishing. Paletted color mode also allows you to use the Color Table command to edit the colors found in the 
image. 
For more information on editing your paletted image using the Color Table, see Working with the Color Table . 

To convert an RGB image to 8-bit paletted color
1. Click Image, Convert To, Paletted (8-bit).
2. Click a Dither Type button. Dithering is a method of randomizing the pixels along the edges of adjacent colors 

in a paletted image to make color blends and transitions look more natural.
· None disables dithering.
· Ordered dithering approximates color blends using fixed dot patterns. Ordered dithering applies more 

quickly than error diffusion, but is not as accurate.
· Error Diffusion dithering provides the best dithering results by spreading the dithering across a wider area 

and tailoring the dithering pattern to the transition being simulated.
3. Enable a Palette Type button.

· Uniform provides a range of 256 colors with equal parts of red, green, and blue.
· Standard VGA provides the Standard VGA 16-Color Palette in the conversion.
· Adaptive samples the image and uses the first 256 colors to create the palette.
· Optimized contains colors centered around the image's spectrum of colors.

Custom allows you to choose predefined Color Palettes such as Netscape Navigator  colors and Microsoft®    
Internet Explorer colors, or to add colors to create your own custom palette. If you choose Custom, the Color 
Table dialog box opens. Choose a palette in the Table list box.
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Converting an image to RGB color mode
RGB is a 24-bit additive color mode which builds all colors using varying amounts of red (R), green (G), and blue 
(B). RGB is widely used in digital images because it is based on the color model used by color monitors. 
Converting files from any color mode to 24-bit RGB image mode is a relatively simple procedure.

To convert an image to RGB
· Click Image, Convert To, RGB color (24-bit).
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Creating and selecting colors (page 1 of 2)

Selecting colors from the image
The Eyedropper tool, found in the Toolbox, allows you to sample the color of a particular pixel or group of pixels 
in your image. You can make the sampled color the current paper color, paint color, or fill color. It is useful in 
image editing because it allows you to ensure that the color you are working with exactly matches a color from 
the image. For example, rather than trying to find the right color of pink to enhance the blush on a model's 
cheek, you can sample the exact color directly from her face. 

The Color Roll-Up
The Color Roll-Up is used to choose and customize paint and paper colors for immediate use in Corel 
applications. As with all Roll-Ups in Corel applications, the Color Roll-Up can remain open while you work. This 
gives you quick access to the entire range of Corel color-selection tools without having to go through a series of 
dialog boxes. 
The Roll-Up shows two layered color swatches and the color mode being used by the Roll-Up. The swatches 
represent the current paper color (background swatch) and paint color (foreground swatch).
Click  to access four additional areas of the Roll-Up.
· Show Color Components displays numeric values for the current color.
· Show Color Name displays the name of the current color (if a name has been defined for the color). You can 

also use this option to rename any color in the custom palette.
· Show Mixing Area displays a white space which functions like an artist’s palette. Choose colors from anywhere 

in the Roll-Up and "brush" them into the Mixing Area. These colors are blended with other colors to create 
custom colors. Sample a color from the Mixing Area with the Eyedropper tool provided in the Roll-Up to use it 
as the paint color or to add it to a custom palette.

· Show Model displays the color model, palette, or color blend. For each model, there is a visual selector that 
you use to define the color. You click the selector box to select your color. For palettes, a set of swatches is 
shown to represent the available colors. The models and palettes available depend on the color mode of your 
image. For example, with a 24-bit image you can use colors from any color model and from all color-matching 
palettes.

{button ,Next()} Click here to see the next page.
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Creating and selecting colors (page 2 of 2)

The Color dialog box
The Color dialog box appears in several places in Corel WEB.PhotoPaint under a variety of names Uniform Fill, 
Fountain Fill, Paint Color, Paper Color, and Select Color. 
The Color dialog box is larger than the Color Roll-Up and offers more options. It shows you a number of color-
selection features at once: a color palette, a color model, and numerical values for a color in up to four color 
models.
Use the controls on the right side of the dialog box to choose colors from color models and palettes and blend 
them in the Mixing Area. The Color Options menu, accessed by clicking  at the upper right of the Color dialog 
box, provides options for changing color models and adding new colors to the custom palette.
Use the lower part of the dialog to develop a custom palette. The Palette Options menu, accessed by clicking  
located to the right of the palette at the bottom of the Color dialog box, provides options for starting new 
palettes, deleting colors from the current palette, and saving and loading the palettes you develop. Within the 
custom palette area, you can reorganize and rename the color swatches.

The upper left portion of the dialog includes the Reference and New Color swatches. The Reference Color swatch 
shows the last color used as the reference. The New Color swatch shows the color you are creating or editing in the 
dialog box. You can use these swatches to fine-tune the edited color by comparing the difference between the two 
colors. 

The Color Component boxes display the numerical values of the color displayed in the New Color swatch, based 
on the color model chosen.

 Tip
· To access the Color dialog box quickly for paint, fill or paper colors, double-click the paint, paper, or fill 

swatches on the Status Bar.
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Selecting colors using the Eyedropper tool
Use the eyedropper tool to sample colors from your image. You can use a sampled color as a palette color or use 
it to get colors for paint, paper, and fill.

To sample colors from your image
1. Click the Eyedropper tool.
2. On Property Bar, click a sampling area button.

· Point takes the color sample from the color of a single pixel you click.
· 3 X 3 takes the color sample from an average of the 9 pixels around the pixel you click.
· 5 X 5 takes the color sample from an average of the 25 pixels around the pixel you click.
· Custom allows you to click and drag a custom sampling area, from which an average is taken.

3. To sample a color or range of colors, click the image pixel or pixels you wish to use. You have the following 
options:
· Hold down CTRL and click the image to choose the paper color
· Hold down SHIFT and click the image to choose the fill color

To set the fill color using the right mouse button
1. Click the Eyedropper tool.
2. Click View, Roll-Ups, Tool Settings
3. Enable the Use Right Button For Fill Color check box.
4. In the Image Window, position the Eyedropper tool on a color and click the right mouse button.

 Tip
· Watch the Status Bar at the bottom of your desktop: it gives you exact numeric values for image pixel colors 

as the Eyedropper tool moves over them.
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Using the paint and paper color swatches in the Color Roll-Up
The paint and paper color swatches, found in the upper left corner of the Color Roll-Up allow you to set and swap
colors for paint and paper. The paint and paper color swatches in the Status Bar are updated according to the 
changes you make in the Roll-Up.

To swap paper and paint colors
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2. Do one of the following:

· Click  to make the paper color the paint color and vice versa
· Click , Swap Colors.

To reset the paper and paint colors 

· Click  to reset the paper color to white and the paint color to black.
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Selecting colors from a visual selector
An easy way to pick colors is to use one of the visual selectors to sample colors directly from a chart of a color 
model. The layout of the visual selector is based on the number of channels in the color model you choose in the
Color Model box. 
· The single channel visual selector, used in the grayscale color model, is a vertical slider along a gradation from

black (0) to white (255).
· The three-channel visual selector is a square containing gradients of a color, from black along the bottom, to 

white in the upper left. Pure color is in the upper right with a slider to change the hue of the pure color. 

To pick a color from a visual selector
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2.Choose a color model from the Color Model list box. 
3 Drag the markers in the visual selector box to edit the color.
 Note

· In Corel WEB.PhotoPaint, only models that are compatible with the image mode of the active image are 
available.
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Defining colors numerically
The Color Component boxes allow you to define a color by entering values for each of its components. To define 
an RGB color, for example, enter component values for Red, Green, and Blue channels.

To edit the selected color 
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2 Cick , Show Color Components.

3. Choose a color model from the list box located at the top of the Color Roll-Up. 
The color models listed depend on the color mode of the image.

4. Type a number one of the Color Component boxes. You can type any number that is within the color model’s 
range of values. Higher values will be clipped to the maximum value.
· For RGB, CMY, YIQ, and Grayscale color models, type a number from 1 to 255. 
· For HLS and HSB color models, type a Hue value from 1 to 255 and percentage values for the other 

components.
5. Repeat steps 2 and 3 for each component.
 Note

· If you type values above the maximum possible for color component, the value is automatically set to the 
highest possible value.
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Creating colors in the Mixing Area
The Mixing Area resembles an artist’s palette on which you apply and mix colors using the Brush tool. A blend 
setting lets you to control how much color you apply to the Mixing Area so that you can achieve subtle variations
in color.
The Mixing Area differs between the Color dialog box and the Color Roll-Up. In the Color Roll-Up, the Mixing Area 
is roughly half the size of the Mixing area found in the Color dialog box.
You can save a Mixing Area to a bitmap file. In this way, you can create a variety of Mixing Areas based on color 
models or on the needs of specific projects. You can also load any bitmap image into the Mixing Area. This lets 
you choose and modify colors from bitmapped photographs and drawings.

To mix colors in the Color Roll-Up
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2 Cick  Show Mixing Area.

3 Select a paint color in the visual selector.
4 Click the Paint tool found in the Roll-Up. 

Click , Brush Size if you want to change the brush size or characteristics.
5 To apply color to the Mixing Area, click and drag inside it with the tool. 

The new brush strokes blend with those already in the Mixing Area to create new colors.
6 Repeat steps 2 to 4 to create blends of color.
7 Move the Blend slider to set the transparency of the brush nib.
8. Using the Eyedropper tool, click the Mixing Area to pick up a color you wish to use.
 Tip

· Blend either increases (high value) or decreases (low value) the subtlety of color blending. This feature gives 
you greater control over the mixing process. Use a high value when you want to gradually build up color to the
desired saturation. Use a low value when you want to create a heavily saturated base.

· You can clear your Mixing Area, save it or load a new one using the following options: 
· Click , Clear Bitmap.

· Click , Save Bitmap, type a filename in the File Name box, and click the Save button.
· Click , Load Bitmap, and select a bitmap to use as a mixing area.
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Creating colors with the Color Blend
The Color Blend is a visual selection feature that allows you to select colors using gradations between four colors
across a square grid.

To mix colors in Color Blend area
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2 Coose Color Blend from the Color Model list box.
3 Click one of the four color buttons at the corners of the Color Blend.
4 Click a color on the custom palette that appears.
5 Repeat steps 2 and 3 for each color button.
6 Ensure that the Auto-Blend button is enabled. This will continuously update the Color Blend as you add new 

colors.
7 Click a grid square to choose a color.

To get image colors from other sources
1. Pick a color using any color selection tool (color models, palettes, mechanical color measurement devices, 

etc.). The color appears in the Paint Color swatch.
2. Drag the color from the active color swatch to one of the boxes at the corners of the Color Blend.

To change the Color Blend grid size 
1. Click , Grid Size.

2. Enable one of the grid sizes.
Grid sizes range from 3 x 3 to 25 x 25 in single-unit increments. Increase the grid size to create a more subtle 
gradation of color; decrease the grid size for more marked gradation.

To change the color blend color model 
1. Click , Color Model.

2. Choose one of the color models in the flyout.
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Selecting colors from palettes in the Color Roll-Up
The Color Roll-Up gives you access to colors from a number of color palettes and color-matching systems.

To pick a color
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2 In the Color Roll-Up, choose Palette from the Color Model list box, (to the right of the color swatches).
3 Choose a palette from the Palette Name list box, which appears above the color palette in the Roll-Up.
4 Click a color from the palette.
 Note

· The availability of specific palettes in Corel WEB.PhotoPaint depends on the color mode.
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Selecting the colors for the on-screen Color Palette
The on-screen Color Palette (often called the color picker) allows you to keep a range of colors available in your 
application window for quick color selection as you work. The colors this feature displays are determined by the 
color palette you select. 
This feature appears by default as a single row of color swatches, but you can stretch your Color Palette, move it 
anywhere in your Application Window, or anchor it to the sides,

To activate the on-screen Color Palette and choose a collection of colors
1. Click View, Color Palette.
2. Choose a color palette from the flyout menu.

To load a custom palette as the on-screen Color Palette
1. Click View, Color Palette.
2. Choose Load Custom Colors from the flyout menu.
3. Choose a Custom Palette file (.CPL) from the dialog box that opens.
4. Click Open.
 Tip

· To create your own custom palette of colors, use the Color Roll-Up.
· You can customize the appearance of the color palette by removing the three-dimensional wells around the 

swatches or changing the size of the swatches themselves. Click Tools, Customize, and click the Color Palette 
tab to choose these options.

{button ,AL(`PRC Creating and selecting colors;',0,"Defaultoverview",)} Related Topics



Using custom color palettes



Using custom color palettes
Custom palettes contain a range of colors that you choose. In both the Color Roll-Up and the Color dialog box, 
you can create new custom palettes, or add and remove colors from existing palettes.
Colors can be added to a custom palette from any source  from an image, a color model, a color-matching 
palette, a color blend, the Mixing Area, or from mechanical color measurement devices. A custom palette can 
include colors from all of these sources.

By using the New Palette, Open Palette, and Save/Save As Palette commands, you can create custom palettes for 
specific applications or projects, and save palettes in libraries. These commands are only available when you are 
working with the Palette option enabled in the Color Model list box and Custom Palette enabled in the Palette list 
box.
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Adding and deleting colors in the custom palette

To add a color to the custom palette in the Color Roll-Up
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2 Choose Palette from the Color Model list box, (to the right of the color swatches).
3 Choose Custom Color in the palettes list box.
4 Choose the color you want to add from the color models, palettes, or mixers.
5 Click  and enable Show Color Name.

6 Type a name for the color in the Name box (optional).
7 Click , Add Color. 

A swatch for the new color is added at the end of the custom palette.

To add a color to the custom palette in the Color dialog box
1. Select the color you want to add from the color model’s visual selector or from the Mixing area.

The color is displayed in New Color swatch in the upper left corner of the dialog box.
2. Click the New Color swatch and drag it to the custom palette at the bottom of the dialog box.

To delete a color from the custom palette 
1. Click a color in the custom palette.
2. Click , Delete Color.

3. Click Yes to delete the color; click No to cancel.
 Note

· When colors are taken from pre-defined color-matching palettes (i.e. TRUMATCH), the color names are 
retained.

· You cannot add more than one color with the same name in the custom palette. 
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Creating, saving, and opening custom palettes

To create a new custom palette 
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2. Click , New Palette.

3. Type a filename for the new palette in the File Name box.

To save a custom palette 
· In the Color Roll-Up, click , Save.

To open a custom palette 
1. Save the current custom palette, if you want to keep it.
2. Click , Open Palette.

3. Locate the file in the File Name list box.
4. Double-click the filename.
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Using the Image Colors palette
The Image Colors palette is available only for images in the paletted color mode in Corel WEB.PhotoPaint. This 
palette is a custom palette that contains all of the colors in your paletted image and changes to reflect any 
changes to image colors.
To edit colors in your Image Colors palette and to apply them to your image, use the Color Table. See Working 
with the Color Table.

To view or refresh the Image Colors palette in Corel WEB.PhotoPaint 
1. Click View, Roll-Ups, Color to open the Color Roll-Up.
2. Choose Palette from the Color Model list box, (to the right of the color swatches).
3. Choose Image Colors from the Palette list box.
 Tips

· You can save an image palette to use it as you would any custom palette.
· If you are saving the palette to an existing file, double-click the filename in the list box and then click Yes when

prompted.
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Using Netscape Navigator  or Microsoft Internet Explorer ® color palettes
There are two Browser palettes available in Corel WEB.PhotoPaint: Netscape Navigator  Colors, and Microsoft 
Internet Explorer Colors. These 8-bit color palettes are designed to display a range of pure colors consistently in 
any browser by the company that supports them. Colors outside the range of these palettes may have 
unpleasant amounts of dithering. The image should be in Paletted color mode before you convert it to a custom 
palette.

To check the image's color mode
· Click Image, Info.

The image’s color mode information appears in the Type area.

To change the color palette to one of the custom Browser palettes
1. Click Image, Convert To, Paletted (8-bit).
2. Click one of the Dither Type buttons.
3. Click the Custom button in the Palette Type area.
4. Click OK.

The Color Table dialog box opens.
5. Choose either Netscape Navigator  Colors, or Microsoft Internet Explorer Colors from the Table list box.
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Working with the Color Table
The Color Table opens when you are converting an image to paletted color mode and you choose the Custom 
Palette Type option. You can also access it from the Image menu while you are editing a paletted image.
If you wish to use the Netscape Navigator  Colors palette or the Microsoft® Internet Explorer Colors palette, 
you can choose them from the Table list box in the Color Table dialog box.

The Color Table feature is especially useful for editing images with an optimized range of colors, such as .GIF 
images being prepared for Internet publishing. Despite its limitations, the paletted color mode is being used 
increasingly as the standard for images published to the Internet. It provides acceptable image quality at file sizes 
that can be as much as 90 per cent less than comparable RGB images.

The Color Table also permits you to create simulated duotones from your paletted image.
For information on converting your images to the paletted color image mode, see Converting your image to 
paletted image mode. 
 Note

· Paletted images are often called indexed color images or 256-color images.
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Editing color using the Color Table

To edit individual colors in the Color Table
1. Click Image, Color Table.
2. Choose Custom from the Table list box. Custom displays all the colors that are contained in the palette used to 

create your image.
3. Click the color swatch that you wish to change.
4. Click the Edit button.
5. In the Select Color dialog box, choose a replacement color using the visual selector, the Mixing Area, or the 

Color Blender.
6. Click OK. Any instances of the original color in the image are replaced with the new color.

To edit a range of colors in the Color Table
1. In the Color Table, click the swatch of the first color you want to edit and drag to the last.
2. Click the Edit button. 
3. In the Select Color dialog box, choose a replacement color for the first color and click OK. 
4. Repeat step 3 for the last swatch when a second color dialog appears and click OK.
· The original colors in the table are replaced by a graduated series of colors that blend from the first 

replacement color to the last. 
 Tips

· You can also double-click a color swatch to edit the selected color. This option does not work for color ranges.
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Creating simulated duotones from paletted images using the Color Table

You can use the Color Table command to simulate the effect of creating 8-bit duotones from your paletted image.
True duotones are representations of your image in one ink (monotones), two inks (duotones), three inks 
(tritones), or four inks (quadtones). 
After you have plotted densities for each ink on the inks tone curve, the Color Table creates a custom palette 
using those inks.

To create duotones
1. Click Image, Color Table.
2. Click the Duotone button in the Color Table dialog box.
3. Create your paletted duotone using the same procedure as duotone color mode conversion. See Converting a 

grayscale image to duotone.
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Correcting or adjusting the colors in your image
Corel WEB.PhotoPaint offers a number of features you can use to adjust or correct the colors in your image. 

Color Balance filter
This filter lets you shift the colors in your image between CMY (cyan, magenta, and yellow) color values and RGB
(red, green, and blue) color values. This is useful for correcting color casts in your image  for example, if 
someone's face is too red in your photograph, you could shift values from red to cyan. You can also use the Color
Balance filter to change the hue values for your entire image.

Hue/Saturation/Lightness filter
The Hue/Saturation/Lightness filter lets you adjust the colors in your image using HLS values. This is useful for 
changing the intensity of your image's colors or for changing their hue entirely.

Replace Colors filter
The Replace Colors filter lets you replace one color in your image with another color. Depending on the range 
you set, you can use this filter to replace a single color, or to shift the entire image from one range of color to 
another. 

Desaturate filter
The Desaturate filter lets you remove the hue component of all colors in your image, making the colors appear 
as their grayscale equivalents. 

Invert filter
The Invert filter makes a negative of your image by converting all color values to their opposites: blacks become 
white, blues become yellow, etc. 

Posterize filter
The Posterize filter transforms the color range of your image to solid blocks of color, reducing gradual blends to 
hard edges between areas of color. 

Threshold filter
The Threshold filter converts certain shades of each color in an image to black, white, or in bi-level mode, to 
control the process of conversion to black and white. 
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Adjusting color using the Color Balance filter
Use this filter to shift the colors in your image between complementary pairs of the primary (RGB) and secondary
(CMY) colors.

To shift the color balance of your image
1. Click Image, Adjust, Color Balance.
2. Enable the check boxes for the tonal ranges you want to shift.
3. Enable the Preserve Luminance check box to ensure that the brightness levels aren't affected.
4. Move the Color Channel sliders to set color levels for each of the three channels (Cyan-Red, Magenta-Green, 

and Yellow-Blue).
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Adjusting hue, saturation, and lightness
Use the Hue/Saturation/Lightness filter to alter the hue, richness, and white values of your colors.
The color preview area allows you to see how the color of the original image (the top color bar) compares with 
the adjusted values (the lower color bar). In the case of the examples below, the Hue slider was moved to a 
value of minus 180.

Original Color

New Color
Notice that the color in the center of the original color bar is a light blue while the color at the center of the new 
color bar is red. So, all of the light blues in your image will appear red.

To adjust Hue/Saturation/Lightness values
1. Click Adjust, Hue/Saturation/Lightness.

· Hue is a measure of the "color" of the colors in your image (e.g. green is a hue).
· Saturation is a measure of the depth of color in your image (the "richness" of a color).
· Brightness is a expression of the overall percentage of white in your image.

2. Move the Hue slider to shift the colors of all the pixels in your image. 
The color preview area allows you to see how the color of the original image (the top color bar) compares with 
the adjusted values (the lower color bar).

3. Move the Saturation slider to set the strength of the colors in your image. 
A Saturation slider setting of -100 results in a grayscale image, while a setting of 100 produces unnaturally 
vibrant colors.

4. Move the Lightness slider to determine the brightness of the image.
Lightness determines the amount of white (positive values) or black (negative values) in the image.
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Replacing colors in your image
Use this filter to identify and replace colors in your image. The filter applies a temporary color mask over the 
image using controls similar to those used in Color Masking. You control this mask with the Range slider. Higher 
settings result in more colors being replaced.

To replace colors
1. Click Image, Adjust, Replace Colors.
2. Click the Eyedropper tool and use it to choose the color you wish to replace. The color bar on the Old Color and

New Color flyouts in the Color Picker section changes to that color.
3. Do any of the following:

· Move the Hue slider to set the hue level of the new color.
· Move the Saturation slider to set the saturation level of the new color.
· Move the Lightness slider to set the lightness level of the new color.
· Click the New Color flyout and choose a new color from a Color Palette or model.

4. Move the Range slider to set the range of affected colors. Applying the effect with a range of one affects only a
single color; applying a range of 100 will shift most of the colors in the direction of your new color.

{button ,AL(`PRC Correcting or adjusting the colors in your image;',0,"Defaultoverview",)} Related 
Topics



Desaturating your image
Use this filter to convert all the colors in your image to their grayscale equivalents. 

To remove color from your image
· Click Image, Adjust, Desaturate.

Colors are converted to shades of gray.
 Tip

· For more control over desaturation, use either the Color Hue or the Hue/Saturation/Lightness filters.
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Inverting colors in your image
Use this filter to reverse the colors in your image, making it appear to be a film negative of itself.

To invert the colors in your image
· Click Image, Transform, Invert.
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Posterizing your image
Use this filter to reduce groups of color to solid colors and to exaggerate the edges between areas of color in 
your image.

To posterize your image
1. Click Image, Transform, Posterize.
2. Move the Level slider to determine the level at which posterization begins. The slider values range from 1 to 

32. A level of 1 results in the most drastic posterization; a level of 32 has no effect on most images.
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Using the Threshold filter
Use the threshold filter to convert parts of your image to black or white, or change your whole image to black 
and white by enabling the bi-level check box.

To work with threshold levels in your image
1. Click Image, Transform, Threshold.
2. Choose one of the options in the Threshold section.

· To Black sets the amount of black in the final image.
· To White sets the amount of white in the final image.
· Bi Level allows you to divide the color in your image between high and low (black and white) values.

3. Enable the Automatically check box in the Histogram Display Clipping section. Histogram clipping changes the 
level of sensitivity of the histogram, ensuring that you will be able to see all the levels on your screen at once. 

4. Choose a channel to edit in the Channel list box. The channels that appear depend on the color mode of your 
image. Choose the color mode name to alter all three channels at once.

5. Move the Low-level slider to set the brightness level of the darkest color in your image. A value of 0 is black; 
higher values are shades of gray.

6.  Move the High-level slider to set the brightness level of the lightest color in your image.
7. Move the Threshold slider to set the brightness level at which colors are converted to black or white.
 Note

· The High level slider is grayed out in To Black mode; the Low Level slider is grayed out in To White mode.

To use threshold to convert an image to black and white values
1. In the Threshold dialog box, enable the Threshold as Bi-Level check box.
2. Move the Low Level slider to set the brightness of the lower tone (the black). 
3. Move the High Level slider to set the brightness of the higher tone (the white).
4. Move the Threshold slider to set the brightness level at which colors will convert to black.
 Tip

· Use this filter in bi-level mode to prepare an image for conversion to the Black and White color mode.
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Preserving image color on the Internet
You want the image you post to the Internet to look just like the one on your screen in Corel WEB.PhotoPaint, but 
you also want it to be small enough that people will wait around long enough for it to load. 
There are two major issues with publishing color images to the Internet. The first takes place at your end and has
to do with color conversion in Corel WEB.PhotoPaint. The second happens at the other end when your image is 
displayed in a browser somewhere on the Internet. Internet Browsers can process only a limited range of colors. 
This increases speed and eases file handling, but it means that your image may lose even more detail when 
displayed on a browser. 
In order to shrink your image files to manageable sizes for Internet publishing, you will have to convert them into
a different color mode and likely compress them as well. This process always results in some lossiness. The trick 
is to lose as little color as possible while reducing bit depth and file size. 

Converting your images to 8-bit color mode
The best way to reduce the size of your files is to reduce the number of colors in them. By converting your file 
from 24--bit color to 8- or even 4-bit color, you can reduce your file size by 90 per cent or more. Converting your 
image from 16 million colors to a 256 color paletted mode will obviously involve some loss of image quality. 
However, with the right techniques and some practice, any image can be converted to 256 colors with 
acceptable results.
In converting to paletted color mode, Corel WEB.PhotoPaint converts colors to their closest equivalents in a 
palette of 256 colors or less. The picture of the sunflower takes up 123KB of memory in its original 24-bit 
RGB, .TIF format, even after it has been resampled to a resolution of 72 dpi.

Conversion to standard palettes

256 colors 16 colors
In Uniform, Standard VGA, and most of the Custom Color palettes, the range of colors is set by a broadly 
accepted standard, and Corel WEB.PhotoPaint simply tries to get the colors in your image as close to these as 
possible. The advantage of this is that, because they conform to these standards, you can be more sure that 
colors will be consistent wherever your image goes. Also, with dithering enabled, image quality isn't too bad. 
However, for most images, a large number of the 256 colors will be wasted because they fall outside the set 
colors of the palette. 

Smart conversion
In using either the Adaptive or the Optimized options, you allow Corel WEB.PhotoPaint to create a palette based 
on colors that appear in the original image. That way, the range of 256 colors can ignore the colors that don't 
appear. Or, as in the case of the .GIF image above, you can reduce the number of colors all the way down to 16 
while retaining good image quality.
By reducing your image palette to 16 colors, your image crosses the line between the 8-bit and 4-bit color 
modes. So as strange as it may seem, a 17 color image is substantially larger than a 16 color image.
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Customizing Corel WEB.PhotoPaint
The Tools menu provides several commands that let you customize the behavior and user interface of Corel 
WEB.PhotoPaint so that it works the way you do.
The Options command lets you choose how Corel WEB.PhotoPaint behaves when you launch it, the color of many
on-screen indicators, which indicators are displayed, the units of measurement to use when transforming objects
or mask selections, memory usage options, and much more.
You can use the Pen Settings command to set the sensitivity and behavior of a pressure-sensitive tablet and pen 
that you can use instead of a mouse when you work in Corel WEB.PhotoPaint. You can even assign a tool to be 
activated when you press the eraser on the pen.

For more information see the following:
{button ,JI(`',`Choosing how Corel WEBPhotoPaint behaves')} Choosing how Corel WEB.PhotoPaint behaves
{button ,JI(`',`Disabling the display of warnings')} Disabling the display of warnings
{button ,JI(`',`Choosing measurement options')} Choosing measurement options
{button ,JI(`',`Choosing default viewing options')} Choosing default viewing options
{button ,JI(`',`Changing the look of onscreen indicators')} Changing the look of on-screen indicators
{button ,JI(`',`Safeguarding your work')} Safeguarding your work
{button ,JI(`',`Setting pressuresensitive pen options')} Setting pressure-sensitive pen options
{button ,JI(`',`Setting memory and performance options')} Setting memory and performance options
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Choosing how Corel WEB.PhotoPaint behaves
Many decisions about the behavior of Corel WEB.PhotoPaint must be made during the development cycle. To 
ensure you can make Corel WEB.PhotoPaint work the way you want, and to save time, you can reverse many of 
these decisions by choosing different options.
For example, you can choose to display one of three dialog boxes automatically when Corel WEB.PhotoPaint is 
launched. This allows you to save a few steps.
Another example is the location of dialog boxes; every dialog box displays by default in the center of the screen. 
You can move the dialog boxes to another location to see both the image and the dialog box. For your 
convenience, you can enable an option to have Corel WEB.PhotoPaint remember the last location of every dialog 
box and place them there again in the future.
Several features can be limited or completely disabled to free up some of your computer’s resources. For 
example, you can set the number of undo levels or disable the Undo and Undo List commands altogether. 
If you have sufficient memory and hard disk space on your system, you may prefer to retain all of Corel 
WEB.PhotoPaint’s features to derive maximum benefit from them. 
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Choosing a task to perform when opening Corel WEB.PhotoPaint
You can choose to have one of two dialog boxes open automatically when you launch Corel WEB.PhotoPaint. If 
you use Corel WEB.PhotoPaint mostly for image editing, choose to have the Open An Image dialog box displayed.

To choose the task to perform when launching Corel WEB.PhotoPaint
1. Click Tools, Options.
2. Click the General tab.
3. Choose an option in the On Startup list box. Your choices are

· Nothing: no dialog box opens automatically.
· New file: the Create A New Image dialog box opens automatically.
· Open file: the Open An Image dialog box opens automatically.

4. Click OK.
The next time you launch Corel WEB.PhotoPaint, the selected dialog box will open automatically. You can 
always cancel the selected dialog box if you need to perform a different task.
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Preserving dialog box position on screen
You can now tell Corel WEB.PhotoPaint to remember where you place a dialog box. The next time you open the 
dialog box it appears in the same location. If the dialog box has several tab pages, the tab you last used is also 
remembered and displayed.

To preserve dialog box position on screen
1. Click Tools, Options.
2. Click the Display tab.
3. Enable the Preserve Dialog Position And Last Used Tab check box.
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Enabling and disabling pop-up help
Pop-up help appears as small labels when you rest the mouse over a tool, button, or other screen element. The 
labels identify the element above which the mouse is located. You can switch the display of these labels on or 
off.

To enable and disable pop-up help
1. Click Tools, Options.
2. Click the General tab.
3. Enable the Show Pop-Up Help check box to display the labels, disable it to switch them off.

The option you select is effective immediately.
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Enabling and disabling undo capabilities
The Undo and Undo List commands found in the Edit menu allow you to reverse the last action performed on the 
image or a sequence of actions ending with the last one. Although this is extremely useful when editing images, 
it does take system resources. If your system does not have a lot of memory and you find that Corel 
WEB.PhotoPaint is not running at the speed you want, you can disable one or both of these commands to regain 
system resources.

To disable Undo and Undo List
1. Click Tools, Options.
2. Click the Memory tab.
3. In the Undo section, disable the Undo or the Undo List check boxes. You can also disable both check boxes.
 Note

· To enable the options again, simply click the check boxes again.
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Choosing the number of undo levels
The Undo command found in the Edit menu reverses the last action performed. You can choose the number of 
undo levels the command will support. Corel WEB.PhotoPaint will remember the number of actions you specify so
that you can use the Undo command repeatedly to reverse several actions. Keep in mind that the more undo 
levels you use, the more system resources are required (see note). An alternative to setting a very high number 
of undo levels is to use the Undo List command, also located in the Edit menu. 

To choose the number of undo levels
1. Click Tools, Options.
2. Click the Memory tab.
3. In the Undo Levels box, type the number of levels you want. The maximum number is 30.
 Note

· The number of Undo levels you choose affects the size of the swap disk required for Corel WEB.PhotoPaint to 
run properly. Each undo level requires that Corel WEB.PhotoPaint temporarily save the state of the image 
before you apply a new change. If you choose a very high number of undo levels, 30 for example, and apply 
30 commands that affect every pixel in the image, Corel WEB.PhotoPaint saves each version of the image on 
the swap disk; if the image is 5 megabytes in size for example, you would require 30 X 5 megabytes or 150 
megabytes of swap disk to handle so many Undo levels properly. If instead of using commands that affect 
every pixel, you apply brush strokes to the image, Corel WEB.PhotoPaint does not have to save as much 
information and therefore requires less disk space for each undo level. 

· For more information about swap disks and other memory options, see Setting memory and performance 
options.
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Disabling multi-tasking
Multi-tasking allows you to work on an image while Corel WEB.PhotoPaint is performing another task such as 
printing, or running a script, etc. If you mostly work on one image per work session and would like to free system
resources to improve Corel WEB.PhotoPaint’s performance, you can disable Multi-tasking.

To disable multi-tasking
1. Click Tools, Options.
2. Click the General tab.
3. Clear the Enable multi-tasking check box.
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Disabling the display of warnings
Several message boxes are regularly displayed when you use Corel WEB.PhotoPaint’s commands and tools. 
Although those warnings and messages are helpful, after you become familiar with the software, you may not 
need them. You can use the Options command to turn many of the warnings off.
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Enabling and disabling the read-only warning
When you open a file that has the read-only property, such as a Kodak Photo CD image file, Corel 
WEB.PhotoPaint displays a warning that the file is read-only and that the Save command is not available.

To enable and disable the read-only warning
1. Click Tools, Options.
2. Click the General tab.
3. Click the Enable Read-Only Warning check box to turn it on. Clear the check box to turn the warning off.
 Tip

· To save changes made to a read-only image, use the Save As command to save a copy of the file with a 
different name or save it in a different location.
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Disabling tool warnings
When you use tools like the Text, the changes you perform in the image are displayed in the Image Window but 
are not permanently applied until you click the Apply button on the Property Bar or in the Tool Settings Roll-Up. 
When you choose another tool, a message box is displayed that states that the tool you were using has changed 
the image and asks you if you want to apply the changes. Click Yes to apply the changes, No to return the image 
to its previous state. The Transparency Brush tool has its own specific message. You can turn these messages off 
so that the changes are applied automatically as soon as you choose another tool. 

To disable tool warnings
1. Click Tools, Options.
2. Click the Advanced tab.
3. Disable the Enable Tool Apply Warning check box.

To disable the Transparency Brush tool warning
1. Perform steps 1 and 2 above.
2. Disable the Show Transparency Brush Warning check box.
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Disabling the effect preview warning
When you work with an image that has objects and you choose a command from either the Effects menu or the 
Adjust and Transform commands from the Image menu, a message appears to advise you that the preview 
window in the selected effect’s dialog box may not be completely accurate. You can also disable this warning.

To disable the effect preview warning
1. Click Tools, Options.
2. Click the Plug-In Filters tab.
3. Disable the Show Warning When Editing Multiple Objects check box.
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Choosing measurement options
Measurement options are available in the Options dialog box. The General tab in the dialog box allows you to 
change the current units of measurement. The units you choose are used for:
· the horizontal and vertical rulers
· the object and mask transformations applied using the Tool Settings Roll-Up for the Object Picker and Mask 

Transform tools
· the Image Info command found in the Image menu
· the Crop tool and its associated Tool Settings Roll-Up
You can also choose the units in the Grid and Ruler Setup dialog box accessed from the Tools menu. There are 
two differences between this command and the Options command. The Grid and Ruler Setup command allows 
you to choose different units for the horizontal and vertical ruler, and these units apply only to the current 
image. The settings you choose in the Options dialog box are used for the current image as well as all new 
images. 
Other measurement options allow you to set two nudge distances to move objects and mask marquees in 
precise increments. The Calibrate Rulers option (Display tab) is used to adjust the rulers so that the current 
system of measurement matches real life dimensions.
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Choosing the units of measurement
You can use this procedure to change the units of measurement for both the horizontal and vertical rulers. To 
change only one ruler’s units, use the Grid and Ruler Setup command found in the Tools menu. The units you 
choose are also used when you apply transformations to objects and masks using the Tool Settings Roll-Up. 
These units will be used for all future images until you decide to change them.

To choose the units of measurement
1. Click Tools, Options.
2. Click the General tab.
3. Choose the units in the Units box.

The selected units are used in the Tool Settings Roll-Up for the Object Picker and Mask Transform tools.
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Settings the nudge increments
Nudge and Super-Nudge are used to move objects and mask marquees in precise increments by using the arrow 
keys, and SHIFT + an arrow key. You choose the nudge distance and then set the super-nudge distance as a 
multiple of the nudge distance.

To set the nudge increments
1. Click Tools, Options.
2. Click the General tab.
3. In the Nudge box, type the number of pixels you want the object or mask to move each time you press an 

arrow key.
4. In the Super-nudge box, type a multiple of the nudge distance specified in step 3.
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Making sure that one inch is really one inch
It is very important to make sure that one inch in your image really corresponds to one inch in your printed 
image. This makes the Zoom 1:1 accurate and gives you the exact size of your image when you view it at 1:1.

To make sure that one inch is really one inch
1. Click Tools, Options.
2. Click the Display tab.
3. Click Calibrate Rulers.
4. Hold up a clear plastic ruler next to the horizontal ruler displayed on your monitor.
5. Adjust the horizontal coordinates displayed in the top left of the screen until one inch on the ruler corresponds 

exactly to one inch on the plastic ruler.
6. Repeat step 5 for the vertical ruler, or type the coordinates that are in the horizontal box in the vertical box.
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Choosing default viewing options
By default, Corel WEB.PhotoPaint opens images at 100 per cent magnification. You can choose a different 
magnification for all images you open.
When you perform image manipulation such as resampling, cropping, or resizing, the Image Window remains at 
the size as it was before the transformation. This results in a border being produced around the modified image. 
You can tell Corel WEB.PhotoPaint to automatically resize the Image Window to fit the image.
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Setting the zoom level when opening images
You can set the default magnification that Corel WEB.PhotoPaint uses when it opens images. By default, the 100 
per cent option is selected.

To set the zoom level when opening images
1. Click Tools, Options.
2. Click the General tab
3. Choose the magnification level from the Zoom State On Open list box.

The level selected will be used the next time you open an image.
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Making the Image Window resize automatically
You can use these instructions to make the Image Window conform to the size of the image when the image is 
resampled, cropped, or in any way resized. This eliminates the border area that typically surrounds a resized 
image.

To size the Image Window automatically
1. Click Tools, Options.
2. Click the General tab
3. Enable the Automatic View Resize check box.

The option is effective immediately.
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Changing the look of on-screen indicators
There are many on-screen indicators in Corel WEB.PhotoPaint. They identify the boundaries of objects and 
masks, or represent various alignment tools such as guidelines and rulers, and represent the transparency layer 
used when editing objects.
These indicators are extremely useful because they eliminate guess work when you are editing images. To 
ensure that they work well in different images, many of their characteristics such as their color, their shape, their
style, and their position can be customized.
The options you choose become effective immediately; there is no need to restart Corel WEB.PhotoPaint to use 
them.

For more information see the following:
{button ,JI(`',`Mask and object indicators')} Mask and object indicators
{button ,JI(`',`Grid guidelines and other indicators')} Grid, guidelines, and other indicators
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Mask and object indicators
Objects and masks are commonly used when you edit images. Because images can vary in color, from very light 
to very dark, you can set the color of object and mask marquees as well as the mask overlay. 
The default location of the marquee around masks and objects that have been feathered can also be changed. 
This is helpful when you make very fine adjustments to the edges of an object or to an unprotected area of a 
mask. It allows you to place the marquees a little further away from the boundary of the object or mask. You can 
then edit the outlining pixels without the marquee being in the way.
You can also control where the object marquee appears, i.e., whether it should be around all visible objects in the
image, or only around the editable object(s). Choosing the latter means that an object that is displayed in the 
Image Window but that is locked in the Objects Roll-Up would not have a marquee surrounding it.
Pixels pasted from the clipboard into a mask’s selection are also enclosed by a marquee. You can change the 
color of that marquee.
When you edit objects, you can hide the image background to minimize distracting elements in the image. When
you do so, the visible objects are on a transparent layer that is displayed in the Image Window as a checkerboard
pattern. The pattern colors can also be customized.
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Changing the color of the mask overlay
By default, the mask overlay is red. If you are working on an image that has a lot of red in it, the overlay may not
be as visible when trying to identify the protected areas and the mask selection.

To change the color of the mask overlay
1. Click Tools, Options.
2. Click the Display page
3. Click the Mask tint color button.
4. Click a color in the palette to select it. Click Others to see more colors or create your own.
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Choosing the color of object and mask marquees
By default, object marquees are blue and mask marquees are black.

To choose the color of object and mask marquees
1. Click Tools, Options.
2. Click the Marquee tab
3. In the Colors section, click the Object Marquee color button.
4. Click a color in the palette to select it. Click Others to see more colors or to create your own.
5. In the Colors section, click the Mask Marquee color button.
6. Click a color in the palette to select it. Click Others to see more colors or to create your own.

The marquees of objects and masks that are currently in the Image Window change to the new colors you 
have selected.
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Choosing which objects have an object marquee
By default, the object marquee is displayed around the editable objects in the Image Window. You can choose to 
have the marquee displayed on all visible objects.

To choose which objects have an object marquee
1. Click Tools, Options.
2. Click the Marquee tab
3. Click a button in the Show Object Marquee On section:

Visible: displays the marquee on all objects displayed in the Image Window.
Editable: displays the marquee only on objects that are active, i.e., that can be edited. This means the objects 
that are not locked.
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Choosing the marquee color of data pasted in a selection
Pixels copied or cut to the clipboard can be pasted into an existing mask selection which represents the image’s 
editable area. If the pasted data is smaller than the mask selection you are pasting into, a marquee encloses the 
pasted data. You can choose the color used to represent that marquee.

To choose the marquee color of the pixels pasted inside a mask selection
1. Click Tools, Options.
2. Click the Marquee tab.
3. In the Colors section, click the Paste Into Marquee color button.
4. Click a color in the palette to select it. Click Others to see more colors or to create your own.
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Choosing the colors of the transparency grid pattern
When you hide the image background to edit objects, the objects are displayed on a transparent image 
background. A checkerboard pattern is used to represent the transparent background to avoid mistaking it for a 
white background. You can use this procedure to choose the checkerboard colors.

To choose the colors used in the transparency grid
1. Click Tools, Options.
2. Click the Display tab.
3. In the Transparency Grid section, click the Color 1 button.
4. Click a color in the palette to select it. Click Others to see more colors or to create your own.
5. Repeat steps 3 and 4 using the Color 2 button.
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Grid, guidelines, and other indicators
The mouse cursor is used to pinpoint where you want to start painting, erasing, cloning, or defining a mask 
shape. There are three types of cursor available; keep in mind that the Object Picker tool, the Text tool, and the 
Path Node Edit tool are always represented in the same fashion, regardless of the cursor type selected.
Alignment tools such as the guidelines and the grid can be colored according to your preference. The 
appearance of the grid can also be modified. The sensitivity of the Snap to Guidelines command is also 
customizable using the Options command.
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Choosing the color of guidelines
You setup guidelines with the Guidelines Setup command (Tools menu). The following procedure is used to 
change the color of guidelines.

To choose the color of guidelines
1. Click Tools, Options.
2. Click the Display tab
3. Click the Guideline color button.
4. Choose a color from the palette. Click Others to see more colors or to create your own.
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Customizing the Snap to Guidelines sensitivity
The Snap to Guidelines command found in the Tools menu makes guidelines magnetic; moving an object close to
a guideline makes the object automatically jump to that guideline. You can set the sensitivity of this feature in 
pixels; if you move an object within the specified number of pixels of a guideline, the object snaps to that 
guideline.

To customize the Snap to Guidelines sensitivity
1. Click Tools, Options.
2. Click the Display tab.
3. Type a number of pixels in the Snap Tolerance box.
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Choosing the color and style of the grid
1. Click Tools, Options.
2. Click the Display tab.
3. Click the Grid color button.
4. Choose a color from the palette. Click Others to see more colors or to create your own.
5. Choose the appearance of the grid in the Grid Style list box. The option are:

· Solid line: a series of solid horizontal and vertical lines
· Dashed line: a series of dashed horizontal and vertical lines
· Dots: a dot is displayed at each grid intersection
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Choosing the cursor type
You can change the appearance of the mouse cursor displayed in the Image Window to suit your preference.

To choose the cursor type
1. Click Tools, Options.
2. Click the General tab.
3. Choose a cursor in the Cursor Type list box. The options are: Shape, Tool, Crosshair.
4. If you select Tool or Crosshair, you can also enable the Shape Cursor For Brush Tools check box. 

This choice overrides the choice you made in step 3 for all tools that use nib controls; the cursor for these tools
now shows the current shape and size of the nib instead of the tool or crosshair.
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Safeguarding your work
After spending a lot of time working on an image and making it just the way you want, the last thing you want is 
to lose your work because of a power failure or a system glitch that corrupts files. Saving your images regularly 
while you work is a solution but how easily we can forget to do that when the creative forces take over. 
To avoid unpleasant surprises, the Options dialog box allows you to save your work automatically at regular time 
intervals. If you prefer not to overwrite the file saved on disk, you can choose to have a checkpoint performed 
automatically instead of a full save. 
You can even have a backup file created each time you save your image. The backup is an exact replica of the 
image that is saved in the location of your choice.
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Creating backup copies of your images
Corel WEB.PhotoPaint can create and update a copy of your image files each time you save them to disk. If a file 
becomes corrupted because of glitches in the system, you always have a saved version of the file on your 
system. The backup files are saved with the same file extension as the original file; therefore, they must be 
saved in a different location than the original.

To create backup copies of your images
1. Click Tools, Options.
2. Click the Advanced tab.
3. In the Backup section, enable the Make Backup On Save check box.
4. Type the path of the drive and folder in which you want the backup to be located. Click Browse to find the path

if you do not know it.
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Saving your images automatically
You can have Corel WEB.PhotoPaint perform a save or a checkpoint feature so that is performed automatically at 
regular intervals. Save stores the image file to disk and overwrites the previously saved version. Checkpoint 
temporarily saves the image at its current state, so that you can return to this image if you are not pleased with 
the changes you have applied to it since. Checkpoint does not overwrite the saved version of the image.

To save your images automatically
1. Click Tools, Options.
2. Click the Advanced tab.
3. In the Auto-Save section, enable the Auto-Save Every check box.
4. Type the time interval in the Minutes box.
5. Choose the type of save by clicking the Save To File or the Save To Checkpoint button. 

Save To File overwrites the last version of the file saved to disk; whereas, Save To Checkpoint temporarily 
saves the image at its current state without overwriting the version saved to disk. When you save the image 
manually or exit Corel WEB.PhotoPaint, the version of the image saved as a checkpoint is lost.

6. Enable the Warn Me Before Saving check box if you want to confirm every auto-save operation.
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Setting pressure-sensitive pen options
The Pen Settings command found in the Tools menu lets you control the relationship between the pressure you 
apply with the pen to the tablet, and the effect produced by brush tools in Corel WEB.PhotoPaint. As you press 
down on a drawing tablet with the pen, the effect produced by such tools changes. For example, if you set the 
Size option to 10 percent and apply pressure to the tablet, the nib widens (just as a real paintbrush does as you 
apply more pressure to the stroke) by a maximum of 10 percent.
All options found in the Pen Settings dialog box correspond to brush tool attributes found in the Tools Settings 
Roll-Up or Property Bar. Use them to set the maximum level that the attributes vary when you apply pressure on 
the tablet. 
Experimentation is the key to adjust the options properly. Each set of attributes can be saved as custom settings 
so that you may easily switch between them. 
You can also assign any Corel WEB.PhotoPaint tool to become active when you use your pen’s eraser.
The following is a description of the attributes you can vary according to the amount of pressure you apply on 
the tablet. All attributes affect the functionality of the Paint tool; however, other brush tools are not affected by 
all attributes. For example, the behavior of the Object Transparency Brush tool is not affected by the Hue, 
Saturation, Brightness, Bleed, or Sustain Color controls because it does not use color.
Attribute Description
Size A percentage of the tool’s current size, that is set in the Tool Settings Roll-Up. 

Positive values increase the size of the brush as you increase the pressure. The 
maximum size equals the nib’s size plus the percentage you select. Negative 
values decrease the size of the brush as you increase pressure. Note: artistic nibs 
do not support pressure sensitive sizing; use variants of the circle and rectangular 
nibs, instead to vary their shape.

Opacity A maximum opacity value that is to be used when you apply pressure with the 
pen. Positive values make the stroke more opaque as you increase the pressure, 
as long as you set transparency in the Tool Settings Roll-Up to a value other than 
zero. Negative values make the stroke more transparent as you increase the 
pressure; however, a negative value has no impact if the tool’s transparency is 
already set to the maximum, i.e., it cannot make the stroke any more transparent.

Softness A percentage value that is used to apply a soft edge to the stroke as you apply 
pressure with the pen. Positive values make the soft edge more apparent as you 
increase pressure. Negative values make the soft edge less apparent as you 
increase pressure.

Hue An angle on the color wheel that is used to apply various colors of the spectrum in 
a single brush stroke as you increase pressure on the pen. Positive values make 
the stroke go from the current paint color in a clockwise direction along the 
specified angle. Negative values make the stroke go from the current paint color in
a counter-clockwise direction along the specified angle.

Saturation A percentage value that represents the maximum variation in the paint color’s 
saturation. Positive values increase the saturation of the color as you increase 
pressure with the pen. Negative values decrease the saturation of the color as you
increase pressure.

Brightness A percentage value that represents the maximum variation in the paint color’s 
brightness. Positive values increase the brightness of the color as you increase 
pressure with the pen. Negative values decrease the brightness of the color as you
increase pressure.

Texture A percentage value that makes the paint tool’s current texture more or less visible 
in the stroke applied to the image as you increase pressure on the pen. Positive 
values make the texture more visible as you increase pressure. Negative values 
make the texture less visible as you increase pressure.

Bleed A percentage value that represents the maximum variation in the paint color’s 
bleed value. A bleed value makes a long brush stroke run out of paint and simply 
smear the background colors. Positive values increase the bleed value as you 
increase pressure with the pen. Negative values reduce the bleed value as you 
increase pressure.

Sustain Color A percentage value that represents the maximum variation in the paint color’s 
Sustain rate. Sustain Color works in conjunction with the Bleed value. Sustain 
Color makes a long brush stroke that is running out of paint keep traces of the 
paint color throughout the stroke. Positive values increase the Sustain Color value 
as you increase pressure with the pen; this keeps more of the paint color in the 



stroke as you increase pressure. Negative values decrease the Sustain Color value 
as you increase pressure; this makes the stroke run out of the color as you 
increase pressure.
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Trying out various pen settings
A pressure-sensitive pen and its corresponding Windows driver must already be installed on your system to use 
the following instructions.

To try pen settings
1. Click Tools, Pen Settings.
2. Enable the check box associated with the option you want to try.
3. Click the Value box associated with the option.

Scroll arrows appear in the Value box.
4. Type a value for the option.

Some options are set as percentages, others are set in angles.
5. Click Apply.

The dialog box remains on-screen so that you can quickly adjust the settings.
6. Click the Paint tool.
7. In the Image Window, click and drag using the pen and vary the amount of pressure you are apply to the 

tablet.
8. Examine and evaluate the result of the setting you chose in step 4. 
9. If necessary, adjust the setting’s value in the Pen Settings dialog box, click Apply, and test the effect in the 

Image Window, or disable the option’s check box and try out another one.
 Tip

· If you are not pleased with the effect of the current values, or have saved them and now wish to create 
another customized series of values, you can reset all values to zero and start again by clicking  and 
choosing Clear Values.
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Assigning a tool to a pen’s eraser
The eraser of your pressure-sensitive pen can be used to access any of the Corel WEB.PhotoPaint tools. 

To assign a tool to a pen’s eraser
1. Click Tools, Pen Settings.
2. Click a tool name in the Pen Eraser list box.
3. Click Apply.

The selected tool becomes active when you press the pen’s eraser.
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Saving and loading pen settings
Pressure-sensitive pen settings can be saved for future use. You can save several series of settings so that you 
can switch between them depending on the task at hand.

To save pen settings
1. Click Tools, Pen Settings.
2. Choose the settings you want in the Pen Settings dialog box.
3. Click Save Settings.
4. In the Save Pen Settings dialog box, type a name for the settings and click OK.

The settings are saved and you can access them at any time. If you close the Pen Settings dialog box at this 
time, a message appears asking if you want to apply the settings to the pen. Even if you choose not to apply 
the settings now, they are saved and can be used later.

To load previously saved settings
1. Click Tools, Pen Settings.
2. In the Settings list box, click the name of the saved settings you want to load and use.

The attributes you select in the settings and their respective values are displayed in the dialog box.
3. Click Apply to make the settings active.
 Note

· If you have assigned a Corel WEB.PhotoPaint tool to become active when you use the pen’s eraser, that 
information is also saved with the settings.
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Setting memory and performance options

Memory tab
The Memory tab in the Options dialog box is used to choose how much hard disk space is available for Corel 
WEB.PhotoPaint to save temporary files, and how much of your system’s memory is reserved for the images you 
are editing. This can help you improve the performance of Corel WEB.PhotoPaint and allows you to customize the
memory usage according to the way you work.
For example, if you use Corel WEB.PhotoPaint in conjunction with both desktop publishing and drawing 
applications and need to have all three applications running at the same time, the Options dialog box allows you 
to limit the amount of memory you reserve for the images you are editing in Corel WEB.PhotoPaint. This ensures 
that enough memory remains available to run all three applications. If you decide to work exclusively in Corel 
WEB.PhotoPaint, you can increase the amount of memory it can access.
The memory settings you set are displayed in Corel WEB.PhotoPaint’s Status Bar.

Scanner Transfer mode
When you use the Acquire command in the File menu to acquire images from your scanner, the data from the 
scanner must be placed somewhere. The Options dialog box allows you to choose the mode that is used to 
transfer the data from the scanner to Corel WEB.PhotoPaint. Some modes are faster than others but require 
more system resources.
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Using hard disk space for temporary files
Enabling Corel WEB.PhotoPaint to use available hard disk space to store temporary files not currently in use, 
artificially increases the amount of memory available on your system. This procedure also allows Corel 
WEB.PhotoPaint to use disk space in larger increments than Windows, which is better for handling bitmap 
images. Hard disk space used for temporary file storage is called a swap disk. 
When you close Corel WEB.PhotoPaint after a work session, the temporary files are deleted automatically to free 
the swap disk space. If the application closes abnormally because your system crashes, the temporary files are 
not deleted. To ensure that Corel WEB.PhotoPaint can be launched properly, delete the temporary files manually. 
Using the Windows Explorer, locate the root of the drive(s) on which you have set up swap disks, select all files 
that have a the ~VMxx file name and the TMP extension, and press DELETE. 

To choose swap disks
1. Click Tools, Options.
2. Click the Memory tab.
3. In the Swap Disks section, do the following:

· In the Primary box, choose the drive letter corresponding to the hard disk you want to use first to store 
temporary files.

· In the Secondary box, choose the drive letter corresponding to the second hard disk you want to use.
4. Restart Corel WEB.PhotoPaint for the options to take effect.

The amount of swap disk space is displayed in the Status Bar.
 Tip

· If you have two hard disks or two partitions we recommend that you use them to setup both a primary and a 
secondary swap disk.

· For best results, we recommend that you set the total amount of swap disk space to be 2 or 3 times the size of
your uncompressed image. If you have several images open at once, the total swap disk size should be 2 or 3 
times the total uncompressed size of all the images. 

· Use the Info command in the Image menu to see an image’s size. The Info dialog box tells you whether or not 
the file size displayed is compressed. When you work with .CPT or .BMP images, the file size is always 
uncompressed in the Info dialog box.
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Setting the amount of RAM available for images in Corel WEB.PhotoPaint
You can choose how much of the available RAM (Random Access Memory) on your system is set aside to store 
the images you open and edit in Corel WEB.PhotoPaint. Set the amount of memory based on the type of work 
you perform in Corel WEB.PhotoPaint and the number of applications you usually run simultaneously. If you 
increase the amount of memory reserved for images and find that Corel WEB.PhotoPaint’s performance has 
decreased, you may need to reduce this amount so that more memory is available to run Corel WEB.PhotoPaint. 

To set the amount of available memory used for images
1. Click Tools, Options.
2. Click the Memory tab.

The Memory Usage section of the dialog box displays the total amount of memory available on your system.
3. In the Max box, type the percentage of the total memory you want to make available for images in Corel 

WEB.PhotoPaint.
The amount of memory this percentage corresponds to appears to the right of the Max box.

4. Restart Corel WEB.PhotoPaint for the settings to take effect.
The amount of memory allocated for images in Corel WEB.PhotoPaint is displayed in the Status Bar.

Caution
· If too much RAM is reserved for Corel WEB.PhotoPaint images, the swap disks you have set will be used 

intensively by Windows and other applications you are running to compensate. This may result in a decrease 
in overall performance. 
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Choosing a scanning transfer mode
The scanning transfer mode determines how the information is transferred from your scanner to your computer. 
Some modes are faster than others but they require more system resources. 

To choose a scanning transfer mode
1. Click Tools, Options.
2. Click the Advanced tab.
3. Choose a mode in the Transfer Mode list box. The options are:

· Buffered: enabled by default, this mode transfers the data from the scanner to Corel WEB.PhotoPaint using 
RAM. The data is transferred by sections. If you have enabled Color Correction in Corel WEB.PhotoPaint’s 
View menu prior to acquiring the image, color correction is applied to each section as soon as the sections 
are transferred to Corel WEB.PhotoPaint.

· Memory: the data from the scanner is loaded directly into RAM. 
· File: the data from the scanner is saved as a file that is automatically opened in Corel WEB.PhotoPaint.
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Initializing third-party effects when opening Corel WEB.PhotoPaint
You can use this procedure to have third-party plug-in effects, installed on your system, initialize when you 
launch Corel WEB.PhotoPaint. This takes a few seconds when you open the application. If you turn off this option,
the third-party effects are initialized the first time you access the Effects menu. If you do not plan to use any 
special effects, you can save a few seconds on start-up by turning off the option.

To initialize third-party effects when opening Corel WEB.PhotoPaint
1. Click Tools, Options.
2. Click the Filters tab.
3. Enable the Initialize Filters At Start-Up check box.
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Adding and removing plug-in filters
Adding third-party plug-in filters to Corel WEB.PhotoPaint is done through the Options dialog box

To add a plug-in
1. Click Tools, Options.
2. Click the Filters tab.
3. Click the Insert button.
4. Locate the folder that contains the filters you want to add. 
5. Select the filters.
6. Click OK to add the filters and return to the Options dialog box.

To remove a plug-in
1. Click Tools, Options.
2. Click the Filters tab.
3. Locate the folder that contains the filter you want to remove. 
4. Click the Delete button.
 Note

· The dialog box does not show you the files included in the selected folder. You must know in advance the 
name of the folder that contains the filters to remove.
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Applying effects to your image
Some of the most fascinating and useful items in Corel WEB.PhotoPaint are the special effects filters. These 
filters can completely change the look and feel of your image.

How effects filters work
Effects filters are small programs that execute a predefined series of commands to produce a specific effect. 
They automatically calculate the values and characteristics of every pixel in your image and then alter the pixels
according to these new values. For example, if you applied the Motion Blur filter to an image, the filter would 
analyze all pixel values, then "smear" the values in a specified direction, creating the illusion of motion.

Don't forget masks
You don't have to apply effects to your entire image  you can apply the effect to specific areas of your image 
by enclosing them in a masked selection. See Working with masks for information on creating and working with 
masks. 

Common controls
The effects filters include Original and Result windows so that you can see the impact the effect will have on your
image before you apply it. Most dialog boxes also contain a Zoom tool and Hand tool, so you can zoom in or out 
of the Original and Result windows, and drag other areas into view. If you want the Result window to update 
automatically as you make adjustments to the settings, enable the Auto Preview button. The effects filters now 
include a button that lets you switch between viewing the Original and Result windows, and viewing a single, 
large Result image.

Other types of filter in Corel WEB.PhotoPaint
Besides the special effects filters, Corel WEB.PhotoPaint offers enhancement filters you can use to improve the 
quality of your image, as well as import and export filters so you can change your image's file format. For 
information about filters that help you improve the quality of your image, see Retouching and refining your 
image. For information about using filters to color correct your image, see Working with color. 

Plug-in filters
Corel WEB.PhotoPaint also supports plug-in filters from third-party companies. These filters are called plug-ins 
because they plug in to the application platform. Once you have added the plug-in filters through the Options 
dialog box, they appear at the bottom of the Effects menu. To learn how to add and remove plug-in filters, see 
Adding and removing plug-in filters.

For more information see the following:
{button ,JI(`',`Using the twodimensional filters page 1 of 2')} Using the two-dimensional filters
{button ,JI(`',`Using the threedimensional filters page 1 of 2')} Using the three-dimensional filters
{button ,JI(`',`Using the color transform filters')} Using the color transform filters
{button ,JI(`',`Using the render effects')} Using the render effects
{button ,JI(`',`Using the fancy filters')} Using the fancy filters
{button ,JI(`',`Using Digimarc digital watermarking')} Using Digimarc digital watermarking
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Using the two-dimensional filters (page 1 of 2)

Edge Detect filter
The Edge Detect filter, like the Trace Contour and Find Edges filters, finds the edges of elements in your image, 
then converts them to lines on a background of a single color, allowing you to add a variety of outline effects to 
your image. The Sensitivity slider determines the amount of edge enhancement. You can use black, white, or the
current paint color to fill the areas of the image that are not a part of the outline. For best results, use the Edge 
Detect filter on high-contrast images that include text.

Pixelate filter
The Pixelate filter breaks up your image into square, rectangular, or circular cells. Use the Square or Rectangular 
options to create a blocky, exaggerated, digital appearance, or the Circular option to create a spider web effect. 

Puzzle filter
The Puzzle filter breaks down the image into puzzle-like pieces or blocks, resembling a jigsaw puzzle. You can 
control the block width, height, and offset to create blocks that range in shape from simple squares to ice shards.
You can fill the spaces left between the pieces with white, black, or the current paint color. 

Ripple filter
The Ripple filter creates vertical or horizontal rippled waves throughout the image. You can select the distance 
between the wave cycles, the angle the waves travel through your image, and the amount of displacement the 
waves create.

Shear filter
The Shear filter distorts an image along a path that you define using a shear curve. By manipulating nodes on 
the shear curve, you create curves that determine the shape and amount of the shearing. Your image will 
conform to the curve you have defined. There are three options for filling the area left empty by the 
displacement: the Ignore option will fill the empty area with the paint color, the Wrap Around option produces a 
tiling effect, while the Repeat Edges option produces a stretched effect.

{button ,Next()} Click here to see the next page.
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Using the two-dimensional filters (page 2 of 2)

Swirl filter
The Swirl filter creates a swirling vortex of distortion on your image according to the direction and angle you 
select. The image swirls around a fixed center point in either a clockwise or counterclockwise direction, 
completing the number of whole rotations you set. A lower value in the Whole Rotations box will result in a 
swirling effect, while a higher value will result in a concentric, reverberating effect.

Tile filter
The Tile filter reduces the dimensions of your image and reproduces the image as a series of tiles on a grid. 
When you move the Width and Height sliders in the dialog box, the values entered represent the number of 
images duplicated on each axis. You can use the Tile effect in combination with flood fills to create backgrounds 
or to make wallpaper for Web pages or your Windows desktop. 

Vignette filter
The Vignette filter creates a frame around your image. A vignette can have a soft or hard edge, can be one of 
four shapes, and can be any color. Use a vignette with a higher fade rate to create a dreamy, nostalgic effect.

Wet Paint filter
The Wet Paint filter creates the illusion that your image is a painting that is still wet. The effects can range from 
subtle changes in the luminescence of colors to streaks of wet paint dripping down your image. You set the 
percentage and degree of wetness. The Percentage slider controls the size of the drips. The Wetness slider 
controls the range of colors that are affected. Negative Wetness values cause darker colors to drip; while positive
values cause light colors to drip. 

Wind filter
The Wind filter blurs your image in a specific direction, creating the effect of wind blowing across your image. 
You set the direction, opacity, and strength of the wind effect.

Whirlpool filter
The Whirlpool filter applies a pattern of fluid streamlines over your image. There are a number of preset effects 
you can use or customize, or you can create your own effect by setting the smear length, spacing, twist, and 
streak detail.
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Working with the Edge Detect filter

To highlight edges
1. Click Effects, 2D Effects, Edge Detect.
2. Move the Sensitivity slider to define the sensitivity value for the effect. The higher the value, the more edges 

are enhanced. 
3. Click one of the Background Color buttons to select a color for the background. 

{button ,AL(`PRC Using the twodimensional filters;',0,"Defaultoverview",)} Related Topics



Working with the Pixelate filter

To apply a pixelated effect
1. Click Effects, 2D Effects, Pixelate.
2. Click one of the Pixelate Mode buttons. 

· Square maintains equal Height and Width settings.
· Rectangular allows you to set Height and Width individually.
· Circular builds pixels out from the center in a radial pattern.

3. Move the Width and Height sliders to define values the size of the blocks.
4. Move the Opacity slider to set the transparency of the effect. 
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Working with the Puzzle filter

To apply a puzzle effect
1. Click Effects, 2D Effects, Puzzle.
2. Click one of the Fill Empty Areas With buttons.

· Black fills the empty area with black.
· White fills the empty area with white.
· Paint Color fills the empty area with the current paint color.
· Original Image fills the empty area with the original image.
· Inverse Image fills the empty areas with a negative of the original image.

3. Move the Block Width and Block Height sliders to set the dimensions of the puzzle pieces.
4. Move the Max. Offset (%) slider to set the distance between pieces.
 Note

· The Fill Empty Areas With options are not available in Layer Mode.
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Working with the Ripple filter

To apply a ripple effect
1. Click Effects, 2D Effects, Ripple.
2. Move the Ripple Direction dial to set a direction for the waves. 
3. Click either the Period or Frequency button.

· Period sets the wave length as a percentage of image area.
· Frequency sets the number of waves appearing in the image.

4. Move the Amplitude slider to set the amount of displacement each ripple creates.
 Tip

· To apply waves with jagged edges, enable the Distort Ripple check box.
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Working with the Shear filter

To distort images along a path
1. Click Effects, 2D Effects, Shear.
2. Click one of the Fill Undefined Areas With buttons. 

· Wrap Around fills exposed areas with the opposite edge of the image. 
· Repeat Edges stretches the edges of the image to fill in exposed areas.
· Paint Color fills exposed areas with the paint color.

3. Choose an editing style from the Editing Style list box. 
· Curve lets you distort the image along a curve. 
· Linear lets you distort along a straight path. 
· Freehand distorts along an irregular path you define.

4. Click either the horizontal or the vertical button to set an orientation for the distortion path.
5. Edit the shear curve by clicking and dragging.
 Tip

· Since moving the Scale slider allows you to set the intensity of distortion, set a gentle curve, then use the 
slider to experiment with different settings.
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Working with the Swirl filter

To apply a swirl effect
1. Click Effects, 2D Effects, Swirl.
2. Click either the Clockwise or Counter-Clockwise button to set the direction of rotation.
3. Move the Whole Rotations slider to set the number of times the base swirl rotates.
4. Move the Additional Degrees slider to choose the degree of rotation.
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Working with the Tile filter
Enable the Identical Values check box to maintain equal values for columns and rows. This ensures that the tiles 
maintain their relative proportions.

To apply a tile effect
1. Click Effects, 2D Effects, Tile.
2. Move the Horizontal Tiles slider to set the number of tile columns. If you enable the Identical Values check box,

enter one value and the other will be adjusted.
3. Move the Vertical Tiles slider to set the number of tile rows.
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Working with the Vignette filter

You can use any color for the frame. Simply select the color you want to use as the paint color before you open 
the Vignette filter.

To apply a frame to images
1. Click Effects, Artistic, Vignette.
2. Choose a shape for the vignette.
3. Move the Offset slider to set the size of the center of the frame. Move the slider to the left to increase the size 

of the frame; move the slider to the right to decrease the size of the frame.
4. Move the Fade slider to set the fade-out rate.
5. Click a Color button to choose a frame color. 
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Working with the Wet Paint filter

Try applying successive combinations of positive and negative wetness values to the same image to produce 
some incredible effects. For example, if you apply a negative Wetness value to an object, it will appear to have a 
drop shadow that smears down the page.

To apply a wet paint effect
1. Click Effects, 2D Effects, Wet Paint.
2. Move the Percent slider to set the size of drips.
3. Move the Wetness slider to determine which colors will drip.

Negative values cause the dark colors to drip, and positive values cause the light colors to drip. The higher the
value, the more light or dark pixels will be affected. 
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Working with the Wind filter

To apply a wind-blown effect
1. Click Effects, 2D Effects, Wind.
2. Move the Direction dial to set the direction of the wind.
3. Move the Opacity slider to set the transparency of the effect.

Higher values produce visible distortion and blurring, while lower values produce a more subtle effect.
4. Move the Strength slider to set the strength of the wind.
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Working with the Whirlpool filter
This filter is memory-intensive, and can take a while to apply, even to the preview image. Try experimenting with
lower values first, and working your way up. 

To apply a whirlpool effect
1. Click Effects, 3D Effects, Whirlpool.
2. Move the Spacing slider to set the frequency of the whirls. 
3. Move the Smear Length slider to set the length of the fluid streamlines. The longer the Smear, the smoother 

the whirl will be. Short smears can produce noisy results.
4. Move the Twist slider to control the whirl method. High values make the fluid flow around the whirls much like 

whirlpools, whereas low values make the fluid flow out of the whirls like fountains.
5. Move the Streak Detail slider to set the level of smearing. Higher values restore some of the image detail 

removed when the effect was created.
6. Enable the Warp check box to distort the pixels in the image along the whirls.

To load a preset warp style
1. Click Effects, 3D Effects, Whirlpool.
2. Choose a style from the Style list box.

To save a customized warp style
1. Create or customize a whirlpool effect using the previous procedures.
2. Click Save.
3. Type a filename in the Save New Preset As box.

To delete a preset warp style
1. Click Effects, 3D Effects, Whirlpool.
2. Choose the style you want to delete from the Style list box.
3. Click Delete.
4. Click Yes.

{button ,AL(`PRC Using the twodimensional filters;',0,"Defaultoverview",)} Related Topics



Using the three-dimensional filters



Using the three-dimensional filters (page 1 of 2)

3D Rotate filter
The 3D Rotate filter rotates the image horizontally and vertically according to the horizontal and vertical limits 
you set. The image is rotated as if it were one side of a three-dimensional box. The preview window shows the 
perspective of the image with the current slider settings. The plane of the box that is shaded represents the 
image. The Best Fit option ensures that no part of the rotated image falls outside the Image Window.

Emboss filter
The Emboss filter transforms your image into a relief, making the details appear as ridges and crevices on a flat 
surface. The Direction Control indicates the location of the light source relative to the image (at the center of the
circle). You can use the original image, gray, black, or the paper color as the embossing color. The Emboss filter 
works best on images with medium to high contrast.

Map to Object filter
The Map To Object filter creates the illusion that the image has been wrapped around a sphere, or a horizontal or
vertical cylinder. The value you set using the Percentage slider determines the direction and amount of the 
effect. Negative values wrap the image toward the back; positive values wrap the image toward the front. 

Mesh Warp filter
The Mesh Warp filter distorts an image according to the manipulation of nodes on a grid. You determine the 
number of nodes and the number of grid panels. Higher numbers of nodes and a tighter grid provide finer control
over small details in your image. Moving a node, does not affect the position of any of the other nodes. However,
altering one node affects all connected gridlines.

Page Curl filter
The Page Curl filter is used to give the impression that a corner of your image has rolled in on itself. Controls in 
the dialog box let you select a corner, the orientation and size of the curl, and its transparency level. You select 
colors for the curl as well as for the background that becomes visible as a result of the image curling away.

{button ,Next()} Click here to see the next page.
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Using the three-dimensional filters (page 2 of 2)

Perspective filter
The Perspective filter allows you to give your image a sense of three-dimensional depth, as if it were on a flat 
plane receding into the distance. The exposed areas of the Image Window are filled with the original image. 

Pinch/Punch filter
The Pinch/Punch filter warps your image by either "pinching" the image away from you or "punching" it toward 
you. Negative values apply a punch effect; positive values apply a pinch effect. You can produce dramatic effects
by applying the Zig Zag filter to a masked selection.

Zig Zag filter
The Zig Zag filter distorts an image by bending the image lines that run from the center of the image to its edge.
This effect produces waves of straight lines and angles which seem to twist the image from its center outwards. 
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Working with the 3D Rotate filter
If you want to ensure that the image stays within the boundaries of the Image Window, enable the Best Fit check
box.

To rotate your image in three dimensions
1. Click Effects, 3D Effects, 3D Rotate.
2. Move the Vertical and Horizontal sliders to set the degree of rotation. 
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Working with the Emboss filter
If you want more precise control over the lighting angle, intensity, color, and contrast, emboss your image using 
the Lighting Effects dialog box. See Working with the Lighting Effects filter for more information.

To apply a three-dimensional relief effect
1. Click Effects, 3D Effects, Emboss.
2. Move the Depth slider to set the amount of embossing around the edges. This affects how deep the ridges and

crevices will appear to be.
3. Click a point along the edge of the Direction dial to select a location for the light source.
4. Click one of the Emboss Color buttons to set the color of the embossed image.
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Working with the Map To Object filter

To wrap your image around an object
1. Click Effects, 3D Effects, Map to Object.
2. Click one of the Mapping Mode buttons to choose an object type.
3. Move the Percentage slider to set the amount of wrapping.

Negative values wrap the image toward the back; while positive values wrap the image toward the front.
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Working with the Mesh Warp filter

You can make simple but effective movies by applying the Mesh Warp filter to successive frames of a movie or 
animation file.

To distort your image using a warping grid
1. Click Effects, 3D effects, Mesh Warp.
2. Move the No. Gridlines slider to set the number of grid panels. 
3. Drag the nodes in the preview window to produce the desired distortion.
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Working with the Page Curl filter

To apply the effect to a portion of the image, select an area using a mask before you choose the effect. The page
will only curl inside the masked area.

To curl a corner of an image
1. Click Effects, 3D Effects, Page Curl.
2. Click a button in the Adjust section to select a corner to curl. 
3. Move the Width and Height sliders to determine the curl shape. 
4. Click either the Opaque or Transparent button. Click the Opaque option if you want the back of the curl to be a 

solid color. Click the Transparent option if you want the underlying image to be visible through the curl.
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Working with the Perspective filter

To apply a perspective effect
1. Click Effects, 3D Effects, Perspective.
2. Click either the Perspective or Shear button.

· Perspective allows you to move two nodes at a time toward or away from each other. 
· Shear maintains the distance between two nodes at a time, while allowing you to skew the image.

3. Enable the Best Fit check box to keep all parts of the image within the Image Window.
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Working with the Pinch/Punch filter

To apply a pinch/punch effect
1. Click Effects, 3D Effects, Pinch/Punch.
2. Move the Punch/Pinch slider to set the intensity of the effect. 
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Working with the Zig Zag filter

To apply a swirling or twisting effect
1. Click Effects, 3D Effects, Zigzag.
2. Click one of the Type buttons.

· Pond Ripples distorts your image in overlapping concentric circles.
· Out from center radiates outward in a more uniform manner than Pond Ripples.
· Around Center gives more control over distortion.

3. Move the Waves slider to set the number of waves.
4. Move the Strength slider to set the intensity and the where the crests and troughs of the distortion waves will 

appear.
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Using the color transform filters

Halftone filter
The Halftone filter gives your image the appearance of a color halftone. As in color commercial printing, the 
screen angles you set determine how the halftone dots on the screens line up and how the color blends when all 
the screens are seen together. You can adjust the screen angles to produce a wider range of colors.

Psychedelic filter
The Psychedelic filter changes the colors in your image to bright, electric colors such as orange, hot pink, cyan, 
and lime green. 

Solarize filter
The Solarize effect, like the Invert effect, transforms colors to appear like those of a negative photographic 
image. In photographic terms, solarization is a darkroom technique in which a sudden flash of light is used to 
darken unfilled areas of a print. Unlike the Invert filter (which produces an absolute that actually inverts the 
image colors), you control the intensity of the effect with the Solarize filter. 
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Working with the Halftone filter

To give your image the appearance of a color halftone
1. Click Effects, Color Transform, Halftone.
2. Move the Max Radius slider to set the maximum radius of a halftone dot.
3. Move the Channel Angle sliders to set the angle of each of the color screens. 

Use the Cyan, Magenta, and Yellow slider bars to control the channel angle in order to determine the color 
mixture and to produce a wider range of mixing patterns.
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Working with the Psychedelic filter

To apply psychedelic colors
1. Click Effects, Color Transform, Psychedelic.
2. Move the Level slider to set the intensity of the effect. 
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Working with the Solarize filter

To create solarized images
1. Click Effects, Color Transform, Solarize.
2. Move the Level slider to set the intensity of the effect.
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Using the render effects
The filters in the Render Effects menu offer ways of simulating lighting, photographic realism, and the 
appearance of three-dimensional depth.

Lens Flare filter
The Lens Flare filter produces rings of light on your image that simulate the flare that appears on a photograph 
when the camera is aimed toward a direct bright light. In a camera, this occurs because the light is being passed
through a series of lenses, each of which affects its intensity and spread. Lens flares will differ from lens to lens, 
depending on focal length and lens magnification. The Lens Flare filter provides you with three different lens 
types. Use the Lens Flare filter to add a touch of photographic realism to images.

Lighting Effects filter
The Lighting Effects filter offers a range of tools for adding up to 19 light sources to your RGB images. This allows
you to add dramatic special effects: shine a spotlight on the subject of your image, or use colored lighting to set 
a mood. The controls in the Lighting Effects dialog box provide control over the color, brightness, and contrast; it 
even allows you to use the light source as a way to define embossing texture values. The Lighting Effects filter 
offers four preset light source types.
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Working with the Lens Flare filter
Because this filter simulates bright light striking a camera lens, the flare created is refracted into a series of 
small lightened circles as well as the bright flare point. Be careful that these secondary light circles don't fall in 
undesirable areas.

To create a lens flare in your image
1. Click Effects, Render, Lens Flare.
2. Set the center of the flare by clicking on the preview image.
3. Click a Lens Type button. 

· 50-300 mm Zoom creates a lens flare effect common to focal lengths between 50 mm (standard lens, 
normal perspective) and 300 mm (telephoto/zoom lenses, magnified perspective). 

· 35 mm Prime creates a lens flare effect common to a moderate wide-angle lens.
· 105 mm Prime creates a lens flare effect common to a moderate telephoto lens. 

4. Click a filter color from the Color picker.
5. Move the Brightness slider to set the flare's brightness.
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Working with the Lighting Effects filter

To add light sources to your image
1. Click Effects, Render, Lighting Effects.
2. Choose a lighting source from the list box.

· Ambient is a light source like an average light bulb offering a soft, even light across the image with no harsh
center and no shadows. You can't aim ambient lights.

· Spotlight is a beam light source with more clearly defined edges than the others. You can aim, elevate, and 
focus spotlights. 

· Omni is similar to a theatrical flood light. It has a hot center of light but a soft, wide spread. You can't aim or 
focus omni light, but you can elevate and brighten it. 

· Directional is similar to an ambient light: it provides even lighting with no hot center. You can aim a 
directional light. It is especially useful for defining textures when relief is being applied to your image.

3. Click a color from the color picker.
4. Click and drag the light source selector. to set the position, angle, and elevation of the light. To hide the light 

source in the preview window, click the Reveal/Hide Light Source button. 
5. To add or remove additional light sources, click the Add and Subtract Light Source buttons. You can add and 

define up to 19 light sources.
6. For each light source, do any of the following:

· Move the Brightness slider to set the light's intensity.
· Move the Elevation slider to control the light's vertical angle, from 0 to 90 degrees. At 90 degrees the beam 

shines straight down at the image.
· Move the Aperture slider to control the width of the pool of light, from 0 to 180 degrees.
· Move the Focus slider to control the amount of spill at the edges of the pool of light  it is the softness of 

the edge expressed as a percentage of the sharpest level of focus.
· Move the Flash Expose slider to set a brightness value to be applied across the image pixels without 

factoring tonal values. Use this sparingly  it tends to wash out the image.
· Move the Image Exposure slider to set the overall brightness of the image, including the areas outside the 
pool of light.

To save a lighting style
1. Create a lighting style using the previous procedure.
2. Click the plus button.
3. Type a filename for the style in the Save New Light Type As box.

To load a preset lighting style
1. Click Effects, Render, Lighting Effects.
2. Choose a preset style from the Style list box.

To delete a lighting style
1. Click Effects, Render, Lighting Effects.
2. Choose the preset style to delete from the Style list box.
3. Click the minus button.



To create an embossed relief using light
1. Click Effects, Render, Lighting Effects. 
2. Choose a preset style from the Styles list box.
3. Choose one of the single channel options from the Channel list box. 
4. Move the Relief slider to set the depth of the relief.
5. Move the Contrast slider to set the amount of contrast in the relief.

{button ,AL(`PRC Using the render filters;',0,"Defaultoverview",)} Related Topics



Using the fancy filters



Using the fancy filters

Alchemy filter
The Paint Alchemy filter enables you to transform your image into a natural media painting by applies 
brushstrokes to your image. The image must be RGB, 16 or 256 color for this filter to work.
The Alchemy filter provides 30 user-definable parameters and many preset styles from which to choose. If you 
apply the preset styles to images, you will notice the incredible versatility of this filter and begin to realize the 
thousands of possibilities it offers. The parameters are presented in five groups, each one identified by a tab: 
Brush, Color, Size, Angle, and Transparency. Keep in mind that a small change in one parameter can make a big 
difference on the overall effect; change one parameter at a time so that you become familiar with the effects of 
each one. The sophistication of the Alchemy filter sometimes makes it slower than the other effects; however, 
the results are well worth the wait.

Terrazzo filter
The Terrazzo filter allows you to create kaleidoscope-like designs using elements in your image. This filter takes a
single tile  a portion of your image cropped into a simple shape 
 and repeats, reflects, or flips it a number of times in interlocking symmetrical patterns over the surface of your 

image. 
Terrazzo provides 17 tiling  or symmetry 

 options. Each Symmetry option offers a different tile shape (the blue polygon) and tiling pattern (the black yin 
and yang forms). You can apply the result to the image you used to create it, or to another image. 
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Working with the Alchemy filter

To apply natural media brushstrokes to images
1. Click Effects, Fancy, Alchemy. 
2. On the Brush tab, do any of the following:

· Click one of the Layering Option buttons.
· Click a brush type from the brush thumbnails.
· Move the Horizontal Variation and Vertical Variation styles to set the direction of the brush strokes.
· Move the Density slider to set the density of the brush strokes.

3. Click the Color tab, and do any of the following:
· Click one of the Brush Color buttons. If you choose Solid Color, choose a color from the color picker.
· Click one of the Background Color buttons. If you choose Solid Color, choose a color from the color picker.
· Move the Hue slider to set the amount of hue variation in the brush strokes.
· Move the Saturation slider to set the amount of saturation variation in the brush strokes.
· Move the Brightness slider to set the amount of variation in the brightness levels of brush strokes.

4. Click the Size tab, and do any of the following:
· Move any of the Adjust sliders to adjust the size of the brushstrokes.
· Choose an option from the Vary Brush Size list box.

5.  Click the Angle tab, and move the Adjust sliders to adjust the angle of the brushstrokes.
6. Click the Trans tab, and move the Adjust sliders to determine the transparency of the brushstrokes.

To save customized Alchemy settings as a preset style
1. Customize the Alchemy settings using the previous procedure.
2. Click the Save As button.
3. Type a filename for the new style in the Save New Style As box. 

To load a preset Alchemy style
1. Click Effects, Fancy, Alchemy.
2. Choose a style from the Styles list box. 

To delete a preset Alchemy style
1. Click Effects, Fancy, Alchemy.
2. Choose the style you wish to delete from the Styles list box. 
3. Click Delete.
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Working with the Terrazzo filter

To make kaleidoscope patterns using your image
1. Click Effects, Fancy, Terrazzo.
2. Click the Symmetry button.
3. Click one of the Symmetry tiling thumbnails.
4. Click OK.
5. Move the Feather slider to set a soft edge for tiles.
6. Move the Opacity slider to set the transparency level of the repeated tiles.
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Using Digimarc digital watermarking
Corel WEB.PhotoPaint include PictureMarc from Digimarc, which allows you to embed and read digital 
watermarks in your image. These watermarks allow you to embed information which communicates your 
copyrights and authorship. The watermarks are imperceptible, apparent to the computer, but not to the viewer 
of an image, providing a persistent identity which travels with the image wherever it goes. 
A Digimarc watermark carries a unique Creator Id, and image attributes. A Creator ID is assigned when you 
subscribe to Digimarc’s on-line service. You provide a complete set of contact details, including your name, 
phone number, address, e-mail and web addresses, and specialty. This is uniquely associated with your creator 
ID.
A Digimarc watermark is actually a small amount of random noise added to the luminance component of the 
pixels in your image. At high magnification, you might notice seemingly random changes in brightness of a pixel.
This change is not enough to harm the visual integrity of your image, but carries information which survives 
normal edits and even printing and scanning.
Digimarc watermarks do not prevent someone from using your images or infringing on your copyright. But they 
do communicate that your are claiming your copyrights, and provide a mechanism for interested parties to 
contact you about the image or one like it.
Whenever someone opens or scans a watermarked image into Corel WEB.PhotoPaint, it is automatically checked 
for a watermark. If one is present, a copyright symbol is added to the title bar, communicating to the viewer that
someone has embedded information in the image. From there, the viewer can read the watermark, where they 
discover your Creator Id. By clicking the Web Lookup button in the read dialog, or calling Digimarc’s fax-back 
service, the viewer has direct access to your contact details.
To find out more about Digimarc and PictureMarc, go to www.digimarc.com. 
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To embed a watermark
1. Click Effects, Digimarc, Embed watermark.
2. If you have not personalized your copy of PictureMarc, click Personalize. In the Personalize dialog, click the 

Register button, or call the Digimarc phone number to subscribe to MarcCentre, and get your unique Creator 
Id. Enter this Id in the Creator Id field, following the instructions on the registration form, and click OK.

3. Select the Type of Use attribute (Restricted Use or Royalty Free), and set or unset the Adult Content attribute.
Note: This is for communication only, and does not affect display of the image.

4. Set the watermark intensity. This determines how strongly the watermark is placed in the image. The higher 
the intensity, the more visible the watermark will be, and the more edits and transformations it will survive. 
Likewise, the lower the intensity, the less visible the watermark will be, and the less it will survive. The default 
setting is 2, and is suitable for most applications.
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To read a watermark
1. Click Effects, Digimarc, Read watermark.
2. If a watermark is present, you will see a read results dialog displaying the creator id and image attributes 

found in the watermark.
3. To find out more about the creator or distributor of the image, either launch a web browser and go to the URL 

provided; call the Digimarc fax-back service at the number listed; or if you have a Web connection, click the 
Web Lookup button to go directly to the page of contact details for that Creator Id.
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Getting started
Corel WEB.PhotoPaint is a powerful bitmap-based image editing and painting program that is ideal for preparing 
images for use on Web pages, retouching photographs, editing images and animation files, and creating original 
artwork. Corel WEB.PhotoPaint combines a vast array of special effects filters with impressive painting, masking, 
and object-handling tools to allow you to produce effects ranging from the simple to the sublime.
You can use Corel WEB.PhotoPaint to make subtle changes such as adjusting the lighting, sharpening the focus, 
or removing scratches. You can make drastic changes such as removing people and things, swapping details 
between images, adding text and objects, adjusting color, colorizing black-and-white and gray-scale images, 
splicing animations, and applying unique combinations of special effects. 

Setting up an image for editing
There are several ways of setting up an image for editing or enhancement in Corel WEB.PhotoPaint. You can 
create a new, blank document and either paint on it or create a montage with bits and pieces of other images. If 
the image you want to work on is a photograph or drawing, you can access your scanning software from within 
Corel WEB.PhotoPaint and create an image file from it.
This section will show you how to set up a new or existing image for composition, editing, or enhancement, the 
different viewing options that are available to you, and how to save your file and shut down.

Before you begin: understanding bitmap images
Bitmap images, also called raster or paint images, are made of individual dots called pixels (picture elements) 
that are arranged and colored differently to form a pattern. When you zoom in, you can see the individual 
squares that make up the total image. Increasing the size of a bitmap has the effect of increasing individual 
pixels, making lines and shapes appear jagged. However, when viewed from a greater distance, the color and 
shape of a bitmap image appear continuous. Because each pixel is colored individually, you can create photo-
realistic effects such as shadowing by manipulating select areas, one pixel at a time.
Because a bitmap image is created as a collection of arranged pixels, its parts cannot be manipulated (e.g., 
moved) individually. 

For more information see the following:
{button ,JI(`',`Setting up a new image')} Setting up a new image
{button ,JI(`',`Opening existing files')} Opening existing files
{button ,JI(`',`Scanning images')} Scanning images
{button ,JI(`',`Saving and closing')} Saving and closing
{button ,JI(`',`Viewing your image page 1 of 2')} Viewing your image
{button ,JI(`',`Viewing system application and image information')} Viewing system, application, and image 
information
{button ,JI(`',`Using the Scrapbook')} Using the Scrapbook
{button ,JI(`',`Safety nets')} Safety nets
{button ,JI(`',`Organizing and retrieving files')} Organizing and retrieving files
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Setting up a new image
When you create a new image or animation file, you select a color mode, image size and resolution, and the 
background paper color. The image’s color mode and resolution are particularly important because they affect 
both the size of the file and the quality of your final image. If the file you are creating is going to be particularly 
large or has a really high resolution, try working on it in parts. This reduces the amount of data your system has 
to process at one time. 

Choosing the right color mode
Corel WEB.PhotoPaint has several color modes to choose from: black-and-white (1-bit), grayscale (8-bit), duotone
(8-bit), paletted (8-bit), RGB (24-bit), and CMYK (32-bit). The number of bits a color mode uses dictates both the 
horsepower it requires from your system as well as the number of colors or shades it is capable of producing. 
One bit can either be on or off, so 1-bit color is capable of creating just two pixel depths: 0 (off) results in black, 
and 1 (on) results in white. On the other end of the scale, 32-bit color has more than four billion possible pixel 
depths (colors), and requires a great deal more memory. 
For more information on selecting a color mode, see Working with color.

Image size
An image’s size and resolution are often confused. An image’s size refers to the actual, physical dimensions of 
the image as it will be output (usually printed). You can measure an image’s size by standard measurement units
such as centimeters or inches, or by how many pixels high and wide it is. If you are printing an image, you will 
probably want to know its size in terms of inches or some other unit of measure you are comfortable with. If you 
are going to be displaying your image on the Web or as part of a slide show, you will probably want to know its 
size by pixels so you can display it on a one-to-one pixel ratio with the final display device.

Image resolution
An image’s resolution determines the degree of detail it contains, and is measured by the number of pixels, or 
dots, it contains per inch (dpi). Because the number of pixels in a bitmap is fixed, the resolution of the image is 
tied in to the size of the printed image. If you print the image at a small size, the pixels are tiny, and the 
resolution high. Print the image large, and the pixels become enlarged and look coarse, resulting in a lower 
resolution.
A higher resolution allows for more detail and smoother color transitions than a lower resolution, but also results 
in a much larger file. Setting the resolution is a balancing act between achieving the level of detail you need and 
keeping the file size down to a level your system can handle.
Base your image resolution on what your output will be. If you are going to print your image, keep the resolution 
lower than that of the final output device: if you create a 1200 dpi image to print on a 600 dpi printer, you are 
going to end up with a 600 dpi printed image and a file that is much larger than you need.
If you are going to display your image on screen, you can generally get away with a lower resolution. Again, keep
in mind the memory restrictions of your particular setup, and try to set the resolution to correspond with that of 
the monitor you plan to use.
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Starting from scratch
When you create a new image, you choose a color mode, image size and resolution, and the background paper 
color. If the file you are creating is going to be particularly large or has a really high resolution, try working on it 
in parts. This reduces the amount of data your system has to process at one time. 

To create a new image
1 Click File, New.
2. Choose a color mode from the Color Mode list box.
3. Click the arrow at the side of the paper color swatch to open the Paper Color Palette. If you wish to choose 

from a wider variety of colors, click Others to open the Select Color dialog box.
4. Click a color swatch to select it.
5. Type values in the Width and Height boxes to set the dimensions of the image. If you want to use a different 

unit of measurement, click the down arrow in the Units list box and choose a different one.
6. Type values in the Horizontal and Vertical boxes to set the resolution.

To create an image in parts
1. Click File, New.
2. Follow steps 2 to 6 from the previous procedure to choose the color mode, image size, and resolution.
3. Enable the Create a Partial File check box at the bottom of the dialog box.
4. Click OK.
5. Choose a grid from the Grid Size list box.
6. Click the portion of the image you would like to work on first.
 Tip

· You can create a custom grid by choosing Custom Grid in the Grid Size list box or by enabling the Edit Grid 
check box. Click and drag the nodes to reshape a panel, or move a panel by clicking and dragging it.

To create a animation
1 Click File, New.
2. Choose a color mode from the Color Mode list box.
3. Click the arrow at the side of the paper color swatch to open the Paper Color Palette. If you wish to choose 

from a wider variety of colors, click Others to open the Select Color dialog box.
4. Click a color swatch to choose it.
5. Type values in the Width and Height boxes to set the dimensions of the image. If you want to use a different 

unit of measurement, click the down arrow in the Units list box and choose a different one.
6. Type values in the Horizontal and Vertical boxes to set the resolution.
7. Enable the Create a Animation check box.
8. In the Number of frames box, type in the number of frames you want in the animation.
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Opening existing files
Although you can create impressive original bitmap artwork in Corel WEB.PhotoPaint, it is most popular for 
editing existing images. You can import and work on just about any digitized image, as long as it has been 
rasterized; that is, rendered into pixels. If you import a vector image into Corel WEB.PhotoPaint, it will open as a 
duplicate bitmap file, leaving your original file intact. 
If your image is particularly large or has a high resolution, try working on it in sections. This reduces the amount 
of data your system has to process at one time.

Image sources
Image sources include scanned photos and artwork, stock photo libraries, video capturing cards, and images 
from other graphics applications. 
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Opening an image
Although you can create original artwork in Corel WEB.PhotoPaint, it is most popular for editing existing images. 
If your image is particularly large or has a high resolution, try working on it in sections. This reduces the amount 
of data your system has to process at one time and can keep it from getting bogged down. 

To open an image
1. Click File, Open.
2. Choose the drive where the file is stored in the Look In list box. 
3. Double-click the folder containing the image.
4. In the list box to the left of the Options button, choose Full Image.
5. Double-click the file’s name.

To open a section of an image
1. Click File, Open.
2. Choose the drive where the file is stored in the Look In list box. 
3. Double-click the folder containing the image.
4. In the list box next to the Options button, choose Partial Load.
5. Double-click the file name.
6. Choose a grid from the Grid Size list box.
7. Click the portion you would like to open.
 Tip

· You can create a custom grid by choosing Custom Grid in the Grid Size list box or by enabling the Edit Grid 
check box. Click and drag the nodes to reshape a panel, or move a panel by clicking and dragging it.

To open a different section of an image
1. Click File, Select Partial Area.
2. Click the rectangle containing the area you wish to open. The flashing section indicates the area that is 

currently open.

To open a section of a animation
1. Click File, Open.
2. Choose the drive where the file is stored in the Look In list box. 
3. Double-click the folder containing the image.
4. In the list box next to the Options button, choose Partial Load.
5. Double-click the file name.
6. Enter the range of frames you want to open in the From and To boxes. 
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Scanning images

Selecting an original
The quality of your scanned image depends on the quality of the original image. When choosing an original, you 
should try to avoid images that are badly damaged or stained. Rips and tears in an image may require extensive 
editing to correct. 
You can use Corel TWAIN’s features to make minor adjustments to the image. If your image requires major 
changes, scan the image using Corel TWAIN, then use the powerful image editing tools available in Corel 
WEB.PhotoPaint to make corrections.

Improving image quality
To get the best possible scan, you should start with a high quality original. However, if you have to scan a poor 
quality image, Corel TWAIN provides tools to help improve the look of the scan.
One common problem with images is what professional photographers refer to as flat images, meaning that a 
picture has very little contrast. By adjusting the contrast or brightness when scanning, you can increase the 
differences between highlights and shadows to give the image the appearance of more depth. These features 
can also be used to enhance over or under exposed images.
Two of the most significant image adjustments that you can make are to the color depth and the resolution. To 
determine the best settings for these two adjustments, you'll need to consider the following:
· how much detail you need
· what is original image type, and final image type (color depth)
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Selecting a source
The scanner source is the scanner that you're using to create digital images. You need to hook up your scanner 
and install the scanner software, following the documentation provided by the manufacturer. Once you've done 
that, you need to identify the scanner in the your graphics application.

To select a source
1. In your graphics application, click File, Acquire Image, Select Source.
2. Choose your scanner model name from the list, ensuring that the model is preceded by "Corel."

A Corel source must be selected in order for you to use Corel TWAIN.
3. Click Select.
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Scanning an image
You can use your scanner to produce scanned, digital images of line art, drawings, photographs, and even 3D 
objects (as long as they fit on the scanner bed!). You can use a graphics application to preview the image you're 
scanning, scan entire images, selections of images, or multiple images.
Using the Prescan feature, you can preview images before you scan them into your application, allowing you to 
define the image area to be scanned.

To preview an image
Prescan is a low resolution preview of your image.
1. In your graphics application, click File, Acquire Image, Acquire. 

The Corel TWAIN dialog box appears.
2. Click Prescan.

To scan an image
1. In your graphics application, click File, Acquire Image, Acquire. 

The Corel TWAIN dialog box appears.
2. Click Scan.

To scan a selection
1. In your graphics application, click File, Acquire Image, Acquire. 

The Corel TWAIN dialog box appears.
2. Click Prescan.
3. In the preview window, drag the selection box around the area you want to scan.
4. Click Scan. 
 Tip

· To enter precise measurements for the selection box, type values into the Left, Top, Width, and Height boxes.

To scan with an Automatic Document Feeder
1. In your graphics application, click File, Acquire Image, Acquire. 

The Corel TWAIN dialog box appears.
2. Click the Custom tab.
3. Enable either the Feeder or ADF (Automatic Document Feeder) check box, if applicable.

Your scanner must support the ADF function for the ADF or Feeder option to be available. Refer to the scanner 
manufacturer's documentation for more information.

4. Choose a page size from the list box.
5. Click Scan.
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Rotating images
You can rotate an image by either 90, 180 or 270 degrees in TWAIN. When you rotate your image using TWAIN, 
the preview window displays the results quickly, but when you actually scan the image, the transformation may 
take considerable time. If your graphics application supports image rotation, you may consider making the 
transformation there.

To rotate an image
1. Click the Layout tab.
2. Choose a rotation angle from the Rotation list box.
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Adjusting color depth
Color Depth determines the range of colors and tones that are available in an image. It is usually measured by 
the number of colors displayed (e.g. 256 colors, or 16 million). Each color depth has advantages and limitations:
If scanning Then use this color depth
line art black and white
duotones grayscale
to print to a black and white printer grayscale
high quality color photos 16 million

To adjust color depth
1. Click the Layout tab.
2. Choose a color depth from the Depth list box.

As you decrease the color depth, some details may be lost. You may want to use a higher color depth for 
detailed images even if it has a small color range. Scanning at a higher color depth may also save you the 
trouble of having to do extensive color correction in a photo-editing package.

 Tip
· Keep in mind that the image will only appear as good as your output sources will allow. It may be a waste of 

disk space to scan an image at a high color depth if the monitor or printer you’re using is not capable of 
producing such a wide range of color.
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Adjusting resolution
It is important to choose the appropriate resolution at which to scan your image. But how do you determine this?
You usually don't need to scan your image at the highest possible resolution; this only increases your file size 
and slows down the printing or display of the image onscreen. The following guidelines may help you determine 
the best scanning resolution for your image:
When scanning for Use
halftone print images 1.5 to 2 times the screen frequency, or refer to the printer manufacturer's 

documentation to find the printer's line screen frequency
continuous tone print images the printer resolution; refer to the printer manufacturer's documentation to find 

the printer's line screen frequency
black and white images the printer resolution; refer to the printer manufacturer's documentation to find 

the printer's line screen frequency
display onscreen/Internet 72 or 96 dots per inch
Enlarging your image will also impact on the resolution. When possible, try to scan at 100 per cent of the image 
size, and modify the size in a graphics application such as Corel WEB.PhotoPaint.

To adjust resolution
1. Click the Layout tab.
2. Choose a resolution from the Resolution list box.

It is not always necessary to choose the highest possible resolution to get a good quality scan. If the image 
has little detail or is only black and white, you can use a lower resolution. This helps reduce the size of the file, 
as images scanned at higher resolutions require more disk space.

To adjust resolution when displaying images on the Internet
1. Click the Layout tab.
2. Choose custom from the Resolution list box.
3. Use the scroll arrows to select either 72 x 72 or 96 x 96 dots per inch.
 Tips

· If scanning an image to be displayed on the Internet, choose a resolution of 72 or 96 dots per inch.
· Check the scanner manufacturer's documentation to find the optical resolution of the scanner.
· The most important thing to remember when choosing a resolution is that you want to get the highest possible

image quality without making the file any larger than necessary.
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Saving and closing
When you save a file for the first time, you assign it a name and choose a folder in which to store it. If you try to 
close Corel WEB.PhotoPaint and have made changes since your last save, you will be prompted to save your 
image again.

Selecting a file type
When you save a file for the first time, it will automatically save as a .CPT image unless you specify otherwise. 
See Choosing a file format for the Web for more information on the various file formats that work on the World 
Wide Web.

Backup
You can automatically create a backup copy of your image every time you save by enabling the Backup check 
box in the Save dialog box. The backup copy’s file extension will end with a "$". For example, the backup copy of
a file named APPLE.CPT would be APPLE.CP$.

Compressing files
If you need to save space on your hard drive, you can store files in a compressed format. Generally speaking, the
more compressed a file is, the slower it is to read from or write to. 

Leave yourself a note
As you save a file, you can attach a description to it in the Notes box. This is particularly useful for similarly 
named files (for example, TEXTURE1.CPT, TEXTURE2.CPT, etc.). 
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Saving an image
These procedures show you how to save new and existing image files. For information on file formats that work 
best for the Web, see Choosing a file format for the Web. For information on saving animation files, see Saving 
an animation.

To save a new image
1. Click File, Save As.
2. Choose a drive in which to store the file in the Save In list box. 
3. Double-click the folder where you want the file saved.
4. Type a name in the File Name box.
5. Choose a file type in the Save As Type list box.
6. Click Save.

To save a previously saved image
· Click File, Save.

To save an image as a new file
1. Click File, Save As.
2. Choose a drive in which to store the file in the Save In list box. 
3. Double-click the folder where you want the file saved.
4. Type a name in the File Name box.
5. Choose a file type in the Save As Type list box.
6. Click Save.

To save a section of an image as a separate file
1. Click File, Save Partial Area As.
2. Choose a file type in the Save As Type list box.
3. Click the down arrow (next to the Save In list box) and click a drive letter.
4. Double-click the folder where you want the file saved.
5. Type a name for the file in the File Name box.
6. Click Save.
 Notes

· To use this command, a partial area must already be open.
· The Save Partial Area As command saves the currently open section of the image to a separate file. If you 

would rather save the changes to the original image, click File, Save.
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Closing down

To close an image
· Click File, Close.

To close Corel WEB.PhotoPaint
· Click File, Exit.
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Viewing your image (page 1 of 2)
Corel WEB.PhotoPaint provides several viewing tools to ensure that the image you see on screen is accurate and 
to allow you to view and work on your image from as close up or as far away as you need to.

The Zoom tool
The Zoom tool allows you to magnify or decrease the size of your on-screen image without affecting the actual 
image size. The real-life equivalent to the Zoom tool is a telescope. When you look through one side, your image 
is magnified. When you flip it over, your image seems farther away. 
When you zoom in so that all of an image is not visible, you can move around by clicking the scroll bars that 
appear at the sides and bottom of the Image Window, or you can use the Hand tool (also on the Zoom flyout) to 
drag the image around.
The Zoom Tool Settings Roll-Up contains a single check box for enabling or disabling the right mouse button as a 
means of zooming out on an image. If the check box is disabled, you can still zoom out by holding down SHIFT 
while clicking the image.

Moving to areas of your image that fall outside the Image Window
When you have zoomed in so far that all of the image is no longer visible in the Image Window, you can use 
either the Hand tool or the Navigator pop-up to move to a different section of the image.

Viewing and playing animations
You can use the zoom tools for viewing animation files just as you would for other images. The Animation menu 
and the Animation toolbar contain controls that let you play and stop the animation, as well as to rewind or fast 
forward to the beginning or end of the animation, or move through it frame by frame.

On-screen alignment tools
Grids, rulers, and guidelines are alignment tools that help you to align or size things on your image with 
precision. These tools are only visual, so you don’t have to worry about your image printing with a grid on top of 
it.

{button ,Next()} Click here to see the next page.
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Viewing your image (page 2 of 2)

Maximizing your work area
If you want to make your work area as large as possible, use the Maximize Work Area command (found under the
View menu). This command temporarily eliminates the Title and Menu Bars, and allows you to continue editing 
your image. The Full-Screen Preview command (View menu) hides the Corel WEB.PhotoPaint desktop and 
displays your image at the size of your monitor, but does not allow you to continue editing.

Screen dithering
Screen dithering is a method of enhancing the display of monitors that are capable of 16-bit color or less. It 
works by averaging the depth of pixels in a given area to create additional colors or shades of gray (depending 
on whether you are working with color, grayscale, or black-and-white images). If you are working on an image 
that contains more colors than your monitor is capable of producing, use screen dithering. If your monitor 
supports more than 16-bit color, there is no need.
There are two types of screen dithering: error diffusion and ordered. The difference between the two options is in
the size of the areas they use to average pixel depths. In error diffusion, the colors or grays are averaged using 
the accumulated error over the whole image. This is the most accurate method of screen dithering, but, 
naturally, also slows your computer down the most. Ordered diffusion approximates pixel depth using a larger, 
fixed-dot pattern, much like the printed halftone. 
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Viewing your image as large as possible
If you want to view your image as large as possible, use the Maximize Work Area or Full-Screen Preview 
commands. Maximizing your work area hides the title and Menu Bars, but allows you to continue editing your 
image (you can still access all the menus using keystrokes). You can view your image at an even larger size 
using the Full-Screen Preview command, but in this case you can’t continue editing your image until you return it
to normal view. 

To maximize the work area
· Click View, Maximize Work Area.
 Note

· You can access any of the menus while your work area is maximized by using keystrokes. For example, to 
access the View menu (so you can disable the Maximize Work Area command and return to normal view), 
press ALT + V.

To see a full-screen preview of your image
· Click View, Full-Screen Preview. 

The Corel WEB.PhotoPaint interface disappears and the image displays at full-screen size.
 Note

· To return to normal view, press any key.
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Making the most of your monitor
If you are working on an image that contains more colors than your monitor is capable of producing, use one of 
the screen dithering options. Screen dithering works by averaging the depth of pixels in a given area to create 
additional colors or shades of gray (depending on whether you are working with color, grayscale or black-and-
white images). 

To set the screen dithering
· Click View, Screen Dithering, and choose a dithering option from the flyout menu.
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Zooming in and out of your image
Zooming in to and out of your image allows you to view and work on your image from as close up or as far away 
as you need to. This is useful when you perform tasks that require precision, such as outlining something with a 
path or mask marquee.

To zoom in
1. Click the Zoom tool.
2. Click the area you wish to zoom in on. Each time you click, the zoom level increases to the next preset level.
 Tip

· You can also zoom in by selecting the Zoom tool and clicking and dragging around an area. In this case, the 
zoom level will depend on the size of your Image Window and the area you select.

To zoom out
1. Click the Zoom tool.
2. Right-click the area you wish to zoom out from. Each time you click, the zoom level decreases to the next 

preset level.

To choose a specific zoom level
1. Click View, Zoom.
2. Choose a preset zoom level from the flyout menu.
 Tip

· You can also choose a preset zoom level from the Zoom list box on the Standard Toolbar.

To view areas of an image that fall outside of the Image Window
1. Click the Hand tool.
2. Click and drag the image until the area you want to see is visible in the Image Window.
 Note

· You can also use the Navigator pop-up to view areas of your image that fall outside the Image Window. 
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Viewing and navigating through animations
You can use the controls in the Animation menu to view your animation, as well as to navigate through its 
frames. You can fast forward or rewind to the beginning or end, or move through the animation frame by frame. 
For shortcuts on playing animations, see Shortcuts for playing animations.

To play the animation
· Click Animation, Control, Play Animation.

To stop the animation
· Click Animation, Control, Stop Animation. 

To rewind to the beginning of the animation 
· Click Animation, Rewind To Beginning. 

To fast forward to the end of the animation
· Click Animation, Fast Forward To End.

To move to a specific frame
1. Click Animation, Go To Frame. 
2. Type the number of the frame in the Frame box. 

To move forward one frame
· Click Animation, Control, Step Forward One Frame.

To move back one frame
· Click Animation, Control, Step Back One Frame.
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Using rulers
Rulers are exactly what you expect them to be  virtual rulers that appear along the side and/or top of your 
work area to help you keep track of the actual size and location of parts of your image.

To display or hide the rulers
· Click View, Show Rulers.

To change the units of measurement
1. Click Tools, Grid and Ruler Setup.
2. On the Ruler tab, choose the units of measurement in the horizontal and vertical list boxes You can use 

different units for each of the rulers.

To move rulers
· Hold down SHIFT and drag the ruler to its new position. 
 Tips

· To return a ruler to its previous position, hold down SHIFT and double-click it.
· To move both rulers at once, hold down SHIFT and drag the intersection point of the two rulers.

To set the origin point of the rulers
1. Click the icon joining the horizontal and vertical rulers and drag the crosshair into the working area.
2. Release the mouse where you want the origin point to be. 
 Note

· You can choose the location of the origin point precisely in the Grid and Ruler Setup dialog box (Tools menu).
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Using grids
A grid is just that  a grid that overlays your image so you can know exact coordinates as you work. You can 
adjust the amount of space between the horizontal and vertical lines in the Grid and Ruler Setup dialog box, and 
you can choose a color and style in the Options dialog box.

To display or hide the grid
· Click View, Show Grid. 

To set grid spacing
1. Click Tools, Grid and Ruler Setup.
2. On the Grid tab, type the amount of space you want between each horizontal grid line and each vertical grid 

line. The units shown in the dialog box are the ones currently selected for the rulers. To change them, click the 
Ruler tab.

To align an object to the grid
1. Click Tools, Snap To Grid.
2. If the grid is not visible, click View, Show Grid.
3. Click and drag the object to the desired grid point.

To change the color and style of the grid
1. Click Tools, Options.
2. Click the Display tab.
3. Click the arrow beside the Grid Color picker and choose a color. If you want a larger selection, or if you want to 

create your own color, click Others.
4. Choose a grid style from the Grid Style list box.
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Using guidelines
Guidelines are lines that you place at precise points on your image to help guide you as you work. 

To display or hide guidelines
· Click View, Show Guidelines.

To create guidelines
1. If the rulers aren’t displayed, click View, Show Rulers.
2. Click and drag guidelines from the rulers.

Tip
· You can also create guidelines in the Guidelines Setup dialog box (Tools menu).

To move guidelines
· Click and drag the guideline to its new location.

To remove guidelines
1. Click View, Guideline Setup.
2. Do one of the following:

· Click the Clear button on either tab to remove all horizontal or vertical guidelines.
· Click the Clear All button to remove all guidelines.
· Select a specific guideline in the list and click Delete.

To align an object to a guideline
1. Click Tools, Snap To Guideline.
2. If the guideline is not visible, click View, Show Guideline.
3. Click and drag the object to the guideline.

To choose the color of guidelines
1. Click Tools, Options.
2. Click the Display page.
3. Click the arrow beside the Guideline color picker.
4. Choose a color from the palette. Click Others to see more colors or to create your own.
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Viewing system, application, and image information
The Corel WebMaster Suite of applications provides easy access to information about your computer as well as 
the applications themselves. 

System information
The System Info dialog box provides details on your system's setup. You can display detailed information about 
any of the following five categories: system, display, printing, Corel .EXE and .DLL files, and system .DLL files.

Program information
Program information consists of the program name, version number, serial number, and user name. This 
information doesn't change. You'll find this information particularly useful if you ever need help from Corel 
Technical Support Services.

Image information
The Image Info dialog box lets you instantly determine the image's file name, size, resolution, how much 
memory it is taking up (in bytes), its format, whether it is compressed, the type of file compression used, and its 
color mode. 
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Viewing system information
System information shows the current state of your computer. You can choose any of five different categories of 
system information. These categories let you see details about your system, display, printers, Corel .EXE 
and .DLL files, and system .DLL files. For example, you can use this feature to see how much memory you have 
on the drive to which you want to save a file. You can save any system information in a text file called 
SYSINFO.TXT.

To view system information
1. Click Help, About Corel WEB.PhotoPaint. 
2. Click System Info.
3. Choose a category in the Choose a Category list box.
 Tip

· Use the Save button to store system information for printing. System information is saved as SYSINFO.TXT. A 
message box tells you where the file is saved.
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Viewing program information
You can view information about your program, including the program name, version number, serial number, and 
user name. Keep this information handy if you call Corel Technical Support Services for help.

To view program information
· Click Help, About Corel WEB.PhotoPaint.
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Viewing image information
Corel WEB.PhotoPaint allows you to view detailed information about your image.

To view information about an image
· Click Image, Info.
 Tip

· Use the Save button to store system information for printing. System information is saved as SYSINFO.TXT. A 
message box tells you where the file is located.
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Using the Scrapbook
The Scrapbook is a Roll-Up that provides drag and drop access to the folders that store the collections of objects 
and photographs that come with Corel WEB.PhotoPaint. You can also use the Scrapbook to browse your system 
and add shortcuts to the locations you access most often.
The Scrapbook has three tabs, each of which serves a unique purpose. 

The Browse tab
The Browse tab provides a searchable view of your computer's folder and file hierarchy. It allows you to search 
your computer for any file you want to open. Once you find the file, you can drag and drop it directly into Corel 
WEB.PhotoPaint. 

The Objects and Photos tabs
The Object and Photos tabs provide easy access to Corel WEB.PhotoPaint's collection of photographs and objects 
on CD-ROM. Like the Browse tab, the Objects and Photos tabs allow you to search through folders to find 
photographs and objects to add to your image. To help you find the right photograph or object, these tabs 
display thumbnail bitmaps of each file's contents along with filenames. Because the Photos and Objects tabs 
look for the contents of one of the CDs that comes with Corel WEB.PhotoPaint, you must have it in your CD-ROM 
drive to use the Objects or Photos tabs. You can't add items to the Objects or Photos tabs.

Find feature
In addition to its main tabs, the Scrapbook provides an easy-to-use Find feature that allows you to search for 
items based on the names, keywords, and notes associated with them. You can use this feature to search for any
file accessible using any of the tabs in the Scrapbook.
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Browsing your files and folders using the Scrapbook

To browse your system using the Scrapbook
1. Click View, Roll-Ups, Scrapbook.
2. Click the Browse tab.
3. Choose a drive from the list box.
4. Double-click a folder to see the files within it.
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Using the Objects and Photos tabs of the Scrapbook

To open an image or object using the Scrapbook
1. Ensure that the Corel WebMaster CD that contains objects is in your CD-ROM drive. 
2. Click View, Roll-Ups, Scrapbook.
3. Click the Objects tab.
4. Drag the object onto the Image Window.

To open an image using the Scrapbook
1. Click View, Roll-Ups, Scrapbook.
2. Click one of the tabs.
3. Choose the drive where the file is located from the list box.
4. Drag the file onto the Image Area.
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Adding and removing tabs

To add a shortcut to your favorite location
1. Click the Browse tab.
2. Select the folder, album, or file to which you wish to add a shortcut.

3. Click , Create Shortcut To Current Location. 

To remove a tab
1. Click the tab you wish to remove.

2. Click , Delete The Currently Selected Tab. 
 Note

· If the Scrapbook is not displayed, click View, Roll-Ups, Scrapbook.
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Safety nets
Corel WEB.PhotoPaint allows you the freedom to experiment by being forgiving. If you make a change and think 
it has ruined your image, you can undo the change, undo a series of changes, revert to the last saved version of 
the image, or return to a checkpoint you have set.

Using the auto-save and backup options
Corel WEB.PhotoPaint offers two automatic methods of safeguarding your work: the auto-save option saves your 
work automatically at regular intervals, while the backup option creates a backup copy of your image every time 
you save. For more information on these options, see Safeguarding your work.

Working on a duplicate
If you want to experiment before actually applying any effects or commands to your image, try working on a 
duplicate copy. The Duplicate command (found in the Image menu) opens a duplicate copy of your image so you 
can test out effects without affecting the original image file. 

Undo/Redo command
The Undo command, which you can access through the Edit menu, undoes the changes you have made to your 
image one at a time starting with the most recent. You can specify the number of undo levels in the Options 
dialog box (see Choosing the number of undo levels). Once you have undone an action, the Undo command 
becomes the Redo command, which essentially allows you to undo what you have undone.

Undo list
If the effect you dislike has taken you a while to achieve, the Undo List command opens a dialog box that lists 
each action you have performed in chronological order and allows you to choose which one to start with. This 
command, and all those following it, will be undone. The more actions you choose to undo, the longer it will take 
your system to do it, so you should only use this option if you want to undo some, but not all, changes you’ve 
made since your last save.

Revert command
The Revert command undoes all the changes you have made to the image since your last save. This is the best 
method to use if you want to wipe out a whole list of changes, and if you tend to save each time you get to a 
point in your image’s development that you like. If you don’t, maybe you should saving often is not a bad habit
to foster.

Restore to Checkpoint command
The Restore to Checkpoint command is a great safety net, but only works if you have first used the Checkpoint 
command. When you set a checkpoint, you are asking Corel WEB.PhotoPaint to remember this exact point in 
your image’s development so you can return to it later.

Clear command
The Clear command is the most drastic of the undo options. It essentially wipes out your image and leaves you 
with the empty page. When you use the Clear command, your deleted image won’t be placed on the Clipboard. 
Use this command only if you want to start over at the very beginning, but want to keep the same initial settings
as you are currently using (i.e., paper color, size, resolution and color mode).

The Undo tools
The Undo tools are available as a flyout from the Toolbox, or as a separate toolbar. They work on effects or paint 
you have applied with any of the brush tools. These tools are covered in Editing your artwork in the Painting, 
filling and editing section.
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Undoing changes
If you make a change you don’t like, you can undo the change, undo a series of changes, revert to the last saved
version of the image, or clear your image.

To undo the last change
· Click Edit, Undo.

To undo a series of changes
1. Click Edit, Undo List.
2. Select a command in the list. 

This command and all those following it will be undone.
3. Click Undo. 

The image reverts to the state it was in before the selected command was executed.
 
Note

· The commands File Open, File New, and File Save can’t be undone.

To undo all changes since you last saved
· Click File, Revert.

To clear the Image Window
· Click Edit, Clear.
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Redoing changes
The options that allow you to redo changes are only enabled after you have undone changes  in essence, they 
allow you to undo what you have just undone.

To redo the last change
· Click Edit, Redo.

To redo a series of changes
1. Click Edit, Redo List.
2. Select the last operation you want to redo in the list.
3. Click Redo.
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Setting and using a checkpoint
When you set a checkpoint, Corel WEB.PhotoPaint records this point in your image’s development so you’ll have 
the option of returning to it later.

To set a checkpoint
· Click Edit, Checkpoint.

To restore to a checkpoint
· Click Edit, Restore to Checkpoint.
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Organizing and retrieving files
It's a good idea to get in the habit of organizing your files. If you specify information about a file when you save, 
it's easier to keep tabs on the whereabouts and the contents of your files.
When you save documents, specify information that might help you find them easier in a later session. Later, 
when you open your documents, you'll find the notes, annotations, thumbnails, and keywords that you've 
assigned to them will help to jog your memory.
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Adding notes, annotations, thumbnails, and keywords
You might find it useful to annotate and assign keywords to files and to use thumbnails (small bitmap 
representations of graphic files) to find files without having to remember their names.
When you open files to which you've added notes, the information you specified when you saved the files 
appears in the Open dialog box.

To add notes to a file
1. Click File, Save if you're saving the file for the first time, or Save As if you want to add notes to a file you saved

previously.
2. In the Notes box, type the information you want to record about the file.
3. Click Save.

To change the thumbnail of an open file
1. Click File, Save if you're saving the file for the first time or Save As if you want to change the thumbnail of a 

file you saved previously.
2. Choose the type of thumbnail from the Thumbnail list box.

To assign keywords to your files
1. Click File, Save if you're saving the file for the first time, or Save As if you want to add notes to a previously-

saved file.
2. Choose the name of the file to which you want to assign keywords.
3. In the Keywords box, type the keywords you want to assign to the file.

If you want to add more than one keyword, separate each keyword with a comma. You can type as many 
keywords as you want.

4. Click Save.
 Notes

· To display thumbnails in the Open dialog box, enable the Preview check box. Thumbnails allow you to see a 
small bitmap of a file's contents before you open it.

· By default, Corel WebMaster Suite applications add a color header to a file when you save it. You can specify a 
monochrome header instead, or turn the header off.
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Retrieving files by file type
Applications in the Corel WebMaster Suite provide two ways to sort files on your system. You can sort files by 
their names or file types. 

To open files by file type
1. Click File, Open.
2. In the Files of Type box, choose the file type of the document you want to open.

Only the files of the format you specified are displayed.
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Working with masks (page 1 of 2)
Masks are powerful tools that allow you to make the most of the retouching capabilities of Corel WEB.PhotoPaint.
They are used to select the area within an image that you wish to modify. The area is called the selection. The 
rest of the image is protected from change by the mask and is called the protected area. You can even choose to
what degree a selection, or part of a selection, is editable. This is done by changing the transparency of the 
mask. Detailed information is provided later in this chapter.
Once you’ve defined a selection, you can paint on it, copy it, apply special effects or image adjustments to it, 
without affecting the rest of your image. You can transform the selection into an object, or make the selection 
float above the image so that it can be moved without affecting the underlying image. 
You can use the power of masks to create unusual effects or replace color in your image. Ever wondered what 
you’d look like as a redhead?
There are two types of masks. Regular masks define a selection within an image that has a discernible shape. 
Color-sensitive masks create selections based on the color of the pixels in the image. For example, to see 
yourself as a redhead, you could either create a regular mask in a shape that selects all of your hair, or apply a 
color-sensitive mask in which only the current color of your hair is included in the selection.

Yes but what are masks?
A mask is like a stencil. It protects the image and has «holes» that allow the image areas showing through these 
holes to be changed. Technically speaking, a mask is an 8-bit grayscale image that covers the entire image. You 
can assign grayscale values between 0 and 255 to any pixel in the mask. An area of the mask that has pixels 
that have a value of 0 (black), completely protects the underlying image from any changes that you make. An 
area that has pixels that have a value of 255 (white) makes the underlying image pixels receive the full effect; 
this area is the selection. You can determine the extent to which the pixels are editable by assigning a pixel value
of anywhere between 1 and 255.

The mask marquee
The mask marquee is the outline of the selection and is represented by a dashed line that looks like marching 
ants. It separates the selection from the protected areas of your image. 

{button ,Next()} Click here to see the next page.
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Working with masks (Page 2 of 2)

Mask overlay
Another method to differentiate between the selection and the protected area in a mask is to apply the mask 
overlay. Initially, the overlay is a red-tinted transparent sheet superimposed over the entire image. The 
transparent area is the selection and is therefore editable. The red areas are protected to various degrees 
according to the saturation of the red tint. You see the mask overlay by choosing the Mask Overlay command in 
the Mask menu, or by clicking the Overlay button. The Options command in the Tools menu allows you to change
the color of the overlay.

How masks behave
Masks exist on a layer above your image. You can move, rotate, skew, and stretch a mask marquee without 
affecting the image underneath. 

Mask modes 
There are four mask modes to work in. The Normal mode is the default mode, used when first creating a mask on
an image. The other modes are used to add areas to an existing selection or subtract areas from it. They allow 
you to fine-tune the shape of a selection, and to create complex masks that include several areas. These modes 
are explained in greater detail in Expanding and reducing a mask selection.

For more information see the following:
{button ,JI(`',`Creating masks')} Creating masks
{button ,JI(`',`Sizing mask marquees')} Sizing mask marquees
{button ,JI(`',`Moving mask marquees and selections')} Moving mask marquees and selections
{button ,JI(`',`Mask Transformations')} Mask Transformations
{button ,JI(`',`Altering the edges of a selection')} Altering the edges of a selection
{button ,JI(`',`Expanding and reducing a mask selection page 1 of 2')} Expanding and reducing a mask selection
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Creating masks
You create a mask by defining a selection in the image. Corel WEB.PhotoPaint provides all the tools required to 
create any selection shape. This versatility is necessary because there are situations when you need to select a 
simple shape in an image, other situations when you need to select intricate areas or even only the pixels of a 
specific color. Typically, when you create a mask from scratch, you do so by defining an area on the image which 
is to become the selection. The selection is enclosed by the mask marquee. All mask tools are grouped in a 
Toolbox flyout. Click and hold the current mask tool to see the flyout. Click View, Toolbars, and choose Mask tools
in the dialog box to see all mask tools in a single separate toolbar.
You can use an existing item such as an object, a path, or data copied to the clipboard from another image to 
create masks. The area enclosed by the object marquee or the path becomes the selection; the rest of the image
becomes the protected area.

Inverting masks
Any mask that you create can easily be inverted, i.e., the selection becomes protected and the protected area 
becomes the selection. When you want to edit an area that is intricate, it’s much easier to draw a mask marquee
around the section of the image you want to protect and then invert the mask so that the area outside the 
original marquee becomes the selection.

Edge control
Mask creation in Corel WEB.PhotoPaint allows you to control how the edges of the selection are defined, i.e. 
whether they are crisp and obvious, or whether they blend in gradually with the protected area. These results 
are achieved with the anti-alias and feathering options.

Anti-alias
To produce a curved or diagonal edge on a selection, pixels in the image that are diagonal to each other are part 
of the selection’s edge. This diagonal pixel selection can produce a jagged edge. Anti-aliasing makes some of the
pixels located along the inside edge of the selection semi-transparent which smoothes out the edges of the 
selection. The anti-alias option is provided on the Property Bar and in the Tool Settings Roll-Up for all mask tools 
except the Rectangle Mask tool. Rectangle edges are not jagged because they are vertical and horizontal 
therefore, do not have pixels diagonal to each other. Anti-alias is enabled by default for the other mask creation 
tools; you can disable it if you want to. 

Feathering
Feathering is a gradual increase in the transparency of the pixels in the selection. It results in a smooth transition
between the pixels located in the outlining area of a selection and the pixels located in the rest of the image. 
The Property Bar and the Tool Settings Roll-Up for mask tools each provide a Feathering box in which you choose 
the width, in pixels, of the feathered edge. If you forgot to feather when creating the mask, or you thought you 
did not need to, you can always feather afterwards as described in Altering the edges of a selection. The 
feathered edges of a selection are not apparent on the marquee; to see the result of feathering, apply the mask 
overlay and zoom in on the edge of the selection to see how it fades gradually into the protected area(s).

For more information see the following:
{button ,JI(`',`Masking by creating a shape')} Masking by creating a shape
{button ,JI(`',`Colorsensitive masks')} Color-sensitive masks
{button ,JI(`',`Alternative methods to create masks page 1 of 2')} Alternative methods to create masks
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Masking by creating a shape
Regular mask tools are used to create a mask marquee in the Image Window. In Normal mode, the area enclosed
by the marquee is the selection and the area outside of it is the protected area. You can always invert the mask if
you need to interchange them. Use the regular mask tools to define a selection within an image that has a 
discernible shape, such as a compact disk, a ruler, or a book. 
The Property Bar displayed for each one of the mask tools, provides controls that are specific to each of the 
tools. The controls are used to set precise dimensions for rectangular or elliptical selections, to apply feathering, 
anti-aliasing, and, in the case of the Mask Brush tool, to set nib attributes such as size and shape.
You can use a single mask tool to define the selection, or any combination of the masking tools to create a 
complex mask. Use a mask mode that allows you to add or remove areas to the selection you create.
·  The Rectangle Mask tool defines a rectangular selection. Holding down CTRL before defining the mask 

constrains the shape to a square. Holding down SHIFT expands or contracts the selection from the center.
· The Circle Mask tool defines an elliptical selection. Holding down CTRL before defining the mask 
constrains the shape to a circle. Holding down SHIFT expands or contracts the selection from the center.
·  The Freehand Mask tool defines more intricate selections. You can either click and drag to draw curved 
segments, click to establish anchor points joined by straight segments, or use a combination of the two methods to 
include curved and straight-line segments in the shape of the selection.
· The Mask Brush tool defines a selection by painting over the image. Holding down CTRL constrains the brush

to a vertical or horizontal movement.
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Creating a rectangular selection
A rectangular selection can be the starting point when you need to select an area for editing that is not perfectly 
rectangular. The selection can be adjusted afterwards using the Mask Transform tool or the Mask Brush tool. You 
can also use any other mask tool in the Subtractive or Additive modes to remove or add to any selection created 
using these procedures.

To create a rectangular selection
1. Click Mask, Mode, Normal.
2. Open the Mask Tools flyout and click the Rectangle Mask tool.
3. On the Property Bar, type a width, in pixels, in the Feather Width box (optional).
4. In the Image Window, click and drag to surround the area you want to select. 

Hold down CTRL while drawing to create a square or hold down SHIFT to draw from the center.

To create a rectangle selection of a fixed size
1. Click the Rectangle Mask tool.
2. On the Property Bar, choose Fixed Size in the Mask Style list box.
3. Type values in the Width  and Height 
 boxes.

4. Type a width, in pixels, in the Feather Width box (optional).
5. In the Image Window, click where you want the top left corner of the selection to be located.
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Creating a selection of a specific height or width
You can easily create a rectangular selection that has either the full width of the image and the height you set, or
the full height of the image and the width you set.

To create a rectangle selection of a specific height or width
1. Click Mask, Mode, Normal.
2. Open the Mask Tools flyout and click the Rectangle Mask tool.
3. On the Property Bar, choose Row(s) or Column(s) in the Mask Style list box.

If you choose Row(s), type the number of rows of pixels to include in the mask, i.e. the height of the selection; 
its width will be the full width of the image.

4. In the Height  or Width 
 box, type a value in pixels. 
Only one of the boxes is available, depending on what you chose in the previous step.

5. Type a width, in pixels, in the Feather Width box (optional).
6. Position the cursor where you want the selection to be placed.
7. Click to create the selection. 

A mask marquee of the specified size displays on the image.
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Creating a circular or elliptical selection
Regardless of the method you choose to create the circular selection, anti-aliasing is enabled to produce smooth-
looking edges for the selection. Anti-aliasing can be disabled from the Property Bar or the Tool Settings Roll-Up.

To create a circular mask
1. Click Mask, Mode, Normal.
2. Open the Mask Tools flyout and click the Circle Mask tool.
3. On the Property Bar, type a width, in pixels, in the Feather Width box (optional).
4. Click and drag to create the desired selection.

Hold down CTRL to create a true circle, or hold down SHIFT to draw from the center.

To create a circular mask of a fixed size
1. Click the Circle Mask tool.
2. On the Property Bar, choose Fixed Size in the Mask Style list box,.
3. Type values in the Width  and Height 
 boxes.

4. Type a width, in pixels, in the Feather Width box (optional).
5. In the Image Window, click where you want the top left of the selection’s highlighting box    to be located.

The selection appears below and to the right of the location you clicked. The specified width and height values 
are applied to the imaginary lines, horizontal and vertical respectively, passing through the selection’s center 
point.
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Creating an irregular selection
When creating an intricate selection, you can combine straight-line segments with curved segments. When using
only line segments, a minimum of three points are required in order to create a selection. 

To create an irregular selection shape
1. Click Mask, Mode, Normal.
2. Open the Mask Tools flyout and click Freehand Mask tool.
3. On the Property Bar, type a width in pixels in the Feather Width box (optional).
4. In the Image Window, point and click where you want the mask marquee to start.
5. Do one of the following:

· Move to another location and click to draw a straight line segment between this location and the starting 
point defined in the previous step.

· Hold down the mouse button and drag to create freehand curved segments.
6. Using either method, repeat step 5 until the selection is complete. Alternate between the two methods to 

combine straight and freehand segments.
To connect a straight line segment to a freehand segment, draw the freehand segment and release the mouse 
button at the location you want the line segment to start. Move to the location you want the line segment to 
end and click.

7. Double-click to finish the selection.
 Note

· If the last point you double-click to finish the selection shape is not close to the first point, Corel 
WEB.PhotoPaint automatically joins the points with a line segment to close the selection.
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Painting the area to select
You can easily create or add to an existing selection by brushing over the section of the image that you want to 
select or include in the current selection.

To define a mask by brushing a selection
1. Click Mask, Mode, Additive.
2. Open the Mask Tools flyout and click the Mask Brush tool.
3. Brush over the area you wish to select as if you were painting. 

The mask marquee and the selection expand with each stroke of the tool.
 Note

· To adjust the size and shape of the brush, click the tool and choose the options you want on the Property Bar 
or in the Tool Settings Roll-Up.
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Creating a mask that selects the entire image
The Select All command makes the entire image the selection. You can then use any of Corel WEB.PhotoPaint’s 
tools to edit the selection. You can, for example, fill the selection with a gradient fill which makes the degree of 
protection vary according to the style of the fill and the grayscale values of its pixels.

To create a mask that selects the entire image
· Click Mask, Select All. 

A mask marquee appears along the image’s edge. If you are zoomed in to the image, you do not see the 
marquee.

 Tip
· Double-clicking the Rectangle, Circle, or Freehand Mask tool also selects the entire image.
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Inverting a mask
To select an irregularly shaped area, it is often easier to select the area surrounding it first, and then invert the 
mask. 

To invert a mask
· Click Mask, Invert. 

The original mask’s selection is now the protected area, and its protected area is now the selection.
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Color-sensitive masks
When you want to select or protect a specific color within an image, such as a blue sky in a landscape, using a 
color-sensitive mask can give you the best results with the least amount of effort. Specify a range of color to be 
included in the selection by choosing a tolerance value on the Property Bar or Tool Settings Roll-Up. The following
tools and command are used to create color-sensitive masks:

Color-sensitive mask tools
· The Lasso Mask tool selects specific colors within the area you enclose. It uses the first color you click to 

choose the pixels to exclude from the selection. This first color, called the seed color, and all other pixels in the
area that fall within the tolerance range you defined are included in the protected area. You can draw freehand
around an area or click to establish anchor points. Double-clicking sets the mask marquee, causing it to shrink 
until it reaches its color tolerance limit.

· The Magic Wand Mask tool selects all pixels adjacent to the pixel you click that are within the tolerance 
range you specified. Click the color you wish to select, and the mask marquee expands until it reaches its color
tolerance limit.

Color Mask command
The Color Mask command found in the Mask menu can also be used to create color-sensitive masks. The 
advantage of using the Color Mask command is that the colors you choose are selected, or protected, throughout
the image rather than just in a single area. One or more colors are selected from the image using the Eyedropper
tool. The selected colors can be part of either the selection or the protected area. A preview area is displayed in 
the Color Mask dialog box so that you can view the result of your selections, and fine-tune the color selection 
and tolerance values without having to apply the mask. 
In the Color Mask dialog box, the mask resulting from the current selections can be represented by a grayscale, 
black matte, white matte, or an overlay. The overlay color used in the preview is the same as the color used to 
view the mask overlay in the Image Window. The overlay color can be changed in the Options dialog box found in
the Tools menu.
The functionality of the Color Mask dialog box is not available when working with a black and white, 16-color, or 
duotone image.
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Selecting certain colors in a specific area
The Lasso Mask tool works in a similar manner to the Freehand Mask tool, except that the selection boundary 
shrinks to include only the pixels that fall outside the defined color tolerance range. Use the Lasso Mask tool to 
easily select colors in an area that stand out from the surroundings i.e., that are surrounded by very different 
colors.

To use the Lasso Mask tool
1. Click Mask, Mode, Normal.
2. Open the Mask Tools flyout and click the Lasso Mask tool.
3. Click the image where you want the mask to start.

The color of the location you click becomes the seed color on which the selection of color is based.
4. Enclose the area using one of these methods:

· Click and drag around the area.
· Click to establish an anchor point, move to the next position and continue clicking at different points until 

the area is enclosed.
5. Double-click to set the mask. 

The mask marquee shrinks until it reaches color that exceed its color tolerance limit. All pixels that fall within 
the color range are in the protected area.

To change the color tolerance of the mask
1. Click the Lasso Mask tool.
2. On the Property Bar, click the button corresponding to the tolerance mode you want to use: Normal or HSB.
3. Type a value between zero and 100 in the number box next to the tolerance mode buttons. If you chose the 

HSB mode, three number boxes are shown; type a value in each one. 
Higher tolerance values reduce the number of pixels included in the selection because more colors are kept in 
the protected area.
To reapply the mask with the new settings, repeat steps 3 to 5 of the previous procedure.
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Selecting adjacent pixels of similar color
Use the Magic Wand Mask tool to create a mask marquee that includes all pixels adjacent to the pixel you first 
click, that fall in the color range defined by the tolerance level. The selected pixels make up the selection. All 
other pixels in the image make up the protected area. The Magic Wand tool makes it easy to select a large area 
in an image containing similar colors, for instance, a sky containing various shades of blue. To protect those 
colors, create the mask, and then invert it.

To use the Magic Wand tool
1. Click Mask, Mode, Normal.
2. Open the Mask Tools flyout and click the Magic Wand Mask tool.
3. On the Property Bar, click a tolerance mode: Normal or HSB.
4. Type a tolerance value in the number box. In HSB mode, you must type a tolerance value for each component 

represented by the three number boxes on the Property Bar.
Higher values include more colors in the selection.

5. Click the color in the image that you wish to edit.
The mask marquee expands to include all adjacent pixels that fall within the tolerance range starting from the 
value of the pixel that you clicked. The image pixels inside the marquee are editable, while those outside the 
marquee are protected. 

 Tip
· If the mask is not exactly what you wanted, you can remove it and start again with a different tolerance value. 

You can also add to the area produced the first time you used the Magic Wand by using the Additive mode. 
· To remove certain colors from the selection, use the Subtractive mode, and, with the Magic Wand mask tool, 

click a color in the selection that is different from the one that you clicked to create it. This removes certain 
pixels from the selection and produces a hole in the selection, i.e., an area within the selection that is 
protected from editing changes. 

To protect the pixels included inside the marquee
· Click Mask, Invert. 
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Creating and editing a color mask that considers all pixels
The colors you choose can either be protected from change, (which means that all other colors are editable) or 
be editable, (which means that all other colors in the image are protected). 
The advantage of using the Color Mask command is that all pixels in the image that fall within the defined color 
range are selected even if they are not adjacent. Use this command to mask several different colors in an image,
or to mask a color that is found in several isolated locations in the image. 

To create a color mask
1. Click Mask, Color Mask.

If colors from a previous session appear in the dialog box, click the Reset button.
2. Click the Options button and choose Protect Colors or Modify Colors.
3. Choose Sampled Colors from the Create From box.

Other options in the list are used to choose colors automatically without using the eyedropper tool.
4. Click the Eyedropper tool in the dialog box.
5. Click a color in the preview area or in the image. 

The color appears in a color box on the right side of the dialog box.
6. Repeat step 5 to select additional colors.
7. Click the Preview icon to examine the mask before applying it. 

The red-tinted areas are protected from change. Click Preview again to remove the overlay. 
After you click OK, the selected colors are protected or unprotected from any changes made to the image, 
depending on the selection you made in step 2.

To adjust the tolerance for a specific color included in the mask
1. Click Mask, Color Mask.
2. Locate the color in the list of all sampled colors.
3. Type a tolerance value between 0 and 100 in the box associated with the color. 

Higher tolerance values expand the mask marquee to include similar colors; lower tolerance values reduce the
mask marquee to enclose the selected color only. If you are using the HSB mode to define tolerance, type a 
tolerance value in each component box.

4. Repeat for additional colors if desired. 
5. Click OK to reapply the mask with the change in tolerance.
 Tip

· Selected colors can be omitted by removing the check mark associated with them in the color list.
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Editing selected colors within a mask
1. Click Mask, Color Mask.
2. Click the Eyedropper tool in the dialog box.
3. In the preview area, point and click a color to add to the protected area or to the selection. 

The color appears in a color box.
4. Repeat step 3 to select additional colors.
5. Click the Options button and choose an operating mode; Modify Colors puts the selected colors in the 

selection, whereas Protect Colors puts the colors in the protected area.
6. Click the Preview icon. 

The colored areas are protected from change when the mask is applied. Click Preview again to remove the 
overlay. Even though the overlay affects the entire image, only those colors within the mask boundary are 
ultimately affected. 

7. Click OK. 
A second mask is temporarily applied over the current mask that protects or allows the modification of the 
selected colors within the marquee. The new mask is not identified by a marquee. 
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Alternative methods to create masks (page 1 of 2)
Although the regular and color-sensitive mask tools provide extensive flexibility when creating masks, there are 
other methods available which can save you time and allow you to create complex masks.

From objects and text
You may have created an object that has the perfect shape for a mask that you need in a different area of the 
image. Instead of trying to recreate the same shape that already exists, create the mask from the object itself. 
The Preserve Image command found in the Image menu influences the result of creating a mask from an object. 
When the command is enabled, which is the default, the object is copied to create the mask which means that 
both the mask and object marquee appear simultaneously. If you move the mask marquee, the object is still 
there, intact. When Preserve Image is disabled, creating the mask makes the object merge into the background. 
Only the mask marquee is visible. Don’t worry if you forget to use Preserve Image; you can undo the Create From
Object command, or recreate the object from the mask.
By default, text created in Corel WEB.PhotoPaint is an object. An option is provided in the Tool Settings Roll-Up 
and the Property Bar for the Text tool, that allows you to make the text a mask selection automatically.

From the clipboard contents
You can also use the image pixels located on the clipboard to create a mask. The Paste As New Selection 
command found in the Edit menu allows you to do just that. It pastes the pixels into the active image as a 
floating selection. When a selection is floating you can move it, and the pixels it encloses move along with it 
above the image. The floating selection behaves somewhat like a mask in the sense that you can apply effects 
or color to the image, and only the area included in the marquee is affected.
If you click outside the floating selection, choose the Mask Transform or Mask Brush tool, or use any other mask 
tool in the Image Window, the selection’s pixels are combined with the image background and the marquee 
disappears. To merge the pixels into the background and still use the marquee as a mask, simply defloat the 
selection by choosing the Defloat command found in the Mask menu.

{button ,Next()} Click here to see the next page.
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Alternative methods to create masks (page 2 of 2)

From paths
Paths are line segments, curve segments, or any combination thereof, created with the Path Node Edit tool. 
There are situations in which you might prefer to create a mask from a path instead of using the mask tools. If 
the outline you wish to create for the mask’s selection is complicated, you will have more editing power with the 
Path Node Edit Tool than you would with the Freehand Mask Tool. Also, you may prefer to start with the Path 
Node Edit tool, rather than editing a selection made with the Lasso or Magic Wand tool.
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Creating a mask in the shape of text
You can easily apply color or special effects such as embossing or blurring to a text shape by making text a mask
selection. The applied effect will only change the pixels inside the text-shaped mask marquee, making it stand 
out from the rest of the image. 
There are two methods for making a text-shaped mask selection: you can create the selection as you are 
creating the text, or convert an existing text object into a selection. The first method creates only the selection, 
the second can be used to have both the text object and the text-shaped selection in your image.

To create a mask in the shape of text
1. Click the Text Tool. 
2. On the Property Bar, choose the font, point size and other text attributes.
3. Click the Render To Mask button.
4. In the Image Window, click to anchor the cursor, and type the text.

The text displays using the current paint color.
5. Choose any other tool in the Toolbox.

A dialog box appears asking you if you want to apply the changes.
6. Click Yes.

The text color disappears and each character is outlined by a mask marquee.

To convert a text object into a mask selection
1. Click the Text tool.
2. On the Property Bar, make sure the Render To Mask button is not active.
3. Create the text.
4. Click the Object Picker tool.

A dialog box appears asking you if you want to apply the changes. 
5. Click Yes.

The characters are enclosed in the object marquee and selection handles surround the text string.
6. Verify that Preserve Image found in the Image menu is enabled, i.e., it has a check mark. If it does not, click 

the command to enable it.
Enabling Preserve Image ensures that the text object remains in the Image Window after creating the 
selection; disabling Preserve Image creates the selection, but merges the text object into the image 
background.

7. Click Mask, Create From Object(s).
The mask selection and object are superimposed in the Image Window. You can move the object with the 
Object Picker tool, or move the selection using the Mask Transform tool.
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Creating a mask from an object
Save time by creating a mask selection that is shaped exactly like an existing object. This often eliminates the 
task of creating a mask from scratch.

To create a mask from an object
1. Select the object with the Object Picker tool.
2. Enable or disable Preserve Image in the Image menu. 

Enabling the command creates the mask and keeps the object; disabling the command creates the mask and 
combines the object with the background.

3. Click Mask, Create From Object(s).
 Tip

· To create a selection from several objects, hold down SHIFT, click to select as many objects as you want, and 
proceed with step 2.
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Creating a new selection with the clipboard contents
Information that is cut or copied to the clipboard can be pasted into Corel WEB.PhotoPaint as a floating selection.
The pasted image pixels are enclosed by a mask marquee. Moving the selection also moves the image pixels it 
contains. The floating selection marquee behaves essentially like a mask; you can apply color or effects that only
affect the content of the marquee, or you can invert the area to protect it from change. The distinction between 
a mask and a floating selection is that the floating selection includes the image pixels.

To paste from the clipboard into a new selection
1. Cut or copy the selected data to the clipboard in the application of your choice. If working from an image file in

Corel WEB.PhotoPaint, select the area to copy to the clipboard with a mask tool.
2. In Corel WEB.PhotoPaint, click Edit, Paste, As New Selection.
 Note

· As soon as you click outside the floating selection, choose the Mask Transform or Mask Brush tool, or use any 
of the other mask tools outside of the selection, the pixels inside the floating selection are combined with the 
image background and no longer float above the image.

{button ,AL(`PRC Alternative methods to create masks;',0,"Defaultoverview",)} Related Topics



Pasting into an existing mask selection
1. Cut or copy the selected data to the clipboard in the application of your choice. If working from an image file in

Corel WEB.PhotoPaint, select the area to copy to the clipboard with a mask tool.
2. In Corel WEB.PhotoPaint, click Edit, Paste, Into Selection.

The clipboard’s contents appear inside the current mask marquee. If the pasted data is smaller than the 
selection it was pasted into, it is enclosed by a second marquee. You can move the pasted data inside the 
selection without affecting the underlying image. You can also move the mask selection that includes the 
pasted data. Keep in mind that the marquee around the pasted pixels disappears when you move the entire 
selection; the pixels move along with the selection, but can no longer be repositioned inside it.

 Note
· If the pasted data is smaller than the selection you are pasting it into, its marquee is red. You can change the 

color of this marquee, called the Paste Into marquee, in the Options dialog box.
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Creating a mask from a path
1. Click the Path Node Edit tool.
2. Using the Property Bar controls, create a new path, or open an existing one using either the Create New Path 

or the Open Existing Path button.
3. Click the Mask From Path button.
4. In the Create Mask from Path dialog box, enable the Anti-aliasing check box to produce smoother edges in the 

mask. This may take more processing time.
 Note

· If the path consists of several separate closed paths, any overlapping areas between the paths are protected 
by the mask; only the non-intersecting areas are part of the selection.
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Sizing mask marquees
To size a mask marquee, you must first click it with the Mask Transform tool  to display the sizing handles.

Masks marquees can be sized interactively on screen by clicking and dragging handles. A non-printable grid can be 
displayed on screen to facilitate precise sizing. The Snap to Grid command found in the Tools menu makes the grid 
magnetic, which means that as you start dragging the handles the mask marquee automatically jumps to the 
closest gridline.
The Mask Transform tool’s Property Bar is used to choose the marquee dimensions numerically. It includes an Anti-
alias option which is enabled by default and is functional even if you size a mask using its handles. Anti-aliasing 
produces smoother looking edges. The size values displayed on the Property Bar use the current units of 
measurement. Those can be changed in the Options dialog box found in the Tools menu.

 Note
· The Tool Settings Roll-Up for the Mask Transform tool can also be used when sizing a mask marquee. It 

includes the same controls as the Property Bar.
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Selecting the current mask’s marquee
· Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear around the edges of the mask marquee.
The handles are placed on an invisible rectangular box, that completely encloses the marquee, called the 
highlighting box.
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Sizing a mask marquee precisely
1. Open the Mask Tools flyout and click the Mask Transform tool.

Handles appear along the marquee’s highlighting box.
2. On the Property Bar, choose the Size mode.
3. Type the horizontal {pbwidth.bmp} and vertical {pbheight.bmp} dimensions.
4. Do one or both of the following:

· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.
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Sizing a mask marquee in the Image Window
Sizing handles allow you to change only one dimension of the mask marquee, which changes its aspect ratio. You
can also use the handles to change both dimensions at the same time to preserve the mask’s aspect ratio.

To change only one dimension of the marquee
1. Open the Mask Tools flyout and click the Mask Transform tool.

Handles appear along the marquee’s highlighting box.
2. Click and drag a center handle on any side of the marquee.
3. Release the mouse when the desired size has been achieved.
4. Double-click inside the selection to apply the change, outside to cancel.

To scale a mask marquee proportionately
1. Select the mask marquee with the Mask Transform tool.
2. Click and drag a corner handle.
3. Release the mouse when the desired size has been achieved.
4. Double-click inside the selection to apply the change, outside to cancel.
 Tips

· For both procedures, holding down CTRL increases or decreases the size in 100% increments. 
· Holding down SHIFT sizes the marquee from the center, i.e., the center does not move. The change in size 

occurs in two opposite directions when dragging a center handle, and in all four directions when dragging a 
corner handle.

· You can use both CTRL and SHIFT at the same time to size in 100% increments without moving the center. 
· You must hold down the keys before you start to drag, and release them only after you have released the 

mouse button.
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Moving mask marquees and selections
You can move the mask marquee or the entire selection (the marquee and the pixels enclosed by it).

Moving a marquee
To move a marquee, you click the Mask Transform tool ( ) and drag the marquee to a different position on the 
image. Moving the marquee does not affect the underlying image. 

Moving a mask selection
To move a selection, you select the Rectangle, Circle, Freehand, Lasso, or Magic Wand Mask tool, click inside the 
marquee, and drag. By default, the pixels inside the marquee are cut from the image when the mask is moved. A
paper-colored area in the shape of the selection is left on the image where it was originally located. 
However, if you hold down ALT when moving the selection, or choose the Float command from the Mask menu 
before moving it, the pixels are copied; the underlying image therefore remains intact. Both of these methods 
result in a floating selection. Clicking outside the selection at any time causes its contents to be merged into the 
background.
When you initially move a selection, its pixels are floating above the image. While the selection is floating, you 
can paste copies of it onto the image much like using a stamp to replicate a signature or shape.
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Moving a mask marquee and the pixels inside it
You can move or create copies of the mask selection. You must have created a mask selection in the image 
before using this procedure.

To move a mask and its content
1. Open the Mask Tools flyout and click the Rectangle, Circle, Freehand, Lasso, or Magic Wand Mask tool.
2. Right-click inside the selection and drag to the desired location.
3. Release the mouse and click Move Here or Copy Here from the flyout menu. 

Move Here cuts the selection from the image and pastes it at the current location. A paper-colored area is left 
on the image where it was originally placed. 
Copy Here copies the selection from the image. The pixels at the original selection location are merged with 
the underlying image, leaving the background intact.
In both situations, the mask marquee is active at the new location.

 Tip
· Using the left mouse button instead of using the right mouse button to move the selection cuts it from the 

image. Hold down ALT, or choose the Float command from the Mask menu, prior to dragging to copy the 
selection and leave the underlying image intact.

· Using the Copy Here command from the flyout, the Float command from the Mask menu, or moving the mask 
marquee while holding down ALT, makes the selection become a floating selection. The selection can then be 
moved anywhere in the Image Window without affecting the image background.
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Moving only the mask marquee
1. Select the mask marquee with the Mask Transform tool.
2. Click inside the marquee and drag it to the desired location.
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Moving a mask marquee in preset increments
You can set a distance increment to nudge mask marquees. You move the marquee in increments of the nudge 
distance as many times as you need. You can also set a second nudge distance which is a multiple of the first 
one, to move the marquee a longer distance in a single operation.

To move a mask marquee in preset increments
1. Click Tools, Options.
2. In the Options dialog box, click the General tab.
3. Type the desired distance increments in the Nudge box.
4. Type the number of repetitions of the nudge distance required in the Super Nudge box. Click OK.
5. Click the selection with the Mask Transform tool.
6. Do one or both of the following:

· Press a keyboard arrow key to move the object in the arrow’s direction by the Nudge distance.
· Press SHIFT and an arrow key simultaneously to move the marquee by the Super-Nudge distance.

7. Repeat step 6 as many times as is necessary.
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Stamping copies of the selection onto the background
In a single operation, you can make a copy of the pixels included in a selection, enclosed by the mask marquee 
at another location. If the selection is floating, its content will be merged at its original location when the copy is 
created. Make sure that the selection is at the appropriate location before proceeding with these instructions.

To stamp copies of the mask marquee content onto the background
1. Right-click inside the marquee with the Rectangle, Circle, Freehand, Lasso, or Magic Wand Mask tool.
2. Drag the mask to the desired location and release the mouse.
3. From the flyout menu, click Copy Here.

The marquee content is merged into the background at the location where it was originally placed. The 
marquee remains active on the copy of the selection content, at the location you copied it to.

4. Repeat steps 1 to 3 to create additional stamped copies of the selection on the image.
 Tip

· To create a copy of the selection using the left mouse button, hold down ALT before dragging the selection to a
new location.
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Removing a mask
Remove the mask from the Image Window to make the entire image editable.

To remove a mask
· Click Mask, Remove.

If the mask selection was floating before choosing this command, the pixels contained in it are merged into the
image.
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Mask Transformations
Mask transformations affect the shape of the mask marquee. The pixels inside the marquee are not affected by 
transformations. However, if you have made the selection float, the pixels are automatically combined with the 
underlying image before the transformation is applied. To apply transformations to the pixels enclosed by a mask
marquee, convert the mask to an object using the Create From Mask command found in the Object menu, then 
apply the transformations to the new object.
A mask marquee can be scaled, rotated, skewed, mirrored, distorted, and can have perspective applied to it. All 
transformations can be performed using the Mask Transform tool and its associated Tool Settings Roll-Up or 
Property Bar, or can be performed directly in the Image Window by clicking and dragging handles that appear 
along the mask marquee when using the Mask Transform tool. Distortion and perspective, however, can only be 
applied directly in the Image Window using handles.
With a mask in the Image Window, Click  to display handles for sizing, scaling and mirroring. Click the tool and 
click once inside the selection to display handles for rotating and skewing. Click another time inside the selection
to display handles for distorting. Clicking yet again inside the selection displays handles for applying perspective

When you scale, skew, or rotate a mask marquee, its edges can become somewhat jagged. For that reason, the 
Property Bar and the Tool Settings Roll-Up each provide an Anti-alias option. It is enabled by default. Even if you 
wish to apply transformation using the handles, the Anti-alias option is functional. 

The Horizontal and Vertical values displayed on the Property Bar and in the Tools Settings Roll-Up for 
transformations are based on the current units of measurement; you can change the units in the Options dialog 
box accessed from the Tools menu.
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Rotating the mask marquee

To rotate using the Property Bar
1. Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. On the Property Bar, choose the Rotate mode.
3. Type the horizontal  and vertical 
 coordinates to position the center of rotation. Click the Relative Center button to move it relative to its current 

location.
4. Type the rotation angle in the Rotation Angle box.
5. Do one or both of the following:

· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply. 

To rotate directly in the Image Window
1. Click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. Click inside the selection.

Rotation handles appear in the four corners of the marquee.
3. Drag a corner handle until you’ve achieved the desired rotation.
4. Double-click inside the selection to apply the rotation, outside to cancel.
 Tip

· By default, the marquee rotates around its center point which is represented by a bull’s-eye. You can move the
center of rotation by dragging it to the desired location.
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Scaling a mask marquee

To scale using the Property Bar
1. Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. On the Property Bar, choose the Scale mode.
3. Type the Horizontal and/or Vertical scaling percentages.
4. Click the Maintain Aspect button to scale each side proportionately.
5. Do one or both of the following:

· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

To scale directly in the Image Window
1. Click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. Click and drag a corner handle until the desired size is achieved.
3. Double-click inside the selection to apply the scaling, outside to cancel.
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Creating a mirror image of a mask marquee

To mirror a mask marquee using the Property Bar
1. Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. On the Property Bar, choose the Scale mode.
3. Do one or more of the following:

· Enable the Flip Horizontal button to mirror the marquee along a vertical axis.
· Enable the Flip Vertical button to mirror the marquee along a horizontal axis.

4. Do one or both of the following:
· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

To mirror directly in the Image Window
1. Click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. Drag a middle handle over the selection beyond the opposing middle node.

Hold CTRL while you drag to make the mirrored marquee the same size as the original.
3. Double-click inside the selection to apply the transformation permanently, outside to cancel.
 Tip

· You can enable the Snap To Grid command in the Tools menu to help control sizing.
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Skewing a mask marquee
You can slant the mask marquee using the controls on the Property Bar or by manipulating the marquee in the 
Image Window.

To skew using the Property Bar
1. Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. On the Property Bar, choose the Skew mode.
3. Type the horizontal  and vertical 
 distances by which you want to slant the marquee.

4. Do one or both of the following:
· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

To skew directly in the Image Window
1. Click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. Click inside the selection.
3. Drag a skewing handle, i.e. a straight double-headed arrow, in the direction of either arrow.
4. Double-click inside the selection to apply, outside to cancel.
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Distorting a mask marquee
1. Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. Click inside the selection until diagonal outlined arrows appear at each corner of the marquee.
3. Drag the arrows to create the desired effect.
4. Double-click inside the selection to apply the distortion, outside to cancel.
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Applying perspective to a mask marquee
Perspective makes a marquee look like it is in 3D space which gives the illusion of depth.

To apply perspective to a mask marquee
1. Open the Mask Tools flyout and click the Mask Transform tool.

Eight handles appear along the mask marquee’s highlighting box.
2. Click inside the selection until hollow circular handles appear at each corner of the marquee.
3. Drag one of the handles to create the desired effect.

The opposite handle from the handle you are dragging also moves, but it moves in the opposite direction.
4. Double-click inside the selection to apply the perspective, outside to cancel.
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Altering the edges of a selection
The edges of a selection are identified by the mask marquee which is the boundary between the protected and 
editable areas of your image. You can see the boundary by applying the mask overlay. Corel WEB.PhotoPaint 
provides features that allow you to change the look of the edges of a selection; edges can be feathered, made 
smooth, or even have color applied along them to produce special effects.

Feathering
Feathering can be applied to a selection during or after its creation. It is particularly useful if you edit the 
contents of the selection but not the surrounding pixels, and would prefer to make the transition between the 
two areas gradual, therefore less noticeable. For example, you want to brighten a few flower bushes in a 
photograph. You want the change to appear as if the photo was always like that; you don’t want it to be apparent
that the photo has been edited. Feathering is the answer. You may also want to use feathering to make a pasted 
selection blend in with the image background.

Smoothing
Smoothing lets you smooth over or round off the sharp angles of a selection, resulting in a more fluid selection 
shape. It is a good feature to apply to a color-sensitive mask that is very complex in shape; such a mask usually 
has many sharp angles.

Applying color along the mask marquee
The mask marquee can be stroked. Using the Stroke Mask command, you can choose any brush or effect tool, 
choose the color, and set other options. The options you choose are applied along the mask’s marquee. Stroking 
a mask marquee can be used, for example, to highlight a section of an image as if you were adding a visible 
aura or halo to a component of the image.
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Feathering pixels around a selection
Feathering a selection changes the transparency of the pixels located near the mask marquee. Any effect or 
command applied to the selection fades gradually as you get near the protected area. 

To feather pixels around a mask
1. Click Mask, Feather.
2. Type a value in the Width box.
3. Click a feathering direction in the Direction list box.
4. Click an edge type in the Edges list box. 

If you choose Average as the direction, the Edges list is unavailable. See the note below.
 Note

· The Average direction creates a transition between the pixels directly inside and outside of the marquee. 
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Smoothing the edges of a mask
Produce a more fluid selection boundary by smoothing out sharp bends in the mask marquee that occur when 
creating color-sensitive masks. Some pixels that are not in the selection before smoothing will become part of 
the selection after smoothing, and some pixels that are currently in the selection will no longer be included in it.

To smooth the edges of a mask
1. Click Mask, Shape, Smooth.
2. Type a value in the Radius box.
 Note

· The use of the Smooth command on a mask selection can also result in the elimination of protected areas that 
are completely surrounded by the selection often found in color-sensitive masks.
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Applying color or an effect along the mask marquee
1. Click Mask, Stroke Mask.
2. Choose a position for the border of color relative to the mask’s marquee and click OK.
3. In the Stroke Mask dialog box, click the first tab to use the Paint tool, the second tab to use the Effect tool, or 

the third to use the Color Replacer or Eraser.
When using a brush, the current paint color is used.

4. Click a tool icon in the dialog box.
5. Click the Edit button to change the tool’s attributes. 
6. Click OK to return to the Stroke Mask dialog box.
7. Click OK. 

The selected effect or brush color is applied along the mask marquee
 Note

· If you used a brush tool to apply the stroke to the mask marquee and then use the Repeat command in the 
Edit menu to apply a second stroke to the mask, the brush tool defaults back to the Quick Doodler brush.
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Expanding and reducing a mask selection (page 1 of 2)
Corel WEB.PhotoPaint offers several methods for increasing or decreasing a selection. The most basic way to add
or remove areas from a selection is to use the Additive, Subtractive, or XOR mask modes and define the shapes 
to add or remove with any of the Mask tools. The selections in color-sensitive masks can also be expanded to 
include more pixels that fall in the defined color tolerance range than in the original selection.

Mask modes
Mask modes are often used to create complex masks, i.e., masks that comprise several selections created one at
a time and combined in different ways. They are also used to remove areas from an existing selection. You can 
activate the mask modes from the Mode command found in the Mask menu, or by clicking the mode buttons 
displayed on the Property Bar when a mask tool is selected.
·  The Normal mode is the default mode where you can only define a single selection in a mask.

·  The Additive mode creates a mask consisting of two or more selections. When this mode is enabled, you
create one selection, move to a different spot, define another selection and so on until you have achieved the 
selection shape you want. You can use a combination of mask tools to define the areas to add to the selection. 
·  The Subtractive mode removes sections from a selection using one or more mask tools. When this mode
is enabled, you choose a mask tool, define an area on the selection and the mask marquee automatically shrinks to 
exclude that area from the selection. This mode is useful for fine-tuning a mask.
· The XOR mode also creates a selection consisting of two or more defined areas. The difference between this 

mode and the Additive mode is that the XOR mode excludes the space where two defined selections overlap; 
those overlapping sections become part of the protected area.

Are the Mask tools behaving strangely?
If you have difficulty getting the result you expect when using mask tools, verify the mask mode that is active. 
Changing the mode may be the answer. For example, if you used the Rectangle Mask tool to create a selection to
isolate an area of the image for editing, but the effect used after creating the selection is applied to everything 
but the area you wanted to change, the Subtractive mode was probably active when you defined the selection. 
You can switch back to Normal mode and start again, or you can undo the effect, invert the mask, and reapply 
the effect to achieve the results you want.

{button ,Next()} Click here to see the next page.
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Expanding and reducing a mask selection (page 2 of 2)

Shape command (Mask menu)
The Shape command submenu provides several commands that edit the shape of any mask selection by adding 
to it or subtracting from it. The commands are used to make the selection more suited to the task you want to 
accomplish. The Border command converts the existing marquee to two marquees that have the same shape 
and share the same center but that are separated by a specific number of pixels. This creates a frame-like 
selection. The Smooth command allows you to smooth out the edges of a mask selection. Remove Holes selects 
the protected areas that are completely enclosed by a selection; Expand and Reduce are used to add or remove 
a specific number of pixels along a selection’s edge.

{button ,AL(`OVR Working with masks;',0,"Defaultoverview",)} Related Topics



Adding areas to a selection
You can add to a selection using any of the mask tools. Two mask modes give you the choice of adding new 
areas to the existing selection or adding new areas, but excluding overlapping sections of the original selection 
and the new areas.

To add areas to a selection
1. Click Mask, Mode, Additive.
2. Click a mask tool and define an additional area.
3. Release the mouse.

The mask marquee expands to include the new area in the selection.

To add areas to a selection but exclude overlapping sections
1. Click Mask, Mode, XOR.
2. Click a mask tool and define an area that overlaps the selection.

If the new area does not overlap the current selection, this mode behaves exactly like the Additive mode 
described in the previous procedure.

3. Release the mouse to set the mask.
Everything except the overlapping area becomes part of the selection.
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Removing protected islands within a selection
Protected areas completely enclosed by editable areas are typically found in selections created using the Lasso 
Mask tool, the Magic Wand Mask tool, or the Color Mask command. They are the result of the tolerance settings 
selected prior to masking. The Remove Holes command includes those protected «islands» part of the selection.

To remove holes within a selection
· Click Mask, Shape, Remove Holes.
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Expanding or reducing a selection by a number of pixels
You can increase or reduce the size of a selection by a number of pixels along its entire outline. The mask 
marquee moves inwards or outwards by the number of pixels that you choose.

To expand a selection by a specific number of pixels
1. Click Mask, Shape, Expand.
2. Type a value in the Width box.

To reduce a selection by a specific number of pixels
1. Click Mask, Shape, Reduce.
2. Type a value in the Width box.
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Adding adjacent pixels of similar color to a selection
The Grow command found in the Mask menu uses the current color tolerance to expand the mask. 

To expand a selection to include adjacent pixels of similar color
· Click Mask, Grow. 

Watch the Progress Indicator on the Corel WEB.PhotoPaint Status Bar to see the status of the operation.
The selection expands until it reaches pixels that are dissimilar in color to those located along the original 
mask marquee. 

To expand the selection even more
1. Open the Mask Tools flyout and click the Magic Wand Mask tool.
2. On the Property Bar, click the button corresponding to the tolerance mode you want to use: Normal or HSB.
3. Type a new tolerance value in the number box(es) next to the tolerance mode buttons. 
4. Click Mask, Grow, or the Grow button on the Property Bar, to expand the selection using the new tolerance 

setting. 
5. Repeat if necessary.
 Tip

· To use anti-aliasing with the Grow command, enable in the Magic Wand’s Property Bar or Tool Settings Roll-Up.
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Subtracting areas from a selection
1. Click Mask, Mode, Subtractive. 
2. Click a mask tool and define an area on the current selection that you want to remove. 

If you are using the Magic Wand Mask tool, click a pixel inside or outside the selection, of a color you want to 
remove from the selection.

3. Release the mouse. 
Any overlapping area between the selection and the area defined in step 2 is removed from the selection and 
is now part of the protected area.
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Creating a border-shaped selection
The Border command subtracts an area from a selection. The resulting selection frames protected pixels in the 
image. You can frame parts of an image with a color, a texture, or a special effect.

To create a border-shaped mask
1. Click Mask, Mode, Normal.
2. Define a selection using one or more mask tools.
3. Click Mask, Shape, Border.
4. Type a value in the Width list box. 

The border’s width is determined by adding the typed value to both sides of the original marquee. Selecting a 
value of 10, for example, produces a selection border 20 pixels wide.

5. Choose an edge type in the Edges list box. 
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Creating a new image from a selection
1. Using one or more mask tools, define the selection with which you would like to create the new image.
2. Click Edit and click either Cut or Copy in the menu.
3. Click Edit, Paste, As New Document.
 Note

· The new image consists of a single object that is surrounded by a flashing marquee. If you wish to merge the 
object with the background, making it a permanent part of the image, click Object, Combine, Objects With 
Background.

{button ,AL(`PRC Expanding and reducing a mask selection;',0,"Defaultoverview",)} Related Topics





Painting, filling, and editing



Painting, filling, and editing tools
In Corel WEB.PhotoPaint, painting is as easy as clicking a color swatch from the on-screen Color Palette, clicking 
the Paint tool, and clicking and dragging across your image. However, just under the surface are a great many 
powerful options that let you control the way you paint or draw with a precision that rivals the real world, and in 
some cases, exceeds it. You can select or create different nibs, textures, transparency levels, bleed and fade-out 
rates for brushes, as well as control the way the paint or ink combines with the colors that already exist on your 
image. 
Painting in Corel WEB.PhotoPaint is as easy as you need it to be. You can play it safe and use preset brushes until
you get a little more comfortable with the options, or take the dive into the world of customization.
This section will help you get started creating original bitmap artwork with the many brush tools Corel 
WEB.PhotoPaint offers, introduce the fundamentals of customization, and show you how to fine-tune your 
artwork after you're finished. You will also learn about the different methods of selecting and customizing fills to 
apply to your image. 

For more information see the following:
{button ,JI(`',`The basics of brush tools page 1 of 2')} The basics of brush tools
{button ,JI(`',`Unleashing the artist')} Unleashing the artist
{button ,JI(`',`Using the fill tools page 1 of 2')} Using the fill tools
{button ,JI(`',`Editing your artwork')} Editing your artwork



Working with brushes and paint modes



The basics of brush tools (page 1 of 2)
Brush tools are any of Corel WEB.PhotoPaint's tools that you apply with a brush and paint mode. The Paint, 
Clone, Effect, Undo, Mask Brush, and Object Transparency tools are all brush tools. 
You can vary the effect any brush tool has by changing the brush settings and using different paint modes. The 
Tool Settings Roll-Up for most of the brush tools contain three tabs, each dealing with different qualities of the 
brush. The first tab offers a selection of preset brush types, but you can customize any preset brush or create an 
entirely new brush that specifically suits your needs.

Nibs Roll-Up
The Nibs Roll-Up allows you to load and keep all your favorite nibs on a single, compact palette, and keep them 
visible even if you don't have the Tool Settings Roll-Up open. Unless you need to make modifications to a brush, 
the Nibs Roll-Up is the perfect way to select and manage your brush tips. If you have to make modifications to 
brushes, you can do it on the Tool Settings Roll-Up for any of the brush tools.

Customizing brushes
If you open the Tool Settings Roll-Up for any brush tool, you will find a palette on the first tab that offers all the 
preset nibs, as well as the controls you need to customize a nib. You can change the size, shape, flatness, 
transparency, and angle of your nib, or even create a new nib from a mask. This portion of the Roll-Up is identical
to the Nibs Roll-Up. The controls on this first tab of the Roll-Up are also available on the Property Bar.
The second tab contains the controls you need to adjust the texture of the brush stroke, how the color is applied 
through the duration of the stroke, as well as how smooth the edges of the stroke appear. You can select a 
texture for your brush, and apply it throughout the stroke, to just the edge of the stroke, or both, in varying 
amounts.
The third tab is where you can have some real fun creating brush strokes that mimic the masters. Its powerful 
controls make it possible to create brushes that emulate established artistic styles. Corel WEB.PhotoPaint offers 
several artistic styles as preset brushes: try the Pointillism, Impressionism, Cubist, and Op Art presets in the Type
list box for the Artistic brush tool. Try a few of the preset artistic styles, and look at their spacing, spread, and 
color variation settings to see how they work.

Some hints
To... Do this...
To paint with series of disks Increase the spacing
To paint with a fistful of markers Increase the spread
To paint with random dabs Increase the spacing and spread
To get a vertebraic effect Turn a puzzle-shaped masked selection into a nib, and increase the spacing

{button ,Next()} Click here to see the next page.
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The basics of brush tools (page 2 of 2)

Paint modes
Paint modes determine the way the paint is applied to the colors that already exist in your image. You can simply
replace the base colors with the paint color, or you can combine the two using any of the following methods.
Paint mode How the paint color and base color are combined
Normal The paint color replaces the base color. This is the default mode.
Add Creates a result color by adding the values of the paint and base colors. 
Subtract Creates a result color by adding the values of the paint and base colors together 

and then subtracting 255.
Difference Creates a result color by subtracting the paint color from the base color and 

multiplying by 255. If the paint value is 0, the result will always be 255. 
Multiply Creates a result color by multiplying the base color by the paint color and dividing 

it by 255. This has a darkening effect, unless you are painting on white. Multiplying
black with any color results in black. Multiplying white with any color leaves the 
color unchanged. 

Divide Creates a result color by dividing the base color by the paint color, or vice versa, 
depending on which color has a higher value. 

If Lighter The paint color replaces any base pixels that are a darker color. Base pixels that 
are lighter than the paint color are not affected. 

If Darker The paint color replaces any base pixels that are a lighter color. Base pixels that 
are darker than the paint color remain unchanged.

Texturize Creates a result color by converting the paint color to grayscale, and then 
multiplying the grayscale value by the base color.

Color Creates a result color using the lightness of the base color and the hue and 
saturation of the paint color. This is the opposite of Lightness mode.

Hue Creates a result color using the hue of the paint color and the saturation and 
lightness of the base color. If you are painting on a grayscale image, there will be 
no change because the colors are desaturated.

Saturation Creates a result color using the lightness and hue of the base color and the 
saturation of the paint color.

Lightness Creates a result color using the hue and saturation of the base color and the 
lightness of the paint color. This is the opposite of Color mode.

Invert Creates a result color using the paint color's complementary color. If a paint color 
value is 127, there will be no change, because the color value falls in the center of 
the color wheel. 

Logical AND Converts the paint and base colors to binary values, and then applies the Boolean 
algebraic formula AND to them. It's easier to test this one out than to try to 
describe the result.

Logical OR Converts the paint and base colors to binary values, and then applies the Boolean 
algebraic formula OR to them. Test this one out to see the effect.

Logical XOR Converts the paint and base colors to binary values, and then applies the Boolean 
algebraic formula XOR to them. As with the other logical modes, it’s easier to test 
this one than to describe it.

Red Creates a result color by applying the paint color to the red channel of RGB 
images.

Green Creates a result color by applying the paint color to the green channel of RGB 
images.

Blue Creates a result color by applying the paint color to the blue channel of RGB 
images.
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Selecting or customizing brush nibs
The first tab of the Tool Settings Roll-Up for any of the brush tools contains a large selection of preset nibs you 
can use, as well as controls that let you create and modify the size, shape, transparency, and angle of your nib. 
These controls are also available on the Property Bar.

To select a brush nib
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings. 
3. Click the arrow to the right of the nib picker. 
4. Click a preset nib. 

To customize a brush nib
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings. 
3. Do any of the following:

· To adjust the size of the nib, type a value in the Size box. The nib size is measured in pixels.
· To adjust the transparency of the paint or effect you are going to apply, type a value between 0 and 99 in 

the Transparency box.
· To rotate the nib (creates a calligraphic effect), type a value in the Rotate box.
· To change the shape of the nib, click one of the default shape icons and type a value in the Flatten box. A 

higher value will make a round nib oval, and a square nib rectangular.
· To have the paint fade out at the edges of the nib, type a value in the Soft Edge box. 

To create a custom nib from a masked selection
1. Use the mask tools to define a masked selection.
2. Click a brush tool.
3. Click View, Roll-Ups, Tool Settings.
4. Click the arrow next to the nib shape icons.
5. Click Create From Mask.
6. Type a value in the Nib Size box.
7. Click OK.
 Note

· The Create a Nib from Mask option uses the shape of the masked selection and the pixels that fall within it. You
can't create a nib from an empty masked selection. 
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Customizing and saving brushes
The items on the second and third tabs of the Tool Settings Roll-Up control the way the brush applies the paint to
the paper. You can change the level or type of texture the brush uses, as well as the smoothness, bleed, and 
fade-out rate of its stroke. You can also change the spacing, spread, and color variance of dabs applied per 
stroke. This allows you to create brushes that mimic various artistic styles, or to create effects such as drawing 
with a fistful of markers.

To adjust a brush’s texture
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings.
3. Click the second tab. 
4. Do any of the following:

· To adjust the amount of texture the brush uses, type a value in the Brush Texture box. A value of 0 results in 
no texture being applied.

· To adjust the amount of texture applied to the edge of brush stroke, type a value in the Edge Texture box. 

To load a new brush texture
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings.
3. Click the second tab. 
4. Click the arrow next to the texture thumbnail. 
5. Click Load A Texture.
6. Select a texture in the box.
7. Click Open.

To adjust the bleed rate of a brush
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings.
3. Click the second tab.
4. Do any of the following: 

· To adjust how the base color "bleeds" into the paint color, type values into the Bleed and Sustain Color 
boxes. Sustain Color controls the length of the bleed effect. 

· To smooth the brush stroke, enable the Anti-Aliasing check box and type a value in the Smoothing box.
· To make the effects of the brush strokes cumulative, enable the Cumulative check box. Otherwise, the effect

will "max out" after the first stroke, and subsequent brush strokes will have no effect on previously painted 
areas.

To adjust the fade-out rate of a brush
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings.
3. Click the third tab.
4. Type a value in the Fade Out box. A higher value will result in a quicker fade-out.

To adjust the number and spacing of dabs in a brush stroke
1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings.
3. Click the third tab.
4. Type new values in the Spacing and Spread boxes. Spacing controls how far apart the dabs are, and spread 

controls how many dabs wide the stroke is.
 Note

· Depending on the nib size, a large number of dabs with a small amount of spacing and spread can impair the 
brush's performance.

To adjust the color variation in a brush stroke



1. Click a brush tool. 
2. Click View, Roll-Ups, Tool Settings.
3. Click the third tab.
4. Move the Hue, Saturation, and Luminance sliders. Higher values will result in more variation.

To save a customized brush
1. Customize the brush using any of the previous procedures.
2. Click Save Brush on the first tab of the Tool Settings Roll-Up.
3. Type a name for the custom brush in the Save New Brush Type As box.
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Working with the Nibs Roll-Up
The Nibs Roll-Up allows you to load and keep all your favorite nibs on a single, compact palette, and keep them 
visible and handy even if you don't have the Tool Settings Roll-Up open. Unless you actually need to modify a 
brush nib, the Nibs Roll-Up is the perfect way to select and manage your brush nibs.

To add the nib you are currently using to the Nibs Roll-Up
1. Click the Nibs Roll-Up icon on the Property Bar.
2. Click the arrow to the right of the nib picker. 
3. Click Add Currently Used.

To load a set of nibs into the Nibs Roll-Up
1. Click View, Roll-Ups, Nibs.
2. Click the arrow to the right of the nib picker. 
3. Click Load.
4. Select the nib file to load.
5. Click Open.

To delete a nib
1. Click the Nibs Roll-Up icon on the Property Bar.
2. Select a nib from the nib picker. 
3. Click the arrow to the right of the nib picker. 
4. Click Delete.
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Unleashing the artist
Corel WEB.PhotoPaint offers a variety of tools to help you create original bitmap artwork. Use the Paint and Effect
tools to create and edit artwork using virtual versions of traditional art materials, or use the Clone tool to "paint" 
with ready-made images.

The Paint tools
Corel WEB.PhotoPaint offers you the virtual equivalent of a fully-stocked artist's studio, but with the advantages 
of being able to work around things like the law of gravity. Choose from a wide selection of paint tools, such as 
water color, oil pastel, felt markers, chalk, crayons, several types of pen, pencils, spraypaint, and an artistic 
brush with a wide variety of settings. Each of the preset paint tools has a number of variations built in, and you 
can customize any aspect to suit your specific needs. 

Painting with the Clone tool
The Clone tool allows you to duplicate parts of an image either onto a different part of the same image, or onto a
different image altogether. As with all the brush tools, you can create virtually endless numbers of variations by 
using different brushes. The Clone tool comes with Impressionist and Pointillist brushes, as well as the Clone 
from Saved brush, which lets you restore a part of your image that was present when you last saved even if 
you've since obliterated it. 

The Shape and Line tools
Use the Shape tools to draw outlined or filled shapes on your image. If you want to create the shape as an 
object, enable the Render to Object check box in the Tool Settings Roll-Up for the Shape tools. This allows you to 
reposition or edit your object before you merge it into your image. If you do not create the shape as an object, it 
will instantly merge into the background, so ensure you set the color, fill, and outline the way you want to in the 
Tool Settings Roll-Up before you begin.
The Line tool allows you to paint straight line segments using the paint color. You control the width of the line, 
the way the segments are joined, and their transparency.
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Selecting a paint color
There are several ways of selecting a paint color. The easiest is by clicking a color on the on-screen color palette;
however, this only works if the color you want is displayed on it. If you have seen the perfect color in an existing 
image, you can select it as your paint color with the Eyedropper tool. The Paint Color dialog box provides you 
with the most control for selecting a paint color. The paint color you select does not have to be from the same 
color model that your image uses: for example, you can select a color from the CMYK model for use in a RGB 
image. The paint color swatch on the Status Bar changes to reflect the color you choose.

To select a paint color from the on-screen Color Palette
· Click a color from the on-screen Color Palette. If the on-screen palette is not visible, click View, Color Palette, 

and select a palette type from the flyout menu.

To select a color from an image as the paint color
· Click a color in the image with the Eyedropper tool.

To select a paint color from the Color Roll-Up 
1. Double-click the Eyedropper tool.

The Color Roll-Up opens.
2. Choose a color model from the list box.
3. Click a paint color from the model. 

To select a paint color from the Paint Color dialog box
1. Double-click the paint color swatch on the Status Bar.

The Paint Color dialog box opens.
2. Choose a color model from the list box.
3. Click a color selection method: you can use a color model, fixed palette, color blender, or mixing area. 
4. Click a color on the color model.
 Note

· If you choose color model as your color picker, you can change the default by selecting another from the flyout
menu.
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Painting and drawing
Before you start painting, you select a paint color, a painting tool, and a paint mode. If you don't know what a 
paint mode is, see The basics of brush tools. 

To draw or paint
1. Click the Paint tool.
2. On the Property Bar, click the arrow next to the tool picker.

The tool picker opens.
3. Click a painting tool. 
4. Click the arrow next to the nib picker. 
5. Select a nib by clicking it. 
6. Click and drag to paint or draw on your image.
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Using the Clone tool
The Clone tool allows you to duplicate areas of images. You set a source point (the area you wish to copy), and 
then clone it by painting over the destination. The Clone from Saved brush does not actually clone in that you 
don't work with source and destination points; rather, it lets you restore parts of your image to the way they 
were when you last saved. Think of it as the ultimate undo tool.

To clone an area of an image
1. Click the Clone tool.
2. On the Property Bar, click the arrow next to the tool picker.
3. Click one of the cloning tools. 
4. Choose a brush from the Brush Type list box.
5. Click on your image to set a source point for cloning.
6. Move the cursor to the destination area.
7. Click and drag to clone. 
 Note

· To reset the source point, hold down SHIFT and click, or right-click and select Reset.
· Hold down S while clicking to keep the source point stationary. 
· Hold down CTRL while clicking to constrain the movement of the source point. Hold down CTRL + SHIFT to 

change the direction of constraint. 
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Using the Shape and Line tools
If you want to create the shape or line as an editable object, enable the Render To Object check box in the Tool 
Settings Roll-Up. If you do not create it as an object, it will instantly merge into the background, so be careful 
that you have set the color, fill, and outline you want to use in the Tool Settings Roll-Up before you start drawing.

To draw rectangles or ellipses
1. Click the Rectangle or Ellipse tool.
2. To set the fill type for the shape, click the Fill button on the Property Bar and click a fill icon. If you don't want 

to fill the shape, click the No Fill icon. 
3. Do any of the following:

· If you want a paint-colored outline around the shape, type a thickness value in the Width box (to change the
paint color, click a color in the on-screen Color Palette, or click the Outline button and select a new paint 
color in the Paint Color dialog box). 

· If you don’t want the shape to be opaque, type a value in the Transparency box. The higher the value, the 
more transparent the shape will be.

· If you want to create the shape as an editable object, click the Render As Object check box.
4. Click and drag to draw the shape. Hold down CTRL while clicking and dragging to constrain the shape to a 

circle or square.
 Tip

· You can round the corners of a rectangle by typing a value in the Roundness box, or by using the scroll arrows 
to adjust the existing value.

To draw a polygon
1. Click the Polygon tool.
2. On the Property Bar, click the Fill button and click a fill icon. If you want to draw a hollow shape, click the No 

Fill icon. 
3. Choose a method of joining the segments in the Joints list box.
4. Do any of the following:

· If you want a paint-colored outline around the shape, type a border thickness in the Width box (to change 
the paint color, click a color in the on-screen Color Palette or click the Outline button and select a color from 
the Paint Color dialog box).

· If you don’t want the shape to be completely opaque, type a value in the Transparency box. The higher the 
value, the more transparent the shape will be.

· If you want to create the shape as an object (which leaves it editable), click the Render As Object button.
5. Click and click on your image to create polygon segments.
6. Double-click to complete the shape.

To draw straight lines
1. Click the Line tool.
2. On the Property Bar, adjust the width of the line by typing a value in the Size box. A higher value will result in 

a thicker line.
3. If you don’t want the line to be completely opaque, type a value in the Transparency box. The higher the value,

the more transparent the line will be.
4. Choose a method of joining the segments in the Joints list box.
5. Click and click on your image to create straight line segments.
6. Double-click to complete the line.
 Tip

· To change the paint color, click a different color on the on-screen Color Palette, or click Outline and select a 
color from the Paint Color dialog box.
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Using the fill tools (page 1 of 2)
Corel WEB.PhotoPaint allows you to fill your image or parts of your image using a variety of fill types and tools. 
Fills are useful for creating backgrounds, applying textures over top of a finished masterpiece, or to creating a 
variety of effects.

The different types of fill
Corel WEB.PhotoPaint offers four basic types of fill. Uniform fills are the most basic, because they apply a solid 
color over the area you are filling. Fountain fills progress from one color to another following a concentric square,
conical, linear, rectangular, or radial pattern. A bitmap fill is created from any bitmap image: you can load any 
picture as a bitmap fill, but the ones that work best are those that are patterned and can tile seamlessly, 
creating a contiguous pattern, like stones, coins, or bricks. Texture fills are mathematically generated images 
with customizable attributes. Unlike the tiling bitmap fills, textures fill a designated area with a single image. The
many preset textures include water, minerals, clouds, and dozens of others. 

The Fill command
The Fill command (found in the Edit menu) lets you apply a fill to your entire image or to a masked selection. You
might do this to create a background for your image before you start painting, or you might apply a fill over top 
of your image using one of the transparency options so it doesn't obscure your image.
The Edit Fill and Transparency dialog box provides access to the Uniform, Fountain, Bitmap and Texture Fill dialog 
boxes, so you can create, edit, or customize a fill before applying it. It also contains a transparency tab that 
allows you to select a transparency type to apply to the fill. This particular option opens up a lot of possibilities: 
you can apply a circular, conical, linear or rectangular transparency to any of the basic fill types. 

The Fill tool
The Fill tool (found on the Toolbox) allows you to apply a fill to part of your image. You can define the area to be 
filled with a masked selection or by adjusting the color tolerance of the Fill tool in the Tool Settings Roll-Up. The 
Fill tool fills whatever falls within the defined color range. The Tool Settings Roll-Up for the Fill tool also includes 
an anti-aliasing option, which smoothes the edges of the filled area, and a transparency option, which allows you
to control the transparency of the fill.

{button ,Next()} Click here to see the next page.
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Using the fill tools (page 2 of 2)

Uniform Fill dialog box
The Uniform Fill dialog box allows you to select a color model and visual color picker from which to select a solid 
fill color. If you prefer, you can use a fixed palette, color blender, or mixing area rather than a color model to 
select or create custom colors. 

Fountain Fill dialog box
The Fountain Fill dialog box contains all the controls you need to customize, create, save, or delete preset 
gradients. You can create a simple two-color gradient that progresses from one color to another, or you can 
create a custom gradient that progresses through several colors. 

Bitmap Fill dialog box
The Bitmap Fill dialog box contains the controls you need to import, select, and customize bitmap fills. You can 
scale the pattern to fit, which essentially means your image is filled with a single, large tile, or you can modify 
the size, number, and offset of the tiles to suit your specific needs. 

Texture Fill dialog box 
The Texture Fill dialog box allows you to select and customize texture fills in a variety of ways. You can select a 
texture style to browse, and unlock and edit any of the texture’s properties. Click Preview to see variations based
on the unlocked values.
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Applying uniform fills
Uniform fills are the most basic fill type, because they simply apply a single color over the area you are filling. 
You can limit the boundary of the fill while using either the Fill tool or the Edit Fill and Transparency dialog box by 
defining a masked selection. 

To apply a uniform fill over your whole image
1. Click Edit, Fill.

The Edit Fill and Transparency dialog box opens.
2. Click the Uniform Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Choose a color mode from the Model list box.
5. Click a color on the visual color model. 
6. Click OK.
 Note

· If you have objects on your image that you want to protect from the fill, lock them in the Objects Roll-Up.

To apply a uniform fill over part of your image
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Uniform Fill icon. 
3. If you want to change the attributes of the current fill, click Edit.
4. Choose a color mode from the Model list box.
5. Click a color on the visual color model. 
6. Click OK.
7. Do one of the following to define a range for the fill:

· Click the Normal button, and type a tolerance value between 0 and 100 in the box beneath it.
· Click the HSB Mode button, and type values in the H, S, and B boxes.

8. Click on the image to apply the fill. All pixels adjacent to the pixel you click that fall within the defined color 
tolerance are filled.
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Loading a color model or palette into the Uniform Fill dialog box
The Uniform Fill dialog box allows you to select a color model and visual color picker from which you select a 
solid fill color. If you prefer, you can use a fixed palette, color blender, or mixing area rather than a color model 
to select or create custom colors. 

To display a different color model in the Uniform Fill dialog box
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Uniform Fill icon.
3. Click Edit.
4.  Click the arrow beside the top right corner of the visual color model.
5. Click Model, and select a color model from the flyout menu.

To load a palette into the Uniform Fill dialog box
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Uniform Fill icon.
3. Click Edit.
4. Click the arrow to the right of the palette across the bottom of the dialog box.
5. Click Open Palette.
6. Select the palette.
7. Click Open.
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Applying fountain fills
The Fountain Fill dialog box contains all the controls you need to customize, create, save, or delete preset 
fountain fills. You can create a simple two-color gradient that progresses from one color to another, or you can 
create a custom fountain fill that progresses through several colors. If you don't want to fill your entire image, 
you can limit the boundary of the fill by defining a masked selection, or by setting a color tolerance in the Tool 
Settings Roll-Up for the Fill tool. 

To apply a preset fountain fill over your whole image
1. Click Edit, Fill.

The Edit Fill and Transparency dialog box opens.
2. Click the Fountain Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Choose a fountain fill type from the Type list box.
5. Choose a preset style from the Preset list box.
6. Click OK.
 Note

· If you have objects on your image that you want to protect from the fill, lock them in the Objects Roll-Up.

To apply a preset fountain fill over part of your image
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Fountain Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Choose a fountain fill type from the Type list box.
5. Choose a preset style from the Preset list box.
6. Click OK.
7. Do one of the following to define a range for the fill:

· Click the Normal button, and type a tolerance value between 0 and 100 in the box beneath it.
· Click the HSB Mode button, and type values in the H, S, and B boxes.

8. Click on the image to apply the fill. All pixels adjacent to the pixel you click that fall within the defined color 
tolerance are filled.
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Creating, customizing, and deleting fountain fills
The Fountain Fill dialog box contains all the controls you need to customize, create, save, or delete preset 
gradients. You can create a simple two-color gradient that progresses from one color to another, or you can 
create a custom gradient that progresses through several colors. 

To create and save a fountain fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Fountain Fill icon.
3. Click Edit.
4. Do any of the following:

· Choose a gradient type from the Type list box. 
· To adjust the center of radial, conical, square, and rectangular fills, type positive or negative values in the 

Horizontal and Vertical boxes, or click and drag the cursor in the preview window.
· To adjust the angle of linear and conical fills, type a degree in the Angle box, or right-click and drag the 

cursor inside the preview window. 
· To adjust the number of gradations in the fill, type a new value in the Steps box, or adjust the value by 

clicking the scroll arrows.
· To adjust the percentages of the start and end colors that appear in the filled area, type a value in the Edge 

Pad box, or adjust the value by clicking the scroll arrows.
· To create a gradient that starts at one color and progresses through the color wheel to another, click the Two

Color button, and choose start and end colors from the To and From pickers. Determine the intermediate 
colors by clicking a color path button. The straight path option crosses the color wheel in a straight line. The 
clockwise path and counterclockwise path options travel around the color wheel. If you choose the linear 
option, you can move the Mid-point slider to adjust the midpoint of the blend.

· To create a custom gradient that progresses through the colors of your choice, click the Custom button. To 
add a new color to the blend, double-click one of the end-point icons above the gradient preview, drag it 
onto the gradient, and click a new color from the color picker.

5. Type a name for the fill in the Preset box and click the Add Fill button.

To customize and save preset fountain fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Fountain Fill icon.
3. Click Edit.
4. Choose a preset style from the Preset list box.
5. Do one or more of the following:

· Select a gradient type from the Type list box. 
· To adjust the center of radial, conical, square, and rectangular fills, type positive or negative values in the 

Horizontal and Vertical boxes, or click and drag the cursor in the preview window.
· To adjust the angle of linear and conical fills, type a degree in the Angle box, or right-click and drag the 

cursor inside the preview window. 
· To adjust the number of gradations in the fill, type a new value in the Steps box, or adjust the value by 

clicking the scroll arrows.
· To adjust the percentages of the start and end colors that will appear in the filled area, type a value in the 

Edge Pad box, or adjust the value by clicking the scroll arrows.
· To create a gradient that starts at one color and progresses through the color wheel to another, click the Two

Color button, and choose start and end colors from the To and From pickers. Determine the intermediate 
colors by clicking a path button: the straight path option crosses the color wheel in a straight line. The 
clockwise path and counterclockwise path options travel around the color wheel. If you choose the linear 
option, you can move the Mid-point slider to adjust the midpoint of the blend.

· To create a custom gradient that progresses through the colors of your choice, click the Custom button. To 
add a new color to the blend, double-click one of the end-point icons above the gradient preview, drag it 
onto the gradient, and click a new color from the color picker.

6. Type a name for the fill in the Preset box and click the Add Fill button.



To delete a fountain fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Fountain Fill icon.
3. Click Edit.
4. Choose a preset style from the Preset list box.
5. Click the Delete Fill button.
6. Click OK.
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Applying bitmap fills
A bitmap fill is a fill created from any bitmap image. You can load any picture as a bitmap fill, but the ones that 
work best are those that are patterned and can tile seamlessly, creating a contiguous pattern, like stones, coins, 
or bricks. If you don't want to fill your entire image, you can limit the boundary of the fill by defining a masked 
selection, or by setting a color tolerance in the Tool Settings Roll-Up for the Fill tool. 

To select and apply a bitmap fill over your whole image
1. Click Edit, Fill.

The Edit Fill and Transparency dialog box opens.
2. Click the Bitmap Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Click the arrow beside the preview window.
5. Click a bitmap fill from the thumbnails.
6. Click OK.
 Note

· If you have objects on your image that you want to protect from the fill, lock them in the Objects Roll-Up.

To select and apply a bitmap fill over part of your image
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Bitmap Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Click the arrow beside the preview window.
5. Click a bitmap fill pattern from the thumbnails.
6. Click OK.
7. Do one of the following to define a range for the fill:

· Click the Normal button, and type a tolerance value between 0 and 100 in the box beneath it.
· Click the HSB Mode button, and type values in the H, S, and B boxes.

8. Click on the image to apply the fill. All pixels adjacent to the pixel you click that fall within the defined color 
tolerance are filled.
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Importing, customizing, and deleting bitmap fills
The Bitmap Fill dialog box contains the controls you need to import, select, and customize bitmap pattern fills. 
You can scale the bitmap to fit, which essentially means your image is filled with a single, large tile, or you can 
modify the size, number, and offset of the tiles to suit your specific goal. 

To import a bitmap fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Bitmap Fill icon.
3. Click Edit.
4. Click Load.
5. Select the bitmap file.
6. Click Open.
7. Adjust any of the options.

To customize the size and layout of tiles in a bitmap fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Bitmap Fill icon.
3. Click Edit.
4. Click the arrow beside the preview window.
5. Click a bitmap fill’s thumbnail. 
6. Do one or more of the following:

· To adjust the size of the tiles, disable the Use Original Size control and type values in the Width and Height 
boxes.

· To adjust first tile offset, type values in the % Of Tile Width and % Of Tile Height boxes.
· To stagger columns or rows of tiles, click the Column r Row button and type values in the % Of Tile Side box.
· To fill your image with a single, large tile, enable the Scale Pattern To Fit check box. 

To delete a bitmap fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Bitmap Fill icon.
3. Click Edit.
4. Click the arrow beside the preview window.
5. Click the bitmap fill’s thumbnail. 
6. Click Delete.
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Applying a texture fill
Texture fills are mathematically generated images with customizable attributes. Unlike the tiling bitmap fills, 
textures fill a designated area with a single image. The many preset textures include water, minerals, clouds, 
and dozens of others. If you don't want to fill your entire image, you can limit the boundary of the fill by defining 
a masked selection, or by setting a color tolerance in the Tool Settings Roll-Up for the Fill tool. 

To apply a texture fill to your whole image
1. Click Edit, Fill.

The Edit Fill and Transparency dialog box opens.
2. Click the Texture Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Choose a texture library to open in the Texture Library list box.
5. Choose a texture in the Texture list box.
 Note

· If you have objects on your image that you want to protect from the fill, lock them in the Objects Roll-Up.

To apply a texture fill to part of your image
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Texture Fill icon.
3. If you want to change the attributes of the current fill, click Edit.
4. Choose a texture library in the Texture Library list box.
5. Choose a texture in the Texture list box.
6. Click OK.
7. Do one of the following to define a range for the fill:

· Click the Normal button, and type a tolerance value between 0 and 100 in the box beneath it.
· Click the HSB mode button, and type values in the H, S, and B boxes.

8. Click on your image to apply the fill. All pixels adjacent to the pixel you click that fall within the defined color 
tolerance are filled.

 Tip
· If the texture is close to, but not exactly, what you want, ensure that the padlock beside the Texture # box is 

unlocked, and click Preview. Each time you click Preview, you will see different variations of the texture.
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Customizing, saving, and deleting texture fills
The Texture Fill dialog box allows you to select and customize texture fills in a variety of ways. You can select a 
texture style to browse, and unlock and edit various texture properties. Click Preview to see variations based on 
the unlocked values.

To customize and save a texture fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Texture Fill icon.
3. Click Edit.
4. Choose a texture library to open in the Texture Library list box.
5. Choose a texture in the Texture List box.
6. If the padlock beside a texture property you wish to alter is in the locked position, click it to unlock the 

property. 
7. Adjust the values as required, or click Preview to have Corel WEB.PhotoPaint create random variations based 

on the properties you have unlocked.
8. Click the Add Fill button.
9. Type a name in the Texture Name box, and select the library where you’d like to include the new texture.

To delete a texture fill
1. Double-click the Fill tool.

The Tool Settings Roll-Up for the Fill tool opens.
2. Click the Texture Fill icon.
3. Click Edit.
4. Choose the texture library that contains the texture fill you wish to delete in the Texture Library list box.
5. Click the texture in the Texture list box.
6. Click the Delete Fill button.
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Editing your artwork
Corel WEB.PhotoPaint’s editing tools allow you to make minor adjustments to something that is nearly right, or to
undo actions that were decidedly wrong.

Editing your artwork
The Effect tools allow you to apply various corrections and enhancements locally. Some of these tools, such as 
the Brighten and Sharpen tools, are more useful for photo retouching (see Retouching and refining your image), 
but many of them are useful for editing your original bitmap artwork. You can smear, smudge, and blend paint, 
or use the Sponge tool to add or remove paint in varying degrees.

About the Undo tools
Use the Undo tools to edit work you’ve done with the Paint, Clone, Shape, and Fill tools. These editing options are
only available immediately after you have performed an action, so stop and look before you continue.
The Undo tools are available from the flyout on the Toolbox, or as a separate toolbar. The Eraser tool and the 
Color Replacer tool both allow you to apply the background paper color to your image. The difference is that the 
Eraser tool replaces anything you drag over with the paper color, while the Color Replacer tool replaces only the 
current paint color with the paper color. 
The Local Undo tool allows you to selectively remove the last change you made with the Paint, Clone, Effect, Fill, 
Shape, Line, Eraser or Color Replacer tools. As you drag over your image with the Local Undo tool, the pixels you 
covered over reappear, essentially restoring those parts to the way they looked before your last brush stroke.

Larger safety nets
If the decline of your image has taken several steps to achieve and your revisions with the Undo tools aren’t 
helping, there are still ways of salvaging your work. See Safety nets for information on the various methods you 
can use to revert to previous stages in the development of your image, or use the Clone From Saved tool to 
restore parts of your image to the way they looked when you last saved. 
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Smearing, smudging, and blending paint
The Smear tool has much the same effect as dragging your finger across wet paint. The Smudge tool works like 
rubbing your finger across pastels. The Blend tool softens the definition between colors or hard edges by 
blending the adjoining colors. 

To smear parts of your image
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Smear tool.
4. Choose a brush from the Type list box.
5. Click and drag over the areas on your image you wish to smear.

To smudge parts of your image
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Smudge tool.
4. Choose a brush from the Type list box.
5. Type a value in the Rate Of Flow box. A higher value will result in a more pronounced effect.
6. Click and drag over the areas of your image you wish to smudge.

To blend parts of your image
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Blend tool.
4. Choose a brush from the Type list box.
5. Type a value in the Amount box. A higher value will result in a more pronounced effect.
6. Click and drag over the areas of your image you wish to blend.
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Using the sponge to saturate or desaturate paint
If you applied too much paint to an image in a real-world studio, you might dab some paint off with a sponge or 
tissue. In Corel WEB.PhotoPaint, you can saturate or desaturate areas with the Sponge tool. This affects the 
strength or purity of the paint color. Fully saturated color contains no white and is as vibrant as it can be, while 
fully desaturated colors appear as their grayscale equivalents.

To saturate or desaturate areas with the sponge
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Sponge tool.
4. Choose a brush from the Type list box.
5. Type a value in the Amount box. A higher value will result in a more pronounced effect.
6. Click and drag over the areas you wish to affect.
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Adjusting the color of applied paint
The Hue and Hue Replacer tools allow you to modify paint that you've already applied to your image. The Hue 
tool shifts all hues along the color wheel by the number of degrees you type in the Amount box. The Hue 
Replacer retains the brightness and saturation of the original colors, but replaces all hues with the hue you 
select.

To change the color of paint
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Hue Replacer tool.
4. Choose a brush from the Type list box.
5. Type a value in the Amount box. This value determines the result color based on how many degrees around 

the color wheel it is from the paint color. A higher value will result in a more pronounced effect.
6. Click and drag over the paint.

To shift the color of paint
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Hue tool.
4. Choose a brush from the Type list box.
5. Type a value in the Amount box. This value determines how many degrees around the color wheel your hues 

will shift.
6. Click and drag over the paint you wish to change.

To apply a paint-colored tint on an image
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the right of the tool picker.
3. Click the Tint tool.
4. Choose a brush from the Type list box.
5. Type a value in the Amount box. A higher value will result in a more pronounced effect.
6. Click and drag over the areas you wish to tint.
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Using the Undo tools
The Undo tools are available from the flyout on the Toolbox, or as a separate toolbar. The Eraser tool and the 
Color Replacer tool both allow you to apply the background paper color to your image. The difference is that the 
Eraser tool replaces anything you drag over with the paper color, while the Color Replacer tool replaces just paint
with the paper color. 
The Local Undo tool allows you to selectively remove the last change you made with the Paint, Clone, Effect, Fill, 
Shape, Line, Eraser or Color Replacer tools. As you drag over your image with the Local Undo tool, the pixels you 
covered over reappear, essentially restoring those parts to the way they looked before your last brush stroke. If 
your mistake happened several strokes ago, use the Clone From Saved tool. This allows you to restore parts of 
your image to the way they were when you last saved.

To restore parts of your image
1. Click the Local Undo tool.
2. Click and drag over the parts of your image that were affected by your last brush stroke or action.

To restore parts of your image using the Clone from Saved tool
1. Click the Clone tool.
2. On the Property Bar, click the Clone from Saved tool from the clone tool picker.
3. Choose Eraser from the Brush Type list box.
4. Click and drag over the areas you wish to restore to the way they were when you last saved.

To replace areas with the paper color
1. Click the Eraser tool.
2. Click and drag over the parts of your image that were affected by your last brush stroke or action to replace 

them with the paper color.

To replace paint with the paper color
1.  Click the Color Replacer tool. 
2. Click and drag over the parts of your image that were affected by your last brush stroke to replace them with 

the paper color.
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Introduction to paths

What are paths?
Paths are line and curve segments connected by square endpoints called nodes. A path that completely encloses
an area is closed; a path with start and end nodes that are not connected is open.
Paths exist on a layer above your image and are independent from the image resolution. This means that they 
are unaffected by changes in image resolution. Paths offer powerful and precise editing tools that allow you to 
modify isolated segments of the outline you create. You can save the path if you wish to work on it later or use it 
in another image. 

Why use them?
Paths have one main function which is to define and shape open or closed outlines. Once you enclose a portion 
of your image within a path, you can turn it into a mask marquee or apply a brush stroke along it. A brush stroke 
can also be applied to an open path.
The advantage of creating an outline as a path rather than as a mask marquee is that paths are fully editable, 
and although the editing techniques and tools take some getting used to, they are well worth the effort. You can 
edit each individual line and curve segments with precision, and you can easily move, add, remove, or transform
the connecting nodes.
Paths offer just one more method of perfecting your work. Don’t think that because their functions are limited, 
you will be limited by using them. Paths offer flexibility. Just because you create an outline as a path doesn’t 
mean it has to stay that way: you can easily convert your path to a mask, your mask to an object, your object to 
a mask, and your mask to a path. So you can perform any operation the program offers on any portion of the 
image you have enclosed with either a mask marquee or a path. 

Path Node Edit Roll-Up
The Tool Settings Roll-Up and the Property Bar associated with the Path Node Edit tool is the control tower for 
path manipulation. It provides all the controls you need to create, shape, save, remove, stroke and convert your 
paths to masks. It is accessed by double-clicking the Path Node Edit tool.

For more information see the following:
{button ,JI(`',`Creating and saving paths')} Creating and saving paths
{button ,JI(`',`Selecting and moving parts of a path')} Selecting and moving parts of a path
{button ,JI(`',`Editing a path')} Editing a path
{button ,JI(`',`Purpose of paths page 1 of 2')} Purpose of paths

For more information see the following:
{button ,JI(`',`Creating and saving paths')} Creating and saving paths
{button ,JI(`',`Selecting and moving parts of a path')} Selecting and moving parts of a path
{button ,JI(`',`Editing a path')} Editing a path
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Creating and saving paths
The Path Node Edit tool is used to create paths. Its corresponding Property Bar and Tool Settings Roll-Up include 
options that allow you to edit the shape of the path, convert the path to a mask, stroke the path with color, or 
save a path to disk, among others.
Paths consist of line or curve segments and the nodes that connect them. Nodes that connect curve segments 
also have two control points extending from them that determine the angle of the curve you are creating or 
shaping. Control points look like small nodes and are connected by a dashed line that passes through the node. 

Creating a path from scratch
Creating a path is something like connecting the dots; every time you click, you place a node. A segment, either 
straight or curved, joins the new node to the last one. If you want to create a straight line, click where you want 
it to start and click where you want it to end. If you want to create a curved segment, click, drag, and click again 
at the location you want the path to change direction. As you drag, control points move to indicate the direction 
of the curve segment and its angle relative to the node. The curve appears when you click to place the next 
node. 
As you create a path, Corel WEB.PhotoPaint determines which type of node to use based on whether you created
a straight or curved line segment. However, you are not stuck with the nodes Corel WEB.PhotoPaint assigns: you 
can add, remove, and transform them as you wish. Creating curves can take some practice, but do take the time 
to experiment. This can be one of the most versatile and useful tools available to you in Corel WEB.PhotoPaint. 

Creating a path from a mask
If you’ve defined a mask marquee, but feel it could be improved using the extra editing power of the path tools, 
you can convert the marquee to a path, do your editing, and convert it back. The Path Node Editing Tool Settings 
Roll-Up, and Property Bar, each include buttons to instantly convert masks to paths and paths to masks.

Saving paths
Saving paths can save you a lot of time and work in the future; a saved path can be used time and time again in 
any image. It also allows you to create new paths in your image without losing the existing path. Any path 
displayed in the Image Window that has not been saved to disk is called the Workpath. If you want to create a 
new path and have not saved the current one, a dialog box appears letting you know that the Workpath has 
changed and asking if you want to save it to disk before proceeding with the creation of a new one.
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Starting a new path
The Add Nodes button, which you use to compose paths, is enabled by default when you click the Path Node Edit
tool in the Toolbox; however, if you have already used the Property Bar or the Tool Settings Roll-Up during this 
Corel WEB.PhotoPaint session, you may have to select it again. This is because the Add Nodes and Node Edit 
buttons are mutually exclusive (when one is enabled, the other is disabled). 

To erase an existing path before creating a new one
1. Click the Path Node Edit tool.
2. In the Property Bar, click the New Path button.

If the path displayed has not been saved, or has changed since the last save, a message box displays.
3. Click No to erase the path permanently; Yes to save the path to disk.

To start a new path
1. Click the Path Node Edit tool, or click the Add Nodes tool in the Property Bar.
2. Click to place the first node of the path.
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Drawing straight path segments
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Add Nodes button.
3. Click where you want the path segment to start.
4. Click where you want the path segment to end.
5. Repeat step 4 to create the next segment.
6. Continue until all required segments are created.
7. Click any other button, such as Node Edit in the Property Bar, to deactivate the Add Nodes button.
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Drawing curved path segments
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Add Nodes button.
3. Click where you want the path segment to start and drag.

As you drag, two control points move in opposite directions from the node. The distance between the control 
points and the node determines the height or depth of the curve. The angle of the control points determines 
the slope of the curve.

4. Click where you want the path segment to end and drag to begin drawing the next connected curve segment.
As you drag, two more control points appear. These allow you to define the shape of the second segment.

5. Repeat step 4 to add more segments to the path.
6. When the path is done, click any other button in the Property Bar, such as Node Edit, to deactivate the Add 

Nodes button.
 Note

· Curve segments have symmetrical nodes.
 Tip

· To draw a curve with no change of direction (i.e., a curve with one bump) drag in the direction the curve is 
moving through the end node. Dragging in the opposite direction creates a curve with a smooth change in 
direction (i.e., a curve with two bumps).
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Closing a path when creating it
You must close a path if you intend to use it to create an irregularly shaped bitmap, or if you want to create a 
physically separated path segment on screen while the first one remains displayed. An open path can be closed 
at any time; use the following procedure to close the path when you are initially creating it.

To close a path when creating it
1. Draw all path segments except the last one.
2. Move the mouse directly over the first node of the path.
3. Double-click.

The last segment is created; it uses the first node of the path as its end node so the path is closed.
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Creating a path from a mask
Creating a path from a mask gives you all of the Path Node Edit tool’s editing power to shape the mask’s outline 
with precision. You can always convert the path back to a mask. There has to be a mask in the Image Window for
this to work.

To create a path from a mask
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Path From Mask button.

The Create Path from Mask dialog box opens.
3. Type a tightness value between 1 and 10.
4. Type a threshold value between 1 and 10. Click OK.

The new path is created and is superimposed on the mask. You may have to move the mask to see the path.
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Saving and opening paths
Saving a path to disk allows you to remove it from the Image Window to, perhaps, create a new one, without 
losing the work you’ve put into the current one. A saved path can be used again and again in any image. Paths 
are saved with a .PTH file format that makes them easily recognizable.

To save a path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Save Path button.
3. Specify a filename and folder.

To open a saved path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Open Path button.
3. Find the drive and folder where you have saved paths.
4. Choose a path and click Open.

If an unsaved path, or a saved one to which you have applied changes, is already in the Image Window, a 
message box displays asking if you want to save the path or the changes made to it. 
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Removing and deleting paths
Use the Delete Path button to remove a path displayed in the Image Window. This is the only method to delete 
saved paths from disk from within Corel WEB.PhotoPaint.

To remove the path displayed in the Image Window
· In the Property Bar, click the Delete Path button. 

The path is permanently deleted. If the path had previously been saved to disk, a dialog box appears asking if 
you also want to delete the saved version of the path. Choose No if you only want to remove it from the Image
Window but keep it on disk.
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Selecting and moving parts of a path
To change the shape of a path, you can select and move the path segments, nodes, or control points that 
comprise it. Normally, you move the segments to make coarse adjustments to the path’s shape. Finer 
adjustments are made by moving the nodes then the control points. All adjustments made to the segments, 
nodes, and control points, must be done using the Node Edit button found in the Tools Settings Roll-Up, as well as
in the Property Bar, associated with the Path Node Edit tool.

Click and drag editing
When you click and drag a single node, the segments attached to the node change shape in order to stay 
connected. When you select two or more adjacent nodes and drag them, the path segments between them 
retain their shape by default. The Elastic Mode option makes the segments behave like rubber bands, stretching 
and shrinking according to the direction and extent to which you drag the nodes. 
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Selecting and deselecting nodes
You must select a node to move it to another location, delete it, break it up into two nodes, change its node type,
or drag its associated control points. Selecting several nodes at once allows you to perform some tasks on all of 
the nodes. 

To select one node
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the node.

The selected node becomes highlighted in one of two ways: hollow if the associated segment is a line; solid if 
it's a curve. If the node is on a curve, control points extending from the node and those on either side of it 
appear.

To select more than one node
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Hold down SHIFT and click each node.
 Tip

· You may also click and drag a marquee box surrounding all the nodes you want to select.

To deselect one or more nodes
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Hold SHIFT and click the nodes to deselect them
 Note

· To deselect all the nodes, click any space away from the path.
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Shaping a path by moving its segments
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click and drag the segment.
 Note

· Line segments cannot be moved using this method. You must move their associated nodes.
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Shaping a path by moving its nodes
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click and drag a node. 

As you drag, the segments on either side of the node move. If the node is on a curved segment, the control 
points also move so that the angles at which the curve enters and leaves the node remain unchanged.

 Tip
· To move several nodes at once, hold SHIFT and select each one before dragging.
 Note

· When you select and move two adjacent nodes, the path segment between them moves but its shape remains
intact, unless you have selected the Elastic Mode option.
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Shaping a path by moving its control points
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the node you want to manipulate.
4. Click and drag the control points.
 Tip

· To select a control point that is directly over a node, hold SHIFT before clicking it.
 Note

· Control points only extend from the selected node and those on either side of it if the node is on a curved 
segment.

· The control points move differently depending on whether the node they are associated with is smooth, 
cusped, or symmetrical. This, in turn, affects the shape of the curve.
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Moving path segments using the Elastic Mode option
The Elastic Mode option makes path segments attached to nodes behave like rubber bands.

To use the Elastic Mode option
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the Elastic Mode button.
4. Select at least two consecutive nodes.
5. Drag the nodes. 

The segment(s) located between the selected nodes stretch or shrink according to the direction you move the 
nodes.
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Editing a path
Paths can easily be edited. All the path editing tools are located in the Property Bar, and in the Tool Settings Roll-
Up which is accessed by double-clicking the Path Node Edit tool in the Toolbox.
There are many ways of editing a path.You can transform lines into curves, curves into lines, add, remove, and 
transform nodes, break a path into two, connect and disconnect nodes, manipulate segments, nodes, or control 
points. This flexibility ensures you can always shape a path the way you want to. 

For more information see the following:
{button ,JI(`',`Adding and deleting nodes on a path')} Adding and deleting nodes on a path
{button ,JI(`',`Joining nodes and breaking a path')} Joining nodes and breaking a path
{button ,JI(`',`Changing node and segment type')} Changing node and segment type

For more information see the following:
{button ,JI(`',`Adding and deleting nodes on a path')} Adding and deleting nodes on a path
{button ,JI(`',`Joining nodes and breaking a path')} Joining nodes and breaking a path
{button ,JI(`',`Changing node and segment type')} Changing node and segment type
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Adding and deleting nodes on a path

Adding and deleting nodes
A path requires more nodes if you cannot shape it the way you want by moving the existing nodes. You need to 
delete nodes to remove unwanted dips or bumps associated with them.
There are three rules of thumb for determining whether you need to add or delete nodes on a path.

For curves moving in one direction, you need a node every 120 degrees.

For curves changing direction smoothly, you need a node for at least every two points at which the curve 
changes direction.

For curves changing direction at a cusp (pointed corner) you need a node at every cusp.

Reducing the number of nodes on a path automatically
Corel WEB.PhotoPaint provides an Auto-Reduce feature that automatically removes unnecessary nodes on a 
path. This feature allows you to have a path that is more easily edited and that is smoother and smaller in size 
when saved to disk.
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Adding a single node to a path
Adding more nodes to a path is useful when you are shaping a path, especially if the existing segments, nodes, 
and control points are not giving you the results you want.

To add a node to a path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the spot along the path where you want the node added.
4. Click the Add button.
 Note

· If you clicked a node in step 3, the new node appears midway along the adjacent segment.

{button ,AL(`PRC Adding and deleting nodes on a path;',0,"Defaultoverview",)} Related Topics



Adding several nodes at once to a path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Select the nodes between which you want to add more nodes.
4. Click the Add button.

A node is added at the midway point of each selected segment. The new nodes are also selected.
5. Click the Add button again to add nodes midway along each segment again.
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Deleting a node from a path
Deleting closely bunched nodes and segments helps to simplify complex paths. You can also delete them to 
smooth unwanted bumps along a curve. 

To delete a node from a path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the node.
4. Click the Delete button.
 Note

· The position of the deleted node determines the change in the curve's shape.
 Tip

· You can delete several nodes at once by selecting multiple nodes.
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Reducing the number of nodes automatically
Paths created from masks can sometime have more nodes than are required to maintain the shape of the path. 
Also, a path shape that has been edited may have unnecessary nodes on it. Paths with many nodes are 
sometime more difficult to edit. For these reasons, Corel WEB.PhotoPaint provides an Auto-Reduce option; it can 
be used on the entire path or only on a section of it. The path must be displayed in the Image Window before 
using this procedure.

To auto-reduce the number of nodes on a path
1. Click the Path Node Edit tool.
2. Select all the nodes on the path, or the nodes located on the section you want to simplify.
3. In the Property Bar, type a value between 1 and 10 in the Reduce Tolerance box.
4. Click the Auto-Reduce button.

All unnecessary nodes on the path, or selected section of the path, are deleted. The shape of the path may 
change. The extent of the change depends on the Reduce Tolerance value selected.
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Joining nodes and breaking a path
You may want to join nodes to either close an open path or create one path consisting of two physically 
separated path components.
You break up a path for one of two reasons: to make a closed path open, or to create separate components 
within a path to, for example, apply a brush stroke to them.
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Joining two nodes
Nodes must be at the end of separate path segments to be joined. If you join nodes that are far apart, the join is 
made in the middle of their original location.

To join two nodes
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Select two nodes to join.
4. Click the Join Selected button.
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Breaking up a path
You can only break a path at a node location. If you want to break up the path at a point where there is no node, 
add a node first, then proceed. Breaking up a path adds a new node to the node location; both nodes are 
superimposed until you move one or both.

To break up a path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the node where you want to break up the path.
4. Click the Break Selected button.
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Changing node and segment type
Moving, adding, and deleting nodes may not be enough at times to produce the path shape you need. The Path 
Node Edit Tool Settings Roll-Up, and Property Bar, each provide additional editing power to change line segments
to curves and curve segments to lines, as well as change the node type of any node on a path.

Node types
There are three types of node: smooth, symmetrical, and cusp.
· Smooth nodes keep the node and its two control points on a straight line but allow the control points to be at 

different distances from the node. Smooth nodes are used when you need a smooth transition between two 
path segments. A node joining two line segments cannot be made smooth.

· A symmetrical node also keeps the node and its two control points on a straight line; they are both the same 
distance from the node. This keeps the curve on either side of the node the same. Use a symmetrical node 
when you want the curvature on both sides of the node to be identical.

· A cusp node allows you to move the control points and edit the curve on either side of the node independently.
Cusp nodes are useful for adding sharp bends. 

If you convert a node connecting a curve segment to a line segment into a smooth node, you can only move the 
control point on the curve side along an imaginary line which follows the extension of the line segment. A 
smooth node constrains the angle between the two control points to 180 degrees, but allows you to vary the 
length of the control points independently. 
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Changing the node type
Changing a node’s type changes the way the segments attached to it behave when shaping the path. When you 
first do this, the change may not noticeably affect the shape of the path. When you move the control points, 
however, you will notice the difference. You can change the type of several nodes in a single operation.

To change the node type
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the node(s).
4. Click the Smooth, Cusp, or Symmetrical button in the Property Bar or Tool Settings Roll-Up.
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Changing a segment to a curve or line
When you create a path, you make decisions on the type of segments you are drawing; some are lines, others 
are curves. When shaping a path, you can go back on those decisions and change any segment’s type from line 
to curve and vice versa. This can be done for several segments of the same type in a single operation.

To change a segment to a curve or a line
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Node Edit button.
3. Click the node(s) attached to the segment(s) you want to convert.
4. Click the To Line button or the To Curve button.
 Note

· If you chose To Curve, the line segment appears unchanged. However, if you select a node at either end of the
segment, control points appear, indicating that it is now a curve.
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Purpose of paths (page 1 of 2)
Now that we’ve learned how paths are created, moved, and shaped, let’s look at what we can do with them in 
everyday situations. This is where the purpose of paths becomes readily apparent.

Creating masks from paths
There are a couple of scenarios in which you might decide to create a mask selection from a path. If you need to 
define a complicated mask marquee, it may be easier to create it as a path and then convert it to a mask 
marquee than to define it with the Freehand Mask tool or to edit it after using the Lasso or Magic Wand tool. 

Using clipping paths to create non-rectangular bitmaps
A clipping path creates a non-rectangular bitmap by making everything but the selected area transparent when 
the image is printed or previewed in another application. Unless you use a clipping path, any bitmap you export 
for use in another application will be encased in a square or rectangular frame. If, for instance, you’ve created an
intricate path around your favorite cat in Corel WEB.PhotoPaint, and you’d like to put her onto the couch you 
drew for her in CorelDRAW, you really only want to import your cat and nothing else. As long as you are going to 
use a PostScript printer, a clipping path will let you do that.
When you send a clipping path to another application, you are exporting the contents of the path as an EPS 
(Encapsulated PostScript) file, which is why your printer must be PostScript. 

{button ,Next()} Click here to see the next page.
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Purpose of paths (page 2 of 2)

Stroking the path
The Path Node Edit Tool controls include a button that allows you to apply a stroke to the path outline. Any of 
Corel WEB.PhotoPaint’s paint, effect, Eraser, and Color Replacer tools can be used and customized to stroke the 
path and produce precisely shaped strokes on the image.
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Painting along a path
1. Click the Path Node Edit tool.
2. In the Property Bar, click the Stroke Path button.

The Stroke Path dialog box opens.
3. Click one of three tabs in the dialog to choose a tool.
4. On the chosen page, choose a Brush, Effect, or other tool.
5. Click Edit in the dialog box to change the attributes of the tool selected in step 4. To make the stroke adhere 

closely to the shape of the path, type 0 in the Smoothing box for the tool’s attributes. A higher Smoothing 
value smoothes the brush stroke where there are sharp bends in the path shape.

6. Click OK or Cancel to return to the Stroke Path dialog.
7. Click OK to apply a stroke of the tool along the path.
 Tip

· If you only want to paint along a portion of a path, enclose that portion with a mask marquee.
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Retouching and refining your image
Corel WEB.PhotoPaint includes correction and enhancement tools that can compensate for a great many image 
problems. You can use these tools to correct damaged images and to generally improve image quality with as 
much control and precision as you require. In many cases, Corel WEB.PhotoPaint offers both simple and more 
advanced ways of making the same general type of correction, allowing you to decide how much control you 
need.

Instant enhancement: using the Intellihance filter
The Intellihance filter (found under the Effects menu) is a feature that analyzes and corrects your image 
automatically using default settings, or settings that you define. The Intellihance filter performs four types of 
correction: tone, saturation, sharpness, and despeckle.

Don’t forget masks
Don’t forget that you can select specific areas for correction. In some cases, such as repairing rips and tears, 
local correction is all that is necessary. Enclosing the areas as a mask selection helps to protect the rest of your 
image.

Corel WEB.PhotoPaint's safety nets
Take advantage of Corel WEB.PhotoPaint's safety nets. If you are going to be making major changes to your 
image, try working on a duplicate, or ensure that you save or set checkpoints regularly. See Safety nets for 
information on Corel WEB.PhotoPaint's safety nets and undo options.

For more information see the following:
{button ,JI(`',`Changing image dimensions and resolution')} Changing image dimensions and resolution
{button ,JI(`',`Adding deleting and rearranging animation frames')} Adding, deleting, and rearranging animation 
frames
{button ,JI(`',`Changing the orientation of an image')} Changing the orientation of an image
{button ,JI(`',`Image restoration')} Image restoration
{button ,JI(`',`Adjusting the focus and grain of your image')} Adjusting the focus and grain of your image
{button ,JI(`',`Tonal corrections')} Tonal corrections
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Changing image dimensions and resolution
Corel WEB.PhotoPaint allows you to change the physical dimensions of your image and its size (i.e., the amount 
of space the image takes up on your hard drive) in a variety of ways. You can resize or resample your image 
while the image is open, or while it is in the process of opening. If you want to reduce the size of your image 
around a specific area, you can use any of the four cropping methods. 

Cropping your image
Cropping an image involves cutting away unwanted areas without affecting the resolution or dimensions of what 
remains. There are four ways of cropping an image in Corel WEB.PhotoPaint. You can define a cropping area on a 
thumbnail of the image and crop it as it opens, define a cropping area on an open image with the Crop tool, crop 
off just the border color from an open image, or you can crop around a masked selection.

Changing image dimensions
There are two ways of changing image size  you can adjust the dimensions of your image in the Resample 
dialog box, or you can change the size of the paper behind your image. This latter option changes the printable 
area, but does not affect the dimensions of the rest of your image.

Changing an image’s resolution
When you ask Corel WEB.PhotoPaint to increase the resolution of your image (i.e., add more pixels per unit of 
measurement), you are performing an upsample. When you lower it, you are downsampling. Of the two 
procedures, downsampling provides the best results, because Corel WEB.PhotoPaint more or less discards 
information in an orderly fashion. Upsampling, however, requires that Corel WEB.PhotoPaint add pixels that 
weren’t there previously, and because it can’t add information that doesn’t exist, Corel WEB.PhotoPaint does this
by averaging and adding intermediary pixels. This process is called interpolation. It is rare that you will need to 
increase the resolution of your image, but if you need to, you will get much better results by rescanning the 
original at a higher resolution. 
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Cropping an image
Cropping an image involves cutting away unwanted areas without affecting the resolution or dimensions of what 
remains. There are four ways of cropping your image in Corel WEB.PhotoPaint. You can define a cropping area on 
a thumbnail of the image and crop it as it opens, define a cropping area on an open image with the Crop tool, 
crop off just the border color from an open image, or crop around a selection.

To crop an image on opening
1. Click File, Open.
2. Select the file.
3. In the list box to the left of the Options button, choose Crop.
4. Click Open to display the Crop Image dialog box.
5. Click and drag the handles on the bounding box in the preview window to define a cropping area, or specify 

exact dimensions in the Top, Left, Width, and Height boxes.

To crop with the Crop tool
1. Click the Crop tool.
2. Click and drag to define the cropping area.
3. Click and drag the handles of the bounding box to fine-tune the cropping area.
4. Double-click inside the bounding box.

To crop the border color
1. Click Image, Crop, Border Color.
2. Click a button in the Color section of the dialog box.
3. Move the Tolerance slider to set a color tolerance level.

To crop around a selection
1. Define a mask selection around the area you wish to crop. 
2. Click Image, Crop, To Mask.
 Note

· When you crop around a mask selection, the resulting image is rectangular, based on the maximum 
dimensions of the mask selection. To create an irregularly-shaped bitmap, see Purpose of paths for information
on clipping paths.
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Changing an image’s dimensions
Corel WEB.PhotoPaint allows you to change an image's dimensions in two ways: by increasing or decreasing the 
dimensions in the Resample dialog box, or by decreasing the size as the image opens. Each option offers the 
Maintain Aspect Ratio control, which forces the width and height of the image to adjust proportionately.

To change an image’s dimensions
1. Click Image, Resample.
2. Choose a unit of measurement from the Units list box.
3. Type values in the Width and Height boxes. If you have enabled the Maintain Aspect Ratio check box, enter 

one dimension and the other dimension adjusts automatically. 

To reduce the image dimensions on opening
1. Click File, Open.
2. Select the file.
3. In the list box to the left of the Options button, click Resample.
4. Click Open.

The Resample Image dialog box opens.
5. Type values in the Width and Height boxes.

{button ,AL(`PRC Changing image dimensions and resolution;',0,"Defaultoverview",)} Related 
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Changing the paper size
Changing the size of the paper behind your image makes your printable area larger or smaller without affecting 
the dimensions of the actual image. In effect, you are enlarging or reducing the paper-colored border around 
your image. If you enable the Maintain Aspect Ratio check box, it will force the width and height of the image to 
adjust proportionately.

To change the paper size
1. Click Image, Paper Size.
2. Type values in the Width and Height boxes. If you have enabled the Maintain Aspect Ratio check box, enter 

one dimension and the other dimension adjusts automatically. 
3. Choose a position for the image from the Placement list box, or click and drag the image in the thumbnail.
4. If you want to change the paper color, click the arrow beside the paper color swatch and click a new color.
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Changing an image’s resolution
Corel WEB.PhotoPaint allows you to change image resolution in two ways: you can increase or decrease the 
resolution in the Resample dialog box, or you can decrease the resolution as the image opens. Each option offers
the Maintain Aspect Ratio control, which resamples the width and height of the image proportionately. Changing 
the resolution will affect the actual size of the file on disk, unless you enable the Maintain File Size check box. 
This option keeps the file size the same, but means the dimensions of your image will change. 

To change an image’s resolution
1. Click Image, Resample.
2. Type values in the Horizontal and Vertical Resolution boxes. If you have enabled the Maintain Aspect Ratio 

check box, enter one value and the other value adjusts automatically. 
3. Click one of the Process options. Anti-Alias will produce a smoother image than Stretch/Truncate, but takes 

longer to process.

To reduce resolution on opening
1. Click File, Open.
2. Select the file.
3. In the list box beside the Options button, choose Resample.
4. Click Open.
5. In the Resample Image dialog box, type values in the Horizontal and Vertical resolution boxes. If you have 

enabled the Maintain Aspect Ratio check box, enter one value and the other value adjusts automatically. 

{button ,AL(`PRC Changing image dimensions and resolution;',0,"Defaultoverview",)} Related 
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Adding, deleting, and rearranging animation frames
Corel WEB.PhotoPaint's Animation menu contains controls that allow you to manipulate the individual frames of 
animations in a variety of ways. You can insert new, blank frames, create duplicates of existing frames, splice in 
frames from another animation, or rearrange frames. 
For the procedures on creating new animations, opening existing animations, and navigating through 
animations, see Getting started. 
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Adding and deleting animation frames
Corel WEB.PhotoPaint's Animation menu contains controls that allow you to manipulate the individual frames of 
animations in a variety of ways. Use these procedures to add or delete frames. 

To add new frames
1. Click Animation, Insert Frame.
2. Type the number of frames you wish to insert in the Insert Frames box.
3. In the Frame box, type the frame number before or after which you want to place the new frames.
4. Click a position button.
 Tip

· To create duplicates of the active frame, click the Copy Current Frame button.

To add frames from an existing animation
1. Click Animation, Insert From File.
2. Double-click the filename of the animation you want to add in the File Name box.
3. In the Frame box, type the number of the frame before or after which you want to place the animation file.
4. Click the Insert button.

To delete a single frame
1. Click Animation, Delete Frame.
2. In the From Frame box, type the number of the frame you wish to delete.
3. Type the same number in the To Frame box.

To delete a series of frames
1. Click Animation, Delete Frame.
2. In the From Frame box, type the number of the first frame you wish to delete.
3. In the To Frame box, type the number of the last frame you wish to delete.

{button ,AL(`PRC Adding deleting and rearranging animation frames;',0,"Defaultoverview",)} 
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Changing the order of animation frames
Corel WEB.PhotoPaint's Animation menu contains controls that allow you to manipulate the individual frames of 
animations in a variety of ways. Use these procedures to move individual or series of frames. 

To move a single frame
1. Click Animation, Move Frame.
2. In the Move Frame box, type the number of the frame you wish to move.
3. Type the same number in the To Frame box. 
4. Click the Before or After button, and type the number of the frame beside which you want to move the frame.

To move a series of frames
1. Click Animation, Move Frame.
2. In the Move Frame box, type the number of the first frame you wish to move.
3. In the To Frame box, type the number of the last frame you wish to move.
4. Click the Before or After button, and type the number of the frame beside which you want to move the frames.

{button ,AL(`PRC Adding deleting and rearranging animation frames;',0,"Defaultoverview",)} 
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Changing the orientation of an image
Maybe you have found the perfect image, but you want it to face the other direction. Or perhaps you scanned 
your picture in upside down or skewed. Whatever your placement problem, Corel WEB.PhotoPaint allows you to 
fix it. You can flip or rotate your image by preset or custom amounts, and you can straighten crooked images. 

Custom Rotate dialog box
Corel WEB.PhotoPaint's Custom Rotate dialog box contains options that allow you to choose the angle and 
direction of rotation, as well as the paper color that becomes visible as a result of the rotation. If you want the 
image size to remain the same, enable the Maintain Original Size check box. Otherwise, the image will be resized
so that the entire image remains visible in the Image Window. Enable the Anti-Aliasing check box to prevent 
jagged edges.
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Flipping an image
You can flip an image from side to side, or from top to bottom. 

To flip an image horizontally
· Click Image, Flip, Horizontally.

To flip an image vertically 
· Click Image, Flip, Vertically.
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Rotating an image
Corel WEB.PhotoPaint allows you to rotate your image by a preset amount, or by an amount you specify. The 
Custom Rotate dialog box contains options that allow you to choose the angle and direction of rotation, as well 
as the paper color that becomes visible as a result of the rotation. If you want the image size to remain the 
same, enable the Maintain Original Size check box. Otherwise, the image will be resized so that the entire image 
remains visible in the Image Window. Enable the Anti-Aliasing check box to prevent jagged edges.

To rotate an image 90° clockwise
· Click Image, Rotate, 90° Clockwise.

To rotate an image 90° counterclockwise
· Click Image, Rotate, 90° Counterclockwise.

To rotate an image 180°
· Click Image, Rotate, 180°.

To rotate an image by a custom amount
1. Click Image, Rotate, Custom.
2. Type a value in the Angle box.
3. Click a direction button.
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Straightening a crooked image
The Deskew command places imperfectly positioned images squarely in the image area. Deskewing works best 
on four-sided images that have well-defined edges. 

To deskew an image
· Click Image, Deskew.
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Image restoration
Perhaps your scanned or video image came out looking distinctly striped. Or maybe you set a cup of coffee down
on the only existing picture of your grandmother. Whatever the mishap, Corel WEB.PhotoPaint contains a number
of tools to help you minimize the damage, and in some cases, forget that it happened altogether.

Clone tool
Corel WEB.PhotoPaint Clone tool allows you to fill in missing areas of your image with pixel information taken 
from other areas on the image, or even from a different image altogether. Use the Clone tool to repair rips, tears,
and holes, or to perform even more involved editing procedures: just think, with a bit of practice, you can 
remove your "ex" from all your pictures!
The Clone tool is one of the brush tools, so you can adjust the size, shape, and texture of the brush you use to 
apply it. See The basics of brush tools for more information on working with brush tools.

Dust and Scratch filter
The Dust and Scratch filter reduces the amount of noise in your image. You can use this filter to eliminate dust 
and scratch faults by applying it to masked selections. 

Some hints
To repair... Do this... 
Dust marks and scratches Define a masked selection and use the Scratch and Dust filter

Use the Undither tool
Holes, creases, rips, or tears Use the Clone tool to fill in blank areas with information from other areas of the 

image
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Restoring damaged areas
These procedures allow you to repair damage to your image such as dust marks and scratches, and to fill in 
holes with information that you take from other areas of the image.

To fix dust and scratches using the Dust and Scratch filter
1. Enclose the damaged areas as a masked selection.
2. Click Effects, Noise, Dust and Scratch.
3. Move the Threshold slider to reduce image noise. Threshold determines how great a change in value must 

occur to any pixel before the effect is applied. 
4. Move the Radius slider to set the range of pixels the filter uses to produce the effect.

To fix dust and scratches using the Undither tool
1. Click the Effect tool.
2. On the Property Bar, click the arrow to the side of the tool picker.
3. Click the Undither tool.
4. Adjust the brush settings as necessary (for more information, see The basics of brush tools).
4. Click and drag over the damaged area. 

To fill in tears, creases, rips and holes
1. Click the Clone tool. 
2. Adjust the brush settings as necessary (for more information, see The basics of brush tools).
3. Click to place the source point (the area you wish to copy from).
4. Position the cursor over the area you wish to clone to.
5. Click and drag over the damaged area to replace the pixels. 
 Notes

· Hold down CTRL while dragging to constrain the movement of the source point. Hold down CTRL + SHIFT to 
change the direction of constraint. 

· To keep the source point stationary, hold down S while clicking. You can't keep the source point stationary 
while clicking and dragging; just while clicking. 

· To reset the source point, hold down SHIFT and click where you want to place it. 
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Adjusting the focus and grain of your image
Corel WEB.PhotoPaint's Blur, Sharpen, and Noise filters allow you to control the focus and graininess of your 
image in a variety of ways ranging from subtle to obvious. 

Gaussian Blur filter
This filter produces a hazy effect, blurring the image according to a gaussian distribution, which spreads the pixel
information outward using bell-shaped curves. 

Motion Blur filter
The Motion Blur filter creates the illusion of movement in an image. You can set the direction of motion using the 
Direction dial. You can also control the intensity of the effect: the higher the value, the more blurring occurs.

Sharpen filter
Corel WEB.PhotoPaint's Sharpen filter works by increasing the contrast of adjacent pixels to improve the focus 
and enhance edges. 

The Sharpen and Smear tools
The Sharpen and Smear tools allow you to sharpen or soften selected areas of your image by clicking and 
dragging over them with a brush. You can achieve different effects by changing the size, shape, and texture of 
the brush you use to apply these effects. See The basics of brush tools for information on working with brush 
tools. 

Add Noise filter
The Add Noise filter creates a granular effect that adds a texture to a flat or overly blended image. There are 
three noise types you can choose from: Gaussian prioritizes colors along a Gaussian curve. Gaussian results in 
more light and dark pixels than the Uniform Noise option. Spike uses colors that are distributed around a narrow 
curve. It produces a thin, light colored grain. Uniform provides an overall granular appearance. Use this option to
apply colors randomly.

Remove Noise filter
The Remove Noise filter softens the image and reduces the speckled effect that can occur during the scanning or
video capturing process. The Remove Noise filter compares each pixel to surrounding pixels, and calculates an 
average. Each pixel whose brightness value exceeds that of the threshold you set with the slider are removed. 
This effect operates similarly to the Jaggy Despeckle effect; however, it also removes random pixel noise in the 
image.
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Softening the focus
The filters in the Blur Effects flyout menu (in the Effects menu) alter the pixels of your image to soften, smooth 
edges, blend, or create motion effects. 

To soften the focus of the whole image
1. Click Effects, Blur, Gaussian Blur.
2. Move the Radius slider to set the intensity of the effect.

To soften the focus of a selected part of an image
1. Click the Effect tool.
2. On the Property Bar, click the arrow next to the tool picker.
3. Click the Smear tool.
4. Choose a smear or blur blush from the Brush Type list box. 
5. Type a value in the Amount box to set the degree of the effect. A higher value will result in a more pronounced 

effect. 
6. Adjust the brush size and shape as desired. 
7. Click and drag over the area you wish to soften.
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Working with the Motion Blur filter

To give the appearance of speed through blurring
1. Click Effects, Blur, Motion Blur.
2. Click a position on the edge of the Direction dial to set the direction of movement.
3. Move the Speed slider to set the intensity of the effect.
4. Click one of the Off-Image Sampling buttons.
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Sharpening the focus
Corel WEB.PhotoPaint's Sharpen filter works by increasing the contrast of adjacent pixels to improve the focus 
and enhance edges. The Sharpen tool allows you to sharpen the focus locally by increasing the contrast where 
colors or shades intersect.

To sharpen the focus
1. Click Effects, Sharpen, Sharpen.
2. Move the Edge Level slider to set the intensity of the effect.
3. Move the Background slider to determine how much of the image will remain after edge detection.

To bring out edge detail
1. Click Effects, Sharpen, Unsharp Mask.
2. Move the Percentage slider to control the amount of the effect. 
3. Move the Radius slider to control how many pixels the filter evaluates at a time. A larger radius value results in

a more pronounced effect. 

To sharpen selected areas of your image
1. Click the Effect tool.
2. On the Property Bar, click the arrow next to the tool picker.
3. Click the Sharpen tool.
4. Choose a sharpening brush from the Brush Type list box. 
5. Type a value in the Amount box to control the degree of the effect. A higher value will result in a more 

pronounced effect. 
6. Adjust the brush size and shape as desired. 
7. Click and drag over the area you wish to sharpen.
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Adjusting graininess in your image
In bitmap image editing, noise is defined as the random pixels across the image that resemble static on 
television screens. Use the filters in the Noise flyout menu (Effects menu) to create, adjust, or get rid of noise.

To add noise to your image
1. Click Effects, Noise, Add Noise.
2. Click a Noise Type button. 

· Gaussian prioritizes colors along a Gaussian curve. Most colors added by the effect either closely resemble 
the original colors or extend the boundaries of the specified range. This results in more light and dark pixels 
than the Uniform Noise option, producing a more profound effect.

· Spike uses colors that are distributed around a narrow curve. It produces a thinner, lighter-colored grain.
· Uniform provides an overall granular appearance. Use this option to apply noise randomly.

3. Move the Level slider to adjust the intensity and value range affected by the noise.
4. Move the Density slider to set the amount of noise pixels per inch.
5. Enable the Color Noise check box to apply colorful pixels of noise.

To remove noise from your image
1. Click Effects, Noise, Remove Noise.
2. Move the Threshold slider to determine the brightness level at which noise is removed. Enable the Auto check 

box if you want Corel WEB.PhotoPaint to set the threshold for you.

To add graininess locally
1. Click the Effect tool.
2. On the Property Bar, click the arrow next to the tool picker.
3. Click the Smudge tool.
4. In the Brush Type list box, Choose a brush. 
5. Type a value in the Amount box to set the degree of the effect. A higher value will result in a more pronounced 

effect. 
6. Adjust the brush size and shape as desired. 
7. Click and drag over the area you wish to affect.
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Tonal corrections
Tonal corrections allow you to control the relationship between the shadows, midtones, and highlights in your 
image, as well as to adjust the brightness, intensity, lightness, and darkness of your colors. Use tonal corrections
to restore detail that is lost in shadows or highlights, to correct under or over-exposure, and to generally improve
the tonal quality of your image.

Brightness-Contrast-Intensity filter
The Brightness-Contrast-Intensity filter adjusts the brightness, contrast, and intensity of the tones in your image.
The Brightness control shifts all pixel values up or down the tonal range. When you adjust the brightness, you are
lightening or darkening all colors equally. The Contrast slider adjusts the distance between your lightest and 
darkest pixels. Increasing the intensity brightens the lighter areas of your image without washing out the dark 
areas. Contrast and intensity usually go hand-in-hand, because an increase in contrast sometimes washes out 
detail in shadows and highlights, and an increase in intensity can bring it back.

Gamma filter
Gamma is a method of tonal correction that takes the human eye's perception of neighboring values into 
account. For example, if you were to place one 10 per cent gray circle on a black background, and another 
identical gray circle on a white background, the circle surrounded by black will appear lighter to the human eye 
than the circle surrounded by white regardless of the fact that the brightness values are identical. 
The Gamma filter lets you pick up detail in a low contrast image without significantly affecting the shadows or 
highlights. It does affect all the values in your image, but is curve-based so that the changes are weighted 
toward the midtones. You can achieve similar results using the Tone Curve filter, which also includes a gamma 
option. 

Contrast tool
The Contrast tool allows you to adjust the contrast of selected areas of your image by clicking and dragging over
them with a brush. You can achieve different effects by changing the size, shape, and texture of the brush you 
use to apply this effect. See The basics of brush tools for information on working with brush tools.

Some hints
To... Do this... 
Restore shadow detail Increase contrast and intensity

Adjust midtones using the Gamma filter
Change contrast of image Adjust contrast and intensity
Brighten only highlights Increase intensity
Lighten or darken whole image Adjust brightness
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Adjusting the brightness, contrast, and intensity
The Brightness-Contrast-Intensity filter allows you to adjust the brightness, contrast, and intensity of the tones in
your image. The Contrast brush increases or decreases the distinction between light and dark areas in selected 
areas.

To adjust brightness, contrast, and intensity
1. Click Image, Adjust, Brightness-Contrast-Intensity.
2. Move the sliders to adjust the levels of brightness, contrast, and intensity. 

To brighten or darken locally
1. Click the Effect tool.
2. On the Property Bar, click the arrow at the side of the tool picker. 
3. Click the Smudge tool.
4. Choose a brighten or darken brush in the Brush Type list box.
5. Adjust the value in the Amount box to control the degree of the effect. A higher value will result in a more 

pronounced effect. 
6. Adjust the brush size and shape as desired. 
7. Click and drag over the area you wish to affect.

To adjust the contrast locally
1. Click the Effect tool.
2. On the Property Bar, click the arrow at the side of the tool picker. 
3. Click the Contrast tool.
4. Choose a brush in the Brush Type list box.
5. Adjust the value in the Amount box to control the degree of the effect. A higher value will result in a more 

pronounced effect. 
6. Adjust the brush size and shape as desired. 
7. Click and drag over the area you wish to affect.
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Adjusting midtones
Adjusting the midtones allows you to pick up detail in a low contrast image without affecting the shadows or 
highlights. The Gamma filter affects all the values in the image, but in a non-linear fashion, so that the most 
pronounced changes occur in the midtones. 

To adjust midtones using the Gamma filter
1. Click Image, Adjust, Gamma.
2. Move the Value slider to set a gamma curve value. Higher values brighten midtones, while lower values darken

them.
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Introduction to text and objects (page 1 of 2)
An object is an independent bitmap that floats above the image. Think of it as a sticker that you can place on 
your image, move to a different position, color, or rotate, all without changing the base pixels in your image. 
When you’re satisfied with the position and appearance of an object, you can merge it into the background, 
where it is no longer editable as a separate component. You don’t have to combine objects; they are saved with 
the image when you use the .CPT file format.
You can create objects with the Shape tools, the Text tool, the image pixels you paste from the clipboard, or 
existing masks or paths in your image. You can also create a transparent layer that covers the entire image and 
add object elements to it using almost any tool in Corel WEB.PhotoPaint’s Toolbox, e.g., the Shape, Paint, or 
Effect tools. The Undo tools used on a layer, erase sections of the new object.
Click an object with the Object Picker tool to select it and to display handles that you can drag to size the object. 
Double-click inside the marquee to display arrows for rotating and skewing and a circular icon that you can move
to change the center of rotation. Click a third and fourth time to display other handles that are used to apply 
distortion and perspective respectively.
There are a variety of object-editing commands to remove stray pixels from an object’s edge and to feather the 
edges of an object to make it blend gradually into the image background that surrounds it. There are also 
commands in the Object Roll-Up to adjust an object’s opacity and to select a merge mode. 

Object marquee
The object marquee is the boundary of the object. It is represented by a dashed outline that looks like marching 
ants. You choose the marquee color and its position relative to the object on the Marquee tab of the Options 
dialog box, which you can access from the Tools menu. The pixels inside the marquee make up the object and 
float above the image until you decide to merge them with the image background or cut them to the clipboard. 

{button ,Next()} Click here to see the next page.
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Introduction to text and objects (page 2 of 2)

Text
By default, text created using Corel WEB.PhotoPaint’s Text tool is an object. If you select text after typing it, the 
object marquee appears along each character’s boundary as do eight sizing and scaling handles on the text 
string’s highlighting box. You can move the text, apply transformations to it, even change its font or style while it
remains an object floating above the image. The image pixels located underneath the text remain unaffected.

What are objects used for?
Because objects are independent bitmaps that float above the image, you can apply many transformations to 
them without affecting the other pixels in the image. In that regard, you can use objects to limit the application 
of color and other modifications to a specific, defined area. They also give you flexibility to experiment with 
elements you want to add, move, or copy within an image. 
When you create Web pages for use on the Internet, you can use objects to define areas as hot links to bring the 
user to another page or site. People viewing your site simply click the object to access a different page or site.
Objects can be used to create mask selections. If an object has the shape you want for a mask, this saves you a 
lot of time. The resulting mask can be used to create a path. Paths provide amazing editing power to precisely 
enclose an area. You can go from an object to a mask to a path, or from a path to a mask to an object. 

For more information see the following:
{button ,JI(`',`Creating objects page 1 of 2')} Creating objects
{button ,JI(`',`Selecting objects')} Selecting objects
{button ,JI(`',`Moving duplicating and deleting objects')} Moving, duplicating, and deleting objects
{button ,JI(`',`Viewing ordering and aligning objects')} Viewing, ordering, and aligning objects
{button ,JI(`',`Grouping and combining objects')} Grouping and combining objects
{button ,JI(`',`Transforming objects page 1 of 2')} Transforming objects
{button ,JI(`',`Editing objects')} Editing objects
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Object-editing modes (page 1 of 2)
Corel WEB.PhotoPaint provides three object-editing modes: Multi mode, Single mode, and Layer mode. These 
three editing modes are used to add areas to objects, remove areas from them, and choose how tools and 
commands affect objects when you edit them. Each mode offers several benefits depending on the situation and 
your image type. For step-by-step instructions on object editing see Editing objects.

Multi mode
Multi mode is the default object-editing mode. Most tools, when used in an area that includes objects, will affect 
all pixels you touch with them  whether they are part of an object or the image background. The action of the 
tools is not interrupted because the tool reaches an object or the background. The Objects Roll-Up provides 
controls to lock the image background or the objects you want to protect, while using some of these tools in 
Multi mode. This lock functionality allows you to control which element of the image is modified by a tool.
The lock functionality can also be used when applying special effects. To limit the application of a special effect 
to one object, the image background and all other objects must be locked. The shape of the object, represented 
by the marquee, is not altered by effects in Multi mode. The pixels inside the object marquee may change 
position to produce the effect, but none get moved outside the object marquee. This can result in paper-colored 
pixels appearing inside the object marquee. For example, if you apply the Wet Paint effect to an object, its 
various colors drip; the color of the pixels inside the object shifts down to simulate wetness; the pixels at the 
very top of the object will take the current paper color as a result. 
An alternative to locking image elements to isolate an object or the background for editing, is to use masks. You 
create a mask by selecting the area you want to edit with a mask tool; the rest of the image is protected. Masks 
are discussed in «Unveiling the Magic of Masks» chapter.
Multi mode also allows you to edit, in one operation, all objects that have been grouped.

Single mode
This mode locks all image elements except the selected object. This protects the image and objects you are not 
working on currently. You can choose to select a different object directly in the Image Window, or in the Objects 
Roll-Up, and still remain in the Single mode. All other objects become locked automatically. The lock icons in the 
Objects Roll-Up are replaced by a single pencil icon that is used to identify and choose the object that can 
currently be edited.
Just as in Multi mode, if you apply special effects to an object in Single mode, they do not affect the object’s 
overall shape, which is represented by the object marquee. 
If you return to Multi mode after you have worked in Single mode, all objects that were not selected, and the 
image background, are automatically locked. If you want to edit these objects, you must unlock them using the 
Objects Roll-Up.

{button ,Next()} Click here to see the next page.
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Object-editing modes (page 2 of 2)

Layer mode
Layer mode converts the object located on the top of the stacking order into a layer and makes that layer the 
only object that can be edited in the image. This object is identified by the pencil icon in the Objects Roll-Up. In 
the Roll-Up, you click to place the pencil icon next to the object you want to edit in this mode. Layer mode 
creates the layer by adding transparent areas around the object, all the way to the edges of the image. It 
ensures that any work you perform, only affects the new layer, and that the underlying image is protected. 
If you apply effects to an object layer, you might change the shape of the object; for example, if you apply the 
Swirl effect, the shape of the object, and its marquee, are modified because of the nature of this effect.
If you select a group of objects in Layer mode you can individually edit the objects in the group without having to
first ungroup them. 
Layer mode is also used to create objects; it is the only mode where the New Object command found in the 
Object menu is available. This command creates an empty transparent layer to which you can add object 
elements, one at a time, using the Paint, Effect, Clone, Rectangle, Ellipse, Polygon, Line, Curve, and Color 
Replacer tools. The Paste command found in the Edit menu can also be used to add data to the new object. The 
Eraser and Local Undo tools can be used to remove unwanted areas created with other tools.
If you return to Multi mode after working in Layer mode, all objects that were not selected before exiting, and the
image background, are automatically locked. If you want to edit these objects, you must once again unlock them
by using the controls in the Objects Roll-Up.

For more information see the following:
{button ,JI(`',`Creating objects page 1 of 2')} Creating objects
{button ,JI(`',`Selecting objects')} Selecting objects
{button ,JI(`',`Moving duplicating and deleting objects')} Moving, duplicating, and deleting objects
{button ,JI(`',`Viewing ordering and aligning objects')} Viewing, ordering, and aligning objects
{button ,JI(`',`Grouping and combining objects')} Grouping and combining objects
{button ,JI(`',`Transforming objects page 1 of 2')} Transforming objects
{button ,JI(`',`Editing objects')} Editing objects
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Creating objects (page 1 of 2)
Corel WEB.PhotoPaint provides several methods to create objects. This makes it very easy to take advantage of 
the multiple benefits that objects offer when you edit an image.

From masks
The content of a mask selection can easily be converted to an object. This means that the pixels enclosed within 
the mask marquee become the object and float above the image. The Preserve Image command, found in the 
Image menu, is enabled by default. It copies the pixels enclosed by the mask marquee to create the object. 
Therefore, the image underneath the object is unaffected when you move the object. If you disable Preserve 
Image and move the object, a paper-colored hole appears where the pixels used to be located.
When you work in Single mode, only one object can be edited at a time; all other image components  objects 
and the image background, are locked. If you create a mask selection and convert it to an object, the object only 
includes the pixels from the editable object that were inside the mask selection. If you work in Layer mode, the 
editable object is placed on a transparent layer that covers the entire image; the rest of the image components 
are locked. To create an object from a mask selection in this mode, you must make sure that some of the 
editable object’s pixels are included in the mask selection you create.
If you try to create an object from a mask and get the «Selection is empty» message, you are probably working 
in Single or Layer mode and the mask selection does not include any pixels from the object currently editable in 
the mode.

From clipboard data
The Paste As New Object command found in the Edit menu allows you to paste data from the clipboard and 
automatically make it an object in any editing mode.

{button ,Next()} Click here to see the next page.
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Creating objects (page 2 of 2)

From shapes, text, and paths
Rectangles, ellipses, polygons, and lines that you create using the Shape tools can automatically be made into 
objects. By default, text typed with the Text tool is an object.
The Path Node Edit tool provides extensive editing capabilities that you can use to create an object. After you 
create the path to enclose the area you want to make into an object, you can create a mask from the path using 
the Tool Settings Roll-Up or Property Bar for the Path Node Edit tool, then you can create an object from the 
mask.

Exclusive to Layer mode
Layer mode gives you access to the New Object command found in the Object menu. This creates a new empty 
layer that covers the entire image. On this layer you can create an object using a combination of tools, e.g., 
Shape, Effects, Paint, and Undo tools. The underlying pixels are not affected by any tool operation when you 
create a new object on this layer. The object marquee expands to include all new elements in the object and 
shrinks to exclude the areas glided over with the Eraser tool. This allows you to experiment when you create the 
object without any risk of damaging the underlying image.
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Creating an object using the clipboard
1. Open the Mask Tools flyout and choose a mask tool.
2. In the Image Window, define the area you wish to make an object.
3. Click Edit, Cut or Copy. 

The pixels inside the marquee are placed on the clipboard. If you cut the mask selection to create the object, 
the pixels are removed, leaving a paper-colored area on the image. If you copied the mask selection, the pixels
inside the marquee are cloned and the original image remains intact.

4. Click Edit, Paste As New Object.
The pixels are pasted into the current document as an object that floats above the image background. The 
object marquee is blue by default; the color can be changed by using the Options command found in the Tools 
menu. 

{button ,AL(`PRC Creating objects;',0,"Defaultoverview",)} Related Topics



Creating an object and opening it into a new document
1. Open the Mask Tools flyout and choose a mask tool.
2. In the Image Window, define the area you wish to make an object.
3. Click Edit, Cut or Copy. 

The pixels inside the marquee are placed on the clipboard. If you cut the mask selection to create the object, 
the pixels are removed, leaving a paper-colored area on the image. If you copied the mask selection, the pixels
inside the marquee are cloned and the original image remains intact.

4. Click Edit, Paste As New Document.
A new Image Window opens and displays an object floating above the new image’s background, which is the 
current paper color.
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Creating an object from a mask
Creating an object from a mask means that the image pixels included in the mask’s selection become the object.
When working in Single or Layer modes, only the colored, unlocked pixels that are in the editable object, and 
within the mask selection, are included in the new object. 

To create an object from a mask
1. Open the Mask Tools flyout and choose a mask tool.
2. In the Image Window, define the area you wish to make an object.
3. Enable or disable the Preserve Image command in the Image menu.

Enabling the command copies the mask selection’s contents to create the object; disabling the command cuts 
the selection’s contents to create the object. Remember that cutting leaves a paper-colored hole in the image 
where the selection use to be.

4. Click Object, Create From Mask.
The new object floats above the image and is surrounded by a marquee and selection handles. The mask 
marquee disappears.

 Note
If you get the “Selection is empty” error message, you have created the mask selection on an area that is:

· locked in the Objects Roll-Up when working in Multi mode;
· not selected in the Objects Roll-Up when working in Single mode and is therefore locked; or
· completely transparent when working in Layer mode and therefore does not include any pixel data because 

it has no color.
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Creating objects when drawing shapes and segments
This procedure can be used in any object-editing mode to create a new object.

To create objects automatically when drawing shapes and segments
1. Open the Shape Tools flyout and choose the Rectangle, Ellipse, Polygon, or Line tool.
2. On the Property Bar, click the Render To Objects button.
3. Draw a shape in the Image Window.

The new shape is rendered as an object. If the Marquee Visible command in the Object menu is enabled, a 
marquee surrounds the new shape. If you are working in Single or Layer mode, the new object is selected and 
is editable as indicated by the pencil icon beside its name in the Objects Roll-Up.

 Note
· The Render To Objects option remains active for the selected Shape tool until you turn it off. All shapes of that 

type that you draw afterwards are rendered as objects. Shapes created using a different Shape tool however, 
are not rendered as objects unless you enable the option for that tool.

· In Layer mode, the Render To Objects option also makes a new object with the shape you draw. Disabling the 
option makes any shape you draw become part of the currently editable object, i.e., the shape is added to the 
current object.
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Creating objects from scratch
The New Object command creates an empty transparent layer that covers the entire image : this layer is an 
object that is invisible. You can add elements to the layer to create visible elements in the new object. When you 
create an object using these instructions, the underlying image is not affected by any of the tools you use.

To create objects using the painting and editing tools
1. Click View, Roll-Ups, Objects.
2. Click the Layer button
3. Click Object, New Object.

A new transparent layer is added to the Image Window. It is listed as a new object in the Object Roll-Up.
4. Choose a tool in the Toolbox. 

You can use any Shape, Effect, or Paint tools.
5. Choose the tool attributes using the Property Bar.
6. In the Image Window, use the selected tool to create the object. 

All elements applied to the image are enclosed by the object marquee. The object’s thumbnail in the Objects 
Roll-Up is updated each time you modify the object.

7. Repeat steps 4 to 6 with another tool to add more elements to the object. 
Because the object now has areas that are not transparent, you can use the Eraser, Color Replacer, Clone, 
Object Transparency tool, or Object Transparency Brush tools to edit the new object.
The object’s marquee extends to include all new elements in the object. If you use the Eraser tool, the 
marquee shrinks because you are removing pixels from the object.
When the object is completed and you want to perform other operations, you can click the Object Picker tool 
which selects the new object, make another object editable by placing the pencil icon next to it in the Objects 
Roll-Up or change object-editing modes. 

 Note
· Using the Text tool does not add text to the new transparent layer, it creates a separate text object. Using any 

of the Shape tools with the Render To Object option enabled, also makes the shapes separate from the new 
layer. To add shapes to the layer, make sure Render To Object is off on the Property Bar or in the Tool Settings 
Roll-Up.

· If you choose the New Object command and immediately switch to another object-editing mode, you will get a 
message advising you that the layer is empty and will be deleted if you proceed.
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Adding text to an image
The current paint color is applied to text you add to an image.

To add text to an image
1. Click a color for the text in the on-screen Color Palette or in the Color Roll-Up.
2. Click the Text tool.
3. Point and click where you want to place the text. 

If you want to reposition the text cursor, move the mouse to the new location and click again.
4. On the Property Bar, choose the text attributes you want.
5. Type the text in the Image Window. Use the arrow keys to move the cursor to the left of the characters you 

want to overwrite as you type.
6. Click away from the text box. 

The letters are converted into a single, editable object.
 Note

· If you transform a text object, for example rotate it 90 degrees, and then edit the text itself, the 
transformations will be lost.
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Assigning names to objects
Corel WEB.PhotoPaint assigns a default name to each object in an image. Graphic objects are assigned the name
«Object» and a number. The first few characters of a text object are used as the object’s name. You can assign a 
more descriptive name to each object in an image. This is very useful when editing images that have many 
objects. 

To assign a name to an object
1. Click View, Roll-Ups, Objects.
2. In the Roll-Up, look at the thumbnails to find the object you want to name or rename.
3. Click the object’s current name in the Roll-Up. The name is enclosed by a rectangle and a blinking cursor 

appears at the end of the name.
4. Press BACKSPACE to delete the current name.
5. Type a new name.
6. Press ENTER to set the name.
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Selecting objects
An object must be selected before any kind of transformation can be applied to it. You can select several objects 
at the same time to perform operations on all of them at once. Selected objects have eight handles surrounding 
them. The handles define an invisible box, called the highlighting box, that surrounds the object. If you select 
several objects, only eight handles appear, but in this case the highlighting box will be larger because it 
completely encloses all selected objects.
Object selection is done using the Object Picker tool. Text objects can also be selected with that tool. However , 
you must use the Text tool to select text you want to edit or format. The Objects Roll-Up can also be used to 
select objects. The thumbnails of the selected objects in the Objects Roll-Up are surrounded by a highlighting 
rectangle.
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Selecting an object

To select an object
1. Click the Object Picker tool.
2. Click anywhere inside the object’s marquee. 

Eight handles surround the object along its highlighting box.

To select an object using the Objects Roll-Up
1. Click View, Roll-Ups, Objects.
2. In the Roll-Up, click the thumbnail associated with the object you want to select.

A border surrounds the thumbnail in the Roll-Up and if the Object Picker tool is selected, selection handles 
appear along the object’s highlighting box in the Image Window. 
If another object was already selected, both objects are now selected.
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Selecting multiple objects
When you select multiple objects, you can move, size, rotate, skew, distort, and apply perspective to all the 
objects at one time. Clicking away from the objects deselects them.

To select multiple objects
1. Click the Object Picker tool.
2. Hold down SHIFT and click each object you want to select.

To select multiple objects by dragging
1. Click the Object Picker tool.
2. Click and drag to enclose all objects you want to select. 
3. Release the mouse button.

Only the objects you completely enclose in step 2 are selected. Objects that are only partially enclosed are not
selected.

 Tip
· Hold down ALT while you drag, to ensure that all objects that intersect with the marquee selection box are 

selected, even the ones that are not completely enclosed by it. Release the mouse button before releasing ALT.

To select multiple objects using the Objects Roll-Up
1. Click View, Roll-Ups, Objects.
2. In the Roll-Up, click each thumbnail associated with the objects you want to select.

A border surrounds the thumbnails in the Roll-Up and selection handles appear along the highlighting box that 
encloses all selected objects in the Image Window. 

 Note
· When working in Layer or Single mode, you can select several objects at once using these procedures, and 

transformations like rotation, skewing, scaling, distorting, mirroring, and perspective can be applied to all of 
them. However, only the object that has the pencil icon next to its name in the Objects Roll-Up can be edited 
with the tools in the Toolbox, and the commands in the Image and Effects menu.
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Selecting all the objects in an image
· Click Object, Select All. 

A single highlighting box surrounds all objects in the image.
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Deselecting objects

To deselect an object
· Click anywhere outside the object’s marquee.

To deselect one of several selected objects
· Hold down SHIFT and click inside the object’s marquee to deselect it.

The highlighting box shrinks to enclose the remaining selected object(s).

To deselect an object using the Objects Roll-Up
1. Click View, Roll-Ups, Objects.
2. In the Roll-Up, click the thumbnail associated with the object you want to deselect. 

The thumbnail’s highlighting rectangle disappears to indicate that the object is no longer selected.
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Moving, duplicating, and deleting objects

Moving
One significant advantage to using objects is the ease with which they can be moved anywhere in the Image 
Window. 
The quickest way to move an object is to drag it directly in the Image Window. The Tools menu provides several 
commands to set up guidelines and grid lines to make it easy to precisely place an object. You can even make 
the guidelines and the grid magnetic by enabling the Snap to commands, also in the Tools menu; when you use 
these commands objects that you move, automatically jump to the next guideline or grid line.
You can use the Position tab in the Tool Settings Roll-Up, or the Position mode button on the Property Bar, to 
move an object with precision using the Object Picker Tool. These options each provide controls to let you set the
object’s vertical (V) and horizontal (H) coordinates on the page. Coordinates can be relative to the current object 
position or to the image.
Fine adjustments to an object’s position can be made by repeatedly pressing the arrow keys on your keyboard. 
This feature is called nudge. The nudge distance, applied each time you press an arrow key, is set using the 
Options command found in the Tools menu.

Duplicates and drop shadows
You can create an exact copy of an object with the Duplicate command found in the Objects menu. The duplicate
superimposed on the original is a separate object; it has its own thumbnail in the Objects Roll-Up. The Drop 
Shadow command creates an object that has the same shape as the selected object and places it behind the 
original. The Drop Shadow dialog box offers additional controls for choosing the color of the shadow object and 
its precise location relative to the original.
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Moving an object using the mouse
Use the Snap To Grid and Snap To Guidelines commands found in the Tools menu if you want to align the object 
to a grid line or guideline. 

To move an object using the mouse
1. Click the Object Picker tool.
2. Click inside the object and drag to a different position on the page. Hold CTRL before moving the object to 

constrain the movement to a horizontal or vertical direction.
 Tips

· If you use the right mouse button to move the object, a menu is displayed when you release the mouse to 
allow you to cancel, move, or copy the object.

· As you are moving an object, an outline representing the object's shape is displayed under the cursor. To view 
a replica of the object as you are moving it, click the object and hold the position for several seconds before 
dragging the object to the new location.
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Moving an object a precise amount
1. Select the object.
2. On the Property Bar, click the Position mode.
3. Do one of the following:

· Type the horizontal  and vertical 
 absolute coordinates of the location where you want the top left of the object’s highlighting box to be located.

· Click the Relative Position button. The coordinates become zero. In the horizontal and vertical boxes, type 
the distance you want the object to move from its current location.

4. Click Apply.
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Moving an object in preset increments
The Options command found in the Tools menu allows you to set a distance increment you can use to nudge 
objects. You can move an object in increments of the specified nudge distance as many times as you want. You 
can also set a second nudge distance as a multiple of the first one, to allow you to move the object by a longer 
distance in a single operation.

To move an object in preset increments
1. Click Tools, Options.
2. Click the General tab, in the Options dialog box.
3. Type the desired distance increments in the Nudge box.
4. Type the number of repetitions of the nudge distance you want in the Super Nudge box. Click OK.
5. Select the object(s).
6. Do one or both of the following:

· Press an arrow key beside the numeric keypad to move the object in the arrow’s direction by the nudge 
distance

· Press SHIFT and the arrow key simultaneously to move the object by the Super-nudge distance.
7. Repeat step 6 as many times as necessary.
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Deleting objects
You can use any object-editing mode to delete one or several objects.

To delete objects
1. Select one or more object(s).
2. Click Object, Delete.
 Tip

· A quick way to delete objects is to select them and press DELETE on the keyboard.
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Duplicating an object
Selecting two or more objects in this procedure creates one duplicate of each object. All duplicates are separate 
objects that can be selected and edited individually.

To duplicate objects
1. Select one or more object(s).
2. Click Object, Duplicate.

A copy of the object is created and is superimposed over the original. 
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Creating a drop shadow
A drop shadow is a copy of an object’s shape, that is placed behind the original, but is slightly offset from it and 
colored differently. You can apply a drop shadow to several objects at once in any object-editing mode.
Keep in mind that the original object’s transparency and feathered or soft edge is duplicated in the shadow 
object. The feathering and opacity options you choose in the Drop Shadow dialog box are added to the attributes
already found in the original.

To create a drop shadow
1. Select the object(s).
2. Click Object, Drop Shadow.
3. Click the lock icon in the Drop Shadow dialog box to continually update the preview of the result of your 

selections.
4. In the Offset section, choose the position for the drop shadow relative to the original object.
5. Type the distance required for the offset in the horizontal and vertical boxes. Click Identical Values to make 

both distances the same.
6. In the Shape section, type the number of pixels you want feathered in the drop shadow and choose a direction 

for the feathered pixels in the Direction list box. 
Type zero if you do not want any feathering.

7. Type an Opacity value for the drop shadow in the Opacity box.
Zero is completely transparent, 100 is completely opaque.

8. In the color section, click the Black Shadow, White Shadow or Use Custom Color button.
If you selected custom color, click the color button to choose a color from the palette.

9. If you are satisfied, click OK.
The drop shadow is created; it is grouped with the original object. To manipulate either object individually, 
choose the Ungroup command in the Object menu.

 Note
· In the Objects Roll-Up, the shadow object is given the original object’s name with the word «shadow» 

appended.
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Viewing, ordering, and aligning objects
You can see a list of all objects included in the active image in the Objects Roll-Up which is accessed from the 
View menu or by double-clicking the Object Picker tool. In the Roll-Up each object and the image background are 
represented by thumbnails. You can change the size the Objects Roll-Up if there is not enough room in the list to 
see all objects.

Hiding and displaying objects in the Image Window
The Objects Roll-Up makes it easy to manage the objects in your image. It provides controls for selecting, 
displaying, hiding, and making objects editable. Hiding objects does not delete them; they simply become 
invisible. This frees up space in the Image Window for you to edit the image background or other objects that 
usually overlap with the hidden ones. Hidden objects are automatically locked, i.e., they cannot be modified.

Changing the order of objects
When there are multiple objects in an image, the objects stack on top of one another in the order in which they 
were created. The most recently created object is at the top of the stack. However, an object’s position in the 
stack might not be readily apparent just by looking at the image. Two objects might be placed beside each other.
The Objects Roll-Up shows you precisely where each object is in the stacking order and allows you to change the 
order. Each object in the image is listed in the Objects Roll-Up. The first object in the stacking order is positioned 
at the top of the list, followed by the second object and so on. To move an object to a different position in the 
stack, just click and drag its name in the Roll-Up. You can also reorder objects using the Order commands in the 
Object menu.

Aligning
Objects can be aligned to each other, to the center of the page, to guidelines, or to the grid. Aligning to 
guidelines is done manually by moving the objects to the desired location. The Snap To commands found in the 
Tools menu make the grid or the guidelines magnetic and force the selected object to move to the next guideline
or grid line. The object’s edge is what snaps to the guideline or grid line. To center objects on a guideline, you 
must disable Snap To.
The Align command lets you align objects precisely to each other, to the center of the image, or to a grid. 
Objects can be aligned horizontally or vertically in many combinations. When you align objects to each other, the
top-most selected object keeps its position, and all other objects are aligned to it according to the horizontal and 
vertical options that are chosen.
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Sizing the Objects Roll-Up
When there are many objects in the active image, the Objects Roll-Up’s list may not be long enough to display all
thumbnails associated with them. You can make the Objects Roll-Up longer. 

To size the Objects Roll-Up
1. Double-click the Object Picker tool.

The Objects Roll-Up opens.
2. Place the cursor over the Objects Roll-Up bottom border until it becomes a double-headed arrow.
3. Drag to size the object list.
 Note

· If you regroup the Objects Roll-Up with any other Roll-Up after sizing it, the current size is kept. If you switch 
between Roll-Ups in the group, the Objects Roll-Up is always displayed at the size you selected using this 
procedure until you change it. 
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Hiding and displaying objects
If you are working in Multi mode, hiding an object ensures that changes made to the image do not affect that 
object. In other editing modes, all objects other than the one you are currently editing are protected 
automatically. Objects are most often hidden when you want to work on areas close to, or surrounding the 
objects.
You can also use this procedure to hide the image background. A non printable transparency grid is then 
displayed in the Image Window. This grid occupies every space where the image background was visible. You can
choose the transparency grid colors in the Options dialog box accessed from the Tools menu.

To hide an object
1. Click View, Roll-Ups, Objects.
2. Click the eye icon that is located to the right of the object’s thumbnail.

The eye icon becomes gray and the object is hidden from view. 

To display a hidden object
· Click the eye icon again. 

The eye icon becomes black and the object is once again visible in the image.
 Note

· Multi mode allows you to hide all image components. When you work in Layer or Single modes, the editable 
object, i.e., the object that has the pencil icon associated with it in the Objects Roll-Up, cannot be hidden. 
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Changing the order of objects
The image background is considered an object and has a thumbnail in the Objects Roll-Up. It is always placed at 
the bottom of the list of objects in the Roll-Up because no object can be placed behind it.

To change the order of objects using the Order command
1. Select one or more object(s).
2. Click Object, Order, and choose an option.

· To Front  places the selected object in front of all objects in the image.
· To Back  places the selected object behind all objects in the image.
· Forward One  places the selected object in front of the object it was behind.
· Back One  places the selected object behind the object it was in front of.

 Note
· To see the current order of the objects in your image or to change the order of objects interactively, open the 

Objects Roll-Up from the View menu.
· When objects are grouped, they are considered to be at the same level in the stacking order. Therefore, you 

cannot, place another object between individual objects in a group. 
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Changing the order of objects interactively
An object’s position in the list in the Objects Roll-Up relates to its level in the stacking order within the image. If 
an object is second in the list, then you know that it is second in the stacking order, or below one other object in 
the image. The order of objects is only obvious when they overlap.

To change the order of objects interactively
1. Click View, Roll-Ups, Objects.
2. Click the object’s name and hold down the mouse button.
3. Drag the cursor in the direction you want to move the object in the stacking order.
4. When the dashed horizontal bar is located where you wish to position the object, release the mouse button.
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Reversing the order of objects
1. Click the Object Picker tool.
2. Hold down SHIFT and click to select two or more objects.
3. Click Objects, Order, Reverse Order.

The order of the selected objects is reversed.
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Aligning objects

To align objects to each other
1. Click View, Roll-Ups, Objects. 
2. Ensure that the object with which you want to align the other objects is higher than the other objects in the list

in the Objects Roll-Up. If it isn't, click and drag the object's name ahead of the other names in the list.
3. Hold down SHIFT and click to select the objects you want to align.
4. Click Object, Align.
5. Click the options you want.
 Note

· The objects align to the handles on their highlighting boxes.

To align objects to the center of the page or to the nearest grid point
1. Select the objects to align.
2. Click Object, Align.
3. Click the Align to Center of Page checkbox.
4. Do one of the following:

· Click OK to align the object to the center of the page.
· Click the Align to Grid checkbox and choose the horizontal and vertical alignment options you want.
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Aligning an object in the Image Window
1. Select the object you want to reposition.
2. Click Object, Align.
3. Select a position for the object in the Image Window. For example, select Top Left, by choosing from the 

vertical and horizontal options.
 Tip

· To align the object to the center of the page or to the nearest grid point, click that option first, then specify the
options you want.
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Grouping and combining objects

Grouping
Grouping objects allows you to select and transform them as a single object. When an object in a group is 
selected, a single highlighting box appears around the entire group. In the Objects Roll-Up, the thumbnails of 
objects in a group are linked by a thick black line.
After objects have been grouped, any command or operation applied to the group affects all objects in the group.
You can cut or copy the group to the clipboard, or scale, skew, rotate, mirror, distort or apply perspective to the 
group. 
Editing all objects in a group with the painting, undo, or effect tools, or applying special effects to them, can only
be done in Multi mode. Working in one of the other object-editing modes only affects the object within the group 
that is currently editable as indicated by the pencil icon in the Objects Roll-Up.
Grouped objects can easily be ungrouped to allow you to select and edit them individually.
The Layer and Single modes allow you to edit individual objects within a group without having to ungroup them. 
Step by step instructions are provided in the Editing Objects section.

Combining
Objects can be merged, or combined, with the image background or with each other. If you merge the object 
with the image, the object no longer floats; it becomes part of the image at its current location. The object can 
no longer be selected and edited as a separate object. You usually combine objects when they are in the state 
you want, or when you have pasted data from the clipboard and want to integrate it with the image. 
Merging two or more object together makes them become a single object. The new object is still enclosed by an 
object marquee but the original objects that were used to create it can no longer be selected individually. The 
image’s file size is reduced.
You can choose any merge mode to combine objects with the background or with other objects. Merge modes 
determine how the color of the object pixels are combined together or with the color of the image pixels 
underneath them in the image background.
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Grouping objects
Grouped objects can be moved, sized, or deleted as a single entity. You can also apply transformations such as 
rotation and skewing to all objects in the group in one operation. Grouping objects that represent a complete 
element (e.g., the elements of a logo) prevents them from being accidentally separated.

To group objects
1. Click the Object Picker tool.
2. Hold down SHIFT and click each object you want to select.
3. Click Object, Group. 

The objects are now grouped. In the Objects Roll-Up, the thumbnails of each object within the group are 
attached by a thick black line.

To add an object to an existing group
1. Select the group of objects.
2. Hold down SHIFT and click the object you want to add to the group.
3. Click Object, Group.
 Note

· You can group two or more existing groups to create a single entity.
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Moving only one object within a group
Moving one object within a group allows you to adjust its position precisely without having to first ungroup.

To move only one object within a group
1. Click the Object Picker tool.
2. If the group of objects is selected, click anywhere in the Image Window to deselect it.
3. Do one of the following:

· Click and drag to enclose the object in a selection marquee.
· Hold down ALT and click and drag to touch a section of the object with a selection marquee.
Only the object that is enclosed or touched is selected; handles appear along its highlighting box.

4. Click and drag the object to the new location.
 Note

· If you click away from the object, it is deselected. If you click it again the entire group is selected.
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Ungrouping objects
1. Click the Object Picker tool.
2. Click one of the objects in the group.

The group is selected.
3. Click Object, Ungroup. 

The objects are ungrouped but all remain selected. Click away from the group to remove the handles. 
Individual objects can now be selected and edited.
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Selecting multiple groups of objects
· Hold down SHIFT and click an object from each group. A single highlighting box surrounds the groups.
 Tip

· You can also select multiple groups by clicking and dragging a marquee around them.
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Merging objects with the background image
You merge objects with the background image when they are exactly the way you want them to look in the final 
output. This eliminates the risk of moving them accidentally. You can affect the way the combined objects and 
the background image will look by using any of Corel WEB.PhotoPaint’s merge modes. The merge modes are not 
available for black and white and paletted images.

To select a merge mode
1. Click View, Roll-Ups, Objects. 
2. Select an object by clicking its thumbnail.
3. Click a merge mode from the Merge list box.

In the Image Window, the colors in the object change to show you the effect of the selected merge mode. This 
is only a preview. The object is not merged at this point; the object marquee is still visible along its outline and 
its thumbnail is still present in the Objects Roll-Up.

To merge an object with the background
1. Select the object. 

To merge several objects at once, select them by holding down SHIFT.
2. Click View, Roll-Ups, Objects.
3. If you have not done so, choose a merge mode in the Merge list box in the Roll-Up.
4. Move the Opacity slider if you want to change the transparency level of the objects.

The object in the Image Window displays the opacity level selected.
5. Click Object, Combine, Objects With Background.

The object becomes part of the image using the merge mode and opacity level selected in the Objects Roll-Up.

To merge all objects in the image
· Click Object, Combine, All Objects With Background.
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Combining objects together
Combining objects is a permanent operation that can only be reversed using Corel WEB.PhotoPaint’s undo 
capabilities.

To combine objects together
1. Click the Object Picker tool, hold down SHIFT, and click each object you want to combine.
2. Click View, Roll-Ups, Objects.
3. Click the eye icon next to the image background to make it invisible. If the selected objects do not have 

overlapping areas, go to step 5.
4. Choose a merge mode in the Merge list box.

The merge mode you choose will be applied to the overlapping sections of the objects you are merging 
together.

5. Move the Opacity slider if you want to change the transparency of the objects.
The objects in the Image Window display the opacity level selected.

6. Click Objects, Combine, Objects Together. 
The selected objects are permanently combined into a single object.

 Note
· Like all objects, the combined object can be moved, sized, and transformed using the commands in the Object 

menu, or the controls in the Object Picker tool’s Property Bar.
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Transforming objects (page 1 of 2)
Objects can be sized, scaled, rotated, skewed, distorted, flipped, and have perspective applied to them. Most of 
the transformations can be performed using the tabs of the Tool Settings Roll-Up, or the modes of the Property 
Bar associated with the Object Picker tool. The Tool Settings Roll-Up tabs, and the Property Bar modes, let you 
make very precise adjustments to the object. The object distortion and perspective transformations cannot be 
applied using the Roll-Up or the Property Bar; they are applied directly to the object by using the handles that 
appear along the object’s highlighting box when it is selected.
You can also perform all other transformations directly in the Image Window by using the handles of the 
highlighting box. Transformations can be applied to one object, to several selected objects, or to a group of 
objects in all object-editing modes.

Tool Settings Roll-Up and Property Bar
The following is a description of the Tool Settings Roll-Up transformation tabs and Property Bar modes, displayed 
when the Object Picker tool is selected.
The Object Position tab provides controls for placing the object at precise coordinates in the Image Window. 
Instructions are provided in the "Moving, duplicating, and deleting objects" section earlier in this chapter.
The same controls are found in the Object Picker tool’s Property Bar when you choose . 

The Object Rotate tab provides controls for rotating the object on the page. Controls include vertical (V) and 
horizontal (H) coordinates for the center of rotation, and rotation angle. Settings can be displayed relative to either 
the current object position or to the image.

The same controls are found in the Object Picker tool’s Property Bar when you choose . 
The Object Scale tab provides controls for scaling the object. Controls include vertical (V) and horizontal (H) scaling 
percentage settings, plus controls for creating mirrored versions of the objects along either the vertical or horizontal
axis. You can maintain the object’s aspect ratio as you change the scale settings.
The same controls are found in the Object Picker tool’s Property Bar when you choose . 

The Object Size tab provides controls for sizing the object. Controls include horizontal (H) and vertical (V) size 
settings. You can maintain the object’s aspect ratio or size it on each axis independently.
The same controls are found in the Object Picker tool’s Property Bar when you choose . 

The Object Skew tab provides controls for skewing, or slanting, the object. Controls include vertical (V) and 
horizontal (H) settings. Vertical settings greater than zero skew the object by moving its right side; negative 
settings, by moving its left side. Horizontal settings greater than zero skew the object by moving its bottom; 
negative settings, by moving its top.

The same controls are found in the Object Picker tool’s Property Bar when you choose . 

Apply To Duplicate
The Apply To Duplicate option is used to apply the transformations to a copy of the object. When you are 
satisfied with the results of the transformation, you can delete the original object. 

Units of measurement
Sizes used in the Tool settings Roll-Up and on the Property Bar are the dimensions of the object in the current 
units of measurement. You can change the units in the Options dialog box accessed from the Tools menu.
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Transforming objects (page 2 of 2)

Anti-aliasing
All pixels in any given image or object are little squares that are aligned horizontally and vertically to produce a 
grid-like structure. To produce a curved or diagonal edge for an object, pixels that are diagonal to each other are 
selected to be part of the edge. This can produce a jagged edge. Anti-aliasing fills the pixels that are located in 
the gap between the pixels in the object’s edge with an intermediate or semi transparent color. This smoothes 
the edges of the object and makes the object blend more easily with the background without loosing any detail 
included in the object.
The jagged edges are usually not visible at first glance. When you scale, skew, or rotate an object, however, they
can become painfully obvious. For that reason, the Tool Settings Roll-Up and the Property Bar for the Object 
Picker tool both provide an Anti-aliasing option. It is enabled by default. Even if you use an object’s handles to 
apply transformations, the Anti-aliasing option is functional. Disabling the Anti-alias option makes the object 
edges appear quite jagged, especially when multiple transformations are applied to it in different sessions.

Previewing and applying transformations
Whenever you drag a transformation handle or use a control in the Tool Settings Roll-Up or Property Bar, the 
selected object changes in the Image Window; this is only a preview of your choices. You can press ESC or 
double-click outside the object to cancel the transformation. This enables you to experiment with 
transformations before making a commitment.
Regardless of the method you use, transformations are applied to the object only when you press ENTER, double-
click inside the object, click the Apply button on the Property Bar or in the Tool Settings Roll-Up, or choose 
another tool. 

Maintaining the quality of objects
Applying successive separate transformations to an object, i.e., applying one, then another, etc., eventually 
erodes the quality of the object. If you want to perform several transformations, for example scaling, skewing 
and rotating, you will achieve better results if these operations are done in preview mode as a series of 
operations that end with a single use of the Apply button, ENTER key, or double mouse click inside the object.
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Sizing and scaling objects precisely
Sizing allows you to set the width and height for the object. Scaling an object adjusts its size to a percentage of 
the starting size.

To size an object
1. Select the object with the Object Picker tool.
2. On the Property Bar, choose the Size mode.
3. Type the horizontal  and vertical 
 dimensions. Click the Maintain Aspect button to keep the object’s current height to width ratio.

If Maintain Aspect is enabled, type only one dimension; the other dimension is calculated automatically. If you 
type both dimensions before choosing Maintain Aspect, the last dimension you typed in kept and the other is 
modified to maintain the aspect ratio.

4. Do one or both of the following:
· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

To scale an object
1. Select the object.
2. On the Property Bar, choose the Scale mode.
3. Type the scaling factor in percentage, in the horizontal  and vertical 
 boxes.

4. Click the Maintain Aspect button to keep the object’s current aspect ratio (optional).
5. Do one or both of the following:

· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.
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Sizing an object interactively in the Image Window
Sizing handles allow you to change only one dimension of the object and, therefore, to change its aspect ratio, or
to change both dimensions at the same time to preserve the object’s aspect ratio.

To change only one dimension of the object
1. Select the object.
2. Drag a center handle on any side of the highlighting box.
3. Release the mouse button.
4. Repeat steps 2 and 3 until the desired size has been achieved.
5. Double-click inside the object to apply the transformation, outside the object to cancel.

To size an object proportionately
1. Select the object.
2. Drag a corner handle on the highlighting box.
3. Release the mouse button.
4. Repeat steps 2 and 3 until the desired size has been achieved.
5. Double-click inside the object to apply the transformation, outside the object to cancel.
 Tips

· For both procedures, hold down the CTRL key to increase or decrease the size of the object in 100% 
increments. 

· Hold down SHIFT to size the object from the center, i.e., the object’s center does not move; the change in size 
occurs in opposite directions if you drag a center handle, and in all four directions if you drag a corner handle.

· You can use both CTRL and SHIFT at the same time to size in 100% increments without moving the center. 
· You must hold down the keys before you start to drag, and you must release them only after you have 

released the mouse button.
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Rotating an object
Objects can be rotated around a pivot point called the center of rotation. By default, the center of rotation is 
located in the middle of the object’s highlighting box. It is represented by a bull’s-eye icon in the Image Window. 
You can change the location of this icon.

To rotate using the Property Bar
1. Select the object.
2. On the Property Bar, choose the Rotate mode.
3. Type the horizontal and vertical coordinates to define the position of the Center of rotation. (optional).
4. Type an angle in the Rotation Angle box.
5. Do one or both of the following:

· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

To rotate directly in the Image Window
1. Select the object.

Sizing handles appear on the object’s highlighting box.
2. Click inside the object. 

Rotation handles appear in the four corners of the highlighting box.
3. Drag the center of rotation to the desired location (optional).
4. Drag a corner handle and release the mouse button.
5. Repeat step 4 until you’ve rotated the object to the desired angle.
6. Double-click inside the object to apply the transformation, outside the object to cancel.
 Tip

· Click the Relative Center button to move the center of rotation based on its current position. The Horizontal 
and Vertical values are changed to 0. Type the distance (horizontal and/or vertical) by which you want to move
the center of rotation.
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Creating a mirror image of an object
Mirroring an object is essentially the same thing as flipping it horizontally, vertically, or both. The Flip command 
found in the Object menu produces the same result.

To mirror an object using the Property Bar
1. Select the object.
2. On the Property Bar, choose the Scale mode.
3. Do one or both of the following:

· Enable the Flip Horizontal button to mirror the object along its vertical axis.
· Enable the Flip Vertical button to mirror the object along its horizontal axis.

4. Do one or both of the following:
· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

 Note
· When you use the Property Bar, the object is flipped around an invisible line that goes through the exact 

center of either the object’s height or width, depending if you are mirroring it vertically or horizontally.

To mirror directly in the Image Window
1. Select the object. 

Sizing handles appear along the object’s highlighting box.
2. Drag a middle handle over the object past the middle node on the other side of the highlighting box.

Hold down CTRL while you drag to make the object the same size as it was before the transformation.
3. Double-click inside the object to apply the transformation, outside the object to cancel.
 Tip

· If you do not use the CTRL key to constrain the object, you can enable the Snap To Grid option under the Tools 
menu to help control sizing.
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Skewing an object
You use this procedure to slant the object.

To skew an object using the Property Bar
1. Select the object.
2. On the Property Bar, choose the Skew mode.
3. Adjust the horizontal  and vertical 
 settings to skew along that axis.

Horizontal settings greater than zero skew the object by moving its bottom; negative settings, by moving its 
top. Vertical settings greater than zero skew the object by moving its right side; negative settings, by moving 
its left side. 

4. Do one or both of the following:
· Click Transform to see a preview of the transformation in the Image Window (ESC cancels).
· Click Apply.

To skew an object directly in the Image Window
1. Select the object.

Sizing handles appear on the object’s highlighting box.
2. Click inside the object. 

The skewing handles are the straight double-headed arrows located in the center of each side of the 
highlighting box.

3. Drag a skewing handle and release the mouse button.
4. Repeat step 3 until you’ve achieved the desired effect.
5. Double-click inside the object to apply the transformation, outside the object to cancel.
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Distorting an object
1. Select the object.
2. Click twice inside the object.

Diagonal outlined arrows appear at each corner of the object’s highlighting box.
3. Drag the arrows and release the mouse button.
4. Repeat step 3 until you’ve achieved the desired effect.
5. Double-click inside the object to apply the distortion, outside the object to cancel.
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Applying perspective to an object
Perspective is the symmetrical distortion of an object that gives it a sense of depth and makes it look three-
dimensional. This is achieved by moving two handles away from each other. This makes that side of the object 
longer, and it appears to be closer to you than the other side. You could also move the handles closer to one 
another to make a side of the object appear further away. 

To apply perspective to an object
1. Select the object.
2. Click inside the object marquee three times.

Circular perspective handles appear in each corner of the object’s highlighting box.
3. Drag one handle.

The handle on the side opposite to the direction you are dragging moves away from the handle you are 
dragging.

4. Release the mouse button.
The object redraws and to give the illusion of depth.

5. Adjust the perspective until you’ve achieved the desired effect.
6. Double-click inside the object to apply the perspective, outside the object to cancel.
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Editing objects
Editing an object means many things. You can change an object’s color or shape, make it fade into the image 
background, erase part of it, alter the appearance of its edges, apply special effects to it, and more. Objects 
must be selected before they can be edited. 

Object-editing modes
Each object-editing mode in Corel WEB.PhotoPaint provides different options to protect the integrity of various 
areas of an image while you edit objects, and to limit the use of various features to a specific object. You can use
these options to ensure that you don’t accidentally edit the wrong object or modify the image background 
instead of the object. 
The tools or commands you select affect the object in different ways depending on the object-editing mode 
currently in use. For example, Multi is the only editing mode that allows you to use tools on several objects at 
once, or on a group of objects. The other modes, Single and Layer, only allow you to edit one object at a time, 
even if the object is included in a group. 

For more information see the following:
{button ,JI(`',`Protecting your work')} Protecting your work
{button ,JI(`',`Altering object edges')} Altering object edges
{button ,JI(`',`Editing the shape and color of objects')} Editing the shape and color of objects
{button ,JI(`',`Editing text objects')} Editing text objects
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Protecting your work
Many tools, as well as Image and Effects menu commands, can be applied to all areas of an image or be limited 
to one or several objects. Some special effects, when applied to objects only, can alter the overall shape of the 
object. For example, the Wet Paint effect alters the boundary of the object to include the dripping paint; 
therefore, some pixels that were outside the object before the effect was applied, are changed and become part 
of the object. This may be exactly the result you want. However, there may be times when you want to apply the
effect but keep the object’s shape intact. 
The Objects Roll-Up is used to choose the extent to which commands or tools affect the objects in an image. The 
Roll-Up provides access to the Multi, Single, and Layer modes and includes controls to protect both the objects 
and the image background.

{button ,AL(`OVR Editing objects;',0,"Defaultoverview",)} Related Topics



Protecting an object from editing changes
In Multi mode, you can lock objects to protect them from change. Single and Layer modes allow you to edit only 
one object, or the image background, at a time and automatically lock all other elements. A locked object 
remains visible in the Image Window.

To lock an object in Multi mode
1. Click View, Roll-Ups, Objects.

The Objects Roll-Up opens.
2. Identify the thumbnail associated with the object you want to protect.
3. Click the lock icon to the left of the object’s number. 

An object is protected when the lock icon in the Roll-Up is in the closed position. The locked object cannot be 
moved or otherwise edited.

To unlock an object in Multi mode
· Click the lock icon again. 

The lock icon opens to indicate that the object is once more editable.
 Tip

· If the lock icons do not appear in the Objects Roll-Up, you are working in either Layer or Single mode. Both 
modes automatically lock all objects that are not selected for editing.

 Note
· If all objects and the background are locked, you cannot switch from Multi to another object-editing mode.
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Maintaining an object’s shape when editing
This procedure assumes you are using commands in the Effects menu to edit an object. 

To maintain an object’s shape when editing
1. Select the object you want to apply an effect to with the Object Picker tool.
2. Click View, Roll-Ups, Objects
3. In the Objects Roll-Up, do one of the following:

· Click the Multi button and lock all objects except the one you want to edit by clicking their respective lock 
icons.

· Click the Single button and click the third column in the Objects Roll-Up to place the Pencil icon next to the 
object you want to edit.

4. In the Effects menu, choose the effect you want and its attributes, and apply the effect to the object.
The data inside the object marquee changes according to the effect you applied but its overall shape remains 
unchanged.

 Note
· Layer mode is the only object-editing mode in which you can change the overall shape of the object when 

applying special effects such as Swirl, Wet Paint and others.
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Protecting the rest of an image when editing an object
1. In the Image Window, select the object you want to edit.
2. Click View, Roll-Ups, Objects.
3. In the Roll-Up, click Single.

All areas of the image, except the selected object, are locked. They cannot accidentally be modified.
 Note

· If you return to Multi mode after editing an object in Single mode, all other objects and the image background, 
are automatically locked in the Objects Roll-Up. Click their respective Lock icons to unlock them.
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Editing individual objects within a group
Grouped objects can be ungrouped when you need to edit them individually. This procedure is an alternative 
which does not require the objects to be ungrouped.

To edit individual objects within a group
1. Select the group by clicking one of its objects.

Selection handles surround the entire group of objects.
2. Click View, Roll-Ups, Objects.

All objects included in the group have their respective thumbnails in the Objects Roll-Up attached by a thick 
black line to their left.

3. Click Single or Layer in the Objects Roll-Up.
Only one of the objects in the group can be edited at a time. A pencil icon is placed to the left of the name of 
the object that is currently editable. That object is also enclosed by the object marquee in the Image Window. 
However, the selection handles remain located around the entire group.

4. In the Objects Roll-Up, choose the object to edit within the group by clicking to place the pencil icon to the left 
of its name.
The other objects in the group cannot be edited.

5. Make the changes to the selected object using the tools and commands of your choice.
6. Repeat steps 4 and 5 as many times as necessary.
 Note

· If you return to Multi mode after editing an object in Single or Layer mode, the image background and all 
objects in the image that were not selected before you switched modes, whether they are part of the group or 
not, are automatically locked in the Objects Roll-Up. Click their respective Lock icons to unlock them.
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Altering object edges
Object edges must often be modified to make the object blend in with the rest of the image, or to make it stand 
out. For example, you might want to make an object stand out when it is in an image used in a web page on 
which users can click to access another site.
Corel WEB.PhotoPaint offers several features that allow you to alter the object edges in one operation rather 
than having to edit the edge pixels individually. 
The object marquee is very useful to identify the boundary of the object, but it can be in the way when you are 
editing object edges. You can adjust the position of the object marquees for objects that have soft edges, i.e., 
edges that have been feathered or anti-aliased that include pixels that are semi-transparent.

Feathering
Feathering softens and smoothes the edges of an object. This is done by gradually increasing the transparency 
of the pixels located along the object’s edge. You specify the width of the feathered section of the object, and the
transparency gradient you want to use. The gradient, called edge type, can have either a linear or a curved 
progression. Feathering reduces the sharpness of the object edges and will cause some loss of detail. You can 
use feathering to simulate Anti-aliasing on a hard-edged object, or to improve it when an anti-aliased object’s 
edges don’t appear smooth enough. Feathering affects more pixels than anti-aliasing.

Sharpening
Sharpening is the opposite of feathering; it makes the object edges stand out from the rest of the image by 
increasing their sharpness. This is done by choosing the grayscale or transparency value of the pixels located 
along the object’s edges and on which you want the marquee located. The transparency of pixels located on 
either side of this new marquee location changes, as to exclude or include them in the object.
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Feathering the edges of an object
1. Select the object.
2. Click Object, Feather.
3. Type a value, in pixels, in the Width box. 
4. Click an edge type in the Edges box. The options are Linear and Curved.

Edge type refers to the type of gradient used to gradually increase the transparency of the pixels in the 
feathering process. The choices are a linear or a curved progression. Linear makes the gradient progress in 
even increments of added transparency from the beginning to the end of the feathered section. Curved makes 
the gradient follow a slanted «S» shaped curve; this results in small transparency increments at the beginning 
of the feathered edge, larger ones in the middle, and small ones at the end. This makes the feathering look 
more concentrated.

5. Click OK.
 Tips

· Click the Preview button in the Feather dialog box to see the effect before applying it to your image.
· Click inside the preview window to zoom in on the image, and right-click to zoom out. You can reposition the 

image within the preview window by clicking on the image and dragging.
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Editing the shape and color of objects
Almost all of Corel WEB.PhotoPaint’s tools, effects, and image commands can be used to change the shape of an 
object, the color of all or some of the pixels it includes, or the transparency of those pixels. The changes you 
make to an object can be very discreet or quite dramatic. Experimentation is the key. Many tools and commands 
offer previews so you don’t have to commit to a change if you are not completely satisfied with it.

Objects Roll-Up
The Objects Roll-Up provides an opacity control that affects the transparency of all pixels in the selected object.

Tools
Some tools, such as the Object Transparency tool and the Object Transparency Brush, were designed specifically 
with object editing in mind. Other general purpose tools such as the Paint or Eraser tools, can be used to edit 
objects, but they also affect the image background. However, those general purpose tools can be limited to only 
affect selected objects. This is done by using the lock feature included in the Objects Roll-Up, or choosing an 
editing mode that protects all image components except the object you want to edit.

Effects
You can use the special effects found in the Effects menu to edit an object, the entire image, or a section of the 
image made editable with the use of a mask. The Objects Roll-Up controls are used to lock some objects and the 
image background so that only the object you want to change is affected by the effect you select. For additional 
information about effects, see Applying effects to your image.
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Filling an object with a different color or pattern
The Fill tool allows you to fill objects with a solid color, fountain fill, bitmap fill, or texture fill, in any object-editing
mode. In Multi mode, only the portion of the object you see is filled; if you fill an object that is partially behind 
another object, only the section of the object that is visible is affected by the fill. In Single or Layer mode, the 
object you are editing is completely filled even if it is behind another object.
All pixels filled with the selected color or pattern maintain their respective transparency value, i.e., if you fill a 
pixel that was 50% transparent with a dark green, it will still be 50% transparent but it will be dark green in color.

To fill an object
1. Select the object.
2. Click the Fill tool.
3. On the Property Bar, click the Fill button.
4. In the Select Fill dialog box, choose a fill type. Click the Edit button to choose attributes for the fill.
5. Click OK.
6. On the Property Bar, type the tolerance value in the box(es).
7. In the Image Window, click a pixel in the object whose color you want to change to the fill you have chosen.

The fill is applied to all pixels whose previous color fell within the Fill tool tolerance range specified in step 6, 
that are adjacent to the pixel you clicked with the Fill tool. A tolerance value of 100 fills all of the object’s 
pixels; a tolerance of 0 fills only the adjacent pixels that have the same color as the pixel you clicked.
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Adjusting an object’s overall transparency
You can change the transparency level of all pixels included within an object. If some pixels in the object have 
already been made somewhat transparent by processes such as feathering, their existing transparency will be 
affected by this procedure. They will become more transparent as a result of this operation.
You can change the transparency of several objects at a time by selecting them before using this procedure. This
is valid for all object-editing modes.

To adjust an object’s transparency
1. Click View, Roll-Ups, Objects.
2. In the Objects Roll-Up, select one or more objects by clicking their associated thumbnails. 

A border surrounds the thumbnails indicating that the objects have been selected.
3. Move the Opacity slider at the bottom of the Roll-Up.

Moving the slider to the left increases the level of transparency; the object becomes less opaque.
 Note

· The Opacity slider is not available for black and white, or paletted images.
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Adjusting the transparency of some pixels in an object
You can use a brush to apply various degrees of transparency to some of the pixels in an object. Each brush 
stroke applied to the object changes the transparency of the pixels touched by the brush. Brushing over the 
same pixels more than once increases the transparency until the maximum level has been reached. 

To adjust the transparency of some pixels in an object
1. Select an object.

In Multi mode, you can select more than one object when using these instructions. Single and Layer mode 
allow you to alter only the editable object.

2. Open the Object Tools flyout and click the Object Transparency Brush tool.
3. On the Property Bar, type a value in the Transparency box. 

The transparency value you choose is applied to all pixels touched with a single stroke of the brush tool’s nib.
4. Move the opacity slider to set the maximum opacity level for pixels touched by several brush strokes.
5. Click the Use Original Transparency button (optional).

When this option is enabled, the transparency value you apply is added to the existing transparency value of 
the pixels you brush. When the option is disabled, the transparency value you apply replaces the existing 
transparency value of the pixels.

6. Set other brush attributes such as its shape, size, flatten, rotation, and soft edge values.
7. In the Image Window, drag over the pixels you want to make more transparent in the object.

The pixels touched by a single brush stroke take on the transparency value set in step 3. The underlying image
begins to show through these pixels. Pixels touched more than once become increasingly transparent until 
they reach the limit set in step 4.

 Note
· If you set the maximum Opacity slider to zero and set a low Transparency value, one for example, brushing 

over the object removes the pixels from the object entirely and the object marquee is reshaped to exclude 
those pixels. This occurs because you are allowing a maximum of no opacity at all; the tool responds by 
making the object pixels you touch non existent.
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Fading an object into the background
You can use a transparency blend to make an object fade into the background or into another object. It can be 
applied to several objects at once. Fading is applied progressively through all the selected objects, according to 
their respective locations relative to the start and end points you select. Various shapes of transparency blends 
are available; for example, linear, radial, conical, and texture.

To fade an object into the background
1. Select one or more objects.
2. Open the Object Tools flyout and click the Object Transparency tool.
3. On the Property Bar, choose a blend shape in the Transparency Fill Type list box. This fill type will be applied to 

the object to make it fade. 
The blend path with its start and end points appears over the object(s). The start point is the square and the 
end point is the arrow. 

4. Set the transparency level for the start and end points of the fill by moving the Start Transparency and End 
Transparency sliders respectively.
By default, the start point is set to zero which is opaque, and the end point is set to 100, which is completely 
transparent.

5. Adjust the transparency blend by doing one or both of the following:
· Drag the current start and end points to other locations. The transparency blend updates after each move.
· Click and hold the mouse button anywhere in the image to reposition the start point and drag to the location

where you want the end point to be. The blend updates.
6. When you are satisfied, click Apply on the Property Bar or choose any other tool.

If you choose another tool without clicking Apply, a message box advises you that the Object Transparency 
tool has been used to modify the image, and asking if you want to apply the changes. Click Yes to apply them, 
No to discard them.

 Note
· The start and end points can be anywhere in the image, not necessarily on the object; in all cases, the actual 

change in transparency, however, is visible only within the object’s boundary.
 Tip

· Click the Use Original Transparency button on the Property Bar to apply an additional transparency blend to an
object you’ve already faded without canceling the first operation. 
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Editing the shape of an object using a mask tool
You can use this procedure in any object-editing mode. It deletes all object pixels that are not included in the 
mask selection. Make sure the object you want to edit is selected. If you define a mask over an object that is not 
selected and perform this procedure, the selected object will be deleted completely because none of its pixels 
are included in the selection.

To edit the shape of an object using a mask tool
1. Open the Mask Tools flyout and click a mask tool.
2. Use the mask tool to define an area on the object.

Anything inside the mask marquee will remain part of the object; whereas, any part of the object outside the 
marquee will be removed.

3. Click Object, Clip Object To Mask. 
The object is cut to fit the shape of the mask selection.
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Erasing color in an object
You can erase the color inside an object without altering the marquee; in this case, the erased sections display 
the image’s paper color. In Multi and Single modes, the Eraser tool is a paintbrush limited to painting with the 
current paper color.

To erase color in an object
1. Select the object.
2. Click View, Roll-Ups, Objects.
3. Click either the Multi or the Single button.
4. Click the Eraser tool.
5. On the Property Bar, change the attributes of the Eraser tool such as its size.
6. Drag over the object to erase the color. 

The paper color shows in the sections you have erased. The object marquee remains intact. The paper-colored 
sections are copied to the object so that if you move the object, they still display the paper color.
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Removing sections of an object
Use this procedure to make fine adjustments to an object’s shape. The Eraser tool or any of the Mask tools can 
be used to achieve the desired result. In Layer mode, the Eraser tool is a paintbrush that paints with 
transparency making the areas you pass over with it, transparent.

To remove sections of an object with the eraser tool
1. Click View, Roll-Ups, Objects.
2. Click the Layer button.
3. Make the object editable by placing the pencil icon next to its name.

The object is enclosed by a marquee in the Image Window.
4. Click the Eraser tool.
5. On the Property Bar, change the attributes of the Eraser tool such as its size.
6. In the Image Window, drag on the object to erase sections.

The object marquee shrinks to fit the new shape of the object as you drag. The pixels you erase are deleted, 
and the pixels in the underlying image or object appear in those sections. If the background or underlying 
object are hidden, the transparency grid appears where the pixels were deleted.

To remove sections of an object with Mask tools
1. Click View, Roll-Ups, Objects.
2. Click the Layer button.
3. Make the object editable by placing the pencil icon next to its name.
4. Choose a mask tool in the Toolbox.
5. Click and drag over the object to define the area to remove from it.
6. Click Edit, Cut. 

The selection defined with the mask tool is removed from the object; the object marquee changes shape 
accordingly.
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Adding to an existing object using tools
Layer mode can be used to add elements to an existing object. When the Layer mode is enabled, it places the 
object that is at the top of the stacking order on a transparent layer that covers the entire image. Any tool you 
use to add brush strokes, shapes, lines to the object, or to smear or smudge its existing pixels, does not affect 
the underlying image but only the object itself.

To add to an existing object using tools
1. Select the object.
2. Click Object, Order, To Front.
3. Click View, Roll-Ups, Objects.
4. Click the Layer button.
5. Choose a tool and set its attributes on the Property Bar.
6. In the Image Window, use the tool to create new object elements.
7. Repeat as necessary.

The object marquee grows to include all new elements you add to the object.
 Tip

· The elements you add do not have to be physically attached to the original object; they can placed anywhere 
in the Image Window while you remain in Layer mode. Regardless of their location, they are all part of the 
object. The object thumbnail is updated in the Objects Roll-Up.
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Editing text objects
By default, text created using Corel WEB.PhotoPaint’s Text tool is an object until you merge it with the 
background. That said, it is logical that any object transformation, such as change in transparency and size, can 
also be applied to text using the methods described in previous sections.
However, other text-specific modifications are possible such as changing the font, font size, style, alignment, 
character and line spacing. To perform these changes, you must select the text with the Text tool. 
It is important at this time to know that changing text attributes of text that has been rotated, skewed, scaled, or
sized cancels these transformations. Changes made to text with a special effect or an Image menu command are
also canceled if you change text attributes. It is therefore preferable to make the font, font size, style, and 
spacing changes before you apply other transformations.
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Sizing text
If you size text using the handles or the Object Picker Tool Settings Roll-Up, text quality is lost because the edges 
of the text can become jagged. It is better to change the font size which preserves the sharpness of the text’s 
edges.

To size text
1. Click the text with the Text tool until it is enclosed by a solid rectangle.

If the text object has been transformed with the Object Picker tool or with an Effect or Image menu command, 
a message box appears, to let you know that the transformations will be lost if you proceed.

2. Click OK to proceed.
The transformations are cleared, a box surrounds the text, and a blinking cursor appears in the text.

3. On the Property Bar, type a size in the Font Size box.
The text size changes in the Image Window.

4. Double-click outside the text, or choose another tool to apply the change.
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Aligning text
You can change the justification for a text object. This procedure uses the precise location you clicked to create 
the text as the reference point for the alignment.
You can select the text with the Object Picker tool and use the Align command found in the Object menu to 
reposition the text in the Image Window in relation to other objects.

To align text
1. Click the text object with the Text tool.

If the text object has been transformed with the Object Picker tool, or with an Effect or Image menu command,
a message box appears, to let you know that the transformations will be lost if you proceed.

2. Click OK to proceed.
The transformations are cleared, a box surrounds the text, and a blinking cursor appears in the text.

3. On the Property Bar, click the Left, Center, or Right alignment button to align the text within the box.
4. Double-click outside the text, or choose another tool to apply the change.
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Formatting text
1. Click the text object with the Text tool.

If the text object has been transformed with the Object Picker tool, or with an Effect or Image menu command,
a message box appears, to let you know that the transformations will be lost if you proceed.

2. Click OK to proceed.
The transformations are cleared, a box surrounds the text, and a blinking cursor appears in the text.

3. On the Property Bar, choose the text attributes (font, font size, alignment, type style, character spacing, and 
line spacing). The text automatically reformats as options are selected.

4. Double-click outside the text, or choose another tool to apply the change.
 Tip

· You can also format text using the Tool Settings Roll-Up accessed from the View menu.
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Editing text
1. Click the text object with the Text tool.

If the text object has been transformed with the Object Picker tool, or with an Effect or Image menu command,
a message box appears, to let you know that the transformations will be lost if you proceed.

2. Click OK to proceed.
The transformations are cleared, a box surrounds the text, and a blinking cursor appears in the text.

3. Use the arrow keys to scroll to the area you wish to edit and either type additional text or use BACKSPACE or 
DELETE to delete text.
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Adding images to Web pages
The saying "a picture is worth a thousand words" is particularly appropriate in reference to the Internet's World 
Wide Web. With the growth in popularity of the Web, it is rare to see a Web site that does not contain graphic 
images. Graphics add richness to your page; they set the tone, explain concepts visually, and add a look of 
professionalism.
Corel WEB.PhotoPaint gives you the tools to create professional-looking Web images, image maps, backgrounds, 
and even animation. The only limit is your imagination.

For more information see the following:
{button ,JI(`',`Moving between Corel WEBPhotoPaint and Corel WEBDESIGNER')} Moving between Corel 
WEB.PhotoPaint and Corel WEB.DESIGNER
{button ,JI(`',`Choosing a file format for the Web page 1 of 2')} Choosing a file format for the Web
{button ,JI(`',`Creating image maps and backgrounds')} Creating image maps and backgrounds
{button ,JI(`',`Simple animation for the Web')} Simple animation for the Web
{button ,JI(`',`Adding HTML tags')} Adding HTML tags
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Moving between Corel WEB.PhotoPaint and Corel WEB.DESIGNER
There are two ways of placing images in Corel WEB.DESIGNER from Corel WEB.PhotoPaint. If you launched Corel 
WEB.PhotoPaint from within Corel WEB.DESIGNER, you can use the Publish to Web.DESIGNER command (found in
the File menu) to insert the image at the cursor point. If you did not access Corel WEB.PhotoPaint from within 
Corel WEB.DESIGNER, you can edit, save, and close your image, and then place it in Web.DESIGNER using the 
Image command (found in WEB.DESIGNER's Insert menu). 
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Placing images in Corel WEB.DESIGNER
The Publish to WEB.DESIGNER command (in the File menu) lets you place your image in WEB.DESIGNER at the 
cursor point. If you did not access Corel WEB.PhotoPaint from within Corel WEB.DESIGNER, save and close your 
image, launch Corel WEB.DESIGNER, and place the image using the Image command (found in WEB.DESIGNER's 
Insert menu).

To publish a .JPG image to Corel WEB.DESIGNER
1. Click File, Publish to WEB.DESIGNER.
2. Click the down arrow next to the Save In list box, and choose a location for the image.
3. Type a name for the image in the File Name box.
4. Click Save.

The JPEG Export dialog box opens.
5. If you wish to use progressive loading, enable the Progressive Loading checkbox.
6. Move the Quality slider to determine the size and quality of the image.
7. Click OK.

To publish a .GIF image to Corel WEB.DESIGNER
1. Click File, Publish to WEB.DESIGNER.
2. Click the down arrow next to the Save In list box, and choose a location for the image.
3. Type a name for the image in the File Name box.
4. Click Save.

The GIF89 Options Export dialog box opens.
5. If you wish to use interlacing, enable the Interlace checkbox.
6. If you wish to make part of the image transparent, click the Image Color button, and then select the 

transparent color by clicking it on the Preview window, clicking it on the Color Palette, or by entering its index 
number in the Index box.

7. Click OK.
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Choosing a file format for the Web (page 1 of 2)
The two most common image file formats for the Web are Graphics Interchange Format (.GIF) and Joint 
Photographic Experts Group (.JPG or .JPEG). A new graphics file format, Portable Network Graphics (.PNG) is also 
used as an alternative to .GIF files. 
How do you know which format to use for your graphic? There are several things you should consider before you 
decide which format to use:
· the type of image you are creating
· the file size
· the image quality you want
· the display time
Generally, the .GIF format is considered the best choice for line drawings and graphics with few colors or sharp 
edges. JPEG is the preferred choice when saving images with broad tonal ranges, such as photographs or 
scanned images. Read the following descriptions of both formats, then determine the best format for your 
graphic by asking the question "Which format provides me with the best image quality in the smallest file size 
and displays best onscreen?"

GIF file format
GIF was developed as a cross-platform graphic standard and is supported by all graphical Internet browsers. GIF 
supports up to 8-bit color (256 possible colors), and you can store custom palettes with your image. GIF offers 
several advanced graphic options, including transparent backgrounds and image interlacing.
GIF files provide lossless compression, which means that when you convert to .GIF, all the file information is 
stored with the image, and the .GIF file looks exactly like the graphic you created. Because there is limited 
decompression required, .GIFs display fairly quickly onscreen.

PNG file format
PNG is a relatively new format developed as an alternative to .GIF files and should soon be supported by Internet
browsers and graphics software packages such as Corel WEB.PhotoPaint.
PNG supports true color as well as paletted-based graphics. It uses an advanced lossless compression system 
and also supports full transparency.

{button ,Next()} Click here to see the next page.
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Choosing a file format for the Web (page 2 of 2)

JPEG file format
JPEG was developed as a compression scheme specifically for computer graphics. JPEG supports up to 32-bit 
color (16.7 million colors), and is an excellent option for photographs and scanned images. 
JPEG files support lossy compression (loses unnecessary information that does not impede visual perception), 
providing high quality images with a high level of compression. You can choose the display quality, from high 
quality to very low quality reproductions. The higher the image quality, the larger the file size. JPEG images do 
require some decompression time when displaying on screen, but can be displayed progressively.
JPEG compression example
The original image size is 1,890 KB

400 KB using high quality 12 KB using low quality
(lowest compression) (highest compression)
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Converting an image to .GIF file format
An image's color mode must be 8-bit (256 colors) or less when converting to a .GIF format. If you choose to save 
your image as a .GIF and you don't see the option in the File Format list box of the Save dialog box, verify the 
color mode that you're working in.

To check the image's color mode
· Click Image, Info.

The image’s color mode information appears in the Type area.

To save an image as a .GIF file
1. Click File, Save As.
2. Choose CompuServe Bitmap (GIF) from the Save As Type list box.
3. Choose a folder in which to save the image in the Save In list box.
4. Type a name for the file in the File Name box and click OK.
5. In the Transparent Color dialog box, enable either 89a Format or 87a Format (the Transparent Color check box 

is disabled when using 87a Format).
6. Enable the Interlaced button, if desired.
7. Enable the Transparent Color button to make the image's background color invisible.
8. Click a color from the palette.

Choose the color that matches your Web page background, and ensure that the color does not appear in your 
image (otherwise that color will display as a transparent area).
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Converting an image to .JPEG file format
Your image's color mode should be 24-bit RGB or less when converting to .JPEG format. If you choose to save 
your image as a .JPEG and you don't see the option in the File Format list box, verify the color mode that you're 
working in.

To check the image's color mode
· Click Image, Info.

The image’s color mode information appears in the Type area.

To save an image as a .JPEG file
1. Click File, Save As.
2. Choose .JPEG Bitmaps (.JPG) from the Save As Type list box.
3. Choose a folder to save the image to in the Save In list box.
4. Type a name for the image in the File Name box.
5. Click OK.
6. In the JPEG Export dialog box, enable the Progressive check box, if desired.
7. Move the Quality Factor slider to the left to select a high quality image resolution, or to the right to lower the 

image resolution quality.
 Note

· The lower the image quality, the smaller the file.
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Creating image maps and backgrounds
Two new HTML features in Corel WEB.PhotoPaint are tags that allow you to add image maps and backgrounds in 
Web pages.

Image maps
Image maps are graphics with clickable areas that link the user to another Web page. The user clicks on the 
clickable area within the graphic, and is automatically linked to the designated page.
Image maps provide a variety of sophisticated navigation routes for users. You can create a toolbar as a single 
image, and create an image map that links each button to a different page. You can have a map of Europe and 
link to overview pages of each country. Any graphic can become an image map, but there are a few things to 
consider before you decide that you have the perfect graphic to create a map from.
There are two kinds of image maps: client-side and server-side. You select the kind of map to create, or you can 
create client and server maps, which provide the best of both worlds.
To use an image map in your Web page, you need to do the following:
· create the image as either a .GIF or .JPEG file
· determine whether to create a client-side, server-side, or client/server image map
· create a map file that contains the coordinates of the clickable areas, and the associated links for each area
· add the HTML codes in the main Web page to specify the image as an image map
· have a Common Gateway Interface (.CGI) on the server that responds to the image map (required if you 

create a server-side image map)
Corel WEB.PhotoPaint provides click and drag coordinate definition, which allows you to use the application's 
tools to specify the clickable areas of the image. Corel WEB.PhotoPaint also automatically generates a map file 
for you.

Backgrounds
Backgrounds are a new HTML feature that add visual appeal to Web pages. You can create solid colored 
backgrounds, or tile any image across the page. 
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Defining clickable areas for the image map
Corel WEB.PhotoPaint uses objects to define the clickable areas of the image map. When you save the image, 
the map coordinates are stored in a separate map file, and an HTML file is created with the code referencing the 
image map.

To define clickable areas for an image map
1. Create an object. For more information on creating objects, see Creating objects from scratch.
2. Click the Object Picker and click the object to make sure that the object is selected.

The object is surrounded by square handles when selected.
3. Click Object, Tag WWW URL.
4. Choose the object to make a clickable area from the Objects list box, if you have more than one object in the 

image.
5. Type the Universal Resource Locator you wish to link to in the URL box.
6. Type any relevant notes in the Comments box.

These notes are for your information only. They do not affect the image map.
7. Choose a clickable area shape from the Define Area As list box.
 Note

· The WWW Clickable Region Attributes area provides information about the clickable area's coordinates in 
relation to the image as a whole, as well as the width and height of the clickable area. All measurements are 
listed in pixels.

· The map and HTML files are not created until you save the image.
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Saving the image map file
Once you have defined the clickable areas for the image, you need to save the image as an image map file. 
When you save the image the following files are automatically generated by Corel WEB.PhotoPaint:
· an HTML page (with the file extension .HTM)
· a map file (with the extension .MAP) for Client/Server-side NCSA, Client/Server-side CERN, Server-side NCSA, 

and Server-side CERN images. Client-side image maps contain the HTML map tags directly in the HTML page.

To save the map file:
1. Type the name to give the .HTM file in the File Name box.

When you save the image, the HTML file is automatically generated with the name you assign.
2. Choose the map type from the Save As Type list box:

· Client-side
· Client/Server-side NCSA
· Client/Server-side CERN
· Server-side NCSA
· Server-side CERN

3. Type the name to give to the .MAP file in the Map Name box.
When you save the image, the .MAP file is automatically generated with the name you assign. You can remove 
the check option if you do not want to generate the map when saving as a server-side image.

4. Enable the Default URL check box and type a URL address in the box to make any part of the image that is not 
clickable link to that URL's Web page.

5. Enable the Include File Header Information check box to include information about the image in the .HTM file. 
It is very useful for maintenance purposes.
This information is not displayed on your Web page, but is embedded in the HTML code.

6. Include the following file information, if desired:
· the name of the author in the Created By box
· a description of the image file in the Description box
· server information, if applicable
· the name and type of image created, by enabling the Image File Type and Name check box
· the date that the image was saved, by enabling the Date check box
· the type of map file generated, by enabling the Map File Type check box
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Creating a solid background
You can use a solid color for the background of your Web page. In many ways, solid backgrounds are preferable 
to graphics backgrounds: they load faster, text is easier to read, and they add a clean, professional look. 
There are two ways of creating a solid background: you can use an HTML page creation package such as Corel 
WEB.DESIGNER and simply choose a color from the Color Palette, or you can include the background tag and a 
hexadecimal number to make the color appear in an HTML document.

To assign a background color
· Type <BODY BGCOLOR="#XXXXXX"> where XXXXXX equals the hexadecimal number in your HTML 

document.
Example: <BODY BGCOLOR="#FF0000"> would create a bright red background for the page.
The following list provides some sample colors to use as backgrounds.
Color Hexadecimal number to use
 black 000000
 white FFFFFF
 medium gray 808080
 bright red FF0000
 pink FF8888
 magenta FF00FF
 bright green 88FF88
 deep green 008080
 bright blue 0000FF
 light blue 8888FF
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Simple animation for the Web
Corel WEB.PhotoPaint's animation commands allow you to load existing animation or create new animation that 
you can easily save to a Web format as an .AVI, .MPG, .MOV, or animated .GIF file. An animation is a single file 
that contains multiple frames. Each frame contains a different image: showing the frames one after the other in 
rapid sequence simulates motion. 
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Creating animations
When creating a new animation, start by determining the number of frames you'll need. Each frame is its own 
container for an image; you can choose to create your own images, or incorporate existing images into the 
frames.

To create an animation
1. Click File, New.
2. Choose a color mode from the Color Mode list box.
3. Click the arrow at the side of the paper color swatch to open the Paper color palette. If you wish to choose 

from a wider variety of colors, click Others to open the Select Color dialog box.
4. Click a color swatch to select it.
5. Type values in the Width and Height boxes to set the dimensions of the image. If you want to use a different 

unit of measurement, click the down arrow in the units box and choose a different measurement unit.
6. Type values in the Horizontal and Vertical boxes to set the resolution.
7. Enable the Create an Animation check box.
8. In the Number of Frames box, type the number of frames you want in the animation.
 Note

· Each frame appears as a separate, blank page. You can use Corel WEB.PhotoPaint's powerful painting tools to 
create original artwork in the frames.

To add an existing image to an animation frame
1. Ensure that all of the existing images you want to incorporate are the same size (see Changing an image’s 

dimensions).
2. Ensure that all of the images use the same color palette (see Converting your image to paletted image mode).

The best color palette options for Web pages are either Netscape Navigator  Colors or Microsoft Internet 
Explorer Colors.

3. Click Edit, Copy in the image to copy from.
Make sure that the image does not have any masked areas, and that no objects are selected.

4. Click anywhere on the animation file to make it the active window.
5. Click Edit, Paste, As New Object.
6. Click Object, Combine, Objects with Background.

You must complete this step if you do not want the pasted object to appear in all of the frames.
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Saving an animation
You can use any of four different file formats for animations you want to add to your Web page. The color mode 
of animations must be 8-bit or less (256 colors) to use the animated .GIF format. See Converting your image to 
paletted image mode for information on converting an image to paletted image mode. 

To save an animation in .GIF format
1. Click File, Save As.
2. Choose CompuServe Bitmap (.GIF) from the Save As Type list box.
3. Choose a folder in which to save the image in the Save In list box.
4. Type a name for the file in the File Name box and click OK.
5. In the Transparent Color dialog box, enable either 89a Format or 87a Format (the Transparent Color check box 

is disabled when using 87a Format).
6. Enable the Interlaced button, if desired.
7. Enable the Transparent Color button to make the image's background color invisible.
8. Click a color from the palette.

Choose the color that matches your Web page background, and ensure that the color does not appear in your 
image (otherwise that color will display as a transparent area).

To save an animation in .MPG format
1. Click File, Save As.
2. Choose a drive in which to store the file in the Save In list box. 
3. Double-click the folder where you want the file saved.
4. Type a name in the File Name box.
5. Click the arrow beside the Save As Type list box, and choose .MPG.
6. Click Save.
7. Move the Compression slider to set the level of compression you wish to use.
8. Move the Emphasis slider to set the loading speed and image quality.
9. Click OK.

To save an animation in .AVI format
1. Click File, Save As.
2. Choose a drive in which to store the file in the Save In list box. 
3. Double-click the folder where you want the file saved.
4. Type a name in the File Name box.
5. Click the arrow beside the Save As Type list box, and choose .AVI.
6. Click Save.

To save an animation in .MOV format
1. Click File, Save As.
2. Choose a drive in which to store the file in the Save In list box. 
3. Double-click the folder where you want the file saved.
4. Type a name in the File Name box.
5. Click the arrow beside the Save As Type list box, and choose .MOV.
6. Click Save.
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Viewing and navigating through animation frames
You can use the controls in the Animation menu to view your animation, and to navigate through its frames. You 
can fast forward or rewind to the beginning or end, or move through the animation frame-by-frame.

To play the animation
· Click Animation, Control, Play Animation.

To stop the animation
· Click Animation, Control, Stop Animation. 

To rewind to the beginning of the animation
· Click Animation, Rewind To Beginning. 

To fast forward to the end of the animation
· Click Animation, Fast Forward To End.

To move to a specific frame
1. Click Animation, Go To Frame. 
2. Type the number of the frame in the Frame box. 

To move forward one frame
· Click Animation, Control, Step Forward One Frame.

To move back one frame
· Click Animation, Control, Step Back One Frame.
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Adding and deleting frames
Corel WEB.PhotoPaint's Animation menu contains controls that allow you to manipulate the individual frames of 
animations in a variety of ways. Use these procedures to add or delete frames. 

To add new frames
1. Click Animation, Insert Frame.
2. Type the number of frames you wish to insert in the Insert Frames box.
3. In the Frame box, type the frame number before or after which you want to place the new frames.
4. Click a position button.
 Tip

· To create duplicates of the active frame, click the Copy Current Frame button.

To add frames from another animation
1. Click Animation, Insert From File.
2. Double-click the file name of the animation you want to add in the File Name box.
3. In the Frame box, type the number of the frame before or after which you want to place the animation file.
4. Click the Insert button.

To delete a single frame
1. Click Animation, Delete Frame.
2. In the From Frame box, type the number of the frame you wish to delete.
3. Type the same number in the To Frame box.

To delete a series of frames
1. Click Animation, Delete Frame.
2. In the From Frame box, type the number of the first frame you wish to delete.
3. In the To Frame box, type the number of the last frame you wish to delete.
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Changing the order of frames
Corel WEB.PhotoPaint's Animation menu contains controls that allow you to manipulate the individual frames of 
animations in a variety of ways. Use these procedures to move individual or series of frames. 

To move a single frame
1. Click Animation, Move Frame.
2. In the Move Frame box, type the number of the frame you wish to move.
3. Type the same number in the To Frame box. 
4. Click the Before or After button, and type the number of the frame beside which you want to move the frame.

To move a series of frames
1. Click Animation, Move Frame.
2. In the Move Frame box, type the number of the first frame you wish to move.
3. In the To Frame box, type the number of the last frame you wish to move.
4. Click the Before or After button, and type the number of the frame beside which you want to move the frames.
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Adding HTML tags
In order for your images to appear in Web pages, you must save the image in a file format that is readable by 
Web browsers (.GIF and .JPG are the most common file formats), and make a reference to the image in an HTML 
page.
HTML (Hypertext Markup Language) is the World Wide Web authoring standard. HTML is made up of markup 
tags. You use the tags to code text and integrated resources (such as images, sound, video, and animation) to 
create a Web page.
HTML has changed radically over the last few years. The number of HTML tags has grown, allowing Web authors 
to greatly enhance the design of pages. This section provides you with some of the codes that you can use to 
reference images in an HTML document. The section does not provide information on completing HTML pages, 
and you will not be able to produce a complete HTML page using these codes.
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HTML example codes
Use the following HTML codes to reference graphical elements to your Web page. It is not an exhaustive list, nor 
does it provide all the codes necessary to create a Web page.
· Basic image tag to add an image to the page: 

<IMG SRC="file name.file extension">
Example: <IMG SRC="family.gif">

· link to a graphic located in another Web site: 
<"IMG SRC="URL address/directory/file name.file extension">
Example: <IMG SCR="HTTP//www.website.com/mystuff/family.gif">

· Use the image as a hypertext link: 
<A HREF="html page to link to.html"><IMG SRC="graphic file name.file extension"></A>
Example: <A HREF="family.html"><IMG SRC="family.gif"></A>

· Create a solid background: 
<BODY BGCOLOR="#XXXXXX">
Example: <BODY BGCOLOR="#FF00FF">
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General keyboard shortcuts
Corel WEB.PhotoPaint allows you to use the CTRL, SHIFT, and ALT keys on your keyboard in conjunction with 
many of its painting and masking tools to quickly perform specific functions. For certain tasks, you’ll need to use 
a combination of these keys with the appropriate tool. When used with the appropriate tool, these keys allow you
to create perfectly square or circular objects and masks, constrain the movement of various tools either 
horizontally or vertically, size objects from their center, and connect brush stroke segments.

Shortcuts using the CTRL, SHIFT and ALT keys
Press... To...
CTRL Create perfect squares when using the Rectangle tool, perfectly square masks 

when using the Rectangle mask tool, and square cropping areas with the Crop tool
Create perfect circles when using the Ellipse tool and perfectly circular masks 
when using the Circle Mask tool
Constrain the line tool to create horizontal, vertical and 45 degree angle 
segments.
Constrain the brush to horizontal or vertical movements when using the Paint 
tools.
Constrain the movements of the Eraser, Color Replacer, Local Undo, Clone, and 
Effect tools to horizontal or vertical strokes.

SHIFT Change the constrain direction from horizontal to vertical or vice versa when using
the Paint, Effect, Clone, Eraser, Color Replacer, and Local Undo tools; SHIFT must 
be held down at the same time as CTRL to change direction; release SHIFT to 
return to the other direction
Make rectangles and ellipses expand and shrink from their center when created or 
resized. Also valid when resizing a cropping area created with the Crop tool.

ALT Connect all brush strokes when using the Paint, Effect, and Clone tools.
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Shortcuts for basic commands
Corel® WEB.PhotoPaint offers a number of ways of saving you a few clicks. You can access many of the dialog 
boxes through keystrokes or by clicking buttons on toolbars. 

Shortcuts for opening, saving, and closing down
To... Click...

Open the Create a New Image dialog box  on the Standard toolbar

Open the Open an Image dialog box  on the Standard toolbar

Open the Save Image to Disk dialog box  on the Standard toolbar

Open the Select Partial area dialog box  on the Property Bar

Maximize work area  on the Property Bar

Shortcuts for playing animations
To... Click...

Play a animation  on the Animation toolbar

Stop a animation  on the Animation toolbar

Rewind to the first frame of a animation  on the Animation toolbar

Fast forward to the last frame of a animation  on the Animation toolbar

To move forward one frame  on the Animation toolbar

To move back one frame  on the Animation toolbar
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Shortcuts for retouching and refining your image
PHOTO-PAINT offers a number of ways of saving you a few clicks. You can access many of the dialog boxes 
through keystrokes or by clicking buttons on toolbars. Don't forget you can add your own shortcuts by 
customizing the toolbars to include buttons that access the dialog boxes or commands you use the most.

Shortcuts for selecting Effect tools
To select the... Click...

Smear tool  on the Effect Tools toolbar

Smudge tool  on the Effect Tools toolbar

Brighten tool  on the Effect Tools toolbar

Contrast tool  on the Effect Tools toolbar

Hue tool  on the Effect Tools toolbar

Hue Replacer tool  on the Effect Tools toolbar

Sponge tool  on the Effect Tools toolbar

Tint tool  on the Effect Tools toolbar

Blend tool  on the Effect Tools toolbar

Sharpen tool  on the Effect Tools toolbar

Undither tool  on the Effect Tools toolbar
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Shortcuts for painting, filling, and editing
PHOTO-PAINT offers a number of ways of saving you a few clicks. You can access many of the dialog boxes 
through keystrokes or by clicking buttons on toolbars. Don't forget you can add your own shortcuts by 
customizing the toolbars to include buttons that access the dialog boxes or commands you use the most.

Shortcuts for selecting Paint tools
To select the... Click...

Art Brush tool  on the Paint Tools toolbar, or press F5

Airbrush tool  on the Paint Tools toolbar

Spray Can tool  on the Paint Tools toolbar

Pencil tool  on the Paint Tools toolbar

Ball Point Pen tool  on the Paint Tools toolbar

Calligraphic Pen tool  on the Paint Tools toolbar

Felt Pen tool  on the Paint Tools toolbar

Marker tool  on the Paint Tools toolbar

Highlighter tool  on the Paint Tools toolbar

Chalk tool  on the Paint Tools toolbar

Crayon tool  on the Paint Tools toolbar

Charcoal tool  on the Paint Tools toolbar

Pastel tool  on the Paint Tools toolbar

Watery Brush tool  on the Paint Tools toolbar

Artistic Brush tool  on the Paint Tools toolbar

Shortcuts for selecting editing tools
To select the... Click...
Blend tool  on the Effect Tools toolbar

Smear tool  on the Effect Tools toolbar
Smudge tool  on the Effect Tools toolbar
Hue tool  on the Effect Tools toolbar
Hue Replacer tool  on the Effect Tools toolbar
Sponge tool  on the Effect Tools toolbar
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Shortcuts for objects
There are many shortcuts available when you are working with objects. These shortcuts speed up your work. 

Object Toolbar buttons
Click... To activate...

Create From Mask

Multi object-editing mode

Single object-editing mode

Layer object-editing mode

Marquee Visible

Other shortcuts
Do this... To...
Double-click Open the Objects Roll-Up

Press... To...
SPACEBAR Activate Object Picker tool (does not work when Text tool is selected)
SHIFT + click object(s) Select multiple objects
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Shortcuts for masks
Many shortcuts are provided to help you speed up your work when working with masks. Accelerator keys and 
toolbar buttons are used to activate menu commands. Toolbox shortcuts constrain the behavior of mask tools or 
are used as alternatives to commands.

Mask Toolbar buttons
Click... To activate...

Create From Object
Normal mask mode
Additive mask mode
Subtractive mask mode
XOR mask mode

Select All

Remove

Invert

Mask Overlay

Marquee Visible

Double-click... To...
Rectangle/Circle/Freehand Create a mask covering the entire image
Any other mask tool Open the Tools Settings roll-up for the clicked tool.
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